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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you
or third parties arising from the use of these circuits, software, or information.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of
third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of
Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration,
modification, copy or otherwise misappropriation of Renesas Electronics product.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property
damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas
Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any
application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses incurred
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas
Electronics.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation
of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by
you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility
of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws
and regulations.

Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not use
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use
by the military, including but not limited to the development of weapons of mass destruction. When exporting the Renesas
Electronics products or technology described in this document, you should comply with the applicable export control laws and
regulations and follow the procedures required by such laws and regulations.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise
places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this
document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of
unauthorized use of Renesas Electronics products.

This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document
or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




How to Use This Manual

This manual describes the role of the CubeSuite+ integrated development environment for developing applications and

systems for RX family, and provides an outline of its features.

CubeSuite+ is an integrated development environment (IDE) for RX family, integrating the necessary tools for the

development phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the

need to use many different tools separately.

Readers

Purpose

Organization

How to Read This Manual

Conventions

This manual is intended for users who wish to understand the functions of the

CubeSuite+ and design software and hardware application systems.

This manual is intended to give users an understanding of the functions of the
CubeSuite+ to use for reference in developing the hardware or software of systems
using these devices.

This manual can be broadly divided into the following units.

CHAPTER 1 GENERAL

CHAPTER 2 FUNCTIONS
APPENDIX A WINDOW REFERENCE
APPENDIX B 1/0 FUNCTIONS
APPENDIX C INDEX

It is assumed that the readers of this manual have general knowledge of electricity,
logic circuits, and microcontrollers.

Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)

Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention

Remark: Supplementary information

Numeric representation: Decimal ... XXXX

Hexadecimal ... OxXXXX
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CubeSuite+ V2.00.00 CHAPTER 1 GENERAL

CHAPTER 1 GENERAL

CubeSuite+ is an integrated developing environment platform for the RX family, V850 family, RL78 family, 78 KOR
microcontroller and 78K0 microcontroller.

CubeSuite+ comprehensively supports the operations required for program development such as designing, coding,
building, debugging, and flash programming.

In this manual, the debugging is explained out of those operations needed for the program development.

Among them, this manual focuses on the description of debugging the outline of which is provided in this chapter.

1.1  Summary
You can efficiently debug the program developed for the RX family, using the debugger provided by CubeSuite+.

1.2 Features

The following are the features of the debugger provided by CubeSuite+.

- Connectable to various debugging tools
Usable in combination with the on-chip debugging emulator (E1/E20/EZ Emulator) and the simulator, it provides
improved efficiency in program development.

- Mixed display of C/C++ source text and disassembled text
The C/C++ source text and the disassembled text can be displayed together on the same panel.

- Source level debugging and instruction level debugging
C/C++ source program can be debugged either at the source or the instruction level.

- Data flash memory programming
When the selected microcontroller is provided with a data flash memory, you can display or edit the contents of the
data flash memory using the same access method as in other normal memory operations (not including the simu-
lator).

- Real-time display updating function
The values of memory, registers and variables are automatically updated not only when the program is stopped,
but also in execution.

- Saving/restoring the debugging environment
The debugging environment such as breakpoints, event configuration information, file download information, dis-
play condition/position of the panel, etc. can be saved.

R20UT2350EJ0100 Rev.1.00 RENESAS Page 8 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

CHAPTER 2 FUNCTIONS

This chapter describes the debugging process using CubeSuite+ as well as main debugging functions.

21

Overview

Following shows the basic sequence of program debugging using CubeSuite+.

(1)

(2)

©)

(4)

(5)

(6)

(7)

(8)

9)

Start CubeSuite+
Launch CubeSuite+ from the [Start] menu of Windows®.

Remark For details on "Start CubeSuite+", see "CubeSuite+ Integrated Development Environment User's
Manual: Start".

Set a project
Create a new project, or load the existing one.

Remark For details on "Set a project”, see "CubeSuite+ Integrated Development Environment User's Manual:
Start".

Create a load module
Once you are finished with the setting of the active project and the build, execute the build to create a load module.

Remark For details on "Create a load module" with CC-RX, see "CubeSuite+ Integrated Development
Environment User's Manual: Build".

Confirm the connection to a host machine
Connect the debug tool (E1, E20, EZ Emulator or Simulator) to be used to a host machine.

Select the debug tool to use
Select the debug tool to be used in a project.

Remark The selectable debug tool differs depending on the microcontroller type to be used in a project.

Configure the operating environment for the debug tool
Configure the operating environment for the debug tool selected in step (5).
- [E1]
- [E20]
- [EZ Emulator]
- [Simulator]

Connect the debug tool to CubeSuite+
Connect the debug tool to CubeSuite+ to start communication.

Execute downloading
Download the load module created in step (3) to the debug tool.

Displaying source files
Display the contents of the downloaded load module (source files) on the Editor panel or Disassemble panel.

R20UT2350EJ0100 Rev.1.00 RENESAS Page 9 of 506
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CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

(10) Execute programs
Execute the program using the operation method that matches your purpose.
If you wish to stop the program at the arbitrary position, set a breakpoint/break eventN°'® before executing the
program (see "2.10.2 Stop the program at the arbitrary position (breakpoint)"/"2.10.3 Stop the program at the
arbitrary position (break event) [E1] [E20] [EZ Emulator]").

Note These functions are implemented by setting events to the debug tool used.
See "2.17.7 Points to note regarding event setting", when you use events.

(11) Stop the program manually
Stop the program currently being executed.
Note that if a breakpoint/break event has been set in steps (10), the program execution will be stopped
automatically when the condition of the breakpoint/break event is met.

(12) Check the result of the program execution
Check the following information that the debug tool acquired by the program execution.
- Displaying and Changing Memory, Registers, and Variables
- Display Function Call Information from the Stack

- Collecting an Execution HistoryNOte

- Measuring the Execution TimeNote

- Measure Coverage [Simulator]

Note These functions are implemented by setting events to the debug tool used.
See "2.17.7 Points to note regarding event setting", when you use events.

Debug the program, repeating steps (9) to (12) as required.
Note that if the program is modified during debugging, steps (3) and (8) also should be repeated.

Remarks 1.  Other than the above, you can also check the result of the program execution by using the
following functions.

- Set an Action into Programs
- Setting Up the Hook Process
- Using the Debug Console

2. The acquired information can be saved to a file.
- Saving the displayed contents of disassembled results
- Saving displayed memory contents
- Saving the displayed CPU register contents
- Saving the displayed I/O register contents
- Saving the displayed contents of local variables
- Saving the displayed contents of watch-expressions
- Saving the displayed contents of call stack information
- Saving the displayed content of an execution history

(13) Executing an upload
Save the program (the memory contents) to a file in the arbitrary format (e.g. Intel hex format, binary data format,
etc.), as required.

(14) Disconnect the debug tool from CubeSuite+
Disconnect the debug tool from CubeSuite+ to terminate communication.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 10 of 506
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(15) Save the project file
Save the setting information of the project to the project file.

Remark For details on "Save the project file", see "CubeSuite+ Integrated Development Environment User's
Manual: Start".

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 11 of 506
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CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

2.2 Preparation before Debugging

This section describes the preparation to start debugging the created program.

2.21 Confirm the connection to a host machine

Connection examples for each debug tool are shown.
Note that the relationship between the microcontroller selected in the project and the connectable debug tools is as the
following table.

Remark "(Serial)"/"(JTAG)" in the table below means that E1/E20 is used with FINE communications or JTAG
communications.

Table 2-1. Relationship between Types of Microcontroller and Connectable Debug Tools

Microcontroller Debug Tool

E1(Serial) E1(JTAG) E20(Serial) E20(JTAG) | EZEmulator | Simulator

RX610, RX621, RX62N, - v - v - v
RX62T, and RX62G
Groups

RX630, RX631, and Vs v e v - v
RX63N Groups

RX63T Group v v v v e v

RX111, RX210, and e - v - v v
RX220 Groups

RX21A Group < - < - - <

1
2
3
4

[E1]

[E20]

[EZ Emulator]
[Simulator]

(1)
)
©)
(4)

(1) [E1]
Connect a host machine and E1. If required, connect a target board, too.
You can make a choice between FINE communications [E1(Serial)] and JTAG communications [E1(JTAG)] as the
communication method to the target system (see "2.3.1 Select the debug tool to use").
See E1 User's Manual for details on the connection method.

Figure 2-1. Connection Example [E1]

F -y «—O™ MQ
I Dedicated probe . il USB interface cable

- Host machine '
E1 CubeSuite+
Target system
R20UT2350EJ0100 Rev.1.00 RRENESAS Page 12 of 506
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(2) [E20]
Connect a host machine and E20. If required, connect a target board, too.

You can make a choice between FINE communications [E20(Serial)] and JTAG communications [E20(JTAG)] as
the communication method to the target system (see "2.3.1 Select the debug tool to use").

See E20 User's Manual for details on the connection method.

Figure 2-2. Connection Example [E20(JTAG)]

. =
I Dedicated probe \_ﬁ’ USB interface cable

Target system

Host machine @

CubeSuite+

Figure 2-3. Connection Example [E20(Serial)]

I Dedicated probe ! " . -

38-pin to 14-pin E20
' conversion adapterNOte

Target system

-— \\f USB interface cable
Host machine o

CubeSuite+

Note Use a 38-pin to 14-pin conversion adapter attached to the E20 emulator if you have selected FINE [E20

(Serial)] as the method of communication with the target system.

For more details on the connection using a 38-pin to 14-pin conversion adapter, see E20 User's Manual

(3) [EZ Emulator]
Connect a host machine and EZ Emulator. If required, connect a target board, too.
See EZ Emulator User's Manual for details on the connection method.

Figure 2-4. Connection Example [EZ Emulator]

R = o
USB interface cable

EZ Emulator Host machine

L)
CubeSuite+

R20UT2350EJ0100 Rev.1.00 RENESAS
Mar 01, 2013
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(4) [Simulator]
A host machine is only needed for debugging (emulators are not needed).

Figure 2-5. Connection Example [Simulator]

Host machine @

CubeSuite+

R20UT2350EJ0100 Rev.1.00 :{ENESAS Page 14 of 506
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2.3 Configuration of Operating Environment of the Debug Tool

This section describes the configuration of the operating environment for each debug tool.

2.31 Select the debug tool to use

You can configure the operating environment in the Property panel corresponding to the debug tool to use.

Therefore, first, select the debug tool to be used in a project (the debug tool to be used can be specified in the
individual projects).

To select or switch the debug tool, use the context menu shown by right clicking on the [Microcontroller type Debug tool
name (Debug Tool)] node on the Project Tree panel.

Figure 2-6. Select/Switch Debug Tool to Use

Project Tree ]
; @ 3|
= ﬂ_f; Sample {Projecty*

™ REFSA3T4EXFL (Microcontroller)
A, CC-R¥ (Build Tool)

B R Sirnlakor (ks Toal

) _",B File Using Debug Toal — » R E1(Setial)
| dbsct.c Praperty RX EL(ITAG)
U intprg.c
)5 R E2005erial)
J resekprg.c
ﬂ sample.c R E20(ITAG)
fj shrk.c R EZ Emulator
E-| wecktbl.c
: v
U indefine.h
h=| shrk.h

U stacksct.h
u tvpedefine.h

Caution The context menu items displayed differ depending on the microcontroller selected in the project
(see "Table 2-1. Relationship between Types of Microcontroller and Connectable Debug Tools").

Remarks 1.  [E1] [E20]
Select [Microcontroller type E1(Serial)l/[Microcontroller type E20(Serial)] to perform FINE
communications between E1/E20 and the target system.
Select [Microcontroller type E1(JTAG)]/[Microcontroller type E20(JTAG)] to perform JTAG
communications between E1/E20 and the target system.
2. [EZ Emulator]
Only FINE is supported for communication between the EZ Emulator and the target system.

If the Property panel is already open, click the [Microcontroller type Debug tool name (Debug Tool)] node again. The
view switches to the Property panel of the selected debug tool.
If the Property panel is not open, double-click the above mentioned node to open the corresponding Property panel.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 15 of 506
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232  [E1]

Configure the operating environment on the Property panel below when using E1.
Note that the contents of the Property panel differ depending on the communication method (FINE communications
[E1(Serial)] or JTAG communications [E1(JTAG)]) between E1 and the target system.

Figure 2-7. Property Panel [E1(Serial)]
Property (%)

==, R E1[Senal] Property B

E Internal R OMAAM

E Clock
Main clock source ExTAL
Main clock frequency[tdHz]
Allow changing of the clock zource an writing intemal flazh memary Mo
E Connection with Emulator
Emulator zenal Mo, (RS
El Connection with T arget Board
Power target from the emulator. (M 200md) Mo
FINE baud rate[bps] 2000000
= Flash
Input Mode of ID code Specify the 1D code as & 32-digit hexadecimal
ID code El FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
wiork, Rék start address [FE<] 1000

El Operating Modes of CPU

Maode ping zetting Single-chip mode
Reqister zetting Single-chip mode
Endian Little-endian data
El External Flash
Estermal flash definition file [4]

Size of internal ROM[K B ytes]
Size of the internal ROM

"\.‘Etnnnect Snal:tingglsé_,.t;lr Debug Tool Settings ,f' Download File Settings ,{f Hook Transaction Settings ,f -

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 16 of 506
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Figure 2-8. Property Panel [E1(JTAG)]
Property ]
S R ETUTAG) Property =)
=

B Clock

Main clock frequency[MHz]

Allow changing of the clock source on wiiting nternal flash memony Mo

El Connection with Emulator
Eruilator serial Mo, E 1o o

El Connection with T arget Board
Power target from the emulator. [Mak 200ma) Ma
JTAG clock[MHz] 165

El Flash
Input Mode of 1D code Specify the 1D code as a 32-digit hexadecimal
D code FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Wiork RAk start address 1000

= Dperating Modes of CPU
Maode pinz zetting Single-chip mode
Register zetting Single-chip mode
Endian Little-endian data

El External Flash

External flazh definition file [4]

Internal B OM/RAM

"\.‘ Conneck Settings _,{: Debug Tool Settings {{ Download File Settings ,{: Haook, Transaction Settings f -

Follow the steps below by selecting the corresponding tab on the Property panel.

(1) [Connect Settings] tab

(2) [Debug Tool Settings] tab

(3) [Download File Settings] tab
(4) [Hook Transaction Settings] tab

(1) [Connect Settings] tab

In the [Connect Settings] tab, you configure the connection with the debug tool for each one of the following

categories.
(a) [Internal ROM/RAM]
(b) [Clock]
(c) [Connection with Emulator]
(d) [Connection with Target Board]
(e) [Flash]
(f) [Operating Modes of CPU]
(9) [External Flash]

(a) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category.
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<1>

<2>

<3>

Figure 2-9. [Internal ROM/RAM] Category

E Internal BOMMAAM

[Size of internal ROM[KBytes]
The internal ROM size to emulate is displayed (unit: Kbytes).
You cannot change the value of this property.

[Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes).
You cannot change the value of this property.

[Size of DataFlash memory[KBytes]]

The data flash memory size is displayed (unit: Kbytes).

If the currently selected microcontroller does not incorporate the data flash, [0] is displayed.
You cannot change the value of this property.

(b) [Clock]
You can configure the clock in this category.

Caution You cannot change the property in this category while connected to E1.

<1>

Figure 2-10. [Clock] Category [HOCO]

E Clock
b ain clock source HOCO
Allovs changing of the clock zource on witing internal flash memon Mo
Figure 2-11. [Clock] Category [EXTAL]
=: Clocki
ain clock source ExTaL
kain clock frequency(bHz] 12.5000
Allovw changing of the clock source on writing internal flash memaon Mo
[Main clock source]

Select EXTAL frequency or internal HOCO as the main clock source. [EXTAL] will be displayed for
microcontrollers with no internal HOCO.

<2> [Main clock frequency [MHz]]
Specify the main clock frequency (before multiplier).
Specify EXTAL frequency by directly entering a number between 0.0001 and 99.9999 (MHz). The
entered value will be truncated to 4 decimal places. If the value is out of the specifiable range, it will be
rounded to 0.0001 (when 0 or below) or to 99.9999 (when 100 or above).
This property is displayed only when you have selected [EXTAL] in the [Main clock source] property.
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<3> [Allow changing of the clock source on writing internal flash memory]

Specify whether to allow a debugger to operate the clock while the internal flash memory is being
rewritten.

Caution [E1[RX630, RX631, RX63N, RX63T, RX210, RX21A, RX220, RX111]]
When [Yes] is selected, if internal flash ROM is rewritten by the debugger while the
FlashlIF clock (FCLK) of the microcontroller is outside of the guaranteed operating
range (that is, while operating with LOCO or subclock), the E1 will switch the clock
source. After rewriting to the internal flash ROM is completed, the clock will be
restored to the previous clock source.
Note that the operating frequency of the peripheral clock will change during internal
flash memory rewriting because the clock source is switched.
The clock manipulation enabling setting takes effect when the internal flash ROM is
rewritten after program execution or step execution. Note that the clock source is
forcibly switched regardless of the clock manipulation enabling setting if FCLK is
outside of the guaranteed operating range immediately after the debug tool is
activated or when the [CPU Reset] button is clicked.

(c) [Connection with Emulator]
You can configure the connection between E1 and the host machine in this category.

Caution You cannot change the property in this category while connected to E1.

Figure 2-12. [Connection with Emulator] Category

El Connection with Emulator
Ernulator zerial Mo, BT o

<1> [Emulator serial No.]

Serial numbers of all connected E1 emulators are displayed in the drop-down list.
Select the one to be connected to the target system.
The drop-down list is updated every time it is used.

(d) [Connection with Target Board]
You can configure the connection between E1 and the target board in this category.

Figure 2-13. [Connection with Target Board] Category [E1(Serial)]

E Connection with T arget Board
FPower target from the emulator [Mad 200md) Yes

FIME baud rate[bps] 2000000

Figure 2-14. [Connection with Target Board] Category [E1(JTAG)]

E Connection with T arget Board

FPower target from the emulator[MMad 200md,) Mo
JTAG clock[MHz] 165
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<1> [Power target from the emulator. (MAX 200mA)]
Specify whether to supply power to the target system from E1.
Select [Yes] to supply power to the target system ([No] is selected by default).

Caution This property cannot be changed while connected to E1.

<2> [Supply voltage]
Specify the power voltage supplied to the target system from the following drop-down list.
This property appears only when the [Power target from the emulator. (MAX 200mA)] property is set to
[Yes].
The voltage value that can be specified differs depending on the type of the microcontroller.

Caution This property cannot be changed while connected to E1.

<3> [Communications method]
Displays the method of communication used by the E1 emulator for communicating with the
microcontroller on the target system. Specifying [RX E1(Serial)] for a debug tool in the Project Tree panel
will display [FINE] in this property, and specifying [RX E1(JTAG)] will display [JTAG].
You cannot change the value of this property.
For the details of debug tool selection, see "2.3.1 Select the debug tool to use”.

<4> [JTAG clock[MHZz]]
From the drop-down list, select the baud rate (JTAG clock) to be used by the E1 emulator for
communicating with the microcontroller on the target system.
This property is displayed only when [JTAG] is selected in the [Communications method] property.
The following baud rate is displayed in the drop-down list.
- 16.5 (default), 12.38, 6.188, 3.094, 1.547

Cautions 1.  This property cannot be changed while connected to E1.
2. Depending on the length or the method of JTAG signal wiring on the target
system, it may not be possible to communicate using the selected JTAG clock. In
such a case, reducing the JTAG clock may achieve successful communication.

<5> [FINE baud rate[bps]]
From the drop-down list, select the baud rate (FINE baud rate) to be used by the E1 emulator for
communicating with the microcontroller on the target system.
This property is displayed only when [FINE] is selected in the [Communications method] property.
The following baud rate is displayed in the drop-down list.
- 2000000 (default), 750000, 500000, 250000

Cautions 1.  This property cannot be changed while connected to E1.
2. Depending on the length or the method of FINE signal wiring on the target system,
it may not be possible to communicate using the selected FINE baud rate. In such
a case, reducing the FINE baud rate achieve successful communication.

(e) [Flash]
You can configure the flash memory rewriting in this category.

Caution This property cannot be changed while connected to E1.
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<1>

<2>

<3>

Figure 2-15. [Flash] Category

B Flazh
[nput Mode of 1D code Specify the |0 code as a 32-digit hexadecimal
D code [Fe<] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Work, Rabd start address [He<] 1000
[Input Mode of ID code]

Specify a mode for the input of ID code.
Caution This property cannot be changed while connected to E1.

[ID code]

Specify the ID code to use when reading the code from the memory.

If you have selected [Specify the ID code as a 32-digit hexadecimal] in the [Input Mode of ID code]
property, enter the ID code in a 32-digit hexadecimal number. If you have selected [Specify the ID code
as an ASCII code within 16 characters], enter the ID code using maximum 16 ASCII characters.

Cautions 1.  This property cannot be changed while connected to E1.
2. If the ID code entered in ASCII characters is shorter than 16 characters, the
unused space will be padded with 0.

[Work RAM start address]

Specify the location address of the work RAM to be used by the debugger. Specify an address value that
is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value is automatically
corrected.

The amount of memory indicated by the [Work RAM size[bytes]] property beginning with this address is
to be used by the debugger firmware.

Cautions 1.  This property cannot be changed while connected to E1.

2. Although this area can also be used in the user program because memory
contents are saved and restored to and from the memory of the host machine by
the debugger firmware, do not specify this area as the source or destination of
transfer for the DMA or DTC function.

<4> [Work RAM size[bytes]]

Displays the size of the work RAM to be used by the debugger.

(f) [Operating Modes of CPU]
In this category, you configure the operating mode of the microcontroller to be emulated.

Caution This property cannot be changed while connected to E1.

Figure 2-16. [Operating Modes of CPU] Category

E Operating Modes of CPU

Mode pins zetting Uszer boot mode
Allow erasing the USE boat program Mo
Reqister setting Single-chip mode
Endian Little-endian data
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<1> [Mode pins setting]
Specify the operating mode set by the mode pin of the microcontroller.

<2> [Allow erasing the USB boot program]
Select whether to erase the USB boot program in the user boot area when you are starting up the
emulator in the user boot mode by using a microcontroller in which the USB boot program is stored.
This property is displayed only when [User boot mode] is selected for the [Mode pins setting] property.

<3> [Register setting]
Specify the operating mode to be set by the register.
The operating mode that can be specified depends on the type of the microcontroller.

<4> [Endian]
Display the project endian. Acquires endian information from the project and displays its value. Can be
selected only when the debug tool is disconnected.

(g) [External Flash]
In this category, you can configure external flash.
The settings in this category are required when downloading to an external flash memory. For more details
regarding property setting, see "(5) Downloading files to external flash memory [E1] [E20]“.

Caution You cannot change the property in this category while connected to E1.

(2) [Debug Tool Settings] tab
In the [Debug Tool Settings] tab, you configure the basic settings of the debug tool for each one of the following

categories.

(@) [Memory]

(b) [Access Memory While Running]
(c) [Register]

(d) [Break]

(e) [System]

(f) [Trace]

(9) [Timer]
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(a) [Memory]
You can configure the memory in this category.

Figure 2-17. [Memory] Category

E Memory

E Memory mappings [28]
[] Dn-chip Rak area
[1] Fezerved area
[£] [0 registers area
[3] Fezerved area
[4] [0 registers area
[5] [0 registers area
[E] Fezerved area
[¥] Data flazh area
[8] Fezerved area
[9] Qther memory area
[0 Fezerved area
[11] [0 registers area
[12] Fezerved area
[13] [0 registers area
[14] Fezerved area
[15] Euxternal area [C57]
[16] Euternal area [C5E]
[17] Euxternal area [C55]
[13] External area [C54]
[19] Euternal area [C53]
[20] Euternal area [C5:]
[21] Euxternal area [C51]
[22] Fezerved area
[23] Qther memory area
[24] Fezerved area
[25] Qther memory area
[26] Fezerved area
[27] Qn-chip ROM area
Werify on writing to memory ez

<1> [Memory mappings]
Current memory mapping status is displayed for each type of memory area.
It is not possible to change mapping on this panel.
To add or delete an /O protection area, select the [Memory mappings] property and click on the [...]
button that appears on the right to open the Memory Mapping dialog box. For details on how to change
settings, refer to the section of the Memory Mapping dialog box.
This property displays only the number of memory areas.
Expanding the [Memory mappings] property will display the following sub-items.
- [Memory type]
Indicates the memory type of the corresponding area.
Each memory type corresponds to the following areas.

On-chip ROM area Program ROMN°® 1 and data flashNote 2
On-chip RAM area On-chip RAM
I/O registers area Peripheral 1/O register
Divided into areas with different endians for display
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External area(CS7/CS6/.../CS0) External address space
CSO0 to CS7 are displayed separately

Other memory area FCU-RAMNete 3 Fcu firmwareNote 3, user boot

Reserved area Areas other than those listed above

I/O protection area Address range in an external area that is not read by the
debugger. Register this area in the Memory Mapping
dialog box.

Notes 1. |If data in the on-chip flash ROM area is changed by means other than downloading (e.g. by
manipulating it via the Memory panel or line assembling), the flash ROM reflects this change next
time the user program is run.

2. If an attempt is made to reference data in erased data flash ROM, only undefined values are
displayed due to the specifications of the microcontroller. If the debugger is used to write to the
data flash ROM, on the other hand, data is written in 256-byte units. Written areas do not hold
undefined values.

3. Do not use the debugger to write to FCU-RAM. The FCU firmware area also cannot be written by
the debugger.

- [Start address]
Displays the starting address of the corresponding area.
- [End address]
Displays the ending address of the corresponding area.
- [Access width[bits]]
Displays the access width of the corresponding area.
When [Memory type] is an external area, the access width can only be changed when the debug
tool is disconnected.
- [Endian]
Displays the endians of the external area and the I/O register area.
When [Memory type] is an external area, the endian can only be changed when the debug tool is
disconnected.

Caution Connecting to a debug tool (see "2.4.1 Connect the debug tool to CubeSuite+") will
display details for each memory type.

<2> [Verify on writing to memory]
Specify whether to perform a verify check when the memory value is initialized from the drop-down list.
Select [Yes] to perform verification after download or when values are changed in the Watch panel/
Memory panel.

(b) [Access Memory While Running]
You can configure the memory access while executing a program in this category.
The settings of this category are required when using the real-time display update function. See "(4)
Displaying and changing memory contents during program execution" for details on the real-time display
update function.
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Figure 2-18. [Access Memory While Running] Category

B Access Memory While Funning

fccess by stopping execution Ho
Ilpdate dizplay during the execution ez
Dizplay update intervallms] 500

<1> [Access by stopping execution]
Specify from the drop-down list whether to allow access to the memory area while executing a program.
Select [Yes] to allow access ([NO] is selected by default).

<2> [Update the display during execution]
Specify whether to update the display in the Watch panel/Memory panel while executing a program.
Select [Yes] to update the display (default).

Caution You cannot change this property while the program is in execution.

<3> [Display update interval[ms]]
This property is displayed only when the [Update the display during execution] property is set to [Yes].
Specify the interval in 100ms unit to update the contents in the Watch panel/Memory panel display while
executing a program.
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms)
([500] is specified by default).
Note that if you've changed the specified value of the [Update the display during execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(c) [Register]
In this category, make settings related to PC display in the Status bar during program execution.

Figure 2-19. [Register] Category

E Register
PC dizplay during the execution Yes
Dizplay update interval for PClms] a00

<1> [PC display during the execution]
This property specifies whether the PC value is displayed in the Status bar during program execution.
When you select [No], the Status bar under execution will show "Running."

Cautions 1.  You cannot change this property while the program is in execution.
2. [RX100 Series]
This property is hidden because these microcontrollers do not support display of
the PC value in the status bar during program execution.

<2> [Display update interval for PC[ms]]
This property is displayed only when you've selected [Yes] in the [PC display during the execution]
property.
During program execution, specify a PC display updating interval in the Status bar in 100 ms units.
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Enter an integer directly in the range 100 to 65500 (with fractions below 100 ms rounded up). (By default,
[500] is specified.)

Note that if you've changed the specified value of the [PC display during the execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(d) [Break]
You can configure the break function in this category.

Figure 2-20. [Break] Category

E Break
Type of breakpointz to be preferentially used Hardware break.

<1> [Type of breakpoints to be preferentially used]
Specify from the following drop-down list the type of preferential breakpoint to be used with a single click
of the mouse in the Editor panel/Disassemble panel.
When setting a break point after the preferential break point type has been used up, the other break point
type will be automatically selected.
See "2.10.2 Stop the program at the arbitrary position (breakpoint)" for details on breakpoints.

Software break Sets software breakpoint preferentially.

Hardware break Sets hardware breakpoint preferentially (default).

(e) [System]
You can configure the emulation system in this category.
For more information regarding the execution of a specified routine before the execution and after the break of
a program, see "2.9.4 Execute a specified routine [E1] [E20] [EZ Emulator]".

Figure 2-21. [System] Category

= System
Debug the program re-writing the on-chip PROGRARKM ROM Mo
Debug the program re-writing the on-chip DATA FLASH Mo
Execute the specified routing immediately before execution of the user program Yes
Routing to run immediately before execution starts
Execute the specified routing immediately after the uzer program stops Yes
Fouting to run immediately after execution stopz
Wiork RaM start address for executing a zpecified routine 1DDO

<1> [Debug the program re-writing the on-chip PROGRAM ROM]
Specify whether to debug programs that rewrite on-chip program ROM area, such as those that use
ROM P/E mode.

Caution You cannot change this property while connected to E1.
<2> [Debug the program re-writing the on-chip DATA FLASH]

Specify whether to debug programs that rewrite on-chip data flash area, such as those that use data
flash P/E mode.
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Caution You cannot change this property while connected to E1.

<3> [Execute the specified routine immediately before execution of the user program]
Specify whether to execute a specified routine before executing the user program.

Caution You cannot change this property while the program is in execution.

<4> [Routine to run immediately before execution starts]
Specify the address to be executed immediately before the user program execution. This property is
displayed only when [Execute the specified routine immediately before execution of the user program]
property is set to [Yes].

Caution You cannot change this property while the program is in execution.

<5> [Execute the specified routine immediately after the user program stops]
Specify whether to execute a specified routine after the user program break.

Caution You cannot change this property while the program is in execution.

<6> [Routine to run immediately after execution stops]
Specify the address to be executed immediately after the user program break. This property is displayed
only when [Execute the specified routine immediately after the user program stops] property is set to
[Yes].

Caution You cannot change this property while the program is in execution.

<7> [Work RAM start address for executing a specified routine]
Specify the address where the work RAM for use in execution of the specified routine starts. Specify an
address value that is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value
is automatically corrected. The amount of memory indicated by the [Work RAM size [bytes] for executing
a specified routine] property beginning with this address is to be used by the debugger firmware.
This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

Cautions 1.  You cannot change this property while the program is in execution.
2. Specify the range of memory that is not used by the user program.

<8> [Work RAM size [bytes] for executing a specified routine]
Indicates the size of the work RAM for use in execution of the specified routine.
This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

(f) [Trace]
You can configure the trace function in this category.
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Figure 2-22. [Trace] Category

B Trace
Operation after trace memary iz full Qvenwrite trace memon and continue execution
Trace data type Branch
COutput timestamp Yes

Trace clock count zource[MHz]

<1> [Usage of trace function]
[Trace] is displayed as the usage of trace function.
You cannot change the value of this property.
<2> [Operation after trace memory is full]
Select the trace acquisition mode from the following drop-down list.
Overwrite trace memory and continue Continues overwriting the older trace data after the trace memory is
execution full.
Stop trace Stops writing the trace data after the trace memory is full.
Stop Breaks after the trace memory is full.
<3> [Trace data type]
Select the type of data for which trace is to be acquired from the drop-down list.
The type of data that can be selected differs depending on the series of the microcontroller.
Following data types are displayed in the drop-down list.
- [RX600 Series]
Branch, Branch+Data access, Data access
- [RX100, RX200 Series]
Branch, Data access
<4> [Output timestamp]
Specify whether timestamp information is added to the trace data to be collected.
The change options in this property vary depending on the microcontroller series and the specified value
of [Trace data type] property, as follows:
Microcontroller Data type Change options
RX600 Series Branch, Branch+Data access, Changeable only when program is halted.
Data access
RX200 Series Branch Not changeable.
[No] is always displayed.
Data access Changeable only when program is halted.
RX100 Series Branch, Data access Not changeable.
[No] is always displayed.
<5> [Trace clock count source[MHz]]
This property is displayed only when you've specified [Yes] in the [Output timestamp] property.
Enter a count source with which a timestamp value is calculated from a count value.
To specify this, enter a value directly in the range 0.0001 to 999.999.
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Note that if this property is blank, the set value of the [Operating frequency[MHZz]] property in the [Timer]
category is used in place of the count source.

Cautions 1.  You cannot change this property while the program is in execution.
2. The property's set value is not reflected in the trace data that has already been
collected. The property you've set is reflected beginning with the trace data that is
collected after it is set.

(g) [Timer]
You can configure the timer function in this category.

Caution [RX100 Series]
This category is hidden because these microcontrollers do not support timers.

Figure 2-23. [Timer] Category [RX600 Series]

E Timer
Ilze B4bit counter Mo
Operating frequency[tMHz] 250000
Figure 2-24. [Timer] Category [RX200 Series]
E Timer
Operating frequency[tMHz] 250000

<1> [Use 64bit counter][RX600 series]
Specify whether to use two 32-bit counters or one 64-bit counter.

<2> [Operating frequency[MHZz]]
Specify the operating frequency to be used when converting the count value to time.
Directly enter a number between 0.0001 and 999.999 (MHz) to specify the operating frequency.
When operating frequency is not specified, a count value will be displayed.

(3) [Download File Settings] tab
You can configure downloading to the debug tool in [Download File Settings] tab. For the details of settings in
each category, see "2.5.1 Execute downloading".

(4) [Hook Transaction Settings] tab
In the [Hook Transaction Settings] tab, you can configure hook transaction for the debug tool.
See "2.18 Setting Up the Hook Process" for details on hook transaction and the settings in each category.
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233  [E20]

Configure the operating environment on the Property panel below when using E20.

Note that the contents of the Property panel differ depending on the communication method (FINE communications
[E20(Serial)] or JTAG communications [E20(JTAG)]) between E20 and the target system.

Figure 2-25. Property Panel [E20(Serial)]

El Clock

Main clock source

kain clock frequency[kHz]

Allow changing of the clock zource on writing internal lazkh memaon
E Connection with Emulator

Emulator serial Mo,
E Connection with T arget Board

FIME baud rate[bps]
El Flazh
Input Mode of ID code
1D code
“Wwiork Flak start address

E Dperating Modes of CPU
Mode ping zetting
Fieqizter zetting
Endian

El External Flash

External flazh definition file

Internal RO M/MAAM

ExTAL
Mo

E20: XM ¥ R REHRR

2000000

Specify the |D code a: & 32-digit hexadecimal

(5] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF

[F==] 1000

Single-chip mode
Single-chip mode
Little-endian data

41

Property &)
=5 R E20(5 enial) Property E]

\ Connect Settings _;{r Debug Tool Settings ,f Download File Settings f Haook Transackion Settings f
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Figure 2-26. Property Panel [E20(JTAG)]

E Internal ROM/RAM

= Clock

M ain clock zource

Main clock frequency[MHz]

Allow changing of the clock source on witing internal flash menmang
El Connection with Emulator

Ernulator zerial Mo.
El Connection with T arget Board

JTAG clock[MHz]
E Flash
Input Mode of ID code
ID code
Wwhork Rabd ztart address

El Operating Modes of CPU
Mode ping setting
Reqister zetting
Endian

E External Flash

External flazh definition file

Internal ROM/RAM

Property [3)
S R E20[TAG] Property (- ])(+]

ERXTAL
Ma

E20: M

165

Specify the 1D code az a 32-digit hexadecimal
FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
1000

Single-chip mode
Single-chip mode
Littlz-endian data

[4]

[Connect Settings] tab
[Debug Tool Settings] tab

(1)

)

(3) [Download File Settings] tab
(4) [Hook Transaction Settings] tab

(1) [Connect Settings] tab
In the [Connect Settings] tab, you configure the connection with the debug tool for each one of the following

categories.

) [Internal ROM/RAM]

) [Clock]

c) [Connection with Emulator]
) [Connection with Target Board]
) [Flash]

f) [Operating Modes of CPU]

g) [External Flash]
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(a) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category.

<1>

<2>

<3>

Figure 2-27. [Internal ROM/RAM] Category

B Internal ROMAAM

[Size of internal ROM[KBytes]
The internal ROM size to emulate is displayed (unit: Kbytes).
You cannot change the value of this property.

[Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes).
You cannot change the value of this property.

[Size of DataFlash memory[KBytes]]

The data flash memory size is displayed (unit: Kbytes).

If the currently selected microcontroller does not incorporate the data flash, [0] is displayed.
You cannot change the value of this property.

(b) [Clock]
You can configure the clock in this category.

Caution You cannot change the property in this category while connected to E20.

Figure 2-28. [Clock] Category [HOCO]

E Clock
Main clock zource HOCO
Allow changing of the clock zource o writing intermnal flash memany Mo
Figure 2-29. [Clock] Category [EXTAL]
E=: Clock:
tain clock source ExTAL
tain clock frequency[tHz] 12.5000
Allows changing of the clock source on witing internal flash memon Mo
[Main clock source]

Select EXTAL frequency or internal HOCO as the main clock source. [EXTAL] will be displayed for
microcontrollers with no internal HOCO.

<2> [Main clock frequency [MHz]]
Specify the main clock frequency (before multiplier).
Specify EXTAL frequency by directly entering a number between 0.0001 and 99.9999 (MHz). The
entered value will be truncated to 4 decimal places. If the value is out of the specifiable range, it will be
rounded to 0.0001 (when 0 or below) or to 99.9999 (when 100 or above).
This property is displayed only when you have selected [EXTAL] in the [Main clock source] property.
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<3> [Allow changing of the clock source on writing internal flash memory]

Specify whether to allow a debugger to operate the clock while the internal flash memory is being
rewritten.

Caution [E20 [RX630, RX631, RX63N, RX63T, RX210, RX21A, RX220, RX111]]
When [Yes] is selected, if internal flash ROM is rewritten by the debugger while the
FlashlIF clock (FCLK) of the microcontroller is outside of the guaranteed operating
range (that is, while operating with LOCO or subclock), the E20 will switch the clock
source. After rewriting to the internal flash ROM is completed, the clock will be
restored to the previous clock source.
Note that the operating frequency of the peripheral clock will change during internal
flash memory rewriting because the clock source is switched.
The clock manipulation enabling setting takes effect when the internal flash ROM is
rewritten after program execution or step execution. Note that the clock source is
forcibly switched regardless of the clock manipulation enabling setting if FCLK is
outside of the guaranteed operating range immediately after the debug tool is
activated or when the [CPU Reset] button is clicked.

(c) [Connection with Emulator]
You can configure the connection between E20 and a host machine in this category.

Caution You cannot change the property in this category while connected to E20.

Figure 2-30. [Connection with Emulator] Category

E Connection with Emulator
Ermulator zerial Mo, E 200 3 e

<1> [Emulator serial No.]

Serial numbers of all connected E20 emulators are displayed in the drop-down list.
Select the one to be connected to the target system.
The drop-down list is updated every time it is used.

(d) [Connection with Target Board]
You can configure the connection between E20 and the target board in this category.

Figure 2-31. [Connection with Target Board] Category [E20(Serial)]

B Connection with T arget Board

FIME baud rate[bps] 2000000

Figure 2-32. [Connection with Target Board] Category [E20(JTAG)]

B Connectionwith T arget Board

JTAG clock[MHz] 165
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<1> [Power target from the emulator. (MAX 200mA)]
[No] is displayed as the property value.
E20 does not support power supply function.

<2> [Communications method]

Displays the method of communication used by the E20 emulator for communicating with the

microcontroller on the target system. Specifying [RX E20(Serial)] for a debug tool in the Project Tree
panel will display [FINE] in this property, and specifying [RX E20(JTAG)] will display [JTAG].

You cannot change the value of this property.
For the details of debug tool selection, see "2.3.1 Select the debug tool to use®.

<3> [JTAG clock[MHZz]]

From the drop-down list, select the baud rate (JTAG clock) to be used by the E20 emulator for

communicating with the microcontroller on the target system.

This property is displayed only when [JTAG] is selected in the [Communications method] property.

The following baud rate is displayed in the drop-down list.
- 16.5 (default), 12.38, 6.188, 3.094, 1.547

Cautions 1.  This property cannot be changed while connected to E20.

2. Depending on the length or the method of JTAG signal wiring on the target

system, it may not be possible to communicate using the selected JTAG clock. In

such a case, reducing the JTAG clock may achieve successful communication.

<4> [FINE baud rate[bps]]

From the drop-down list, select the baud rate (FINE baud rate) to be used by the E20 emulator for

communicating with the microcontroller on the target system.

This property is displayed only when [FINE] is selected in the [Communications method] property.

The following baud rate is displayed in the drop-down list.
- 2000000 (default), 750000, 500000, 250000

Cautions 1.  This property cannot be changed while connected to E20.

2. Depending on the length or the method of FINE signal wiring on the target system,

it may not be possible to communicate using the selected FINE baud rate. In such

a case, reducing the FINE baud rate may achieve successful communication.

(e) [Flash]
You can configure the flash memory rewriting in this category.

Figure 2-33. [Flash] Category

E Flazh
Input Mode of 1D code Specify the |0 code as a 32-digit hexadecimal
ID code FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
YWhork, RAk start address 1000

<1> [Input Mode of ID code]
Specify the mode in which to input the ID codes.

Caution This property cannot be changed while connected to E20.
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<2>

<3>

<4>

[ID code]

Specify the ID code to use when reading the code from the memory.

If you have selected [Specify the ID code as a 32-digit hexadecimal] in the [Input Mode of ID code]
property, enter the ID code in a 32-digit hexadecimal number. If you have selected [Specify the ID code
as an ASCII code within 16 characters], enter the ID code using maximum 16 ASCII characters.

Cautions 1.  This property cannot be changed while connected to E20.
2. If the ID code entered in ASCII characters is shorter than 16 characters, the
unused space will be padded with 0.

[Work RAM start address]

Specify the location address of the work RAM to be used by the debugger. Specify an address value that
is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value is automatically
corrected.

The amount of memory indicated by the [Work RAM size[bytes]] property beginning with this address is
to be used by the debugger firmware.

Cautions 1.  This property cannot be changed while connected to E20.

2. Although this area can also be used in the user program because memory
contents are saved and restored to and from the memory of the host machine by
the debugger firmware, do not specify this area as the source or destination of
transfer for the DMA or DTC function.

[Work RAM size[bytes]]
Displays the size of work RAM to be used by the debugger.

(f) [Operating Modes of CPU]
In this category, you configure the operating mode of the microcontroller to be emulated.

Caution This property cannot be changed while connected to E20.

Figure 2-34. [Operating Modes of CPU] Category

E Operating Modesz of CPU

Mode pinz zetting Uszer boot mode
Allows erazing the USE boot program Mo

Fegizter setting Single-chip mode
Endian Little-endian data

<1> [Mode pins setting]
Specify the operating mode set by the mode pin of the microcontroller.
<2> [Allow erasing the USB boot program]
Select whether to erase the USB boot program in the user boot area when you are starting up the
emulator in the user boot mode by using a microcontroller in which the USB boot program is stored.
This property is displayed only when [User boot mode] is selected for the [Mode pins setting] property.
<3> [Register setting]
Specify the operating mode to be set by the register.
The operating mode that can be specified depends on the type of the microcontroller.
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<4> [Endian]
Displays the project endian. Acquires endian information from the project and displays its value. Can be
selected only when the debug tool is disconnected.

(g) [External Flash]
In this category, you can configure external flash.
The settings in this category are required when downloading to an external flash memory. For more details
regarding property setting, see “(5) Downloading files to external flash memory [E1] [E20]".

Caution You cannot change the property in this category while connected to E20.

(2) [Debug Tool Settings] tab
In the [Debug Tool Settings] tab, you configure the basic settings of the debug tool for each one of the following

categories.

(@) [Memory]

(b) [Access Memory While Running]
(c) [Register]

(d) [Break]

(e) [System]

(f) [Trace]

(g9) [Timer]
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(a) [Memory]

You can configure the memory in this category.

Figure 2-35.

EH Memory
B Memomn mappings
[0
1]
[2]
[3]
41
[5]
[E]
[F]
[2]
[9]
[10]
[11]
[12]
[13]
[14]
[15]
[16]
[17]
[18]
[19]
[20]
[21]
[22]
[23]
[24]
[25]
[26]
[27]

Yerify on writing to memon

<1> [Memory mappings]

Current memory mapping status is displayed in detail for each type of memory area.

[Memory] Category

[28]

Dr-chip RaM area
Rezerved area

|0 registers area
Rezerved area

|0 registers area
|0 registers area
Rezerved area
Data flash area
Rezerved area
Qther memony area
Rezerved area

|0 registers area
Rezerved area

|0 registers area
Rezerved area
Euternal area [C57]
External area [CSE]
External area [C55]
Euternal area [C54]
External area [C53]
Euternal area [C52]
External area [C51]
Rezerved area
Qther memony area
Rezerved area
Qther memony area
Rezerved area
Qr-chip ROM area
Tes

It is not possible to change mapping on this panel.

To add or delete an 1/O protection area, select the [Memory mappings] property and click on the [...]

button that appears on the right to open the Memory Mapping dialog box. For details on how to change

settings, refer to the section of the Memory Mapping dialog box.

This property displays only the number of memory areas.

Expanding the [Memory mappings] property will display the following sub-items.

- [Memory type]

Indicates the memory type of the corresponding area.

Each memory type corresponds to the following areas.

On-chip ROM area

Program ROMN°® 1 and data flashNote 2

On-chip RAM area

On-chip RAM

I/O registers area

Peripheral 1/O register

Divided into areas with different endians for display
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External area(CS7/CS6/.../CS0) External address space
CSO0 to CS7 are displayed separately

Other memory area FCU-RAMNete 3 Fcu firmwareNote 3, user boot

Reserved area Areas other than those listed above

I/O protection area Address range in an external area that is not read by the
debugger. Register this area in the Memory Mapping
dialog box.

Notes 1. |If data in the on-chip flash ROM area is changed by means other than downloading (e.g. by
manipulating it via the Memory panel or line assembling), the flash ROM reflects this change next
time the user program is run.

2. If an attempt is made to reference data in erased data flash ROM, only undefined values are
displayed due to the specifications of the microcontroller. If the debugger is used to write to the
data flash ROM, on the other hand, data is written in 256-byte units. Written areas do not hold
undefined values.

3. Do not use the debugger to write to FCU-RAM. The FCU firmware area also cannot be written by
the debugger.

- [Start address]
Displays the start address of the corresponding area.
- [End address]
Displays the end address of the corresponding area.
- [Access width[bits]]
Displays the address width of the corresponding area.
When [Memory type] is an external area, the access width can only be changed when the debug
tool is disconnected
- [Endian]
Displays the endians of the external area and the I/O register area.
When [Memory type] is an external area, the endian can only be changed when the debug tool is
disconnected.

Caution Connecting to a debug tool (see "2.4.1 Connect the debug tool to CubeSuite+") will
display details for each memory type.

<2> [Verify on writing to memory]
Specify whether to perform a verify check when the memory value is initialized from the drop-down list.
Select [Yes] to perform verification after download or when values are changed in the Watch panel/
Memory panel.

(b) [Access Memory While Running]
You can configure the memory access while executing a program in this category.
The settings of this category are required when using the real-time display update function. See "(4)
Displaying and changing memory contents during program execution" for details on the real-time display
update function.

R20UT2350EJ0100 Rev.1.00 RRENESAS Page 38 of 506
Mar 01, 2013



CubeSuite+

Vv2.00.00 CHAPTER 2 FUNCTIONS

Figure 2-36. [Access Memory While Running] Category [E20(Serial)] [E20(JTAG)[RX200 Series]]

<1>

<2>

<3>

<4>

B Access Memory While Funnine

fccess by stoppineg execution Ho
Ilpdate dizplay during the execution ez
Dizplay update intervallms] 500

Figure 2-37. [Access Memory While Running] Category [E20(JTAG)[RX600 Series]]

B Access MemoryWhile Bunning

Access by ztopping execution Mo
Update the dizplay during execution Yez
Update interval[msz] R00
Enable the automatic update of realtime dizplay “es

[Access by stopping execution]
Specify from the drop-down list whether to allow access to the memory area while executing a program.
Select [Yes] to allow access ([NO] is selected by default).

[Update the display during execution]
Specify whether to update the display in the Watch panel/Memory panel while executing a program.
Select [Yes] to update the display (default).

Caution You cannot change this property while the program is in execution.

Update interval[ms]]

This property is displayed only when the [Update the display during execution] property is set to [Yes].
Specify the interval in 100ms unit to update the contents in the Watch panel/Memory panel display while
executing a program.

Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms)
([500] is specified by default).

Note that if you've changed the specified value of the [Update the display during execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

[Enable the automatic update of realtime display]

Specify whether to set RRM area automatically.

This property is displayed only when you have selected [Real-time RAM Monitor] in the [Usage of trace

function] property. If you have selected [Trace] there, [No] is displayed instead.

Caution You cannot change this property while the program is in execution.

(c) [Register]
In this category, make settings related to PC display in the Status bar during program execution.

Figure 2-38. [Register] Category

El Register
PC dizplay during the execution Yes
Display update interval for PClms] 500
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<1>

<2>

[PC display during the execution]
This property specifies whether the PC value is displayed in the Status bar during program execution.
When you select [No], the Status bar under execution will show "Running."

Cautions 1.  You cannot change this property while the program is in execution.
2. [RX100 Series]
This property is hidden because these microcontrollers do not support display of
the PC value in the status bar during program execution.

[Display update interval for PC[ms]]

This property is displayed only when you've selected [Yes] in the [PC display during the execution]
property.

During program execution, specify a PC display updating interval in the Status bar in 100 ms units.
Enter an integer directly in the range 100 to 65500 (with fractions below 100 ms rounded up). (By default,
[500] is specified.)

Note that if you've changed the specified value of the [PC display during the execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(d) [Break]
You can configure the break function in this category.

Figure 2-39. [Break] Category

E Break
Type of breakpointz to be preferentialy uzed Hardware breal:

<1> [Type of breakpoints to be preferentially used]

Specify from the following drop-down list the type of preferential breakpoint to be used with a single click
of the mouse in the Editor panel/Disassemble panel.

When setting a break point after the preferential break point type has been used up, the other break point
type will be automatically selected.

See "2.10.2 Stop the program at the arbitrary position (breakpoint)" for details on breakpoints.

Software break Sets software breakpoint preferentially.

Hardware break Sets hardware breakpoint preferentially (default).

(e) [System]
You can configure the emulation system in this category.
For more information regarding the execution of a specified routine before the execution and after the break of

a program, see "2.9.4 Execute a specified routine [E1] [E20] [EZ Emulator]".
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Figure 2-40. [System] Category

E System
Debug the program re-writing the on-chip PROGRARM FOM Mo
Debug the program re-writing the on-chip DATA FLASH Mo
Ewecute the specified routing immediately before execution of the user program Yes
Fouting to wn immediately before execution starts
Ewecute the specified routing immediately after the wser program stops Yes
Routing to mwin immediately after execution stops
Wiork, Bk start address for esecuting a specified routine [*=2] 1DDO
<1> [Debug the program re-writing the on-chip PROGRAM ROM]

<2>

<3>

<4>

<5>

<6>

<7>

Specify whether to debug programs that rewrite on-chip program ROM area, such as those that use
ROM P/E mode.

Caution You cannot change this property while connected to E20.

[Debug the program re-writing the on-chip DATA FLASH]

Specify whether to debug programs that rewrite on-chip data flash area, such as those that use data
flash P/E mode.

Caution You cannot change this property while connected to E20.

[Execute the specified routine immediately before execution of the user program]
Specify whether to execute a specified routine before executing the user program.

Caution You cannot change this property while the program is in execution.

[Routine to run immediately before execution starts]

Specify the address to be executed immediately before the user program execution. This property is
displayed only when [Execute the specified routine immediately before execution of the user program]
property is set to [Yes].

Caution You cannot change this property while the program is in execution.

[Execute the specified routine immediately after the user program stops]
Specify whether to execute a specified routine after the user program break.

Caution You cannot change this property while the program is in execution.

[Routine to run immediately after execution stops]

Specify the address to be executed immediately after the user program break. This property is displayed
only when [Execute the specified routine immediately after the user program stops] property is set to
[Yes]

Caution You cannot change this property while the program is in execution.
[Work RAM start address for executing a specified routine]

Specify the address where the work RAM for use in execution of the specified routine starts. Specify an
address value that is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value
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is automatically corrected. The amount of memory indicated by the [Work RAM size [bytes] for executing
a specified routine] property beginning with this address is to be used by the debugger firmware.

This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

Cautions 1.  You cannot change this property while the program is in execution.
2. Specify the range of memory that is not used by the user program.

<8> [Work RAM size [bytes] for executing a specified routine]
Indicates the size of the work RAM for use in execution of the specified routine.
This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

(f) [Trace]
You can configure the trace function in this category.

Figure 2-41. [Trace] Category

E Trace
Uzage of trace function Trace
Operation after trace memany iz full Dverwrite trace memorny and continue execution
Trace data type Branch
External trace output CPU execution
Trace memory size[MByte] 1
Output timestamp Yes

Trace clock count source[tHz]

<1> [Usage of trace function]
Specify whether to use it as real-time RAM monitor function (RRM function) utilizing the trace function. If
you select [Real-time RAM Monitor], part of the trace functions will be disabled.
For details on applicable restrictions, see "(4) Displaying and changing memory contents during
program execution".
This property can be changed only when the program is not running.

Caution [E20(Serial)] [E20(JTAG) [RX100, RX200 Series]]
The real-time RAM monitor function is not supported. As such, the property value is
displayed as [Trace] and becomes unchangeable.

<2> [Operation after trace memory is full]
Select the trace acquisition mode from the following drop-down list.

Overwrite trace memory and continue Continues overwriting the older trace data after the trace memory
execution is full.

Stop trace Stops writing the trace data after the trace memory is full.

Stop Breaks after the trace memory is full.

Caution [E20(JTAG) [RX600 Series]]
If you have selected [Real-time RAM Monitor] in [Usage of trace function] property, the
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property value is displayed as [Overwrite trace memory and continue execution] and
becomes unchangeable.

<3> [Trace data type]
Select the type of data for which trace is to be acquired from the drop-down list.
The type of data that can be selected differs depending on the series of the microcontroller.
Following data types are displayed in the drop-down list.
- [RX600 Series]
Branch, Branch+Data access, Data access
- [RX100, RX200 Series]
Branch, Data access

Caution [E20(JTAG) [RX600 Series]]
If you have selected [Real-time RAM Monitor] in [Usage of trace function] property, the
property value is displayed as [Data access] and becomes unchangeable.

<4> [External trace output][E20(JTAG)]
From the following drop-down list, select the method in which to externally output the trace acquisition

data.
CPU execution CPU execution given priority over trace output. Trace information may be lost if output.
Trace output Trace output given priority over CPU execution. CPU execution stops during trace
output, affecting real-time performance.
Do not output Only the internal buffer of the microcontroller will be used, with no output of trace
information.
Cautions 1.  If you have selected [Real-time RAM Monitor] in [Usage of trace function] property,

[Do not output] cannot be selected from the drop-down list.

2. If Step in is executed when [CPU execution] or [Trace output] is specified and
trace data is being displayed on the Trace panel, correct trace data may not
always be displayed.

<5> [Trace memory size[MByte]][E20(JTAG)]
Specify the size of memory used to retain the trace data.
The following memory sizes are displayed in the drop-down list.
- 1 (default), 2, 4, 8, 16, 32

Caution If you have selected [Real-time RAM Monitor] in [Usage of trace function] property, the
property value is displayed as [1] and becomes unchangeable.

<6> [Output timestamp]
Specify whether timestamp information is added to the trace data to be collected.
This property is selectable only when you've specified [Trace] in the [Usage of trace function] property.
The change options in this property vary depending on the microcontroller series and the specified value
of [Trace data type] property, as follows:

Microcontroller Data type Change options

RX600 Series Branch, Branch+Data access, Changeable only when program is halted.
Data access
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Microcontroller Data type Change options

RX200 Series Branch Not changeable.
[No] is always displayed.

Data access Changeable only when program is halted.

RX100 Series Branch, Data access Not changeable.

[No] is always displayed.

<7> [Trace clock count source[MHz]]
This property is displayed only when you've specified [Yes] in the [Output timestamp] property.
Enter a count source with which a timestamp value is calculated from a count value.
To specify this, enter a value directly in the range 0.0001 to 999.999.
Note that if this property is blank, the set value of the [Operating frequency[MHz]] property in the [Timer]
category is used in place of the count source.

Cautions 1.  You cannot change this property while the program is in execution.
2. The property's set value is not reflected in the trace data that has already been
collected. The property you've set is reflected beginning with the trace data that is
collected after it is set.

(g) [Timer]
You can configure the timer function in this category.

Caution [RX100 Series]
This category is hidden because these microcontrollers do not support timers.

Figure 2-42. [Timer] Category [RX600 Series]

B Timer
IJze B4bit counter Mo
Qperating frequency[MHz] 25.0000
Figure 2-43. [Timer] Category [RX200 Series]
E Timer
Operating frequency[tHz] 250000

<1> [Use 64bit counter][RX600 series]
Specify whether to use two 32-bit counters or one 64-bit counter.

<2> [Operating frequency[MHz]]
Specify the operating frequency to be used when converting the count value to time.
Directly enter a number between 0.0001 and 999.999 (MHz) to specify the operating frequency.
When operating frequency is not specified, a count value will be displayed.

(3) [Download File Settings] tab
You can configure downloading to the debug tool in [Download File Settings] tab.
For the details of settings in each category, see "2.5.1 Execute downloading".
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(4) [Hook Transaction Settings] tab
In the [Hook Transaction Settings] tab, you can configure hook transaction for the debug tool.
See "2.18 Setting Up the Hook Process" for details on hook transaction and the settings in each category.
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234 [EZ Emulator]

Configure the operating environment on the Property panel below when using EZ Emulator.

Figure 2-44. Property Panel

Property 3]
=% R EZ Emulator Property E]

= Internal BROM/RAM

E Clock
Main clock source ExTaL
Main clock frequency[MHz]
Allow changing of the clock source on witing intemnal flash memaory Mo
E Connection with T arget Board
UszerWeoW]
FIME baud rate[bps] 1000000
= Flazh
Input Mode of 1D code Speciy the |D code as a 32-digit hexadecimal
D code FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Wihork Rakd start address [FE=] 1000

E Operating Modes of CPU

Endian Little-endian data
E External Flash
Esternal flazh definition file [4]
Internal R OM/ARAM
A {Connect Settings: { Debug Tool Settings ,( Dowrload File Settings ,( Hook Transaction Setkings )} -

Follow the steps below by selecting the corresponding tab on the Property panel.

(1) [Connect Settings] tab

(2) [Debug Tool Settings] tab

(3) [Download File Settings] tab
(4) [Hook Transaction Settings] tab

(1) [Connect Settings] tab
In the [Connect Settings] tab, you configure the connection with the debug tool for each one of the following

categories.
(a) [Internal ROM/RAM]
(b) [Clock]
(c) [Connection with Target Board]
(d) [Flash]
(e) [Operating Modes of CPU]
(f) [External Flash]

(a) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category.
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<1>

<2>

<3>

Figure 2-45. [Internal ROM/RAM] Category

E Internal BOMMAAM

[Size of internal ROM[KBytes]
The internal ROM size to emulate is displayed (unit: Kbytes).
You cannot change the value of this property.

[Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes).
You cannot change the value of this property.

[Size of DataFlash memory[KBytes]]

The data flash memory size is displayed (unit: Kbytes).

If the currently selected microcontroller does not incorporate the data flash, [0] is displayed.
You cannot change the value of this property.

(b) [Clock]
You can configure the clock in this category.

Caution You cannot change the property in this category while connected to EZ Emulator.

Figure 2-46. [Clock] Category [HOCO]

E Clock
Main clock source HOCO
Allow changing of the clock zource o writing intermal flash memaorny Mo
Figure 2-47. [Clock] Category [EXTAL]
= Clock:
tain clock source ExTaL
kain clock frequency(tHz] 12.5000
Allow changing of the clock source on writing internal flash memaon Hao
[Main clock source]

Select EXTAL frequency or internal HOCO as the main clock source. [EXTAL] will be displayed for
microcontrollers with no internal HOCO.

<2> [Main clock frequency [MHz]]
Specify the main clock frequency (before multiplier).
Specify EXTAL frequency by directly entering a number between 0.0001 and 99.9999 (MHz). The
entered value will be truncated to 4 decimal places. If the value is out of the specifiable range, it will be
rounded to 0.0001 (when 0 or below) or to 99.9999 (when 100 or above).
This property is displayed only when you have selected [EXTAL] in the [Main clock source] property.
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<3> [Allow changing of the clock source on writing internal flash memory]
Specify whether to allow a debugger to operate the clock while the internal flash memory is being
rewritten.

Caution [EZ Emulator [RX63T, RX210, RX220, RX111]]
When [Yes] is selected, if internal flash ROM is rewritten by the debugger while the
FlashlIF clock (FCLK) of the microcontroller is outside of the guaranteed operating
range (that is, while operating with LOCO or subclock), the EZ Emulator will switch the
clock source. After rewriting to the internal flash ROM is completed, the clock will be
restored to the previous clock source.
Note that the operating frequency of the peripheral clock will change during internal
flash memory rewriting because the clock source is switched.
The clock manipulation enabling setting takes effect when the internal flash ROM is
rewritten after program execution or step execution. Note that the clock source is
forcibly switched regardless of the clock manipulation enabling setting if FCLK is
outside of the guaranteed operating range immediately after the debug tool is
activated or when the [CPU Reset] button is clicked.

(c) [Connection with Target Board]
You can configure the connection between EZ Emulator and the target board in this category.

Figure 2-48. [Connection with Target Board] Category

El Connection with T arget Board
Jzer Yoo

FIME baud rate[bps] 1000000

<1> [User Vcc[V]]
Specify the value of the microcontroller’s operating voltage that is actually supplied to the user board.
Directly enter a numerical value from 0.0001 to 9.9999 (unit: V).

Caution This property cannot be changed while connected to EZ Emulator.

<2> [Communications method]
Displays the method of communication used by the EZ Emulator for communicating with the
microcontroller on the target system.
You cannot change the value of this property.
For the details of debug tool selection, see "2.3.1 Select the debug tool to use".

<3> [FINE baud rate[bps]]
From the drop-down list, select the baud rate (FINE baud rate) to be used by the EZ Emulator for
communicating with the microcontroller on the target system.
The following baud rate is displayed in the drop-down list.
- 1000000 (default), 500000, 250000

Cautions 1.  This property cannot be changed while connected to EZ Emulator.
2. Depending on the length or the method of FINE signal wiring on the target system,
it may not be possible to communicate using the selected FINE baud rate. In such
a case, reducing the FINE baud rate may achieve successful communication.
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(d) [Flash]
You can configure the flash memory rewriting in this category.

Caution This property cannot be changed while connected to EZ Emulator.

<1>

<2>

<3>

Figure 2-49. [Flash] Category

B Flazh
Input Mode of 1D code Specify the |0 code as a 32-digit hexadecimal
D code [FE<] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Whork, RAM start address [He=] 1000
[Input Mode of ID code]

Specify a mode for the input of ID code.
Caution This property cannot be changed while connected to EZ Emulator.

[ID code]

Specify the ID code to use when reading the code from the memory.

If you have selected [Specify the ID code as a 32-digit hexadecimal] in the [Input Mode of ID code]
property, enter the ID code in a 32-digit hexadecimal number. If you have selected [Specify the ID code
as an ASCII code within 16 characters], enter the ID code using maximum 16 ASCII characters.

Cautions 1.  This property cannot be changed while connected to EZ Emulator.
2. If the ID code entered in ASCII characters is shorter than 16 characters, the
unused space will be padded with 0.

[Work RAM start address]

Specify the location address of the work RAM to be used by the debugger. Specify an address value that
is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value is automatically
corrected.

The amount of memory indicated by the [Work RAM size[bytes]] property beginning with this address is
to be used by the debugger firmware.

Cautions 1.  This property cannot be changed while connected to EZ Emulator.

2. Although this area can also be used in the user program because memory
contents are saved and restored to and from the memory of the host machine by
the debugger firmware, do not specify this area as the source or destination of
transfer for the DMA or DTC function.

<4> [Work RAM size[bytes]]

Displays the size of the work RAM to be used by the debugger.

(e) [Operating Modes of CPU]
In this category, you configure the operating mode of the microcontroller to be emulated.

Caution This property cannot be changed while connected to EZ Emulator.
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Figure 2-50. [Operating Modes of CPU] Category

B Operating Modes of CPU

Endian Little-endian data

<1> [Mode pins setting]
Specify the operating mode set by the mode pin of the microcontroller.
The setting is fixed to single-chip mode while the EZ Emulator is in use.

<2> [Register setting]
Specify the operating mode to be set by the register.
The setting is fixed to single-chip mode while the EZ Emulator is in use.

<3> [Endian]
Display the project endian. Acquires endian information from the project and displays its value. Can be
selected only when the debug tool is disconnected.

(f) [External Flash]
In this category, you can configure external flash.
Although this category is controllable while the EZ Emulator is in use, any setting for this category is not
reflected because the microcontroller’s operating mode is fixed to single-chip mode.

(2) [Debug Tool Settings] tab
In the [Debug Tool Settings] tab, you configure the basic settings of the debug tool for each one of the following

categories.

(@) [Memory]

(b) [Access Memory While Running]
(c) [Register]

(d) [Break]

(e) [System]

(f) [Trace]

(g9) [Timer]
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(a) [Memory]
You can configure the memory in this category.

Figure 2-51. [Memory] Category

E Memory

E Memory mappings [28]
[] Dn-chip Rak area
[1] Fezerved area
[£] [0 registers area
[3] Fezerved area
[4] [0 registers area
[5] [0 registers area
[E] Fezerved area
[¥] Data flazh area
[8] Fezerved area
[9] Qther memory area
[0 Fezerved area
[11] [0 registers area
[12] Fezerved area
[13] [0 registers area
[14] Fezerved area
[15] Euxternal area [C57]
[16] Euternal area [C5E]
[17] Euxternal area [C55]
[13] External area [C54]
[19] Euternal area [C53]
[20] Euternal area [C5:]
[21] Euxternal area [C51]
[22] Fezerved area
[23] Qther memory area
[24] Fezerved area
[25] Qther memory area
[26] Fezerved area
[27] Qn-chip ROM area
Werify on writing to memory ez

<1> [Memory mappings]
Current memory mapping status is displayed for each type of memory area.
It is not possible to change mapping on this panel.
To add or delete an /O protection area, select the [Memory mappings] property and click on the [...]
button that appears on the right to open the Memory Mapping dialog box. For details on how to change
settings, refer to the section of the Memory Mapping dialog box.
This property displays only the number of memory areas.
Expanding the [Memory mappings] property will display the following sub-items.
- [Memory type]
Indicates the memory type of the corresponding area.
Each memory type corresponds to the following areas.

On-chip ROM area Program ROMN°® 1 and data flashNote 2
On-chip RAM area On-chip RAM
I/O registers area Peripheral 1/O register
Divided into areas with different endians for display
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External area(CS7/CS6/.../CS0) External address space
CSO0 to CS7 are displayed separately

Other memory area FCU-RAMNete 3 Fcu firmwareNote 3, user boot

Reserved area Areas other than those listed above

I/O protection area Address range in an external area that is not read by the
debugger. Register this area in the Memory Mapping
dialog box.

Notes 1. |If data in the on-chip flash ROM area is changed by means other than downloading (e.g. by
manipulating it via the Memory panel or line assembling), the flash ROM reflects this change next
time the user program is run.

2. If an attempt is made to reference data in erased data flash ROM, only undefined values are
displayed due to the specifications of the microcontroller. If the debugger is used to write to the
data flash ROM, on the other hand, data is written in 256-byte units. Written areas do not hold
undefined values.

3. Do not use the debugger to write to FCU-RAM. The FCU firmware area also cannot be written by
the debugger.

- [Start address]
Displays the starting address of the corresponding area.
- [End address]
Displays the ending address of the corresponding area.
- [Access width[bits]]
Displays the access width of the corresponding area.
When [Memory type] is an external area, the access width can only be changed when the debug
tool is disconnected.
- [Endian]
Displays the endians of the external area and the I/O register area.
When [Memory type] is an external area, the endian can only be changed when the debug tool is
disconnected.

Caution Connecting to a debug tool (see "2.4.1 Connect the debug tool to CubeSuite+") will
display details for each memory type.

<2> [Verify on writing to memory]
Specify whether to perform a verify check when the memory value is initialized from the drop-down list.
Select [Yes] to perform verification after download or when values are changed in the Watch panel/
Memory panel.

(b) [Access Memory While Running]
You can configure the memory access while executing a program in this category.
The settings of this category are required when using the real-time display update function. See "(4)
Displaying and changing memory contents during program execution" for details on the real-time display
update function.
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Figure 2-52. [Access Memory While Running] Category

B Access Memory While Funning

fccess by stopping execution Ho
Ilpdate dizplay during the execution ez
Dizplay update intervallms] 500

<1> [Access by stopping execution]
Specify from the drop-down list whether to allow access to the memory area while executing a program.
Select [Yes] to allow access ([NO] is selected by default).

<2> [Update the display during execution]
Specify whether to update the display in the Watch panel/Memory panel while executing a program.
Select [Yes] to update the display (default).

Caution You cannot change this property while the program is in execution.

<3> [Update interval[ms]]
This property is displayed only when the [Update the display during execution] property is set to [Yes].
Specify the interval in 100ms unit to update the contents in the Watch panel/Memory panel display while
executing a program.
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms)
([500] is specified by default).
Note that if you've changed the specified value of the [Update the display during execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(c) [Register]
In this category, make settings related to PC display in the Status bar during program execution.

Figure 2-53. [Register] Category

E Register
PC dizplay during the execution Yes
Dizplay update interval for PClms] a00

<1> [PC display during the execution]
This property specifies whether the PC value is displayed in the Status bar during program execution.
When you select [No], the Status bar under execution will show "Running."

Cautions 1.  You cannot change this property while the program is in execution.
2. [RX100 Series]
This property is hidden because these microcontrollers do not support display of
the PC value in the status bar during program execution.

<2> [Display update interval for PC[ms]]
This property is displayed only when you've selected [Yes] in the [PC display during the execution]
property.
During program execution, specify a PC display updating interval in the Status bar in 100 ms units.
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Enter an integer directly in the range 100 to 65500 (with fractions below 100 ms rounded up). (By default,
[500] is specified.)

Note that if you've changed the specified value of the [PC display during the execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(d) [Break]
You can configure the break function in this category.

Figure 2-54. [Break] Category

E Break
Type of breakpointz to be preferentially used Hardware break.

<1> [Type of breakpoints to be preferentially used]
Specify from the following drop-down list the type of preferential breakpoint to be used with a single click
of the mouse in the Editor panel/Disassemble panel.
When setting a break point after the preferential break point type has been used up, the other break point
type will be automatically selected.
See "2.10.2 Stop the program at the arbitrary position (breakpoint)" for details on breakpoints.

Software break Sets software breakpoint preferentially.

Hardware break Sets hardware breakpoint preferentially (default).

(e) [System]
You can configure the emulation system in this category.
For more information regarding the execution of a specified routine before the execution and after the break of
a program, see "2.9.4 Execute a specified routine [E1] [E20] [EZ Emulator]".

Figure 2-55. [System] Category

= System
Debug the program re-writing the on-chip PROGRARKM ROM Mo
Debug the program re-writing the on-chip DATA FLASH Mo
Execute the specified routing immediately before execution of the user program Yes
Routing to run immediately before execution starts
Execute the specified routing immediately after the uzer program stops Yes
Fouting to run immediately after execution stopz
Wiork RaM start address for executing a zpecified routine 1DDO

<1> [Debug the program re-writing the on-chip PROGRAM ROM]
Specify whether to debug programs that rewrite on-chip program ROM area, such as those that use
ROM P/E mode.

Caution You cannot change this property while connected to EZ Emulator.
<2> [Debug the program re-writing the on-chip DATA FLASH]

Specify whether to debug programs that rewrite on-chip data flash area, such as those that use data
flash P/E mode.
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Caution You cannot change this property while connected to EZ Emulator.

<3> [Execute the specified routine immediately before execution of the user program]
Specify whether to execute a specified routine before executing the user program.

Caution You cannot change this property while the program is in execution.

<4> [Routine to run immediately before execution starts]
Specify the address to be executed immediately before the user program execution. This property is
displayed only when [Execute the specified routine immediately before execution of the user program]
property is set to [Yes].

Caution You cannot change this property while the program is in execution.

<5> [Execute the specified routine immediately after the user program stops]
Specify whether to execute a specified routine after the user program break.

Caution You cannot change this property while the program is in execution.

<6> [Routine to run immediately after execution stops]
Specify the address to be executed immediately after the user program break. This property is displayed
only when [Execute the specified routine immediately after the user program stops] property is set to
[Yes].

Caution You cannot change this property while the program is in execution.

<7> [Work RAM start address for executing a specified routine]
Specify the address where the work RAM for use in execution of the specified routine starts. Specify an
address value that is a multiple of four bytes. If the entered value is not a multiple of four bytes, the value
is automatically corrected. The amount of memory indicated by the [Work RAM size [bytes] for executing
a specified routine] property beginning with this address is to be used by the debugger firmware.
This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

Cautions 1.  You cannot change this property while the program is in execution.
2. Specify the range of memory that is not used by the user program.

<8> [Work RAM size [bytes] for executing a specified routine]
Indicates the size of the work RAM for use in execution of the specified routine.
This property is displayed only when you have selected [Yes] either for the [Execute the specified routine
immediately before execution of the user program] or [Execute the specified routine immediately after
the user program stops] property.

(f) [Trace]
You can configure the trace function in this category.
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Figure 2-56. [Trace] Category

B Trace
Operation after trace memary iz full Qvenwrite trace memon and continue execution
Trace data type Branch
COutput timestamp Yes

Trace clock count zource[MHz]

<1> [Usage of trace function]
[Trace] is displayed as the usage of trace function.
You cannot change the value of this property.
<2> [Operation after trace memory is full]
Select the trace acquisition mode from the following drop-down list.
Overwrite trace memory and continue Continues overwriting the older trace data after the trace memory is
execution full.
Stop trace Stops writing the trace data after the trace memory is full.
Stop Breaks after the trace memory is full.
<3> [Trace data type]
Select the type of data for which trace is to be acquired from the drop-down list.
The type of data that can be selected differs depending on the series of the microcontroller.
Following data types are displayed in the drop-down list.
- [RX600 Series]
Branch, Branch+Data access, Data access
- [RX100, RX200 Series]
Branch, Data access
<4> [Output timestamp]
Specify whether timestamp information is added to the trace data to be collected.
The change options in this property vary depending on the microcontroller series and the specified value
of [Trace data type] property, as follows:
Microcontroller Data type Change options
RX600 Series Branch, Branch+Data access, Changeable only when program is halted.
Data access
RX200 Series Branch Not changeable.
[No] is always displayed.
Data access Changeable only when program is halted.
RX100 Series Branch, Data access Not changeable.
[No] is always displayed.
<5> [Trace clock count source[MHz]]
This property is displayed only when you've specified [Yes] in the [Output timestamp] property.
Enter a count source with which a timestamp value is calculated from a count value.
To specify this, enter a value directly in the range 0.0001 to 999.999.
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Note that if this property is blank, the set value of the [Operating frequency[MHZz]] property in the [Timer]
category is used in place of the count source.

Cautions 1.  You cannot change this property while the program is in execution.
2. The property's set value is not reflected in the trace data that has already been
collected. The property you've set is reflected beginning with the trace data that is
collected after it is set.

(g) [Timer]
You can configure the timer function in this category.

Caution [RX100 Series]
This category is hidden because these microcontrollers do not support timers.

Figure 2-57. [Timer] Category [RX600 Series]

E Timer
|1ze B4hit counter Ma
Operating frequency[tMHz] 250000

Figure 2-58. [Timer] Category [RX100, RX200 Series]

E Timer
Operating frequency[tMHz] 250000

<1> [Use 64bit counter][RX600 series]
Specify whether to use two 32-bit counters or one 64-bit counter.

<2> [Operating frequency[MHZz]]
Specify the operating frequency to be used when converting the count value to time.
Directly enter a number between 0.0001 and 999.999 (MHz) to specify the operating frequency.
When operating frequency is not specified, a count value will be displayed.

(3) [Download File Settings] tab
You can configure downloading to the debug tool in [Download File Settings] tab. For the details of settings in
each category, see "2.5.1 Execute downloading".

(4) [Hook Transaction Settings] tab
In the [Hook Transaction Settings] tab, you can configure hook transaction for the debug tool.
See "2.18 Setting Up the Hook Process" for details on hook transaction and the settings in each category.
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235

[Simulator]

Configure the operating environment on the Property panel below when using Simulator.

Figure 2-59. Operating Environment Settings [Simulator] (Property Panel)

Property

= R Simulator Property E]

Bl Internal RO M/AAM

E Endian
Endian of CPU Little-endian data
E Clock
Syztem clock [ICLE] frequency[kHz] RO
El Peripheral Function Simulaton
Peripheral function simulation module [21
Peripheral clock rate 1

Size of internal ROM[K.Bytes]
Digplayz the zize of the internal RO,

~ Conneck SEl:tingsE_,{: Debug Tool Settings ,{ Download File Setk... ,{f Hook Transaction... ,-"f ¥

Follow the steps below by selecting the corresponding tab on the Property panel.

(1)

(1) [Connect Settings] tab

(2) [Debug Tool Settings] tab

(3) [Download File Settings] tab
(4) [Hook Transaction Settings] tab

[Connect Settings] tab
In the [Connect Settings] tab, you can configure the connection with the debug tool for each one of the following
categories.

(a) [Internal ROM/RAM]
(b) [Endian]
(c)
(d)

[Clock]
[Peripheral Function Simulation]

(a) [Internal ROM/RAM]
The size of internal ROM/RAM of the selected microcontroller is displayed in this category.

Figure 2-60. [Internal ROM/RAM] Category [Simulator]

B Internal ROM/AAM

<1> [Size of internal ROM[KBytes]
The internal ROM size to simulate is displayed (unit: Kbytes).
You cannot change the value of this property.
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<2> [Size of internal RAM[KBytes]]
The internal RAM size to simulate is displayed (unit: Kbytes).
You cannot change the value of this property.

(b) [Endian]
You can configure endian in this category.

Figure 2-61. [Endian] Category [Simulator]

El Endian
Endian of CPL Little-endian data

<1> [Endian of CPU]
Specify the endian for the CPU.
By default, the endian selected in the build tool property is displayed.

Caution You cannot change this property while connected to the Simulator.

(c) [Clock]
You can configure clock in this category.

Figure 2-62. [Clock] Category [Simulator]

E Clock
System clock [ICLK) frequency[MHz] a0

<1> [System clock (ICLK) frequency [MHz]]
Specify the clock frequency for the CPU (unit: MHz).
You can specify a desired frequency value.
Enter an integer directly in the range 1 to 1,000.
([100] is specified for the RX600 Series and [50] for other microcontrollers by default).

Caution You cannot change this property while connected to the Simulator.

(d) [Peripheral Function Simulation]
You can configure simulation of peripheral functions in this category.

Figure 2-63. [Peripheral Function Simulation] Category

E Penpheral Function Simulabon

E Penpheral function simulation module [21
[ CHT
[1] Icu
Ferpheral clock rate 1

<1> [Peripheral function simulation module]
It displays the name of available peripheral function simulation modules and lets you select from the
drop-down list whether to use each module being displayed.
Select [Use] when using the module ([Not Use] is selected by default).
You cannot change the name of peripheral function simulation modules on this panel.
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<2> [Peripheral clock rate]
Specify from the drop-down list the peripheral-to-internal clock ratio that shows the number of internal
clock that is equivalent to 1 peripheral clock.
The following clock rates are displayed in the drop-down list.
1(Default), 2, 3, 4, 6, 8, 12, 16, 24, 32, 64

Caution You cannot change this property while connected to the Simulator.

(2) [Debug Tool Settings] tab
In the [Debug Tool Settings] tab, you can configure the debug tool for each one of the following categories.

(a)

f) [Stream 1/O]
g) [Execution mode]

(@) [Memory]

(b) [Access Memory While Running]
(c) [Register]

(d) [Trace]

(e) [Coverage]

(

(

(

h) [Instruction decode cache]

[Memory]
You can configure the memory in this category.

Figure 2-64. [Memory] Category [Simulator]

B Memory
B Memorny mappings [19]
[0] Internal Rak area
1] Hon-map area
[£] [0 registers area
[2] Hon-map area
[4] | /0 reqisters area
[5] | /0 reqisters area
[B] Maon-map area
[¥] | /0 reqisters area
[2] | /0 reqisters area
[9] | /0 reqisters area
o [ntermal RO area
1] Maon-map area
12 | /0 reqisters area
[13] Maon-map area
4] | /0 reqisters area
18] Maon-map area
[16] [ntermal RO area
17 Maon-map area
18] Intermal RO area
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<1>

[Memory mappings]

Current memory mapping status is displayed for each type of memory area.

The memory mapping status cannot be changed on this panel. When necessary, you can add a memory
mapping in the Memory Mapping dialog box. This dialog box can be displayed by clicking on the [...]
button which appears on the right end of the setting field after selecting [Memory Mapping] property.
See the section for the Memory Mapping dialog box for details on how to configure the parameters.

Figure 2-65. Opening the Memory Mapping Dialog Box
EH Memory

=] bemory mappings 9

[0] Internal RAM area
[1] Mon-map area

(b) [Access Memory While Running]

You
The

can configure the memory access while executing a program in this category.
settings of this category are required when using the real-time display update function. See "(4)

Displaying and changing memory contents during program execution" for details on the real-time display

update function.

<1>

<2>

Figure 2-66. [Access Memory While Running] Category [Simulator]

B Access Memory While Funnine

Idpdate dizplay during the execution Yes
Dizplay update intervallms] 500

[Update display during the execution]

Specify from the drop-down list whether to update the display in the Watch panel/Memory panel during a
program execution.

Select [Yes] to update the display (default).

Caution You cannot change this property while the program is in execution.

[Display update interval[ms]]

This property is displayed only when the [Update display during the execution] property is set to [Yes].
Specify the interval in 100ms unit to update the contents in the Watch panel/Memory panel display while
executing a program.

Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms)
([500] is selected by default).

Note that if you've changed the specified value of the [Update display during the execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.
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(c) [Register]
In this category, make settings related to PC display in the Status bar during program execution.

Figure 2-67. [Register] Category [Simulator]

El Register
FC dizplay during the execution Yes
Digplay update interval for PClmg) a00

<1> [PC display during the execution]
This property specifies whether the PC value is displayed in the Status bar during program execution.
When you select [No], the Status bar under execution will show "Running."

Cautions 1.  You cannot change this property while the program is in execution.
2. [RX100 Series]
This property is hidden because these microcontrollers do not support display of
the PC value in the status bar during program execution.

<2> [Display update interval for PC[ms]]
This property is displayed only when you've selected [Yes] in the [PC display during the execution]
property.
During program execution, specify a PC display updating interval in the Status bar in 100 ms units.
Enter an integer directly in the range 100 to 65500 (with fractions below 100 ms rounded up). (By default,
[500] is specified.)
Note that if you've changed the specified value of the [PC display during the execution] property from
[No] to [Yes], the previous set value is displayed in this property.

Caution You cannot change this property while the program is in execution.

(d) [Trace]
You can configure the trace function in this category.
See "2.13 Collecting an Execution History" for details on the trace function and this category configuration.

(e) [Coverage]
You can configure the coverage function in this category.
See "2.15 Measure Coverage [Simulator]" for details on the coverage function and this category
configuration.

(f) [Stream 1/O]
You can configure the stream 1/O for performing standard 1/O or file I/O to/from the user program in this

category.
Figure 2-68. [Stream |/O] Category
E Streaml/0
Select stream /0 mode Simulator mode
Ize stream |0 function Mo
Stream /0 address 1]
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<1>

<2>

<3>

[Select stream 1/O mode]

In this property, specify an 1/0 mode from the drop-down list in which mode you want standard 1/O to be
executed.

To use files for the same low-level interface routines (assembly language part) as the emulator, specify
[Emulator mode]. (By default, [Simulator mode] is specified.)

Remark File I/O is usable only when [Simulator mode] is specified. File /O cannot be used when
[Emulator mode] is specified.

Caution This property cannot be changed when a simulator is connected.

[Use stream I/O function]

This property is displayed only when [Simulator mode] is specified in the [Select stream I/O mode]
property.

Specify from the drop-down list whether or not to use the stream 1/O function while simulator mode is in
use.

Select [Yes] when using this function ([No] is selected by default).

[Stream I/O address]

This property is displayed only when [Simulator mode] is specified in the [Select stream /0 mode]
property.

Specify the position at which stream 1/O starts while simulator mode is in use.

Directly enter the desired address ([0x00000000] is specified by default).

(9) [Execution mode]

You can configure the operation that is required in the event of simulation error or exception in this category.

Figure 2-69. [Execution mode] Category

B Execution Mode

Select execution mode Stop
Stop when undefined instruction exception occurs ez
Stop when privileged instruction exception occours ez
Stop when access exception ocours ez
Stop when floating-point exception occurs ez
Stop when interrupt ocours ez
Stop IMT instruction iz executed ez
Stop BRE. instruction iz executed ez

<1> [Select execution mode]
In this property, you can select the execution mode from the following drop-down list.
Stop Stops simulation (default).
Continue Continues simulation (Property items in the bottom section will be enabled.)
<2> [Stop when undefined instruction exception is encountered]
This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when undefined instruction exception is encountered.
Select [Yes] if you wish to stop at the occurrence of undefined instruction exception (default).
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<3>

<4>

<5>

<6>

<7>

<8>

[Stop when privileged instruction exception is encountered]

This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when privileged instruction exception is encountered.
Select [Yes] if you wish to stop at the occurrence of privileged instruction exception (default).

[Stop when access exception is encountered]

This property is displayed only when an MPU module exists in [Peripheral function simulation module]
property and you have selected [Stop] in [Select execution mode] property. Specify from the drop-down
list whether to stop when access exception is encountered. Select [Yes] if you wish to stop at the
occurrence of access exception (default).

[Stop when floating-point exception is encountered][RX600 Series]

This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when floating-point exception is encountered. Select
[Yes] if you wish to stop at the occurrence of floating-point exception (default).

[Stop when interrupt is encountered]

This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when interrupt is encountered. Select [Yes] if you wish to
stop at the occurrence of interrupt (default).

[Stop INT instruction is executed]

This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when INT instruction is executed. Select [Yes] if you wish
to stop at the execution of INT instruction (default).

[Stop BRK instruction is executed]

This property is displayed only when you have selected [Stop] in [Select execution mode] property.
Specify from the drop-down list whether to stop when BRK instruction is executed. Select [Yes] if you
wish to stop at the execution of BRK instruction (default).

(h) [Instruction decode cache]

In this category, you can configure instruction decode cache, a function which retains decode result during

instruction execution so that it can be used again when the instruction at the same address is executed.

<1>

Figure 2-70. [Instruction decode cache] Category

B Instruction Decode Cache

Cache the resultz of decoding instructions and accelerate simulation Mo

[Increase simulation speed by caching instruction decode result]
Specify from the drop-down list whether to enable instruction decode cache function.
Select [Yes] to enable this function ([No] is selected by default).

Caution As the instruction decode cache function reuses the decode result, it cannot be used
in programs that employ self-modifying code. If an instruction is modified as a result
of unintended program operation, error detection may not be performed properly.

(3) [Download File Settings] tab
In the [Download File Settings] tab, you can configure download setting for the debug tool.
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See "2.5.1 Execute downloading" for details on each category configuration.

(4) [Hook Transaction Settings] tab
In the [Hook Transaction Settings] tab, you can configure hook transaction for the debug tool.
See "2.18 Setting Up the Hook Process" for details on each category configuration and hook transaction.
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2.4 Connect to/Disconnect from the Debug Tool

This section describes connection to and disconnection from the debug tool including hot plug-in connection.

241 Connect the debug tool to CubeSuite+

Select the [Debug] menu >> [Connect to Debug Tool] to connect to the debug tool selected in the currently active
project.

After succeeding in the connection to the debug tool, the Status bar of the Main window changes as follows:

For details on each item displayed on the Status bar, see the section of the "Main window".

Figure 2-71. Status Bar Indicating the Successful Connection to the Debug Tool

| 7{ DISCOMNECT |

v
I (m]BREAK EERXEL(ITAG) () Not measured @
| —

The information of the debug tool appears at this area.

Remark When the button on the Debug toolbar is clicked, it will download the specified file after connecting to
the debug tool (see "2.5.1 Execute downloading").
When the button on this toolbar is clicked, it will build the project, connect to the debug tool and then
download the specified file.

(1) Display the Version Information [E1] [E20] [EZ Emulator]
After successful connection to the debug tool, the version information such as the emulator firmware version and
the emulator information such as supplied voltage are displayed on the Output panel.

Figure 2-72. Output Panel after Connection [E1]

Wersion Infnrmatinn:J
FFWEZORXEDOD_ A1l oMM MK
BfwEz0rx600. 5.
LEVELO HoMH_ MK
LEVEL1 HoMH. KX
commutii_odll MMM M
FPGA xx,]
Commumnication FPGAL xxg

Emulator Infnrmatinn:d
Emulator Board Bevision El1 REV.KKJ
User YCC 3.31 vl
[EOF]
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Figure 2-73. Output Panel after Connection [E20]

Wersion Infnrmatinn:J
FFWEZORX&00.d11 . .xx.xxx(J
EfwEz0rx600. s,
LEVELD HoHH. RN HEX]
LEVELL HoHM. XN HMK]
communi . dll oM KK HHH
FPGA xx,
Communication FPGA :{:{(J
Trace Control FPGA :-C:-C‘J
Emulator Infnrmatinn:g
Enmulator Board Revision EZ0 Rev.xxg
User VOC 227 vl
USE Bus Power 481 vl
User IfF Cable 38 pin cahle,|
[EOF]

Figure 2-74. Output Panel after Connection [EZ Emulator]

Wersion Infnrmatinn:(J s
FFUWEZCUBERX. d11 WML ML KN, b
Firuware WML ML KN,

EFVMDLLEECUEERX. dl11 :-c.:-c:-c.:-c:-c.:-::-::-:(J

Emulator Infn:\rmation:,:J
Emulator Board Rewvision EZ Rev.xx,:J

[EQF]

W

\ill Messages | Debug Tool / =

Caution [E1] [E20]
When the emulator firmware should be updated, it is automatically updated. To ensure this
update, do not disconnect the USB or power supply until connection is established.
After emulator firmware updating is completed, the message on the Output panel changes as
follows.
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Figure 2-75. Output Panel after Emulator Firmware Updating

Dewriting emulator firmware ... ,:J)

Pewriting emulator firmware ... Done. S
Wersion Infu:urmat.iu:-n:(J
FFWEZORXE00 _ dll x.xx.xx.xxx‘J

24.2 Disconnect the debug tool from CubeSuite+

Click the button on the Debug toolbar to cut off the communication with the connected debug tool.
After disconnecting from the debug tool, the Status bar on the Main window changes as follows:

Figure 2-76. Status Bar Indicating the Disconnection from the Debug Tool

| (m)BREAK BORXEL(ITAG) (7)Mot measured @ |
v

| §;DISCONNECT |

I
This area is left blank. "DISCONNECT" is displayed.

Cautions 1. The debug tool cannot be disconnected from CubeSuite+ while the program is running. If you

wish to disconnect the debug tool, stop the program in advance.
2. [E1] [E20] [EZ Emulator]

If you are using the E1, E20, or EZ Emulator, select the above or either of the following ways to
disconnect the debug tool from CubeSuite+.
(1) Select [Disconnect from Debug Tool] from the [Debug] menu.
(2) Enter “debugger.Disconnect()” in the Python Console panel.
If you terminate the debugger, you will not be able to start up the debugger correctly next time.
In such a case, turn the power off and turn it on again (i.e. turn off the power switch on the E20
and turn it on or disconnect the USB interface cable from the E1 or EZ Emulator and re-connect
it). When using EZ Emulator, also restart CubeSuite+.

Remark Disconnecting the debug tool will close all the panels and dialog boxes that can be displayed only during the
connection.

243 Connect the debug tool to CubeSuite+ using hot plug-in [E1(JTAG)] [E20(JTAG)]
With hot plug-in function, you can connect the debug tool to the CubeSuite+ and debug the program while it is in
execution.

Follow the steps below to establish hot plug-in connection.

(1) Execute the program

Execute the program which has been downloaded onto the microcontroller on the target system without connecting
to the emulator.
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(2) Specify the debug tool
In the active project, specify the debug tool which supports hot-plug in connection ([E1(JTAG))/[E20(JTAG)]).

Remark [E1(Serial)] [E20(Serial)] [EZ Emulator]
Hot plug-in connection is not supported.

(3) Connect the debug tool to CubeSuite+ using hot plug-in
Select [Hot Plug-in] from [Debug] menu to initiate the preparation for hot plug-in connection.

(4) Connect to the target system
Following message will appear once you are ready to start hot plug-in connection. Connect the emulator to the
target system and click [OK]. This will start the communication with the debug tool which is selected in the currently
active project.

Figure 2-77. Message Indicating that Hot Plug-in Connection Is Ready to be Started

Question{Q0204001) (%]

P Hot Plug-in iz prepared.
\_,./ Connect the debug target to a PC and click OFK.

k. H Cancel H Help

Caution [E1(JTAG)]
To establish hot plug-in connection, you need to connect the emulator to the target system via
"Hot-plug Adapter” (ROE000010ACB00) which is optionally available.
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(5) Hot plug-in connection completed

Once the connection to the debug tool is successfully completed, the Status bar on the Main window will change as

shown below. For details on each item displayed on the Status bar, see the section of the "Main window".

Figure 2-78. Status Bar Indicating the Successful Hot plug-in Connection to the Debug Tool

Cautions 1.

73 DISCONNECT |

v

(»]RUN Rurming  SORXEL(ITAG)  (1)Measuring h

I
This area shows information on the currently active debug tool.

"RUN" indicates that the program is running.

The trace function will not be available until the program breaks following the completion of hot
plug-in connection.

The real-time RAM monitor function (RRM function) will not be available until the program
breaks following the completion of hot plug-in connection. Do not select [Real-time RAM
monitor] for the [Usage of trace function] property under the[Trace] category.

Once the hot plug-in connection is established, all the events that have been set in the project
as the user information (excluding built-in event) will be deleted.

When conducting hot plug-in connection, do not use a project for which software break point is
set as it may result in unsuccessful connection. Check that all the software break points are
deleted in the Events panel of the active project before starting hot plug-in connection (see
2.17.5 Deleting events).

The emulator stops the program temporarily for approximately 800us to check the ID code at
hot plug-in connection (CPU clock: 100 MHz, JTAG clock: 16.5 MHz).

[RX630, RX631, RX63N, and RX63T Groups]

Confirm that the endian settings of the endian select registers (MDEB, MDES) written on the
microcontroller match the endian information of the project. See the hardware manual of the
microcontroller for the details of endian select registers.

Hot plug-ins cannot be used while a flash rewrite program is running.
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2.5 Download and Upload

This section describes how to download the program to be debugged (e.g., load module files) into CubeSuite+, and
how to upload the memory content under debug from CubeSuite+ to files.

251 Execute downloading

Download the load module files to be debugged.
Following the procedure below, make the necessary settings for downloads on the Property panel's [Download File
Settings] tab before you execute a download.

(1) Setting the [Download] category

Figure 2-79. [Download] Category [E1(JTAG)] [E1(Serial)] [E20(JTAG)] [E20(Serial)] [EZ Emulator]

B Download
Dowrload files [11
CPU Reszet after download Yez
Eraze flash ROM before download Mo
Eraze data flazh ROM before download Mo
Autornatic change method of event zetting pozition Suzpend event
=i Debua Information
Execute tothe specified sprmbol after CPU R ezet Yez
Specified zymbol _ain
Figure 2-80. [Download] Category [Simulator]
E Download
B Dovenload files [11
= [0 DefaultBuildhest_Fx. abs
Davwnload object Yes
Dravwnload symbal information Yes
Specify the PFIC/PID offzet Mo
CPU Reset after download ez

Autamatic change method of event setting position Suzpend event

(a) [Download files]
Displays the file names to be downloaded, as well as download conditions. (The numeric value in property
value "[]" indicates the number of files currently specified to be downloaded).
The files to be downloaded here are those files that have been specified as the subject to build in the main
project and sub-projects. This means that the same files that were specified in the project are automatically
determinedN°® to be the download files.
However, the files to be downloaded and the download conditions can be manually changed. In this case, see
"2.5.2 An applied method of download".

Note To download the load module files created by an external build tool (e.g., compilers and assemblers
other than the build tools supplied with CubeSuite+), a debug-dedicated project needs to be created.
If you use a debug-dedicated project as the subject to debug, add your download files to the download
file node on project tree. The files to be downloaded will be reflected in this property.
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For details on how to use "external build tools" and details about "debug-dedicated projects," see the
separate edition, "CubeSuite+ Integrated Development Environment User's Manual: Start".

(b) [CPU Reset after download]
Specify from the drop-down list whether or not to reset the CPU after a download is completed.
To reset the CPU, select [Yes] (default).

(c) [Erase flash ROM before download] [E1] [E20] [EZ Emulator]
Specify from the drop-down list whether or not to erase the flash ROM (program ROM) before a download is
executed.
To erase the flash ROM, select [Yes]. (By default, [No] is selected).

(d) [Erase data flash ROM before download] [E1] [E20] [EZ Emulator]
Specify from the drop-down list whether or not to erase the data flash ROM before a download is executed.
To erase the data flash ROM, select [Yes]. (By default, [No] is selected).

(e) [Automatic change method of event setting position]
If, as debug work proceeds, a program which has had changes added is downloaded again, the position
(address) at which a currently set event is set may happen to be in the middle of an instruction. In such a case,
use this property to specify how the subject event should be handled.
Select one of choices from the drop-down list below.

Move to the head of Resets the subject event at the beginning address of the instruction.
instruction
Suspend event Leaves the subject event pending (default).

However, specification on this property applies to only the event set positions for which debug information is
nonexistent. For the event set positions that have debug information, the event is always moved to the
beginning of the source text line.

(2) Setting the [Debug Information] category

Figure 2-81. [Debug information] Category

E Debug Informaton
Ewecute to the specified sumbal after CPU Reszet Y'es
Specified symbol _main

(a) [Execute to the specified symbol after CPU Reset]
Specify from the drop-down list whether or not to run the program up to a specified symbol position after the
CPU is reset, or after a download is completed (only when you specified [Yes] on the [CPU Reset after
download] property).
To run the program up to a specified symbol position, select [Yes] (default).

Remark If, while you specified [Yes] on the [CPU Reset after download] property, you specify [Yes] on this
property, the Editor panel opens automatically after a download is completed, with the source text
at the position you specified on [Specified symbol] property displayed on it.
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Also, if you specify [No] here, this panel opens, with the reset address displayed on it. (If the reset
address has no source text mapped to it, the relevant place is displayed on the Disassemble
panel.)

(b) [Specified symbol]
This property is displayed only when you specified [Yes] on the [Execute to the specified symbol after CPU
Reset] property.
Specify a position at which you want the program being run after the CPU is reset to be halted.
Enter an address expression directly in the range 0 to "end address of address space" to specify the position.
(By default, [_main] is specified.)
However, if the specified address expression cannot be converted into an address, the program is not
executed.

Remark Normally, specify the following.
For assembler source: Beginning label equivalent to the main function
For C source: Symbol given at the beginning of the main function name

(c) [Specify the debugged overlay section]
"Yes" is displayed when overlay sections (see "2.8 Setting Overlay Sections" for details) exist in the load
module.
Otherwise "No" is displayed. This entry cannot be changed.

(d) [Overlay sections]
Address groups where overlay sections exist are displayed.
This property only appears when "Yes" is displayed on the [Specify the debugged overlay section] property.

Caution By default, CPU reset automatically occurs after downloading the file, and then the program is
executed to the specified symbol position. If this operation above is not needed, specify [No]
with both of the [CPU Reset after download] and [Execute to the specified symbol after CPU
Reset] property.

(3) Executing a download
Click the button in the Debug toolbar.
If this operation is performed while CubeSuite+ is disconnected from the debug tool, it is automatically connected
to the debug tool before a download is executed.

Remark To download a file which has had changes added in the course of debug work again, choose [Build &
Download to Debug Tool] from the [Debug] menu on the Main window, which will help you build and
download easily.

(4) Canceling a download
To cancel a download, click on the [Cancel] button on the Progress Status dialog box, which displays the progress
of downloading, or press the [Esc] key.

When the load module files have been successfully download, the Editor panel opens automatically, with the source
text of the downloaded files displayed on it.

Remark A process can be set that automatically rewrites I/O register or CPU register values with specified values
before or after a download (see Section "2.18 Setting Up the Hook Process").
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2.5.2 An applied method of download

The files to download, as well as the download conditions applied at download time can be changed.
CubeSuite+ permits files in the following formats to be downloaded.

Table 2-2. Downloadable File Formats

File Format Extension Remark

Load module format abs

Extension [IAR]N®t® | Usable exclusively for debug-only

projects
Intel Hex format hex 03 (start segment address code) and
- Standard (offset address) 05 (start linear address code) are
ignored.

- 02 (segment address code)

- 04 (extension linear address code)

Motorola S format mot
- (S0, S1, S9-16 bits)
- (S0, S2, S8-24 bits)
- (S0, S3, S7-32 bits)

Binary data format bin

Note Precautions to take when using IAR compilers (made by IAR Systems of Sweden)
- Supported versions
- IAR Embedded Workbench for Renesas (Ver. 2.30.1 or above)
- Supported options
- General options: Byte order:
Little endian/ big endian
double type size: 32 bits/ 64 bits
int type size: 16 bits/ 32 bits
Denormal number: Handled as zero
Data model: Far
Position-dependence: Off
- C/C++ compilers:
Language: C * C++ and GNU C extended specification are not supported.
Derived languages of C: C89/ C99
(LVA permission, Off; C++ inline semantic, Off)
Type of CHAR: Signed/ unsigned
Optimization: None/ low
Output: Generate debug information, On
- Assemblers:
Language: Discriminate user symbols between uppercase and lowercase, On
Output: Generate debug information, On
- Linkers:
Output: Include debug information in output files, On
- Precautions to take when debugging
- Static variables inside a file cannot be referenced on Watch panel, etc. The static variables defined in
functions can be referenced.
- It is only the current function that can be displayed on the Call Stack panel.
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- If a defined variable is composed of multiple registers, the value of the subject variable cannot be
displayed correctly.
Example 1: long long data = 0x123456789abcdef0
/I A case where the variable "data" is mapped to the registers R7 and R8
Example 2: struct aaa { char a; shortb; long c; char d;};
struct aaa sA ={‘S’, 0x4154, Ox4E455452, ‘D’};
/I A case where the variable "sA" is mapped to the registers R6, R7 and R8
- If a variable is deleted as a result of optimization by the compiler, the subject variable cannot be referred
to in the debugger.
- If a variable is temporarily mapped to a register as a result of optimization by the compiler, the value of the
variable may not be displayed correctly on the Watch panel, etc.

To change the download files, or set the download conditions applied at download time, use the Download Files dialog
box shown below.

The Download Files dialog box is opened by clicking the [...] button that is displayed at the right edge in the column of
the [Download files] property when you select it in the [Download] category on the Property panel's [Download File
Settings] tab.

Figure 2-82. Opening the Download Files Dialog Box

B Download
m_m @

CPU Rezet after download Ves
Eraze flazh ROM before download Mo
Eraze data flazh ROM before download Mo
Automatic change method of event setting posgition Suzpend event

Figure 2-83. An Applied Method of Download (Download Files Dialog Box)

Download Files

Diownload file list: Download file property:
Download file information \

Download object Yes
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Specify the PIC/PID offzet Mo

File
Specify the file ta be downloaded.

= A _
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[Download file list] area [Download file property] area
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Here, a method on how to set in the Download Files dialog box shown above is described, using the following cases as
examples.

Changing the download conditions for load module files
Adding a download file (*.hex, *.mot, or *.bin)

(1)

(2)

(3) Downloading multiple load module files

(4) Performing source-level debug with hex format, Motorola S format, or binary data format files
(5)

Downloading files to external flash memory [E1] [E20]

(1) Changing the download conditions for load module files
To change the download conditions for load module files (whether to load object information or symbol information)
under which they are downloaded, follow the procedure described below as you fill in the Download Files dialog
box.

(a) Selection of a load module file
In the [Download file list] area, select the load module file to download.

(b) Alteration of download conditions
In the [Download file list] area, you'll see the download conditions for the currently selected load module file
displayed in it.
For each displayed item, change their setting.

Download object Specify whether or not to download object information from a specified file.
Default Yes
Method to By selecting from drop-down list
change
Specifiable Yes Downloads object information.
value Lo .
No Does not download object information.
Download symbol Specify whether or not to download symbol information from a specified fileNote 1.
information
Default Yes
Method to By selecting from drop-down list
change
Specifiable Yes Downloads symbol information.
value . )
No Does not download symbol information.

Specify the PIC/PID | Specify whether or not to change the positions of PIC (Position Independent Code) and PID
offset (Position Independent Data) areas of the load module to be downloaded from those at which
they were when the load module was created. When this item is changed to [Yes], "PIC Offset"
and "PID Offset" are displayed in the sub-item.

Default No
Method to By selecting from drop-down list
change
Specifiable Yes Specifies PIC/PID offsetNote 2,
value No Does not specify PIC/PID offset.
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PIC Offset Enter an offset value from an address that was in the load module when it was created.

For example, if the program section's start address begins with the address 0x1000, enter
"1000" for this item. The subject section is downloaded to the address 0x2000.

Default 0

Method to By entering directly from the keyboard
change

Specifiable Hexadecimal number in the range 0x0 to OxFFFFFFFF
value

PID Offset Enter an offset value to be set in the PID register that was specified in the load module when it
was created.

For example, to set 0x200 in the PID register when the load module is executed, enter "200" for
this item.

Default 0

Method to By entering directly from the keyboard
change

Specifiable Hexadecimal number in the range 0x0 to OXFFFFFFFF
value

Notes 1. Unless symbol information is downloaded, source-level debugging cannot be performed.
2. If you select [Yes] for load modules created not using the PIC/PID functions (see Section “2.7
Usage of PIC/PID Function®), debug operation cannot be guaranteed.

(c) Clicking the [OK] button
Settings you've made in this dialog box are enabled, with the download conditions changed.

(2) Adding a download file (*.hex, *.mot, or *.bin)
To add a file to download (hex format (*.hex), Motorola S format (*.mot), or binary data format (*.bin)), follow the
procedure described below as you fill in the Download Files dialog box.

(a) Clicking the [Add] button
When you click the [Add] button, a blank item ("-") is displayed on the last line in the [Download file list] area.

(b) Setting the properties of a download file to add
In the [Download file property] area, select a download file you want to add and set its download conditions.
For each displayed item, make the following setting.
When setting is completed, the file name you've specified here is reflected in the blank item in the [Download

file list] area.

File Specify a download file to add (hex format (*.hex), Motorola S format (*.mot), or binary data
format (*.bin)) (specifiable in up to 259 characters).
Default Blank
Method to By entering directly from the keyboard, or specifying in the Select Download
change File dialog box that is opened by clicking the [---] button displayed at the right

edge of this property when it is selected
Specifiable See "Table 2-2. Downloadable File Formats".
values
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File type Specify the file type of a download file to add.
Here, select [Hex File], [S Record File] or [Binary Data File].
Default Load module file
Method to By selecting from drop-down list
change
Specifiable Either one of the following
values - Load module file
- Hex file
- S record file
- Binary data file
Offset This item is displayed only when the file to download is a hex format (*.hex) or Motorola S format
(*.mot).
Specify an offset value from the address at which a download of a specified file begins.
Default 0
Method to By entering directly from the keyboard
change
Specifiable Hexadecimal number in the range 0x0 to OxFFFFFFFF
values
Start address This item is displayed only when the file to download is a binary data format (*.bin). Specify the
start address from which a specified file is downloaded.
Default 0
Method to By entering directly from the keyboard
change
Specifiable Hexadecimal number in the range 0x0 to OxFFFFFFFF
values

@)

Remark Specification of whether or not to download object information or symbol information is accepted

only when the type of file to download is a load module file.

(c) Confirming the order in which a download is executed

A download is executed in the order in which files are displayed in the [Download file list] area.

To change the order, use the [Up] or [Down] button to move any file up or down in the list.

(d) Clicking the [OK] button
Settings you've made in this dialog box are enabled, with the specified file added as a download file (The

added file name and its download condition are displayed in the [Download] category on the Property panel's
[Download File Settings] tab).

Downloading multiple load module files

To download multiple load module files, follow the procedure described below as you fill in the Download Files

dialog box.

Caution When debugging a program comprised of multiple load module files, be careful that location

addresses will not overlap.

Remark

When multiple load module files are downloaded, the load module names are displayed as the detailed

information on the Events panel.
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(a) Clicking the [Add] button
When you click the [Add] button, a blank item ("-") is displayed on the last line in the [Download file list] area.

(b) Setting the properties of a download file to add

In the [Download file property] area, select a download file you want to add and set its download conditions.

For each displayed item, make the following setting.

When setting is completed, the file name you've specified here is reflected in the blank item in the [Download

file list] area.

File Specify a file in load module format to add (specifiable in up to 259 characters).
Default Blank
Method to By entering directly from the keyboard, or specifying in the Select Download
change File dialog box that is opened by clicking the [...] button displayed at the right

edge of this property when it is selected

Specifiable See "Table 2-2. Downloadable File Formats"
values

File type Specify the file type of a download file to add.

Here, select [Load module file].

Default

Load module file

Download object

Specify whether or not to download object information from a specified file.

were when the load module was created. When this item is changed to [Yes], "PIC Offset" and "PID

Default Yes
Method to By selecting from drop-down list
change
Specifiable Yes Downloads object information.
values Lo .
No Does not download object information.
Download symbol Specify whether or not to download symbol information from a specified fileNote .
information
Default Yes
Method to By selecting from drop-down list
change
Specifiable Yes Downloads symbol information.
values . )
No Does not download symbol information.
Specify the PIC/PID | Specify whether or not to change the positions of PIC (Position Independent Code) and PID
offset (Position Independent Data) areas of the load module to be downloaded from those at which they

Offset" are displayed in the sub-item.

Default No
Method to By selecting from drop-down list
change
Specifiable Yes Specifies PIC/PID offsetNote 2,
values No Does not specify PIC/PID offset.
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PIC Offset Enter an offset value from an address that was in the load module when it was created.

For example, if the program section's start address begins with the address 0x1000, enter "1000"
for this item. The subject section is downloaded to the address 0x2000.

Default 0

Method to By entering directly from the keyboard
change

Specifiable Hexadecimal number in the range 0x0 to OxFFFFFFFF
values

PID Offset Enter an offset value to be set in the PID register that was specified in the load module when it was
created.

For example, to set 0x200 in the PID register when the load module is executed, enter "200" for this
item.

Default 0

Method to By entering directly from the keyboard
change

Specifiable Hexadecimal number in the range 0x0 to OXFFFFFFFF
values

Notes 1. Unless symbol information is downloaded, source-level debugging cannot be performed.
2. If you select [Yes] for load modules created not using the PIC/PID functions (see Section “2.7
Usage of PIC/PID Function®), debug operation cannot be guaranteed.

Remark For the load module files that do not require symbol information, you can set [No] for the [Download
symbol information] item to reduce the amount of memory used (However, this file cannot be
debugged at the source level.).

(c) Confirming the order in which a download is executed
A download is executed in the order in which files are displayed in the [Download file list] area.
To change the order, use the [Up] or [Down] button to move any file up or down in the list.

(d) Clicking the [OK] button
Settings you've made in this dialog box are enabled, with the specified load module file added as a download
file. (The added file is displayed in the [Download] category on the Property panel’s [Download File Settings]
tab).

(4) Performing source-level debug with hex format, Motorola S format, or binary data format files
Even when a file in hex format (*.hex), Motorola S format (*.mot), or binary data format (*.bin) is specified to be the
subject file to download, it is possible to do source-level debug by downloading symbol information for the load
module file from which the subject file was created, along with the subject file that you download.
In this case, follow the procedure described below as you fill in the Download Files dialog box.

(a) Clicking the [Add] button
When you click the [Add] button, a blank item ("-") is displayed on the last line in the [Download file list] area.

(b) Setting the properties of a load module file
In the [Download file property] area, specify for each item as shown below.
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File Specify a load module file from which the file in hex format (*.hex), Motorola S format (*.mot), or
binary data format (*.bin) that you want to download was created.

Enter directly from the keyboard, or specify in the Select Download File dialog box that is
opened by clicking the [-:-] button.

File type Specify [Load module file] (default).

Download object Specify [No].

Download symbol Specify [Yes] (default).
information

Specify the PIC/PID | Specify [No] (defaultyNote,
offset

Note For files in hex format, Motorola S format, or binary data format, be aware that the destination to which
they are downloaded cannot be discriminated between the PIC and PID areas. If you specify PIC/PID
offsets in a load module file, the result will be that the specified offsets do not agree with the debug
function and the file cannot be debugged.

(c) Clicking the [OK] button
Settings you've made in this dialog box are enabled, with the specified load module file added as a download
file (Only the symbol information included in the load module file becomes the subject to download.).

(5) Downloading files to external flash memory [E1] [E20]
The download files you've specified in the Download Files dialog box can be downloaded to the flash memory
connected to an external bus of the microcontroller used (i.e., the external flash memory).
In this case, follow the procedure described below.

(a) Setting up the Property panel
In the [External Flash] [E1] [E20] category on the Property panel's [Debug Tool Settings] tab, register an
external flash definition file (USD file).
External flash memory is recognized by registering a USD file in the [External Flash] [E1] [E20] category. Up to
four USD files can be registered.
By clicking the "+" mark of an external flash definition file, the definition file name, start and end addresses,
and whether to erase the external flash ROM before downloading are displayed for each index ([1] to [4]).

Figure 2-84. [External Flash] Category

E Extemnal Flazh
=

[0

(1]

[]

(3]

<1> [External flash definition file]
Shows the maximum number of registrable USD files.
To register a USD file, specify a USD file name in the [File] property that is expanded on display as a
sub-property.
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Enter a file name directly (if specified by a relative path, it should be referenced to the project folder), or
select a file in the External flash memory dialog box [E1] [E20] that is opened by clicking the [...] button,
which is displayed at the right edge in the setup column of this property when it is selected.

After a USD file is registered, the [Start address], [End address], and [Erase external flash ROM before
download] sub-properties are added to the displayed information.

For the [Start address] and [End address] properties, the external flash memory area defined in the
registered USD file is displayed (this information cannot be modified).

For the [Erase external flash ROM before download] property, select [Yes] or [No] from the drop-down
list.

To erase the external flash ROM before downloading, select [Yes]. ([No] is selected by default.)

To delete registration of a USD file, move the caret to the file name on the relevant [File] property and
then click the [Delete] key.

For more information on USD files, visit Renesas website and see the user's manual for the External
Flash Definition Editor.

Figure 2-85. Opening the External flash memory Dialog Box

Bl External Flash

E Extemal flazh definition file [4]
= [0] E:A\SampletJSDAE stFlash.usd
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[ex]
[Fex]
Eraze external flazh ROM before download Mo
11
[2]
[3]

Cautions 1.  The endian information in USD files is not reflected on the [Memory mappings] property
in the [Memory] category on the Property panel's [Debug Tool Settings] tab. Therefore,
the endian in the external area to which they are downloaded should be changed to suit
the endian information in USD files.

2.  When the address ranges of multiple registered USD files overlap each other,
connection with the debug tool cannot be established.

3. For downloading in external flash memory, internal RAM or CS-area RAM can be used
as a work area. Note that SDRAM areas (SDCS) are not usable.

Remark If the manufacturer ID or device ID does not match, the read value and expected value are
displayed in the Output panel.
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Figure 2-86. Error Messages in the Output Panel
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(b) Setting the CPU operation mode
For files to be downloaded to external flash memory, it is necessary to set the microcontroller's operation
mode when connecting with the debug tool. To do this, change the [Register setting] property in the [Operating
Modes of CPU] [E1] [E20] [EZ Emulator] category on the Property panel's [Debug Tool Settings] tab by
selecting [On-chip ROM enabled extended mode] or [On-chip ROM disabled extended mode] from the
pulldown list, as shown below.

Figure 2-87. Specifying the CPU Operation Mode

E Operating Modesz of CPU
Mode pinz zetting Single-chip mode
Register zetting On-chip ROM enabled extended mode
Endian Single-chip mode

On-chip ROM dizabled extendad mode

(c) Executing a download
Execute a download (see “(3) Executing a download").

Cautions 1.  External flash memory cannot be rewritten on the Memory panel.
2. To use a flash memory device that does not support the use of the Lock command, specify that
the lock bit be cleared when you generate USD files. This specification helps you omit an
unnecessary process to confirm the lock bit status.

253 Executing an upload

The memory content of the currently connected debug tool can be saved (uploaded) to any file.
To do an upload, use the Data Save dialog box that is opened by choosing [Upload...] from the [Debug] menu.
Follow the procedure described below to make the necessary setting in this dialog box.
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(1)

(2)

@)

(4)

Figure 2-88. Uploading Memory Contents (Data Save Dialog Box)
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File Marme: | [lripuat file narme here. ) w | B
File Type: | Intel Hex format [* hex) w |

Save Range &ddrezs/S pmbol:

| [Input the start of zaving range b [ke] » | . | [Input the end of saving range he [k |
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Specifying the [File Name]

Specify a file name in which you save.

Enter directly in the text box (specifiable in up to 259 characters), or select an input history item from the drop-
down list (up to 10 history entries).

Also, you can select a file from the Select Data Save File dialog box that is opened by clicking the [...] button.

Specifying the [File Type]
Select the type of file in which you want to save from the drop-down list below.
The selectable file types are as follows:

Table 2-3. Uploadable File Formats

List display Format
Intel Hex format (*.hex) Hex format™ote
Motorola S-format (*.mot) S Record format
Binary data (*.bin) Binary data format

Note In the Intel hex format, memory contents are always saved in "extension linear address code (32-bit
address)."

Specifying the [Save Range Address/Symbol]

Specify the "start address" and "end address" to set a range of memory to be saved in a file.

Enter hexadecimal values or address expressions directly in the respective text boxes or select an input history
item from the drop-down list (up to 10 history entries).

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").

Clicking the [Save] button
Memory contents are saved in specified form to a specified file as upload data.
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2.6 Displaying and Changing Programs

This section describes how to display and change programs when a load module file with the debug information is
downloaded to a debug tool.
Downloaded programs can be displayed in the following panels.

- Editor panel
The source file is displayed and can be edited.
Furthermore, the source level debugging (see "2.9.3 Execute programs in steps") and the display of the code
coverage measurement result (see "2.15.2 Display coverage measurement results") can be performed in this
panel.

- Disassemble panel
The result of disassembling the downloaded program (the memory contents) is displayed and can be edited (line
assemble).
Furthermore, the instruction level debugging (see "2.9.3 Execute programs in steps") and the display of the code
coverage measurement result (see "2.15.2 Display coverage measurement results") can be performed in this
panel. In this panel, the disassembled results can be displayed with the corresponding source text (default).

Remark It is normally necessary to download a load module file with debugging information in order to perform the
source level debugging, but it is also possible to do so by downloading a hex format (*.hex), Motorola S
format (*.mot), or binary data format (*.bin) file (see "(4) Performing source-level debug with hex format,
Motorola S format, or binary data format files").

261 Displaying source files

Use the Editor panel shown below to display the source file.

The Editor panel opens automatically after a load module file is successfully downloaded, with the source text at the
position you specified (see "2.5.1 Execute downloading") displayed on the panel.

If you want to open the Editor panel manually, double-click on the source file in the Project Tree panel.

For details on the contents and function in each area, see the section for the Editor panel.

Remarks 1.  You can open a file with a specific encoding selected in the Encoding dialog box that is opened via the
[File] menu >> [Open with encoding...].
2.  You can zoom in and out of this panel (See "(I) Zoom in or out on a view") by using the [Ctrl] key +
mouse-wheel combination.
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Figure 2-89. Displaying the Source File (Editor Panel)
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This section describes the following.

Changing the display mode

(1)

(2) Setting the columns to display

(3) Displaying multiple source files in a single panel
(4) Displaying variables

(5) Searching for characters

(6) Moving to a specified line

(7) Jumping to functions

(8) Jumping to a desired line (tag jump)

(1) Changing the display mode
When the debug tool is connected and the downloaded source file is opened, the instruction code, label and
disassembled text can be displayed combined with the corresponding source code by clicking the button
(toggle) on the toolbar (mixed display mode).

Figure 2-90. Editor Panel (Normal Display Mode)
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34 =k

35 EfEERTE3 &9 while (1)1

36 FEEEETAS . tutorial () :
37 }

38

39

an fEEfET o2 W, void tutorial (void)

R20UT2350EJ0100 Rev.1.00 RRENESAS Page 86 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

Figure 2-91. Editor Panel (Mixed Display Mode)
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Cautions 1. The mixed display mode is enabled only when connected to the debug tool and the
downloaded source file is opened in this panel.
2. Inthe mixed display mode, the source files cannot be edited and saved. In addition, [Redo]/
[Cut]/[Paste]/[Delete]/[Select All}/[Replace...]/[Outlining]/[Advanced] from the [Edit] menu
are disabled.

(2) Setting the columns to display
The columns or marks displayed on this panel can be set by selecting the toolbar items shown below.
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Columns The following items are displayed to show or hide the columns or marks on this panel.

Remove the check to hide the items (all the items are checked by default).

Line Number Shows the line number, in the line number area.

Selection Shows the mark that indicates the line modification status, in the line number area.

Out of date module indicator Shows the mark that indicates the update status of the downloaded load module file, in
the line number area.

Note that this item is enabled only when connected to the debug tool.

Coverage Shows the coverage area.

Note that this item is enabled only when connected to the debug tool.

Address Shows the address area.

Note that this item is enabled only when connected to the debug tool.

Op Code Shows the instruction code area.

Note that this item is enabled only when connected to the debug tool and the mixed
display mode is selected.

Label Shows the label area.

Note that this item is enabled only when connected to the debug tool and the mixed
display mode is selected.

Event Shows the event area.

Note that this item is enabled only when connected to the debug tool.

Main Shows the main area.

Note that this item is enabled only when connected to the debug tool.

Column Header Shows the column header.

(3) Displaying multiple source files in a single panel
If the current PC moves between multiple source files when debugging (e.g. when performing step execution),
each of the source files will be opened in a separate editor panel. If this is the case, the recycle mode lets you
display multiple source files in a single Editor panel.
Select the [Use window recycling] check box on the [General - Text Editor] category in the Option dialog box to
enable this feature.

R20UT2350EJ0100 Rev.1.00 RRENESAS Page 88 of 506
Mar 01, 2013



CubeSuite+ vV2.00.00

CHAPTER 2 FUNCTIONS

Figure 2-92. Normal Operation
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Figure 2-93. Recycle Mode Operation
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Cautions 1.  The recycle mode is enabled only when connected to the debug tool and the downloaded

source file is opened in this panel.

2.  When the program is executed with the current PC position located in the source file in the
Editor panel that is being edited in the recycle mode, that Editor panel is released from the
recycle mode, and a new Editor panel is opened in the recycle mode.

Remark If the Editor panel that displays the corresponding source file is already opened, then the source file is
not opened in the panel of the recycle mode, but the Editor panel being opened is displayed.
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(4)

)

Displaying variables

When hovering the mouse cursor over a variable in the source text, a pop-up that shows the name and value of the
variable is displayed ("<variable name>=<variable value>").

The display format of the variable value is same as "Table A-10. Display Form of Watch-expressions (Default)"
depending on the type of the variable.

Figure 2-94. Pop-up Display of Variables (Editor Panel)
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Searching for characters
To search for characters in the source text, use the Find and Replace dialog box that is opened by selecting the

button on the toolbar.

In this dialog box, follow the procedure described below to search for characters.

Figure 2-95. Character Search in Source Text (Find and Replace Dialog Box)

S}

ind and Replace

Quick Find | Find nFilez | Quick Replace | Replace in Files

Search text: |main b | >

Search Jocation: | Current document [main.c) w |

[ Find Previous ] I Firnd M ext ] [ Cancel l [ Help l

(a) Specifying [Search text]
Enter characters to search.
A word (variable/function) at the caret position in the Editor panel is specified by default.
If you want to change it, directly enter the characters into the text box (up to 1024 characters) or select an input
history item from the drop-down list (up to 10 items).

(b) Specifying [Search location]
Select [Current document (file name)] from the drop-down list.

(c) Clicking the [Find Previous]/[Find Next] button
When the [Find Previous] button is clicked, search will start in the order from the large address number to
small and the search results are displayed selected in the Editor panel.
When the [Find Next] button is clicked, search will start in the order from the small address number to large
and the search results are displayed selected in the Editor panel.

Remarks 1.  Click the [Option] button to specify to use wild card, case sensitivity, word by word search, and so
on.
2. Inthe Find and Replace dialog box, various search/replace operation can be performed by
selecting [Find in Files], [Quick Replace], or [Replace in Files] tab.
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(6) Moving to a specified line

To move to a specified address in the source text, select [Go To...] from the context menu and use the Go to Line

dialog box that is opened.

In this dialog box, follow the procedure described below to move to a specified line.

Figure 2-96. Move to the Specified Line in Source Text (Go to Line Dialog Box)
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(a) Specifying [Line number (valid line range)]

"(valid line range)" shows the range of valid lines in the current file.

Directly enter a decimal value as the number of the line you want to move the caret to.

By default, the number of the line where the caret is currently located in the Editor panel is displayed.

(b) Clicking the [OK] button
The caret moves to the specified line.

(7) Jumping to functions

It automatically recognizes the currently selected characters or the word at the caret position as the function name

and jumps to the first executable line of the target function.

Select [Jump to Function] from the context menu after moving the caret to the target function on the source text.

Figure 2-97. Jump to Functions
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Note that this function is available only when the following conditions are satisfied for each specific build tool.
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(@) When CC-RX is used
- The target is a function, variable, or label in C language.
- The focus is in the Editor panel.

(b) When an external build tool is used
- The target function"°® ' resides in an active project.
- The focus is in the Editor panel.
- A fileNote 2 with the symbol information is selected for [Download files]. In case it is disconnected from the
debug tool, the above file is specified as the first file in [Download files].

Notes 1. A jump to a static function cannot be made when the debug tool is disconnected.
2. When the file is in the hex format, setting for downloading the symbol information is required (see
"(4) Performing source-level debug with hex format, Motorola S format, or binary data format
files").

Caution When multiple statements are described in a line, a jump to an illegal location may be made.
Remark The judgement of words will depend on the build tool being used.

(8) Jumping to a desired line (tag jump)
If the information of a file name, a line number and a column number exist in the line at the caret position, you can
open the file in another Editor panel and jump to the corresponding line and the corresponding column (if the Editor
panel is already open, you can jump to the panel).
Select [Tag Jump] from the context menu after moving the caret to the line on the source text.
The tag jump is operated as follows:

Table 2-4. Operation of Tag Jump

Example of Character String Operation
C:\work\src.c Jumps to the top line of the file "C:\work\src.c".
Tmp\src.c Jumps to the top line of the file ".Tmp\src.c".
C:\work\src.c(10) Jumps to the tenth line from the top of the file "C:\work\src.c".
C:\"work sub\src.c"(10) Jumps to the tenth line from the top of the file "C:\"work sub\src.c™".
C:\work\src.c(10,5) Jumps to the fifth column of the tenth line from the top of the file "C:\work\src.c".
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Figure 2-98. Tag Jump
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Jumps are case-insensitive.

2. The reference point of the path is the project folder in which the file is registered. If the file is not

registered in any project, the reference point of the path will be the active project.

3. Path specifications (path/file names) including space characters must be enclosed in "".
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2.6.2 Displaying the disassembled result

To display the disassembled result (disassembled text) of a downloaded program (memory content), use the
Disassemble panel shown below.

Choose [Disassemble] from the [View] menu and then select [Disassemble1 - 4].

Up to four disassemble panels can be opened at a time, with each panel discriminated by the name in their title bar,
"Disassemble1," "Disassemble2," "Disassemble3," or "Disassemble4."

For details on how to read each area and details about their functionality, see the section in which the Disassemble
panel is described.

Figure 2-99. Displaying the Disassembled Result (Disassemble Panel)
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Eventarea  Address area Disassemble area

Remark In the Scroll Range Settings dialog box which opens by clicking on [View] >> , in the toolbar, you
can set the scroll range of the vertical scroll bar on this panel.

Following methods of operation are described here.

(1) Changing the display mode

(2) Changing the display form

(3) Moving to a specified address

(4) Moving to a symbol definition part

(5) Saving the displayed contents of disassembled results

(1) Changing the display mode
Disassembled results are displayed, by default, in the mixed display mode (a mixed display of disassembled text and source
text).
By clicking the toolbar button (toggle), you can choose to show or not show the source text.
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Figure 2-100. Example Display Where Source Text is Hidden
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(2) Changing the display form
The form in which disassembled results are displayed can be changed freely by using the toolbar buttons shown below.

View Shows the following buttons that change the display form.

Displays the offset values of labels. If the address has no labels defined, an offset value from the
closest label is displayed.

)

e Displays address values in the form "symbol + offset value" (default).

However, if the address value has a symbol defined, only the symbol is displayed.

(3) Moving to a specified address
To move to a specified address in the disassembled text, select [Go To...] from the context menu and use the Go
to the Location dialog box that is opened.
In this dialog box, follow the procedure described below to Move to a specified address.

Figure 2-101. Move to the Specified Address in Disassembled Result (Go to the Location Dialog Box)

Go to the Location

Address Symbol: | - |

[ O H Cancel H Help ]

(a) Specifying [Address/Symbol]
Specify an address to which you want to move the caret.
Enter an address expression directly in the text box (specifiable in up to 1024 characters) or select an input
history item from the drop-down list (up to 10 history entries).

Remark By holding down [Ctri]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").
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(b) Clicking the [OK] button
The caret moves to the specified address.

(4) Moving to a symbol definition part
The caret position can be moved to the address at which a symbol is defined.
Move the caret to an instruction that is referencing the symbol and then click the toolbar button .
Also, if, subsequently to the above operation, you click the toolbar button, the caret position is returned to the
instruction that was referencing the symbol before the caret was moved.

(5) Saving the displayed contents of disassembled results
The contents of disassembled results can be saved to a text file (*.txt) or CSV file (*.csv).
When saving to a file, CubeSuite+ gets latest information from the debug tool and saves it in the form in which data
are displayed on this panel.
Choose [Save Disassemble Data As ...] from the [File] menu, and the Data Save dialog box shown below is
opened. (At this time, if you perform this operation while a range is selected on panel, it is possible to save only the
selected range of disassembled data.)
In this dialog box, follow the procedure described below to save the displayed contents of disassembled results.

Figure 2-102. Saving Disassembled Result (Data Save Dialog Box)

Data Save - Disassemble Data §|
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File Type: | Test files” tat] w
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Save H Cancel H Help

(a) Specifying the [File Name]
Specify a file name in which you want to save.
Enter it directly in the text box (specifiable in up to 259 characters) or select an input history item from the drop-
down list (up to 10 history entries).
Also, you can select a file using the Select Data Save File dialog box that is opened by clicking the [...] button.

(b) Specifying the [File Type]
Select the type of file in which you want to save from the drop-down list below.
The selectable file types are as follows.

List display Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated) (*.csv) CSV formatNote
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Note Each piece of data are separated with a comma (,) when saved.
To avoid the problem of an invalid file format in cases where any data includes a comma (,), each piece
of data are enclosed in double-quotes (" ") when they are output to a file.

(c) Specifying the [Save Range Address/ Symbol]
Specify the "start address" and "end address" to set a range of data to be saved in a file.
Directly enter hexadecimal values or address expressions in the respective text boxes or select an input
history item from the drop-down list (up to 10 history entries).
Note that if a range is selected on panel, this selected range is specified, by default, in the text boxes. If no
range is selected, the currently displayed range on panel is specified.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").

(d) Clicking the [Save] button
Disassembled data is saved in specified format to a specified file.

Figure 2-103. Disassembled Data Output Image when Saved

Label (symbol name) 4_‘ Label (symbol) line I
File name Line number C language source text 4—‘ Source text line I
Address Offset  Code Result of Disassembling 4—‘ Disassembling line I
Remarks 1.  If panel contents are saved over an existing file by selecting [Save Disassemble Data] on [File]

menu, the respective Disassemble panels (Disassemble1-4) are handled individually.
Also, as to the save range, the previously specified address range is applied when data is saved.
2. By selecting [File] >> [Print...], you can print the image currently displayed on this panel.

2.6.3 Executing a build in parallel with other processes

CubeSuite+ provides a facility to automatically start a build in synchronism with the timing described below (rapid build
function).

(1) For other than the debug-only project
- When any of the C source files, C++ source files, assembler source files, header files, link directive files,
symbol information files, object module files, relocatable module files or library files added to the project is
updated
- When a file to build is added or removed from the project
- When the order in which object module files is linked is changed
- When the properties of the build tool or the file to build are changed

(2) For the debug-only project
- When a C source file, C++ source file, assembler source file, or header file added to the debug-only project is
saved after editing
- When a C source file, C++ source file, assembler source file, or header file is added or removed from the
debug-only project
- When properties of the debug-only project are changed
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By enabling the rapid build function, it is possible to perform a build in parallel with the above operation.
To choose to enable or disable the rapid build function, click [Rapid Build] on the [Build] menu (This is a toggle switch,
which is, by default, enabled.).

Caution For this function to be enabled when you use an external editor, it is necessary to check the
[Observe registered files changing] checkbox in the [General - Build/Debug] category of the Option
dialog box.

Remarks 1. It is recommended that after editing the source file, you should always be sure to press the [Ctrl] + [S]
keys to save it each time.
2.  When you've chosen to enable or disable the rapid build function, your selection is applied to the entire
project (main project and sub-projects).
3. If, while a rapid build is under execution, the rapid build function is switched off (disabled), execution of
the rapid build is aborted on the spot.

2.6.4 Performing line assembly

The instructions and instruction codes displayed on the Disassemble panel can be edited (line-assembled).
Following methods of operation are described here.

(1) Editing instructions
(2) Editing instruction code

(1) Editing instructions
To edit instructions, follow the procedure described below.

(a) Switching to the edit mode
Double-click an instruction you want to edit, or while the caret is moved to the subject instruction, select [Edit
Disassemble] from the context menu, and the subject you're going to edit is placed into the edit mode.

(b) Editing instructions
Edit the character string of the instruction directly from the keyboard.

(c) Writing into memory
Press the [Enter] key when you've finished editing, and the altered instruction is automatically line-assembled
and the resulting code is written into memory.
However, if this alteration results in an invalid instruction, the character string you've edited is displayed in red
color and not written into memory.

Note that if space is created in memory by overwriting the disassembled result being displayed on panel with
another instruction, bytes are automatically compensated for with nop instructions as in the example shown below.

Examples 1. When the ADD instruction on third line (6-byte instruction) is overwritten with a BCLR instruction
(4-byte instruction)

Before editing 5020 AND [R2] .UB, RO
99e0 MOV.W OCH[R6],RO
700fb98a322a ADD #2A328AB9H, RO, R15
5327 AND R2,R7
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After editing 5020 AND [R2].UB, RO
99e0 MOV.W  OCH[R6],RO
£22a45b2 BCLR #2,0B245H[R2]
03 NOP
03 NOP
5327 AND R2,R7

2. When an MOV.W instruction on second line (2-byte instruction) is overwritten with a BCLR
instruction (4-byte instruction)

Before editing 5020 AND [R2].UB, RO
99e0 MOV.W  OCH[R6],RO
700fb98a322a ADD #2A328AB9H, R0, R15
5327 AND R2,R7

After editing 5020 AND [R2] .UB, RO
99e0 MOV.W OCH[R6],RO
£22a45b2 BCLR #2,0B245H[R2]
03 NOP
03 NOP
03 NOP
03 NOP
5327 AND R2,R7

(2) Editing instruction code

To edit instruction code, follow the procedure described below.

(a) Switching to the edit mode

Double-click instruction code you want to edit, or while the caret is moved to the subject instruction code,
select [Edit Code] from the context menu, and the subject you're going to edit is placed into the edit mode.

(b) Editing instruction code

Edit the character string of instruction code directly from the keyboard.

(c) Writing into memory

Press the [Enter] key when you've finished editing, and instruction code is written into memory.

However, if this alteration results in an invalid instruction, the character string you've edited is displayed in red

color and not written into memory.
When instruction code is written into memory, the disassembled result is updated at the same time.
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2.7 Usage of PIC/PID Function

The PIC/PID function enables the code and data in the ROM to be reallocated to desired addresses without re-linkage
even when the allocation addresses have been determined through previously completed linkage.

To use the PIC/PID function, a "master" program and an "application" program must be prepared.

In the PIC/PID function, a program whose code or data in the ROM has been converted into PIC or PID is called an
application, and the program necessary to execute an application is called the master.

This section describes debugging of an application program (load module) whose code or data in the ROM has been
converted into PIC or PID and reallocated to different addresses.

- PIC
When the pic option is specified for compilation, the PIC function is enabled and the code in the code area (P
section) becomes PIC. The PIC always uses PC relative mode to acquire branch destination addresses or function
addresses, so it can be reallocated to any desired addresses even after linkage.

- PID
When the pid option is specified for compilation, the PID function is enabled and the data in ROM data areas (C,
C_2,C_1,W,W_2, W_1, and L sections) becomes PID. A program executes relative access to the PID by using
the register (PID register) that indicates the start address of the PID. The user can move the PID to any desired
addresses by modifying the PID register value even after linkage.

Remarks 1.  For details on the PIC/PID function, see Chapter 7, Startup, in "CubeSuite+ Integrated Development
Environment User's Manual: RX Coding".
2.  For setting of the PIC/PID function by the build tool, see Chapter 2, Functions, in "CubeSuite+
Integrated Development Environment User's Manual: RX Build".

To start debugging after changing the allocation of a load module whose code or data in the ROM has been converted
into PIC or PID, take the following steps.

(1) Add a download file
Add the application load-module file as a download file for the master (see "2.7.1 Changing the allocation of a
load module using the PIC/PID function").

(2) Set conditions for downloading of the load module file
Specify two offset values for the application load module: [PIC Offset], which is an offset from the original address,
and [PID Offset], which is an offset to be set in the PID register selected at the time the load module was created.

(3) Download
Download the master and the application load-module file (see "2.5.1 Execute downloading").
Debugging of the code and data in the ROM allocated to new addresses is now possible.
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271 Changing the allocation of a load module using the PIC/PID function

An application load-module file can be added to the master through the [Download files] property under the [Download]
category on the [Download File Settings] tab in the Property panel.

Figure 2-104. [Download] Category

B Download
Dawnload files 1] m)
CPU Reset after download Yes

- [Download files]
Click on the [...] button to open the Download Files dialog box.

Click on the [Add] button in the [Download file list] area of the Download Files dialog box and set up information on the
application load module in the [Download file property] area.
- [File]
Specify the application load-module file to be downloaded.
- [Specify the PIC/PID offset]
Select [Yes]. [PIC Offset] and [PID Offset] will appear.
- [PIC Offset]
Specify an offset from the original address allocated at the time the load module was created.
- [PID Offset]
Specify an offset to be set in the PID register selected at the time the load module was created.

Figure 2-105. Adding a Download File and Changing Conditions for Downloading (Download Files Dialog Box)
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When the load module is downloaded after the values of [PIC Offset] and [PID Offset] have been changed, the
allocation of addresses for the P section and external or static variables is changed as shown in the figure below.

The left half shows an example where 4000 is specified for [PIC Offset] and [PID Offset] in the Download Files dialog
box while the right half shows an example where 0 is specified.

In the left half, 4000 is added to the original address.

Figure 2-106. Example of Downloading after the Offset Values of [PIC Offset] and [PID Offset] Have been
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g auc = g acuc sl g auc = g acuc sl
| watcht | v X v X
[Z | @ i ] X | notation~ Bl @ L ] | motation-
Watch Valus Typei(Byte Zize) Bddre Memo Wat ch Valus TypeiBytce Size) Address Memo
g acc ‘0" (0x01) sigmed char(l) Qe f£££4100 g acc ‘0" (0x01) sigmed char(l) Qxf£££2100
< b3 RS b4

R20UT2350EJ0100 Rev.1.00
Mar 01, 2013

RRENESAS

Page 102 of 506



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

2.8 Setting Overlay Sections

The optimizing linkage editor (Optink) used by the CC-RX provides the start option, which allows two or more sections
defined in a program to be allocated to a single address. Sections that have been allocated in this way are called overlay
sections.

This section describes how to set up the "overlay-section selection facility" for overlay sections in a load module.

When the program is executed, only one of the sections allocated to the same address in the load module is executed.

The debug tool provides the "overlay-section selection facility" to select a particular overlay section to be debugged
preferentially (hereafter referred to as the priority section).

With the priority section selected before execution of the program, debugging of that section is simple because
debugging information of other sections is hidden.

An example of using Optlnk's start option to define overlay sections is given below.

Example Defining overlay sections by Optink

start = Psect01/1000,Psect02/2000,Psect03/3000, ram01:ram02:ram03/5000

rom = PsectOl=ram0l,Psect02=ram02, Psect03=ram03

The rom option reserves section "ramXX", which is as large as the "PsectXX" section, and relocates the symbols
defined in the "PsectXX" section to the corresponding addresses in the "ramXX" section (XX: 01, 02, or 03 in this
example).

Remark For setting of overlay sections by the build tool, refer to Chapter 2, Functions, in "CubeSuite+ Integrated
Development Environment User's Manual: RX Build".

Figure 2-107. Allocation of Overlay Sections

Memory space
0x0000
0x1000
Psect01
0x2000
Psect02
0x3000
Psect03 o .
verlay sections
0x5000 ramo01 or ramo02 or ramo03
Runtime section Runtime section Runtime section
for Psect01 for Psect02 for Psect03
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2.8.1 Selecting the priority section

The priority section can be selected under the [Debug Information] category on the [Download File Settings] tab in the
Property panel.

Figure 2-108. [Debug Information] Category

E Debug Informaton
Ewecute to the specified symbol after CPU Feset  Yes
Specified syrbol mait

Specify the debugged averlay section >

(1) [Specify the debugged overlay section]
"Yes" is displayed when overlay sections exist in the load module (this cannot be changed).

(2) [Overlay sections]
Address groups where overlay sections exist are displayed.
This property only appears when "Yes" is displayed on the [Specify the debugged overlay section] property.

Figure 2-109. [Overlay sections] Property

B Debug Information
Execute to the specified symbol after CPU Reset  Yes

Specified symbol _main
= [0 3000 - 0x3074
[e<]
[Hex]
Pricrity zection ram1 b
[1] 03700 - 023110
K [2] 3200 - 03203

This property shows the current information of overlay sections per address group in detail. Only [Priority section]
can be changed.
- [File]
Name of the load module file in which the selected address group has been downloaded (this cannot be
changed).
- [Start address]
First address of the selected address group (this cannot be changed).
- [End address]
Last address of the selected address group (this cannot be changed).
- [Priority section]
List of sections defined in the selected address group. You can choose a section to be debugged (priority
section) from this list.

Cautions 1.  Settings related to overlay sections are not saved in the project file.
After you have downloaded a load module, select the priority section again.
2. Only debugging information is switched when the selection for [Priority section] is changed.
The debug tool does not copy data of the target section.
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The following figure shows an example where "ram01" is selected as the priority section (left pane) and then changed
to "ram02" (right pane) for the [Overlay sections] property in the case shown in Figure 2-107. Allocation of Overlay
Sections.

Figure 2-110. Changing the Selection for [Priority section] from "ram01" to "ram02"

|jmain.c | :fmain.c [

|
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2.9 Execute Programs

This section describes how to execute programs.
The major operations discussed in this section can be conducted either from the debug toolbar or the [Debug] menu in
the Main window, where commands to control the execution of programs are included.

Caution Items in the debug toolbar and the [Debug] menu will be disabled once the connection with the
debug tool is lost.

Figure 2-111. Debug Toolbar

W'Y ®® B == gh

Figure 2-112. [Debug] Menu

Debug |

Jy  Download

ﬁ. Build & Download F&

21 Upload..

.|
E?fj Digconnect from Debug Tool Shift+F6
@

|:E.:| Gio F&
(2 Ienore break and go Fa
G= Step In F11
L= Step Over F10
2= Return Out Shift+F11
K5 GPU Reset Ctrl+Fh
¥y PRestart
291 Reset microcontroller (CPU)

To reset CPU, click the button on the debug toolbar.
When CPU is reset, the current PC value is set to the reset address.

Cautions 1.  [EZ Emulator]

In the event of an internal reset, the emulator cannot control the CPU. Do not allow any modules
(e.g. watchdog timer) to cause an internal reset.

2. [EZ Emulator]
Return from the deep software standby mode involves an internal reset. Thus, the emulator
cannot control the CPU in this state.

3. [EZ Emulator]
If the reset signal is input through the reset pin while the program is running, the program may
become uncontrollable. Although the emulator attempts to internally input a reset signal and
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resume execution of the program after it detects a reset input through the reset pin, this may
lead to a break in execution.

[E1] [E20] [EZ Emulator]

An error message "A timeout error. The MCU is in the reset state. The system was reset." is
displayed in cases of contention between a reset (e.g. input of a reset signal through the reset
pin, or reset of the CPU by the watchdog timer) and operations by the emulator system to the
microcontroller (e.g. memory reference in the Memory panel). The emulator is initialized and the
user program stops running. After the system is reset, trace records are initialized too. You can
continue with debugging.

If a reset input through the reset pin or an internal reset occurs under either of the following
conditions, refer to Table 2-5., showing the notes on the input of a reset signal through the reset
pin, or Table 2-6., showing the notes on internal resets. The points to note depend on the
operating mode of the microcontroller and communication interface of the emulator.

[Conditions]

- While the user program is being executed in on-chip ROM disabled extended mode or user
boot mode

- While the user program is being executed via FINE communication interface

Table 2-5. Notes When a Reset Signal has been Input through the Reset Pin

Groups Interface Operating mode Notes when a reset signal has been
input through the reset pin during user
program execution
RX610, RX621, RX62N JTAG On-chip ROM disabled extended | The reset is canceled by the emulator.
RX630, RX631, RX63N, RX63T | JTAG User boot Therefore, the reset timing here differs
On-chip ROM disabled extended from when the actual microcontroller is
operating singly.
RX630, RX631, RX63N, RX63T, | FINE Any mode
RX210, RX21A, RX220, RX111
RX210, RX21A, RX220, RX111 FINE User boot When a reset signal has been input
On-chip ROM disabled extended | through the reset pin during the
execution of the user system, the timer
measurement counter values and the
acquired trace data are initialized.

Table 2-6. Notes When an Internal Reset has

Occurred

Groups Interface Operating mode Notes when an internal reset has
occurred during user program execution

RX610, RX621, RX62N JTAG On-chip ROM disabled extended | Debugging can be performed after the

RX630, RX631, RX63N, RX63T reset is canceled and the
microcontroller operating mode is set to
the on-chip ROM disabled extended
mode in the user program.

RX630, RX631, RX63N, RX63T | JTAG User boot In the event of an internal reset, the
emulator cannot control the CPU.

RX630, RX631, RX63N, RX63T, | FINE Any mode
Do not allow any modules (e.g.

RX210, RX21A, RX220, RX111 ) ;
watchdog timer) to cause an internal
reset.
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Remark You can automatically overwrite the value of I/O register/CPU register with the specified values after CPU
reset (see "2.18 Setting Up the Hook Process" for details).

29.2 Execute programs

The following types of CubeSuite+ execution functions are provided.
Select any of the following operations according to the purpose of debugging.
See "2.10 Stop Programs (Break)" for details on how to stop the program in execution.

(1) Execute after resetting microcontroller (CPU)
(2) Execute from the current address
(3) Execute after changing PC value

Remarks 1.  You can automatically overwrite the value of I/O register/CPU register with the specified values before
executing the program (see "2.18 Setting Up the Hook Process" for details).
2. The PC value can be displayed in the status bar at any update interval during program execution. (See
"(e) Current PC position".)

(1) Execute after resetting microcontroller (CPU)
You can reset the CPU and start the execution of the program from the reset address.

Click the button on the debug toolbar.

When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.10.1 Stop the program manually").

- The PC has reached a breakpoint (see "2.10.2 Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.10.3 Stop the program at the arbitrary position (break event)
[E1][E20] [EZ Emulator]" and "2.10.4 Stop the program with the access to variables/I/O registers").

- Other break factors have occurred.

Remark This operation is the same as when the button is clicked after clicking the button.

(2) Execute from the current address
Perform any of the following operations to start executing the program from the address at the current PC value.

(a) Normal execution

Click the button on the debug toolbar.

When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.10.1 Stop the program manually").

- The PC has reached a breakpoint (see "2.10.2 Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.10.3 Stop the program at the arbitrary position (break
event) [E1] [E20] [EZ Emulator]" and "2.10.4 Stop the program with the access to variables/I/O
registers").

- Other break factors have occurred.

(b) Execution ignoring break-related events
Click the button on the debug toolbar.

When this operation is performed, the program continues executing until either of the following occurs:

- The button has been clicked (see "2.10.1 Stop the program manually").
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- Other break factors have occurred.

Remark If you have started the execution with this operation, the occurrence of Printf event will also be
ignored.

(c) Execution to the caret position
To start this operation, move the caret to the line/instruction at which you wish to stop the program in the Editor
panel/Disassemble panel, then select [Go to Here] from the context menu.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The PC has reached the address of the caret position.
- The button has been clicked (see "2.10.1 Stop the program manually").
- Other break factors have occurred.

Caution When the corresponding address of the line at the caret position does not exist, the
program is executed to the corresponding address of the lower valid line (if the
corresponding address does not exist, an error message will appear).

Remark If you have started the execution with this operation, the occurrence of Printf event will also be
ignored.

(3) Execute after changing PC value
The program is executed after you have forcibly changed the current PC value to an arbitrary position.
To start this operation, move the caret to the line/instruction at which you wish to start the program in the Editor
panel/Disassemble panel, then select [Set PC to Here] from the context menu (the current PC value is set to the
address of the line/instruction where the caret currently exists).
Then execute either one of the execution method described in "(2) Execute from the current address".

2.9.3 Execute programs in steps

When either of the following operation has occurred, the program will stop automatically after conducting step
execution in the source level (1 line of source text) or in the instruction level (1 instruction).

Once the program is stopped, the contents of each panel will be updated automatically. As such, step execution is
suited for debugging the program execution in transition either in source or instruction level.

The unit in which the program is step-executed is determined by the setting of the Editor panel as follows:

- When the button on the toolbar is invalid (default):
Step execution is conducted in source level.
Note, however, that when the focus is in the Disassemble panel or the line information does not exist in the
address specified by the current PC value, the step execution is conducted in instruction level.

- When the button on the toolbar is valid:

Step execution is conducted in instruction level.

Remark The button is only enabled if the mixed display mode is selected on the Editor panel (see " (1)
Changing the display mode").

Step execution is divided into the following types:

(1) Step into the function (Step In execution)
(2) Step over the function (Step Over execution)
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(3) Execute until return is completed (Return Out execution)

Cautions 1.  Break points, break events, and Printf events that have been set do not occur during step

(1)

(2)

(©)

294

execution.
2. [E1] [E20] [EZ Emulator]
Interrupts are not acknowledged during step execution.
[Simulator]
You may jump to a interrupt handler during step execution.

Step into the function (Step In execution)
When the function is called, the program is stopped at the top of the called function.
Click the button on the debug toolbar to perform Step in execution.

Cautions 1.  Step In execution cannot be performed for a function that has no debug information.
2. If Step in execution is performed for the longjmp function, program execution may not
complete and may wait for a time-out.

Step over the function (Step Over execution)

In the case of a function call by a jump to subroutine instruction, all the source lines/instructions in the function are
treated as one step and the program will be executed until reaching the position to which it returns from the
function (step execution will continue until the same nest is formed as when a jump to subroutine instruction has
been executed).

Click the button on the debug toolbar to perform Step over execution.

In the case of other than a jump to subroutine instruction, operation is the same as when the button is clicked.

Caution If Step over execution is performed for the longjmp function, execution processing may not
complete and may wait for a time-out.

Execute until return is completed (Return Out execution)

Step-execute the program so that the program will stop when it returns from the current function to the calling
function. When the execution of source line/instruction that require checking has been completed, you can perform
step execution using this instruction so that you can make the program return to the calling function without step
executing the remaining instructions inside the function.This instruction can be performed by clicking the
button on the debug toolbar.

Cautions 1.  If a program is returned out in the main function, it will break inside the start-up routine.
2. If a program is returned out in a function that has called the longjmp function, break may
not occur.
3. Executing Return Out from the recursive function may cause the program to run in a free-
run mode.
4. Executing Return Out from a function that uses a jump instruction (i.e. not an RTS (return
from subroutine) instruction) to return to the calling function is not possible.

Execute a specified routine [E1] [E20] [EZ Emulator]

You can execute a specified routine immediately before the start or stop of the program execution. Setting an arbitrary

routine allows you to control the target system in synchronization with the execution or stop of the program. See "2.10

Stop Programs (Break)" on how to stop a program in execution. This section describes the procedure for specifying a

routine to be executed.
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You can specify a routine in the [System] [E1] [E20] [EZ Emulator] category on the [Debug Tool Settings] tab in the
Property panel.

- When executing immediately before the program execution
Select [Yes] in the [Execute the specified routine immediately before execution of the user program] property, and
enter the start address in the [Routine to run immediately before execution starts] property that is displayed. The
specified routine will be executed immediately before the program execution.

- When executing immediately after the break
Select [Yes] in the [Execute the specified routine immediately after the user program stops] property, and enter the
start address in the [Routine to run immediately after execution stops] property that is displayed. The specified
routine will be executed immediately after the stop of the program.

If [Yes] is selected either for the [Execute the specified routine immediately before execution of the user program] or
[Execute the specified routine immediately after the user program stops] property, the [Work RAM start address for
executing a specified routine] property is displayed. The amount of memory indicated by the [Work RAM size [bytes] for
executing a specified routine] this property beginning with this address is to be used by the debugger firmware as a work
RAM area for the facility to execute a specified routine.

When you wish to use the facility to execute a specified routine, select this work RAM area.

Figure 2-113. [System] category

E System

Debug the program re-wniting the on-chip PROGRARM ROM Mo

Debug the program re-wniting the on-chip DATA FLASH Mo

Ewxecute the specified routing immediately before execution of the uzer program Yes

Routine ta run immediately before execution starts

Ewxecute the specified routing immediately after the uzer program stops Yes

Routing to run immediately after execution stops

Woork, RAk start address for executing a specified routine 1DD0
Cautions 1.  In the [Routine to run immediately before execution starts] property, [Routine to run

immediately after execution stops] property, and [Work RAM start address for executing a
specified routine] property, you can also specify function name (when using C language) or
label name (when using Assembly language) as property values.

2. Use an interrupt stack when using a stack inside the specified routine.

3. Describe an RTS (return from subroutine) instruction for terminating the specified routine
processing.

4. The processing time of one specified routine must not exceed 100ms. If a clock remains halted
in the specified routine, it may affect the control over the debug tool.

5. The register value for the start of the specified routine is not determined. As such, you need to
perform initial setting of the register value in the specified routine.

6. Immediately before execution or immediately after stop of the specified routine, execution
enters a stopped state under control of the debug tool. The stop period is determined as
follows.

- User program execution starts about 200 cycles (about 2 us when CPU clock is 100 MHz)
after the specified routine is executed before execution of the user program.

- Execution of the specified routine starts about 200 cycles (about 2 us when CPU clock is 100
MHz) after the stop of user program execution.
In on-chip ROM disabled extended mode, execution of the specified routine starts about 3
ms with a CPU clock of 100 MHz, or about 8 ms with a CPU clock of 32 kHz, after the stop of
user program execution. This also applies when the user program stops for the first time
after the hot plug-in connection is established.
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7. Execution of a specified routine starts in the supervisor mode. Do not switch it to the user
mode.

8. When executing a specified routine, do not perform memory access/download/break point
setting to the program area of the specified routine.

9. While the facility to execute a specified routine is in use, 230h (560) bytes of RAM starting from
[Work RAM start address for executing a specified routine] is reserved for exclusive use by the
emulator.

This area must not be used by the user program or routine.

Also be sure to allocate this area to the internal RAM area.

The value of [Work RAM start address for executing a specified routine] must be a multiple of
four.

10. Following restrictions will apply to the general registers and flags used in the specified routine.

ISP Register Once the specified routine is executed, the value should be

returned to the one at the start of the execution.

U Flag Setting the user stack pointer (USP) is prohibited while the

specified routine is in execution.

| Flag Interrupt is prohibited while the specified routine is in execution.

PM Flag Switching to the user mode is prohibited while the specified

routine is in execution.

11. While the specified routine is in execution, the trace, break, real-time RAM monitor and timer
measurement will be disabled.

12. Non-maskable interrupt is always prohibited while the specified routine is in execution.

13. When starting a program after executing the specified routine, the state of microcontroller will
be as follows

General Register Remains in the state at which the program stopped or reflects the

user setting. The contents of the register following the execution of
the specified routine are not reflected.

Memory Reflects the memory access made after the execution of the

specified routine.

Peripheral Functions The operation of microcontroller peripheral functions after the

execution of the specified routine continues.

14. If a stack is to be used in the specified routine, the ISP register must be set up in the routine.
When the specified routine is started, the value of the ISP register is that of [Work RAM start
address for executing a specified routine].

15. Once the execution of the specified routine is completed, the value of the ISP register must be
returned to the value at the start of the execution.

16. While the facility to execute a specified routine is in use, do not input a reset signal through the
reset pin or allow the watchdog timer to reset the CPU.

17. While the facility to execute a specified routine is in use, do not disable the internal RAM area.

18. While the specified routine is running, do not set the U flag to 1 (i.e. setting the user stack
pointer, or USP).

19. While the specified routine is running, do not use RTFI (return from fast interrupt) instructions.

20. Do not set breakpoints or cause break events, trace start events, or trace end events in the
specified routine.

If a break event occurs within the routine to run before execution of the user program, for

example, the program stops immediately after it has started running. If a trace start event

occurs within the routine, no trace data is acquired while the routine is running. Trace
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acquisition is not resumed until the user program starts running. The emulator will not behave
as expected.

21. While the facility to execute a specified routine is in use, if the Start function does not shift to
the user program, or the Stop function does not stop, an error message "A timeout error has
occurred in Start/Stop function processing. The system was reset." is displayed. The emulator
is initialized and the user program stops. After the system is reset, trace records are initialized
too. You can continue with debugging.
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2.10 Stop Programs (Break)

This section describes how to stop the program in execution.

Remark When the program in execution is stopped, a statement of the cause of the break appears on the Status bar
in the Main window.

2.10.1  Stop the program manually
The program in execution is forcibly stopped by clicking the button on the debug toolbar.

2.10.2 Stop the program at the arbitrary position (breakpoint)

The program in execution can be stopped at the arbitrary position by setting a breakpoint. A breakpoint can be set with
a single click of the mouse.

You need to configure the type of breakpoints to use before setting a breakpoint.

This section describes the following.

(1)

(2) Set a breakpoint

(3) Edit a hardware breakpoint
(4)

Set the type of breakpoints/break timing to use [E1] [E20] [EZ Emulator]

Delete a breakpoint

Caution [E1/E20/EZ Emulator [RX630, RX631, RX63N, RX63T, RX210 and RX111 Groups]]
If a break is generated by an execution-related break that is set to the WAIT instruction or an
instruction immediately preceding it, an error may occur. To cause the target program to break at
the WAIT instruction or an instruction immediately preceding it, use a breakpoint.

(1) Set the type of breakpoints/break timing to use [E1] [E20] [EZ Emulator]
The type of breakpoints/break timing to use can be set in the [Break] [E1] [E20] [EZ Emulator] category on the
[Debug Tool Settings] tab of the Property panel.

Figure 2-114. [Break] Category [E1] [E20] [EZ Emulator]

E Break

e of breakpoaints to be pref@ Hardware break

Specify the type of preferential breakpoint (breakpoint that can be set with a single click of the mouse) in the [Type

of breakpoints to be preferentially used] property.

Note, however, that if the number of the set breakpoints of the specified type exceeds the limit settable (see "(1)
Allowable number of valid events"), a breakpoint of another type will be used.

Select the breakpoint type from the drop-down list according to their functions.

Software break Temporarily replaces instruction code for the specified address with break instruction
and stops the program when this instruction is executed. Once set, it is handled as a
software break event.

Hardware break The debug tool consecutively checks the break condition while the program is in
execution and stops the program when the condition is met (default) ot Once set, it
is handled as a hardware break event.
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Notes 1. Hardware break is a "before execution" (, or pre-execution) break as the program will break before
executing instruction at the specified address. This function is implemented using the debug tool
resources.

2. Software break events cannot be set in external address spaces.

(2) Set a breakpoint
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembled text is
displayed.
In the main area of the Editor panel or the event area of the Disassemble panel, click on the location where you
want to set a breakpoint.
A breakpoint is set to the instruction at the start address corresponding to the clicked line.
When a breakpoint is set, the following event mark appears at the breakpoint location, and the source text line/
disassembled text line is highlighted.
It is interpreted as if a break event (software or hardware break event) has been set at the target address, and it is
managed in the Events panel (see "2.17 Event Management" for details).

Table 2-7. Event Marks of the Breakpoint

Event Type Event Mark
Software Break qﬂf?'
([E1] [E20] [EZ Emulator])
Hardware Break @

Figure 2-115. Breakpoint Setting Example (Disassemble Panel)

Event area
Indicates that a software . 7z child? ': :' ;
_ dn 0000032 |+6 gOff2e00
breakpoint has been set. 74- }
a00003fe |+a lel?
Indicates that a hardware " O00003fE |+ onos
. W 0000031 a |ke abfd
breakpoint has been set. 75 -

Cautions 1.  Since a breakpoint is set as a break event and managed as an event, restrictions apply to
the number of breakpoints that can be set. Also see "2.17.7 Points to note regarding event
setting” for details on breakpoint settings, including the allowable number of valid events.

2. Breakpoints cannot be set to lines with no address indication.

3. [E1] [E20] [EZ Emulator]
Software breakpoints replace the instructions at the corresponding addresses.They cannot
be specified in the area other than the internal ROM area and internal RAM area.

Remarks 1.  Event marks differ depending on the event state (see "2.17.1 Changing states of setting (Enabled/
Disabled)").
When an event is set at a point for which another event is already set, the event mark (,hﬁ') is
displayed to indicate that more than one event is set at the point.
2. [Simulator]
Only hardware breakpoints can be set.
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3. [E1] [E20] [EZ Emulator]
Hardware/software breakpoints can be set regardless of the specification made in "(1) Set the
type of breakpoints/break timing to use [E1] [E20] [EZ Emulator]" by the operation described

below.
Type Operation1 Operation2
Hardware breakpoint [Ctrl] + mouse click Select [Break Settings] >> [Set Hardware Break]
from the context menu.
Software breakpoint [Shift] + mouse click Select [Break Settings] >> [Set Software Break]
from the context menu.

Caution Operation 1 is enabled only in the Disassemble panel.

(3) Edit a hardware breakpoint
When editing a hardware break point you have set, first open the Events panel by selecting [View] menu >>
[Event]. After selecting the hardware break point you wish to edit on the Events panel, click [Edit Condition...] on
the context menu. This will open a dialog box in which you can edit the selected hardware break point. For details
on editing in the dialog box, see "(1) Editing execution-related events".

(4) Delete a breakpoint
Click event marks displayed in the Editor panel/Disassemble panel to delete breakpoints you have set (the event
mark will be erased).
You can also delete a break point on the Events panel which opens by selecting [View] menu >> [Event]. After
selecting the breakpoint you wish to delete on the Events panel, click () in the tool bar to delete it (see "2.17.5
Deleting events" for details).

2.10.3 Stop the program at the arbitrary position (break event) [E1] [E20] [EZ Emulator]

The program in execution can be stopped at the arbitrary position by setting a break event (execution-related). It is an
"after execution" (, or post-execution) break as the program will break after executing instruction at the specified address.
This function is implemented using the debug tool resources.

This section describes the following operations.

(1) Set a beak event (execution-related)
(2) Edit a break event (execution-related)
(3) Delete a break event (execution-related)

(1) Set a beak event (execution-related)
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembled text is
displayed.
After moving the caret to the target line, select [Break Settings] >> [Set Combination Break].
A break event (execution-related) is set to the instruction at the start address corresponding to the clicked line.
When a break event (execution-related) is set, the event mark identical to that of hardware breakpoint appears,
and the disassembled text line will be highlighted (see "(2) Set a breakpoint").
When you have performed this operation, it is interpreted as if a break event (execution-related) has been set at
the target address, and it is managed in the Events panel (see "2.17 Event Management" for details). It is
registered as "after execution" in the detailed information on the combination break in the Events panel.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 116 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

Caution When setting a break event (execution-related), also see "2.17.7 Points to note regarding event
setting” for details on execution-related break event settings, including the allowable number of
valid events.

Figure 2-116. Example of Setting a Break Event (Execution-related) on a Line in the Disassembled Text [E1] [E20]
[EZ Emulator]
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Figure 2-117. Example of a Break Event (Execution-related) in the Events Panel [E1] [E20] [EZ Emulator]
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(2) Edit a break event (execution-related)
When editing a break event (execution-related) you have set, first open the Events panel by selecting [View] menu
>> [Event]. After selecting the break event (execution-related) displayed in the detailed information on the
combination break in the Events panel, click [Edit Condition ...] on the context menu. This will open a dialog box in
which you can edit the selected break event. For details on editing in the dialog box, see "(1) Editing execution-
related events".
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(3) Delete a break event (execution-related)
When deleting a break event you have set, first open the Events panel by selecting [View] menu >> [Event]. After
selecting the break event (execution-related) displayed in the detailed information on the combination break in the

Events panel, click () button on the toolbar to delete it (see “2.17.5 Deleting events®).
Each break event (execution-related) can also be deleted by clicking on the event mark on the source or

disassembled text.

2.10.4 Stop the program with the access to variables/l/O registers

By setting a break event (access-related), it is possible to stop the program in execution when a specified access is

made to any variable or I/O register.
At this time, it is also possible to limit the values accessed.
The types of access specifiable in access-related events are as follows:

Table 2-8. Types of Accesses to Variables

Access Type Description

Read The program in execution is stopped when a specified variable or I/O register is accessed for read
(i.e., to read data from it).

Write The program in execution is stopped when a specified variable or 1/O register is accessed for write
(i.e., to write data to it).

Read/Write The program in execution is stopped when a specified variable or 1/O register is accessed for read or
write (i.e., to read or write data).

Cautions 1. The program is not stopped with the access via DMAC (Dynamic Memory Access Controller) /
DTC (Data Transfer Controller).

2. [Simulator]
With string manipulation instructions and multiply-and-accumulate instructions, the first and

final data accesses are subjected to the event check.

This section describes the following.

(1) Set a break event (access-related) to a variable/I/O register
(2) Edit a break event (access-related) to a variable/IO register
(3) Delete a break event (access-related) to a variable/IO register

(1) Set a break event (access-related) to a variable/l/O register
Use one of the following methods to set a break event (access-related) that stops programs with the access to a

variable/l/O register.

Cautions 1.  Also see "2.17.7 Points to note regarding event setting" for details on break event (access-
related) settings, including the allowable number of valid events.

2. [E1] [E20] [EZ Emulator]
Break events (access-related) are displayed as Read, Write, or Read/Write in the detailed

information on the combination break in the Events panel.

(a) Setabreak event (access-related) to a variable/l/O register in the source text/disassembled text
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembled text is

displayed.
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Follow the operation listed below from the context menu after selecting an arbitrary variable or 1/0 register in
the source text/disassembled text. Note, however, that only global variables, static variables inside functions,
and static variables inside files can be used.

By performing the following operation, it is interpreted as if a break event (access-related) has been set at the
target variable/l/O register, and it is managed in the Events panel (see "2.17 Event Management" for details).

Access Type Operation

Read [E1] [E20] [EZ Emulator]

Select [Break Settings] >> [Set Read Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Break Settings] >> [Set Read Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the reading. On the other hand, if no value is specified, reading the selected
variable by any value will cause the break to occur.

Write [E1] [E20] [EZ Emulator]

Select [Break Settings] >> [Set Write Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Break Settings] >> [Set Write Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the writing. On the other hand, if no value is specified, writing the selected
variable by any value will cause the break to occur.

Read/Write [E1] [E20] [EZ Emulator]

Select [Break Settings] >> [Set R/W Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Break Settings] >> [Set R/W Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the reading or writing. On the other hand, if no value is specified, reading or
writing the selected variable by any value will cause the break to occur.

Cautions 1.  Variables within the current scope can be specified.
2. Variables or I/O register at lines that have no valid addresses cannot be used for break
events.
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Figure 2-118. Example of Setting a Break Event (Access-related) on Variable in the Source Text [E1] [E20] [EZ
Emulator]

22

23

24

25

28

27 IIffE5L3

28

239

30

31

32 ffffE5f8

33 IIfTfB55d

34 IIZfE607

35 ffffesls

38 fiffeg2c

37 ffEfE63E

38 fiffes4c

39 IIZfEGED
0 IIffEs78

41 ffffe6s3

42

43

44

45

46

47

48 ffffE6el

49

50 IIITERIS

51

g im ) ¥l

Go ko Here

Set PC to Here
Jurnp ko Funckion F12
Tag Jump Shift+F12

Jump ko Disassemble

Advanced »

EBreak Settings 3 | % Set Hardware Break,

; k<gap; k++)1{
for{ i=ktgap; i<

for {j=i-

Trace Settings b |l Set Software Break

Timer Settings » f@ Set Combination Break,

1
gap = gap/2;
¥
g_CharBuf = (char)g_IntBuf & Ox00FE

@ﬂ Set Read Combination Break to
.:6 Set Write Combination Break to (]Dxb) |

=[1] = alJ+gspl; [T set R Combination Break to
al[ifgap] = t©:

@f Break Option

ennle

From the context menu above the variable "g_IntBuf",

select [Break Settings] >> [Set Write Combination
Break to]. Enter a value in the text box in the menu,
then press the [Enter] key.

Here, the program will break when the value "0Oxb" is

written to the variable "g_IntBuf".

Figure 2-119. Example of a Break Event (Access-related) in the Events Panel [E1] [E20] [EZ Emulator]
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Figure 2-120. Example of Setting a Break Event (Access-related) on a Variable in the Source Text [Simulator]
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Here, the program will break when the value "0xb"
is written to the variable "g_IntBuf".

Figure 2-121. Example of a Break Event (Access-related) in the Events Panel [Simulator]
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(b) Set a break event (access-related) to a registered watch-expression
You can set break events in the Watch panel.
Follow the operation listed below from the context menu after selecting the registered watch-expression
(multiple selections not allowed).
Note, however, that only global variables, static variables inside functions, static variables inside files, and 1/0
register can be used.
By performing the following operation, it is interpreted as if a break event (access-related) has been set at the
target watch-expression, and it is managed in the Events panel (see "2.17 Event Management" for details).
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Access Type Operation

Read [E1] [E20] [EZ Emulator]

Select [Access Break] >> [Set Read Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Access Break] >> [Set Read Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the reading. On the other hand, if no value is specified, reading the selected
watch-expression by any value will cause the break to occur.

Write [E1] [E20] [EZ Emulator]

Select [Access Break] >> [Set Write Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Access Break] >> [Set Write Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the writing. On the other hand, if no value is specified, writing the selected watch-
expression by any value will cause the break to occur.

Read/Write [E1] [E20] [EZ Emulator]

Select [Access Break] >> [Set R/W Combination Break to], and then press the [Enter] key.
[Simulator]

Select [Access Break] >> [Set R/W Break to], and then press the [Enter] key.

If you have specified a value in the text box in the menu, a break will occur only when the specified
value is used for the reading or writing. On the other hand, if no value is specified, reading or
writing the selected watch-expression by any value will cause the break to occur.

Remark A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a specified
scope.

Figure 2-122. Example of Setting a Break Event (Access-related) on a Watch-expression [E1] [E20] [EZ Emulator]
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[Z] Refresh "g_IntBuf", select [Access Break] >> [Set Write

= Combination Break to]. Enter a value in the text box in
%j Force Read Yalue

the menu, then press the [Enter] key.

Here, the program will break when the value "0xb" is

written to the watch-expression "g_IntBuf".
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Figure 2-123. Example of Setting a Break Event (Access-related) on a Watch-expression [Simulator]

Walch (%)
Z | @ | % ] X | Notation~
Wartch Valus Type(Byte Size) Address | Memo

L]

............................... /WI @l sotreadBreskto
Trace OutN[@ St Write Break tn< fsch > |

Periodic Updating  » \% to

[E] Refresh From the context menu above the watch-

gj Force Read Value expression "g_IntBuf", select [Access Break] >>
EEEEEEEE—— . .
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in the menu, then press the [Enter] key.
Here, the program will break when the value "0xb"

is written to the watch-expression "g_IntBuf".

(2) Edit a break event (access-related) to a variable/lO register
When editing a break event (access-related) you have set, first open the Events panel by selecting [View] menu >>
[Event]. After selecting the break event (access-related) you wish to edit on the Events panel, click [Edit Condition
... on the context menu. This will open a dialog box in which you can edit the selected break event. For details on
editing in the dialog box, see "(2) Editing access-related events".

(3) Delete a break event (access-related) to a variable/lIO register
When deleting a break event (access-related) you have set, first open the Events panel by selecting [View] menu
>> [Event], and then perform the following operations. Note that event name differs depending on the debug tool to
use.

(a) [E1] [E20] [EZ Emulator]
After selecting the break event (access-related) you wish to delete in the detailed information on the
combination break, click () button on the toolbar in the above panel (see “2.17.5 Deleting events®).
Each break event (access-related) can also be deleted by clicking on the event mark on the disassembled text.

(b) [Simulator]
After selecting the hardware break (access-related) you wish to delete, click () button on the toolbar in the
above panel (see “2.17.5 Deleting events®).

2.10.5 Set multiple break events in combination (Combination break) [E1] [E20] [EZ Emulator]

By setting more than one break event (execution-related and/or access-related) in combination, you can stop the
program when the combination condition is satisfied by the set break event.

Only one combination break can be set. Therefore, when two or more break events have been set, break event will be
added consecutively to the detailed information of one combination break in the Events panel. Combination conditions
listed below can be specified for the combination break.
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Table 2-9. Combination conditions for the combination break

Combination Description
conditions
OR Break will occur when any one of the break event conditions is satisfied.
AND Break will occur when all the break event conditions are satisfied irrespective of the time line.
Sequential Break will occur when the break event conditions are satisfied in the specified sequence.

Only one break event in the combination breaks can be registered as a reset event (R event).
When the registered break event is encountered, all the other break event conditions which have
been holding until then will be cleared.

When editing a combination break, select the combination break in the Events panel and click [Edit Condition ...] in the
context menu. This will open a dialog box in which you can edit the combination break. For details on editing in the dialog
box, see "(3) Editing combination conditions of events [E1] [E20] [EZ Emulator]".

Cautions 1.

settings, including the allowable number of valid events.
2.  When the combination condition is "Sequential”, break event (access-related) can be specified

for the 1st to the 3rd position.

Also see "2.17.7 Points to note regarding event setting" for details on combination break

3.  When the combination condition is "Sequential”, break event (access-related) for which an

address area condition has been se

t can be specified only for the 1st position.

Figure 2-124. Example of the Combination Break (Sequential) in the Events Panel [E1] [E20] [EZ Emulator]
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2.10.6 Other break factors

Other than the causes described above, a program can be stopped by the following break factors.

You can check such break factors on the Status bar in

the Main window.

Table 2-10. Other break factors
Debug Tool to Use
Break factors E1(Serial)/E1(JTAG)/ Simulator
E20(Serial)/)E20(JTAG)
EZ Emulator
Trace memory fuliNote 1 < e
Temporary break occurred e vy
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Debug Tool to Use

Break factors E1(Serial)/E1(JTAG)/ Simulator
E20(Serial)/E20(JTAG)
EZ Emulator

Execution failed or cause unknown v -
WAIT Instruction executed - v Note 3
Undefined instruction exception encountered - v Note 3
Privileged instruction exception encountered - v Note 3
Access exception encountered - v Note 3
Floating-point exception encounteredNote 2 - - Note 3
Interrupt encountered - v Note 3
INT instruction exception encountered - v Note 3
BRK instruction exception encountered - v Note 3
Peripheral function simulation error occurred - v
lllegal memory access made - v Note 3
Stream 1/O error occurred - ¥
Allocation of coverage memory failed - v
Allocation of trace memory failed - e

Notes 1.

The operation depends on the setting of the [Operation after trace memory is full] property in the [Trace]

category on the [Debug Tool Settings] tab of the Property panel.

[Simulator]
Applicable only to the RX600 Series.
[Simulator]

The operation depends on the settings of each property in the [Execution Mode] [Simulator] category on the

[Debug Tool Settings] tab of the Property panel.
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211 Displaying and Changing Memory, Registers, and Variables

This section describes how to display or change the contents of memory, registers, and variables.

2111 Displaying and changing memory contents

Use the Memory panel shown below to display memory contents or change values.

Choose [Memory] from the [View] menu and then [Memory1 - 4].

Up to four pieces of Memory panels can be opened at a time. Each panel is discriminated by the name "Memory1,"
"Memory2," "Memory 3," and "Memory 4" in the title bar.

For details on how to read each area and details about their functionality, see the section where the Memory panel is
described.

Figure 2-125. Displaying Memory Contents
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Remark In the Scroll Range Settings dialog box which opens by clicking on [View] >> button in the toolbar, you
can set the scroll range of the vertical scroll bar on this panel.

This section describes the following.

Specifying the display position

Changing the display form of values

Changing memory contents

Displaying and changing memory contents during program execution

P e e e
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Searching for memory contents
Collectively changing (initializing) memory contents
Saving displayed memory contents

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 126 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

(1) Specifying the display position
By specifying an address expression in the display position specification area, it is possible to specify the position
at which CubeSuite+ starts displaying memory values. (CubeSuite+ starts displaying, by default, from the address
“OXO,")

Remark An offset value of the display start position of memory values can be set via the Address Offset Settings
dialog box that is opened by selecting [Address Offset Value Settings...] from the context menu.

Figure 2-126. Display Position Specification Area (Memory Panel)

[] Move when Stop |

(a) Specifying an address expression

Directly enter in the text box an address expression that designates the address of the memory value you want
to be displayed. An input expression of up to 1,024 characters can be specified, the calculation result of which
is handled as the address for the display start position.

However, no address expressions can be specified that exceed the address space of the microcontroller.

Remarks 1. By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function")
2. If the specified address expression is the symbol and its size can be recognized, everything from
the start address to the end address of that symbol is displayed selected.

(b) Specifying whether the address expression is evaluated automatically or manually
The timing with which the display start position will be changed is determined by selection of the [Move when
Stop] checkbox and by the [Move] button.

[Move when The address expression is automatically evaluated after the program has halted and the
Stop] caret moves to the address derived from that calculation.

|:| The address expression is not automatically evaluated after the program has halted. In this
case, the address expression is evaluated by clicking the [Move] button.

[Move] If the [Move when Stop] checkbox is not checked, the address expression is evaluated by
clicking this button and the caret moves to the address derived from that calculation.

(2) Changing the display form of values
The forms in which data are displayed in the address area, memory value area and character string area can be
changed freely by using the toolbar buttons shown below.
However, these buttons are disabled during program execution.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 127 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

Notation Shows the following buttons that change the form in which memory values are displayed.

i

Displays memory values in hexadecimal (default).

Displays memory values in signed decimal.

Displays memory values in unsigned decimal.

Displays memory values in octal.

Displays memory values in binary.

Ba|EE

Size notation Shows the following buttons that change the form in which size of memory values are displayed.

[

Displays memory values in 4-bit width.

Displays memory values in 8-bit width (default).

Displays memory values in 16-bit width.

Values are converted depending on the endian of the target memory area.

[=]

Displays memory values in 32-bit width.

Values are converted depending on the endian of the target memory area.

Displays memory values in 64-bit width.

Values are converted depending on the endian of the target memory area.

Encode Shows the following buttons that change the encoding in which character strings are displayed.
‘ﬁ-‘-sc Displays character strings in ASCII code (default).
‘ESJIS! Displays character strings in Shift_JIS code.
‘[ELEJ Displays character strings in EUC-JP code.
‘[UTFJ Displays character strings in UTF-8 code.
[ Displays character strings in UTF-16 code.
‘ Fio| Displays character strings as a single-precision floating-point valueNote,
‘ DDI: Displays character strings as a double-precision floating-point value.
F__!EL: Displays character strings as a complex number of single-precision floating-point.
o} Displays character strings as a complex number of double-precision floating-point.
,F,Iﬁ']: Displays character strings as an imaginary number of single-precision floating-point.
',:',,Pu': Displays character strings as an imaginary number of double-precision floating-point.
View Shows the following buttons that change the display form.
Opens the Scroll Range Settings dialog box to set the scroll range.
Column Opens the Column Number Settings dialog box to set the number of view columns in the memory value
Number area.
Settings...
Address Opens the Address Offset Settings dialog box to set an offset value for addresses displayed in the
Offset Value | address area.
Settings...

Note For details on the display of a floating-point value, see the section for the Memory panel.
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(3) Changing memory contents
Memory values can be edited.
In the memory value area or character string area, move the caret to the target memory value and then edit it
directly from the keyboard.
When a memory value is edited, the altered portion is displayed in a different color. While in this state, press the
[Enter] key and the altered value will be written into the target memory. (Pressing the [Esc] key before you hit the
[Enter] key cancels editing.)
However, the character strings that can be entered when changing memory contents are limited to only those that
are handleable by the currently specified system of notation. Also, changes in the character string area are only
possible when character code in "ASCII" is specified.
You can edit memory values even when the program is in execution. For details, see "(4) Displaying and
changing memory contents during program execution".

In the case shown below, caution is required when editing the memory values.

Examples 1. When the maximum value of the displayed bit width is exceeded

If, while memory is displayed in decimal 8 bits, you edit the displayed value "105" by entering "3"
for "1," then the altered value becomes "127" which is the maximum value.

2. When "-"is entered in the middle of a numeric value
If, while memory is displayed in signed decimal 16 bits, you edit the displayed value "32768" by
entering "-" in the middle of it like "32-68," then numerals "3" and "2" change to spaces and the
altered value becomes "-68."

3. When a space character is entered in the middle of a numeric value
If, while memory is displayed in decimal 16 bits, you edit the displayed value "32767" by entering a
space in the middle of it like "32 67," then numerals "3" and "2" change to spaces and the altered
value becomes "67."

4. When the same value is entered
Even when you enter the same value as the current memory value, the specified value is written
into memory.

(4) Displaying and changing memory contents during program execution
The Memory panel and Watch panel come with a realtime display update function that permits you to update
display of, or even rewrite, the contents of memory or watch-expressions in real time.
By enabling this realtime display update function, it is possible to display or change the values of memory or watch-
expressions even while the program is running, not just when the program is halted.

Cautions 1.  [E20(JTAG)[RX600 Series]]
The trace function and the real-time RAM monitor function (RRM function) in part are usable
exclusively of each other. Therefore, before making the settings below, you must finish the
following settings on the [Debug Tool Settings] tab of the Property panel in order to specify
the function to be used preferentially.
- [Trace] category >> [Usage of trace function] properties >> [Realtime RAM Monitor]

2. [E20(JTAG)[RX600 Series]]

If a reset e.g. input of a reset signal through the reset pin, or reset of the CPU by the
watchdog timer) is issued while a user program is running, the results of the real-time RAM
monitor cannot be guaranteed (values displayed may be incorrect).

Remark The real-time display update function is materialized by the debug tool's RRM (real-time RAM monitor),
pseudo-RRM, and DMM (dynamic memory modification) functions.
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The pseudo-RRM function temporarily momentarily breaks program execution to perform reads/writes

by means of software emulation.

The subject area to and from which you can write and read using the realtime display update function varies

depending on how the debug tool you use and the Property panel are set.

Referring to the set contents of respective properties in the [Access Memory While Running] and [Trace]

categories on the [Debug Tool Settings] tab of the Property panel shown below, make settings in Table 2-11.

through Table 2-13. according to the purpose of use of the realtime display update function.

Mark

Properties in [Trace] Category

Setting Value

Note

A

Usage of trace function

[Real-time RAM monitor]

E20(JTAG) [RX600 Series]

Mark

Properties in [Access Memory While
Running] Category

Setting Value

Note

Access by stopping execution [E1] [E20]
[EZ Emulator]

[No] (default)

RRM/DMM functions enabled.

Enable the automatic update of realtime
display

[Yes] (default)

E20(JTAG) [RX600 Series]

Access by stopping execution [E1] [E20]
[EZ Emulator]

[Yes]

Pseudo RRM function enabled.

Update display during the execution

[Yes] (default)

Display update interval[ms]

[Integer number between

100 and 65500]

(a) For Read

Table 2-11. Subject Area of the Real-Time Display Update Function (Read by Pseudo-RRM Function)

Area E1(Serial)/E1(JTAG)/E20(Serial)/
E20(JTAG)/EZ Emulator

Setting Subject

Internal ROM C+D Entire range

Internal RAM

Data flash

Target memory

Emulation memory -

CPU register Not available

I/O register
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Table 2-12. Subject Area of the Real-Time Display Update Function (Read by RRM Function)

Area E20(JTAG) [RX600 Series] Simulator
Setting Subject Setting Subject
Internal ROM A+B+D Automatic setting | D Entire range
area NOte
Internal RAM
Data flash -
Target memory
Emulation memory - D Entire range
CPU register Not available -
I/0 register D Entire range

Note [E20(JTAG) [RX600 Series]]
The subject area of the RRM function is limited to a maximum of 4,096 bytes (4 areas each containing
maximum 1024 bytes).
Therefore, CubeSuite+ automatically determines the subject of realtime display updates within the
above limit according to the determination rules (order of priority) shown below. (Only the panel that is
displayed in front of others immediately before program execution becomes the subject.)
(1) Watch-expressions displayed on Watch panel are set in order from the top. (If multiple Watch panels
are open, they are set in increasing order of panel number.)
(2) Memory contents displayed on Memory panel are set in increasing order of address. (If multiple
Memory panel are open, they are set in increasing order of panel number.)
Note that if the subject area includes a read-prohibited area, display of that area is not updated.

(b) For write

Table 2-13. Subject Area of the Real-Time Display Update Function (Write by DMM Function)

Area E1(Serial)/E1(JTAG)/E20(Serial)/ Simulator
E20(JTAG)/EZ Emulator
Setting Subject Setting Subject
Internal ROM Not available D Entire range
Internal RAM C+D Entire range
Data flash Not available -
Target memory C+D Entire range
Emulation memory - D Entire range
CPU register Impossible -
I/O register D Entire range

Caution Local variables are not the subject of the real-time display update function.

Remark For details on how to rewrite values on Memory panel and Watch panel, see "(3) Changing memory
contents" and "(6) Changing the contents of watch-expressions".
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The memory values/watch-expressions updated by the pseudo-RRM function are highlighted in pink on the
Memory panel, whereas those updated by the RRM function are highlighted as follows in accordance with the
access status.

(The font and background colors depend on the configuration in the [General - Font and Color] category of the
Option dialog box.

Access Condition Display Example
Read or fetch 00 00 00 00
Write 00 00 00 0O
Read and Write 00 00 00 OO0
Lostm

Note The watch-expression value will be displayed as "?" in the event of "Lost" on the Watch panel.

Figure 2-127. Example of Memory Display by the Pseudo-RRM Function (Memory Panel) [E1] [E20] [EZ Emulator]

[Z] @ MNotation- Sige Notation ~ Encoding - \

[] Mave when Stop | | Move
14T 42 43 44+ 6 7 43 0 4a b 4o +d +e Hf e
aooooosan | 3o 01 38 01|F0 00 F8 oojoo 01 08 011001 28 oo [ 7. ==
Qoooooan ) 0o o0 D8 00 ED OO0 ES 00)AD 00 A3 00)EO 00 BS 00 LR L L LML
aoooooen | Cooo0 F8 00|80 00 88 00040 00 98 00CC 01 QoM I I B Y S Y
aoooooco) 04 01 08 01)0C 01 B3 01|BC 01 CO 01)C4 01 C3 M LR L LML
aooooodo | A4 01 A3 01)AC 01 BO 01)B4 01 30 0194 01 38 M I I A R S Y
aoooooe | AC 01 A0 01)7C 01 80 0184 01 83 01)8C 01 62 M FI I R T P
aooooofo) BC 01 70 01|74 01 78 01|80 07 E1 YO|E0 07 44°M lop.tox et
aooooton) g2 o7 E1 FO|E0 07 44 0184 07 E1 YO|E0 07 44°M TR LT TR
aooooiin) 8e 07 E1 FO|E0 07 44 0188 07 E1 VO|E0 07 44°M EI =X U= I
noonoian) an o7 E1 30)E0 07 44 0182 07 E1 A0)E0 07 44°M T DGO DL

Figure 2-128. Example of Memory Display by the RRM Function (Memory Panel) [Simulator]

@ '@ Motation = Sige Motation = Encodine - \

[] Mowe when Stop | | Mowe

0 41 +2 43 44 +h 46 47 +3 43 4a +h 4o 4+d te Hf Y
aooooosan | 3o 01 38 01|F0 00 F8 oOojoo 01 08 011001 68 oo [ 7. =
Q000oooan) Do 00 D8 00 ED OO0 ES 00)AD 00 A3 00)EO 00 BS 00 T
aoooooen | Co 00 78 00|80 00 88 000480 00 98 00)CC 01 Do M I T B Y S Y
aoooooco) D4 01 D8 01|DC 01 B3 01|BC 01 CO M1)C4 01 C3 M IR
aoonooodo | A4 01 A3 01)AC 01 BO 01)B4 01 30 0194 01 38 M I A Y S Y
aoooooe | AC 01 A0 01)7C 01 80 0184 01 88 01)48C 01 B2 M FI I I R B
aooooofo) BC 01 70 01|74 01 78 01|80 07 E1 YO|E0 07 44 M I =2 ) Y I
aooooion) g2 o7 E1 FO|E0 07 44 0184 07 E1 YO|E0 07 44 M TR DL TR D
aooooiin) 86 07 E1 FO|E0 07 44 0188 07 E1 VO|E0 07 44 M EI =X L =Y L
noonoi2ng an o7 E1 300E0 07 44 0182 07 E1 A0)E0 07 44 M T DLTLI0TL DL
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Figure 2-129. Example of Memory Display by the RRM Function (Memory Panel) [E20 (JTAG) [RX600 Series]

IE @ Motation = | Sige Motaktion = | Encoding « © Wiew T

[ Move when Stop | 0x1000 |

+0 +4 +3 +c P

ooooL1oo0 OEEDFz00 OEEDFZO01l(0OBEDFZ0E OBEDFEOZ R S i R B S
oooololo OBEEDFz04 OBEDFZO0L (OBEDFZ0& OBEDFEO7 R S i R B S
oooolozo OBEEDFz028 OBEDFZO0S (0DBEDFZ0A OBEDFEOE R S i R B S
ooooloz0 OBEDFz0C OBEDFZOD (OEEDFZ0E OBEDFEOF R S i R B S
00001040 OBEEDFz10 OEBEDFZ1l|(0OBEDFZlE OBEDFELZ R S i R B S
ooooloLn OBEDF:z14 OBEDFZ1EL (OEEDFZle OEEDFZLY (R S i
ooooloen OBEEDFz1S8 OBEDFZ1S (0OBEDFZli OBEDFELE R S i R B S
oooolozo OBEEDFz1C OEBEDFZ1D (OEEDF1lE OBEDFLLF R S i R B S
oooolosn OBEEDF1lz0 OEEDFl:zl|OBEDFlEZ OBEDFlEZ | 27177,

(5) Searching for memory contents

To search for memory values, use the Memory Search dialog box that is opened by selecting [Find---] from the
context menu. A search is conducted in the subject area, either the memory value or the character string area,
where the caret exists.

In this dialog box, follow the procedure below to search for memory contents.

Figure 2-130. Searching for Memory Contents (Memory Search Dialog Box)

Memory Search @
Search Data: | w |
Search Range: |Speu:ify address range w |
Address: | 00 v | - |Elefffffff v |

[ Cancel ] [ Help ]

Cautions 1.  Memory contents cannot be searched during program execution.
2. Character strings displayed as floating-point values cannot be searched.

(a) Specify the [Search Data]
Specify the data you want to search.
Directly enter it in the text box (specifiable in up to 256 bytes) or select an input history item from the drop-
down list (up to 10 history entries).
To perform a search in the memory value area, you need to enter data in the same display form (numeral
system and size) as that area.
Also, if you perform a search in the character string area, you need to specify a character string as the search
data. The specified character string, before being searched, is converted to data in appropriate encoding form
in which data are currently displayed in that area.
Note that if you select any memory value immediately before opening this dialog box, the value you've
selected is displayed by default.
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(b) Specifying the [Search Range]
Select the range in which to search from the drop-down list below.

Specify address range

A search is conducted within the address range specified by [Address].

Memory mapping

A search is conducted within the selected range of memory mapping.

This list item displays memory mappings individually (except non-mapped areas) that
are displayed in the Memory Mapping dialog box.

Display form: <memory type> <address range> <size>

(c) Specifying the [Address]
This item is valid only when you've selected [Specify Address Range] in "(b) Specifying the [Search Rangel]."

Specify the "start address - end address" to set the address range in which you want a memory value to be

searched. Directly enter address expressions in the respective text boxes (specifiable in up to 1,024

characters) or select an input history item from the drop-down list (up to 10 history entries).

The calculation results of the address expressions you've entered are respectively handled as the start

address and end address.
However, searchable addresses are limited to the upper-limit address of the program space (OxFFFFFFFF).

Also, no address values can be specified that are greater than the value representable in 32 bits.

(d)

Remarks 1.

present caret position (see "2.20.2 Symbol name completion function").

2. If the "start address" text box is blank, address "0x0" is assumed.

space is assumed.

Clicking the [Search Backward] and [Search Forward] buttons

the specified range and the searched spot shown on Memory panel is in a selected state.

(6) Collectively changing (initializing) memory contents
Memory values can be changed collectively (initialized).
Selecting [Fill...] from the context menu opens the Memory Initialize dialog box that permits you to change memory

values in a specified address range collectively.

In this dialog box, follow the procedure below to change memory values collectively.

Figure 2-131.

Memory Initialize

Start address/symbal: End addre=s/zymbal:
w [ - | Input the end addrezs or zv [m] v
Initialize data:

wex (nput the initial data in hexadecimal here. The two or more data  [r]|s

Cancel ] [ Help ]

By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the

If the "end address" text box is blank, the upper-limit address of the microcontroller's address

If you click the [Search Backward] button, a search is conducted in the direction toward smaller addresses
within the specified range and the searched spot shown on Memory panel is in a selected state.
If you click the [Search Forward] button, a search is conducted in the direction toward larger addresses within

Changing Memory Contents Collectively (Memory Initialize Dialog Box)

R20UT2350EJ0100
Mar 01, 2013

Rev.1.00 RENESAS

Page 134 of 506



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

(a) Specifying the [Start address/symbol] and [End address/symbol]
Specify the [Start address/ symbol] and [End address/ symbol] to set an address range in which you want
memory contents to be initialized. Directly enter address expressions in the respective text boxes (specifiable
in up to 1,024 characters) or select an input history item from the drop-down list (up to 10 history entries).
The calculation results of the address expressions you've entered are respectively handled as the start
address and end address.
No address values can be specified that are greater than the address space of the microcontroller.

Caution Note that an address range that covers areas with different endians cannot be specified.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").

(b) Specifying the [Initialize data]
Specify the initialization data to be written into memory.
Directly enter a hexadecimal value in the text box or select an input history item from the drop-down list (up to
10 history entries).
To specify multiple pieces of initialization data, specify a maximum of 16 pieces of up to 4 bytes (8 characters)
of data by separating each with a space.
Each piece of initialization data are interpreted as comprising 1 byte in units of 2 characters from the tail end of
the character string. If the data consists of an odd number of characters, the first character in it is assumed to
be comprising 1 byte.
Values consisting of 2 bytes or more will be converted to the arrays of bytes that match the endians in the
address range to be initialized before being written to the target memory.

Input Character String (Initialize data) Written-in image (in bytes)
Little endian Big endian
1 01 01
012 0012 0012
00 012 345 00 12 00 45 03 00 00 12 03 45
000 12 000345 00 00 12 45 03 00 00 00 12 00 03 45

(c) Clicking the [OK] button
Click the [OK] button.
A pattern of the specified initialization data is written into the specified address range of memory repeatedly. (If
the end address is reached in the middle of this pattern, the write process is terminated.)
However, if an invalid value or address expression is specified, CubeSuite+ displays a message and does not
initialize memory values.

(7) Saving displayed memory contents
It is possible to save a specified range of memory contents to a text file (*.txt) or a CSV file (*.csv).
When saving to a file, CubeSuite+ gets latest information from the debug tool and saves data in an appropriate
form in which data are currently displayed on this panel.
Choose [Save Memory Data As ...] from the [File] menu, and the Data Save dialog box shown below will be
opened. (At this time, if you perform this operation while a range is selected on panel, it is possible to save only the
selected range of memory data.)
In this dialog box, follow the procedure below to save memory contents.
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(a)

(b)

(c)

Figure 2-132. Saving Memory Data (Data Save Dialog Box)

Data Save — Memory Data 3]
File Mame: | Memoryl L [Z]
File Tvpe: | Text files( txt) w

Save Fanee Address/Svmbal:

000000000 w | — | 0x000000ef v

Save ]| Cancel |[ Help

Specifying the [File Name]

Specify a file name in which you want to save.

Directly enter it in the text box (specifiable in up to 259 characters) or select an input history item from the
drop-down list (up to 10 history entries).

Also, you can select a file from the Select Data Save File dialog box that is opened by clicking the [ ...] button.

Specifying the [File Type]
Select the type of file in which you want to save from the drop-down list below.
The selectable file types are as follows:

List display Format

Text files (*.txt) Text format (default)

CSV (comma-separated Variables) (*.csv) Csv formatNote

Note Each piece of data are separated with a comma (,) when saved.
To avoid the problem of an invalid file format in cases where any data includes a comma (,), each piece
of data are enclosed in double-quotes (" ") when they are output to a file.

Specifying the [Save Range Address/Symbol]

Specify the "start address" and "end addresses" to set a range of memory to be saved in a file.

Directly enter hexadecimal value or address expressions in the respective text boxes or select an input history
item from the drop-down list (up to 10 history entries).

Note that if a range is selected on panel, this selected range is specified, by default, in the text boxes. If no
range is selected, the currently displayed range on panel is specified.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").
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(d) Clicking the [Save] button
Memory data is saved in specified form to a specified file.

Figure 2-133. Memory Data Output Image When Saved

[Saved to Text File (*.txt)]
(Example for data displayed in hexadecimal, 8-bit width and ASCII code)

0 +1 +2 +3 +4 +5 +6 +7 +5 +9 +3 +h +C +d +2 +f
CUCDCENCNZC) Qo IC Coc Qg Qo Q0 00 000 00 00 00 00 00 Qg 00 0 |
pooooofop 1T MMttt T AT a1
0O000020) 22 22 22 22 22 22 22 22 22 22 22 20 202 22 22 22 | mmmmimmmimnnin
00000030) 333333333333 33333333 333333333333 |3333333333333333

[Saved to CSV File (*.csv)]
(Example for data displayed in hexadecimal, 8-bit width and ASCII code)

00000000,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,..0.........
00000010,41 14 41,49 41,4111 41 11 A1 41 14 41 41 11 21 .
0000002022 22,22 22,22 ,22 22 22 22 22 22 22 22 22 22 22 ™
00000030,33,33,33,33,33,33,33,33,33,33,33,33,33,33,33,33,3333333333333333

Remark If panel contents are saved over an existing file by selecting [Save Memory Data] on [File] menu, the

respective Memory panels (Memory1 - 4) are handled individually.

Also, as to the save range, the previously specified address range is applied when data is saved.
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2.11.2 Displaying and changing the CPU registers

Use the CPU Register panel below to display the contents of CPU registers (general and control registers) or change
the register values.

Choose [CPU Register] from the [View] menu.

For details on how to read each area and details about their functionality, see the section where the CPU Register
panel is described.

Figure 2-134. Displaying the CPU Register Contents (CPU Register Panel)

CPU Reqgister
Toolbar I @ Motation = Hﬁ,

Begister MName

[# ] Gemeral Degisters _

=i comtrol Begisters
E] 1=p Ox00001E38
E] usp Ox000016dS
] InTE Oxffffaltd

Elrec OxffffaEdd
FE] pew Dx00L30004
EleRC 0300000000
El epsw 0300000000
Bl rmTv 0300000000

[ I
[Register Name] area [Value] area

Following methods of operation are described here.

(1) Changing the form in which values are displayed
(2) Changing the CPU register contents
(3) Saving the displayed CPU register contents
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(1) Changing the form in which values are displayed

The form in which the data in the [Value] area is displayed can be freely changed using the toolbar buttons shown

below.

Notation

Shows the following buttons that change the form in which values are displayed.

Displays the value of a selected item (including low-order item) in predetermined notation (default).

Displays the value of a selected item (including low-order item) in hexadecimal.

Displays the value of a selected item (including low-order item) in signed decimal.

Displays the value of a selected item (including low-order item) in unsigned decimal.

Displays the value of a selected item (including low-order item) in octal.

Displays the value of the selected item (including sub-items) in binary.

0] =1 ) | ) )

Displays the character string of a selected item (including low-order item) in ASCII code.

If the subject consists of 2 bytes or more, characters consisting of 1 byte each are displayed one next to
another.

Displays the value of the selected item in Float.

Note that when the value is not 4-byte data, displays it in the default notation.

Displays a selected item in Double.

Except for 8-byte data, however, they are displayed in predetermined notation.

Adds a hexadecimal equivalent for the displayed value at the end of it, with the equivalent enclosed in
parentheses ( ).

(2) Changing the CPU register contents
The CPU register values can be edited.
Double-click the subject CPU register value in the [Value] area, and the selected value will be placed in edit mode.
(Pressing the [Esc] key cancels the edit mode.)

Edit the value directly from the keyboard and then press the [Enter] key. The value you've changed is written into
the debug tool's target memory.

Caution

This operation cannot be performed during program execution.

(3) Saving the displayed CPU register contents
By choosing [Save CPU Register Data As...] from the [File] menu, it is possible to open the Save As dialog box and
then save the contents of CPU registers in whole to a text file (*.txt) or a CSV file (*.csv).
When saving to a file, CubeSuite+ gets latest information from the debug tool.

Figure 2-135. CPU Register Value Output Image When Saved

Register name Value

Category name
-Register name Value
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2.11.3 Displaying and changing the I/O registers

Use the IOR panel shown below to display I/O register contents or change values.

Choose [IOR] from the [View] menu.

For details on how to read each area and details about their functionality, see the section where the IOR panel is
described.

Figure 2-136. Displaying the 1/0 Register Contents (IOR Panel)

Toolbar §f [Z] @ | ]| % MNotation= | Heg
Search area{ | i |

IO Valus Type(Byte S5ize) Address "_\
EADD.EDDRA Ox0000 IaR(E) O~ 000 £ 2
ﬁlADD.ﬁ.DDRB Ox0000 IOR(E) Ox000823042
ﬁlADD.ﬁ.DDRE Ox0000 IOR(E) Ox000823044
ﬁlADD.ﬁ.DDRD Ox0000 IOR(E) Ozx00082 048
ElADD.jLDESR Ox00 TOR{1) Ozx00082050
ﬁlADD.ﬁDESR.ADIE Ox0 IOR{1lbits) Ox00082050.&
ﬁlADD.ﬁDESR.ADST Ox0 IOR{1lbits) Ox000820E50_5
ﬁlADD.ﬁ.DESR.CH Ox0 IOR{(4bit=) Ox00082050.0
ﬁlADD.ﬁ.DER Ox00 TOR{1) Ox00082051
ElADD.ﬁ.DER. TRGE Ox0 IOR{3bits) Ox000820E51 5 et

Il I'1 I'l |
[IOR] |area [Value] area [Type (ByteISize)] area [Addresls] area

Following methods of operation are described here.

Searching 1/0O register

(1

(2) Putting the I/O registers in order

(3) Changing the form in which values are displayed

(4) Changing the contents of I/O registers

(5) Displaying and changing I/O register contents during program execution
(6) Saving the displayed I/O register contents

(1) Searching l/O register
You can search the name of I/O register.
In the search area, specify the name of I/O register (case-insensitive) in the text box.
You can either enter characters directly from the keyboard (up to 512 characters) or select from the input history
items in the drop-down list (up to 10 items).
Click one of the following buttons.

Searches /O register names containing the character string specified in the text box in the
backward direction and highlights the search result.

Searches /O register names containing the character string specified in the text box in the
forward direction and highlights the search result.

Remarks 1.  1/O register names which are categorized in folders and hidden are also searched (They will be
expanded and selected.).
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2. Atfter entering the search string, pressing [Enter] key will perform the same function as clicking on
the button, and pressing [Shift]+[Enter] will perform the same function as clicking on the

button.

(2) Putting the /O registers in order
The tree form of 1/O registers can be edited by classifying each register by a given category (folder).

Cautions 1.  No other categories can be created within a category.
2. Nol/O registers can be added or removed.

(a) To create a new category
Move the caret to an I/O register name you want to create and then click the toolbar button and enter a
new category name directly from the keyboard.

(b) To edit a category name
Select a category name you want to edit and then click on it again and edit the category name directly from the
keyboard.

(c) Toremove a category
Select a category you want to remove and then click the toolbar button However, only blank categories
can be removed.

(d) To change the order in which 1/O registers are displayed
Drag-and-drop an I/O register name into any category. That way, the I/O registers are classified by a category.
Also, the order in which categories and 1/O register names are displayed (one above or below another) can be
freely changed by a drag-and-drop operation.

(3) Changing the form in which values are displayed
The form in which the data in the [Value] area is displayed can be freely changed using the toolbar buttons shown below.

Notation Shows the following buttons that change the form in which values are displayed.

Displays the value of a selected item in hexadecimal (default).

Displays the value of a selected item in signed decimal.

Displays the value of a selected item in unsigned decimal.

Displays the value of a selected item in octal.

Displays the value of a selected item in binary.

Displays the value of a selected item in ASCII code.

Adds a hexadecimal equivalent for the displayed value of a selected item at the end of the value, with the
equivalent enclosed in parentheses ().

]
HaaiEIE

(4) Changing the contents of I/O registers
The 1/O register values can be edited.
In the [Value] area, click the selected I/O register value again to set it in the Edit mode (Pressing the [Esc] key
cancels the edit mode).
Edit the value directly from the keyboard and then press the [Enter] key. The value you've changed is written into
the debug tool's target memory.

Cautions 1.  This operation cannot be performed during program execution.
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2. The values of read-only I/O registers cannot be changed.

Remarks 1.  If a number with fewer digits than the size of the I/O register is entered, the higher-order digits will
be padded with zeroes.
2. If a number with more digits than the size of the 1/O register is entered, the higher-order digits will
be masked.
3. 1/O register values can also be entered using ASCII characters.
- When "0x41" is entered as the value of I/O register “CRC.CRCDOR”
>> "0x41" is written to "CRC.CRCDOR".
- When ASCII character "A™ is entered as the value of I/O register “CRC.CRCDOR*
>> "0x41" is written to "CRC.CRCDOR".

(5) Displaying and changing I/O register contents during program execution
Select an /O register that is the subject you want to display or change and register it as a watch-expression on
Watch panel. That way, you can display or change the value of any I/O register in real time even while the program
is running, not just when the program is halted.
For details about watch-expressions, see Section "2.11.6 Displaying and changing watch-expressions".

(6) Saving the displayed I/O register contents
By choosing [Save IOR Data As...] from the [File] menu, it is possible to open the Save As dialog box and then
save the contents of I/O registers in whole to a text file (*.txt) or a CSV file (*.csv) (Regardless of whether you've
chosen to show or not show on this panel, the values of all I/O registers are saved.).
When saving to a file, CubeSuite+ reloads /O register values and saves the latest values thus obtained.
However, the I/O registers protected against read are not reloaded. To save the latest content, select [Force Read
Value] from the context menu before saving to a file.

Figure 2-137. 1/0O Register Value Output Image When Saved

IOR name Value Type (Byte Size) Address
Category name
-IOR name Value Type (Byte Size) Address

2.11.4 Displaying and changing global and static variables
Use the Watch panel to display or change global variables or static variables.
Select a variable whose value you want to display or change and register it as a watch-expression on Watch panel.
For details about watch-expressions, see Section "2.11.6 Displaying and changing watch-expressions".

211.5 Displaying and changing local variables
Use the Local Variables panel shown below to display the contents of local variables and change values.
Choose [Local Variable] from the [View] menu.
To display the content of your desired local variable, select a scope in the scope area.
The Local Variables panel shows local variable names and function names. It also shows parameters to functions as

local variables.
For details on how to read each area and details about their functionality, see the section where the Local Variables

panel is described.

Caution During program execution, nothing is displayed on this panel.
The contents of each area on this panel are displayed at the time the program has stopped running.
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Figure 2-138. Displaying the Contents of Local Variables (Local Variables Panel)

LocalYanables
Toolbar { @ Matakion * H%‘ Encoding =

Scope area I Current

Talus Type (Byce Size)

Qxo000lefo lon o *id Ox00001lee0

Ox00001lees
Rl:EREG
Ox00001lede
R&: REG

[ I |
[Name] area [Value] area [Type (Byte Size)] area [Address] area

Following methods of operation are described here.

(1) Changing the form in which values are displayed
(2) Changing the contents of local variables
(3) Saving the displayed contents of local variables

(1) Changing the form in which values are displayed
The form in which the data in the [Value] area are displayed can be freely changed using the toolbar buttons shown

below.
Notation Shows the following buttons that change the form in which values are displayed.
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a Displays values on this panel in per-variable predetermined notation (default).

Displays values on this panel in hexadecimal.

Displays values on this panel in decimal.

Displays values on this panel in octal.

Displays values on this panel in binary.

12| =] 2] ) [0 =

Displays array indexes on this panel in decimal (default).

[Hex

Displays array indexes on this panel in hexadecimal.

1]
=]

Displays values on this panel in Float.

Except for 4-byte data or when values have type information, however, they are displayed in
predetermined notation.

Displays values on this panel in Double.

Except for 8-byte data or when values have type information, however, they are displayed in
predetermined notation.

Adds a hexadecimal equivalent for the displayed value at the end of it, with the equivalent enclosed in
parentheses ().
Encoding Shows the following buttons that change the encoding in which string variables are displayed.
Displays string variables in ASCII code (default).
Displays string variables in Shift_JIS code.
Displays string variables in EUC-JP code.
[fsj Displays string variables in UTF-8 code.
[”?sfl Displays string variables in UTF-16 code.

(2) Changing the contents of local variables
The values of local variables and parameter values can be edited.
Select the value of the subject local variable or the value of parameters to it in the [Value] area and click on it again.
The selected value is placed in edit mode. (Pressing the [Esc] key cancels the edit mode.)
Enter a value directly from the keyboard and then hit the [Enter] key. The value you've changed is written into the
debug tool's target memory. At this time, CubeSuite+ checks the value to see if it fits to type. If inappropriate, the
editing you've done is ignored.

Caution This operation cannot be performed during program execution.

Remarks 1.  If the numeral entered for a variable is smaller than the size of the variable, its high-order digits are
padded with zeroes.

2. If the numeral entered for a variable is larger than the size of the variable, its high-order digits are
masked.

3.  For character arrays (char type or unsigned char type), if ASCII is selected for the display form, it is
possible to use character strings (ASCII, Shift_JIS, EUC-JP, or Unicode (UTF-8/UTF-16) to enter
values.

4. Local variables can also be entered using ASCII characters.

-When using ASCII characters to enter values

Enter the letter "A™ in the [Value] area for the variable "ch".

>>The numeral "0x41" is written into the memory area to which the variable "ch" is mapped.
-When using numerals to enter values

Enter the numeral "0x41" in the [Value] area for the variable "ch".
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>> The numeral "0x41" is written into the memory area to which the variable "ch" is mapped.
-When using character strings (ASCII) to enter values

Set the display form of the character array "str" to ASCII and then enter the letters "ABC™

in the [Value] area.

>> The numerals "0x41," "0x42," "0x43" and "0x00" are written into the memory area

to which the array "str" is mapped.

(3) Saving the displayed contents of local variables
By choosing [Save Local Variables Data As...] from the [File] menu, it is possible to open the Save As dialog box
and then save the contents of local variables in whole to a text file (*.txt) or a CSV file (*.csv).
When saving to a file, CubeSuite+ gets latest information from the debug tool.
Note that if arrays, pointer-type variables, structures/unions, or CPU registers (only those that are assigned the
names to represent sections) are displayed in expanded form, the values of their expansion elements are also
saved. When not expanded, they are marked with "+" at the head, with the values left blank.

Figure 2-139. Local Variable Value Output Image When Saved

Scope : Current scope
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- [V]Variable name[0] Value Type Address

2.11.6 Displaying and changing watch-expressions

C variables, CPU registers, I/O registers, and assembler symbols can be registered as watch-expressions in the Watch
panel shown below. That way, it is possible to get their values from the debug tool at all times and, thereby, to keep watch
on values.

Also, the watch-expressions permit display of values to be updated successively, even while the program is under
execution (see section “(7) Displaying and changing the contents of watch-expressions during program execution").

The Watch panel is opened by choosing [Watch] from the [View] menu and then selecting [Watch 1-4].

Up to four pieces of Watch panels can be opened at a time. Each panel is discriminated by the name "Watch1,"
"Watch2," "Watch3," and "Watch4" in the title bar. The respective Watch panels have their watch-expressions registered
and managed individually and saved as user information for the project.

For details on how to read each area and details about their functionality, see the section where the Watch panel is
described.

Caution It is not possible to display or change the CPU register contents during program execution.
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Figure 2-140. Displaying the Contents of Watch-expression (Watch panel)
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Following methods of operation are described here.

Registering watch-expressions

(1)

(2) Putting the registered watch-expressions in order

(3) Editing the registered watch-expressions

(4) Removing watch-expressions

(5) Changing the form in which values are displayed

(6) Changing the contents of watch-expressions

(7) Displaying and changing the contents of watch-expressions during program execution
(8) Exporting/importing watch-expressions

(9) Saving the displayed contents of watch-expressions

(1) Registering watch-expressions
There are following three methods to register watch-expressions (By default, no watch-expressions are registered.).

Cautions 1.  Up to 128 watch-expressions can be registered in one Watch panel (If an attempt is made to
register beyond the upper limit, a message is displayed).

2. Because of optimization by a compiler, for blocks where variables, or the subject to be
operated on, are not in use, there may be no variable data in the stack and registers. In this
case, those unused variables, even when registered as watch-expressions, will have their
displayed values marked with "?".

Remarks 1.  The respective watch-expressions registered in each Watch panel (Watch1 through Watch4) are
managed individually and saved as user information for the project.
2. Plural watch-expressions with the same name can be registered.

(a) To register from other panels
Watch-expressions can be registered from other panels of CubeSuite+.
In one of other panels, select the subject you want to register as a watch-expression and drag-and-drop it
directly onto any Watch panel (Watch1 through Watch4).
Note that there is certain relationship between the panels that accept this operation and the subjects that can
be registered as watch-expressions. For details, see "Table A-4. Relationship between Panels and Subjects
Registrable as Watch-expressions".
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Figure 2-141. Example for Registering Watch-expressions from Other Panels
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Remark There is an alternative way to register watch-expressions. Select the subject you want to register
as a watch-expression, or move the caret to one of the subject character strings (the subject being
automatically determined), then select [Register to Watch1] from the context menu (However, this
method is usable for only the Watch panel (Watch1)).

(b) To register directly on the Watch panel
In any Watch panel (Watch1 through Watch4), click the toolbar button and the entry box shown below will
be displayed in the [Watch] area.

Figure 2-142. Entry Box for Watch-expressions
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Enter a watch-expression directly in this area.

Enter a watch-expression in the entry box directly from the keyboard and then hit the [Enter] key.
For the input forms of watch-expressions entered this way, see the tables listed below.

- "Table A-5. Watch-expression Input Form"

- "Table A-7. Handling of a C Variable when Registered in Watch by Specifying Scope"

- "Table A-8. Handling of a CPU Register when Registered in Watch by Specifying Scope"
- "Table A-9. Handling of an I/0 Register when Registered in Watch by Specifying Scope"

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").
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(2)

@)

(4)

(c) To register from other applications
Select a C variable, CPU register, I/O register, or assembler symbol character string from an external editor or
the like and then drag-and-drop it directly onto the Watch panel (Watch1 through Watch4).
In this case, the character string you've dropped is registered as a watch-expression directly as it is.

Putting the registered watch-expressions in order
The registered watch-expressions can be classified by a category (folder) for display in tree form (By default, there
are no categories.).

Cautions 1.  No other categories can be created within a category.
2. Up to 64 categories can be created in one Watch panel. (If an attempt is made to create
beyond the upper limit, a message is displayed.).

(a) To create a new category
Move the caret to the position at which you want to create and then click the toolbar button and enter a
new category name directly from the keyboard.

(b) To edit a category name
Select a category name you want to edit and then click on it again and edit the category name directly from the
keyboard.

(c) Toremove a category
Select a category you want to remove and then click the toolbar button .

(d) To change the order in which watch-expressions are displayed
Drag-and-drop a registered watch-expression directly onto the category you've created. That way, watch-
expressions are classified by a category.
Also, the order in which categories and watch-expressions are displayed (one above or below another) can be
freely changed by a drag-and-drop operation.

Remark [f categories or watch-expressions in a watch panel are drag-and-dropped into another Watch panel
(Watch1 to Watch4), the categories or watch-expressions are copied into the target Watch panel.

Editing the registered watch-expressions

The watch-expressions you've registered can be edited.

Double-click on a watch-expression you want to edit, and the subject watch-expression will be placed in edit mode.
(Pressing the [Esc] key cancels the edit mode.)

Edit the content directly from the keyboard and hit the [Enter] key.

Removing watch-expressions
To remove a registered watch-expression, select the watch-expression on Watch panel that you want to remove

and then click the toolbar button .
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(5) Changing the form in which values are displayed

The form in which the data in the [Value] area is displayed can be freely changed using the toolbar buttons shown

below.

Notation

Shows the following buttons that change the form in which values are displayed.

Displays the value of a selected watch-expression in per-variable predetermined notation (default) (see
"Table A-10. Display Form of Watch-expressions (Default)").

Displays the value of a selected item in hexadecimal.

Displays the value of a selected item in signed decimal.

Displays the value of a selected item in unsigned decimal.

Displays the value of a selected item in octal.

Displays the value of a selected item in binary.

Displays the value of a selected item in ASCII code.

1]
=]

(=) [0 =2 20 ) ) [

Displays a selected item in Float.

However, this is valid only when the selected watch-expression consists of 4-byte data.

Displays a selected item in Double.

However, this is valid only when the selected watch-expression consists of 8-byte data.

Adds a hexadecimal equivalent for the displayed value of a selected item at the end of the value, with the
equivalent enclosed in parentheses ().

However, this information is not added when values are displayed in hexadecimal.

(6) Changing the contents of watch-expressions

The values of watch-expressions can be edited.

Double-click the value of the watch-expression in the [Value] area that you want to edit, and the value you've

clicked is placed in edit mode. (Pressing the [Esc] key cancels the edit mode.)

Edit the value directly from the keyboard and then hit the [Enter] key. The value you've changed is written into the

debug tool's target memory.

However, only the watch-expressions that correspond one for one to C variables, CPU registers, 1/O registers, or

assembler symbols can have their values changed. Nor can the values of read-only I/O registers be changed.

This operation can be taken place while the program is in execution. See “(4) Displaying and changing memory

contents during program execution” for details on how to operate it.

Remarks 1.

If the numeral entered for a variable is smaller than the size of the variable, its high-order digits are
padded with zeroes.

If the numeral entered for a variable is larger than the size of the variable, its high-order digits are
masked.

For character arrays (char type or unsigned char type), if ASCII is selected for the display form, it is
possible to use character strings (ASCII, Shift_JIS, EUC-JP, or Unicode (FTF-8/UTF-16)) to enter
values.

Watch-expressions can also be entered using ASCII characters.
-When using ASCII characters to enter values

Enter the letter "A™ in the [Value] area of the variable "ch".

>> The numeral "0x41" is written into the memory area to which the variable "ch" is mapped.
-When using numerals to enter values

Enter the numeral "0x41" in the [Value] area of the variable "ch".

>> The numeral "0x41" is written into the memory area to which the variable "ch" is mapped.
-When using character strings (ASCII) to enter values
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(7)

®)

Set the display form of the character array "str" to ASCII and enter the letters "ABC"
in the [Value] area.

>> The numerals "0x41," "0x42," "0x43" and "0x00" are written into the memory area
to which the array "str" is mapped.

Displaying and changing the contents of watch-expressions during program execution

The Memory panel and Watch panel come with a realtime display update function that permits you to update
display of, or even rewrite, the contents of memory or watch-expressions in real time.

By enabling this realtime display update function, it is possible to display or change the values of memory or watch-
expressions even while the program is running, not just when the program is halted.

For details on how to set, see section “(4) Displaying and changing memory contents during program execution"

Exporting/importing watch-expressions

This feature allows you to export currently registered watch-expressions to a file and import it so that the watch-
expressions can be re-registered.

To do this, follow the procedure described below.

(a) Export watch-expressions
Save watch-expressions currently being registered (including categories) in a file format that is possible to
import.
While the focus is in the Watch panel, select [Save Watch Data As...] from the [File] menu.
On the Save As dialog box that is automatically opened, specify the following items, and then click the [Save]
button.
- [File name]: Specify the name of a file to be saved (the file extension must be "csv").
- [Save as type]: Select "Importable CSV (Comma-Separated Variables)(*.csv)".

Caution Neither values nor the type information of watch-expressions can be saved.
Items that are expanded after analyzing watch-expressions (i.e. an array, structure, and so

on) cannot be saved.

Figure 2-143. Export of Watch-Expressions
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(b) Import watch-expressions
Import the file that was exported in (a) to the Watch panel.
On the Watch panel to which you want to import watch-expressions, select [Import Watch Expression...] from
the context menu.
On the Open Watch Expression Data File dialog box that is automatically opened, specify the exported file,
and then click the [Open] button.

Remark If watch-expressions have been already registered, then imported watch-expressions will be
registered at the bottom of them.

Figure 2-144. Import of Watch-Expressions
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(9) Saving the displayed contents of watch-expressions
By choosing [Save Watch Data As...] from the [File] menu, it is possible to open the Save As dialog box and then
save the contents of watch-expressions and values in whole to a text file (*.txt) or a CSV file (*.csv).
When saving to a file, CubeSuite+ reloads the values of watch-expressions and saves the latest values thus
obtained.
Note that if arrays, pointer-type variables, structures/unions, or registers (only those that are assigned section
names) are displayed in expanded form, the values of their expansion elements are also saved. When not
expanded, they are marked with "+" at the head, with the values left blank.
However, the 1/O registers protected against read are not reloaded. To save the latest content, select [Force Read
Value] from the context menu before saving to a file.

Figure 2-145. Watch Data Output Image When Saved
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Remark If panel contents are saved over an existing file by selecting [Save Watch Data] on [File] menu, the
respective Watch panels (Watch1-4) are handled individually.
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212 Display Function Call Information from the Stack

This section describes how to display function-call information from the stack.

The compiler bundled with CubeSuite+ (CC-RX) places function-call information on the stack in line with the ANSI
standards. By analyzing this function-call information (hereafter referred to as call stack information), it is possible to
know the depth of function calls, the positions from which calls are made, and parameters to those functions.

2121 Display call stack information

Use the Call Stack panel shown below to display call stack information.

Select [Call Stack] from the [View] menu.
For details on the contents and function in each area, see the section for the Call Stack panel.

Caution This panel is left blank while the program is in execution.
The contents of each area on this panel are displayed at the time the program has stopped running.

Figure 2-146. Displaying the Call Stack Information (Call Stack Panel)
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This section describes the following.

(1) Changing the form in which values are displayed
(2) Jumping to the source line
3)
(4)

Displaying local variables
Saving the displayed contents of call stack information

(1) Changing the form in which values are displayed
The form in which values on this panel are displayed can be freely changed using the toolbar buttons shown below.

However, this feature is disabled during program execution.
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Notation Shows the following buttons that change the form in which values are displayed.

Displays values on this panel in per-variable predetermined notation (default).

Displays values on this panel in hexadecimal.

Displays values on this panel in decimal.

Q

=) 2| ) [0

Displays values on this panel in octal.

Displays values on this panel in binary.

Encoding Shows the following buttons that change the encoding in which string variables are displayed.

Displays string variables on this panel in ASCII code (default).

Displays string variables on this panel in Shift_JIS code.

= E &

Displays string variables on this panel in EUC-JP code.

[o8)

Displays string variables on this panel in UTF-8 code.

5]

Displays string variables on this panel in UTF-16 code.

(2) Jumping to the source line
Double-clicking on a line will open the Editor panel, with the caret moved to the source line from which the function
indicated by the selected line is called. (The view will jump to the Editor panel if it is already open.)

Remark Selecting [Jump to Disassemble] from the context menu will open the Disassemble panel
(Disassemble1), with the caret moved to the address from which the function indicated by the selected
line is called. (The view jumps to the Disassemble panel (Disassemble1) if it is already open.)

(3) Displaying local variables
Selecting [Jump to Local Variable at This Time] from the context menu will open the Local Variables panel which
displays local variables of the function indicated by the selected line.

(4) Saving the displayed contents of call stack information
Selecting [Save Call Stack Data As...] from the [File] menu will open the Save As dialog box in which you can save
the entire call stack information either in a text file (*.txt) or a CSV file (*.CSV) format. When saving to a file, the
latest information will be retrieved from the debug tool.

Figure 2-147. Call Stack Information Output Image When Saved

Depth Call stack
0 Call stack information
1 Call stack information

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 153 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

213 Collecting an Execution History

This section describes how to collect an execution history of the program.

Generally, a program's execution history is referred to as a "trace", the term of which is used in the pages below. If the
program goes wild, it is very difficult to find the cause of the problem from the memory contents or stack information after
the program has run out of control. However, analysis of the content of collected trace data makes it possible explore a
process of malfunction until the program starts running wild, providing an effective means for discovering potential bugs in
the program.

Cautions 1.  [E20(JTAG) [RX600 Series]]

Part of the trace functions and real-time RAM monitor functions (RRM functions) can be used
only on a mutually exclusive basis.

2. [E1] [E20] [EZ Emulator]
When you use a Printf event (an action event) and it occurs, the execution history up to that
point is cleared and the onward execution history is recorded.

3. [EZ Emulator [RX100, RX200 Series]]
If the reset signal is input through the reset pin, all trace data that has been acquired before the
reset is erased. Trace acquisition is resumed when the EZ Emulator restarts the execution of
the program.

4. [E1] [E20] [EZ Emulator]
If a reset (e.g. input of a reset signal through the reset pin, or reset of the CPU by the watchdog
timer) is issued while a user program is running, the correct recording of trace information both
before and after the reset will not be possible.

2131  Setting up a trace operation

When the trace function begins, trace data which has recorded in it an execution history of the currently executed
program is collected in trace memory (when program execution stops, the trace function also automatically stops).

Before the trace function can be used, it is necessary to make settings relating to the operation of a trace.

Note that the method on how to set differs with each debug tool used.

(1) For [E1]

(2) For[E20]
(3) For [EZ Emulator]
(4)

4) For [Simulator]

(1) For [E1]
Make settings in the [Trace] category on the Property panel's [Debug Tool Settings] tab.

Figure 2-148. [Trace] Category [E1]

B Trace
Operation after trace memary iz full Ovenwrite trace memony and continue execution
Trace data type Branch
Output timestamp Yes

Trace clock count zource[MHz]

(a) [Usage of trace function]
Only the trace function can be used.
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(b) [Operation after trace memory is full]
Specify the operation to be performed when the trace memory is filled with collected trace data, from the drop-
down list below.

Overwrite trace When the trace memory is filled, CubeSuite+ continues writing trace data over the old data
memory and (default).
continue execution

Stop trace When the trace memory is filled, CubeSuite+ stops writing trace data (but does not stop
program execution).

Stop When the trace memory is filled, CubeSuite+ stops writing trace data and stops program
execution at the same time.

(c) [Trace data type]
For this property, specify the type of trace data to be collected from the drop-down list below.

Branch Source/destination address information of branching during program execution are collected as
trace data.

Branch + Data Source/destination address information of branching during program execution, as well as data

accessNote 1 information on access events that occurred are collected as trace data.

Note 2

Data access Data information on access events that occurred during program execution are collected as trace

data.

Notes 1. [E1(Serial) [RX100, RX200 Series]]
Trace data for [Branch + Data access] cannot be collected. Therefore, this item is not displayed in
the drop-down list.
2. [E1(Serial) [RX100, RX200 Series]]
To collect trace data for [Data access], it is necessary to set address conditions in a point trace. For
details about the point trace, see "2.13.4 Collecting an execution history only when conditions are
met".

(d) [Output timestamp]
This property specifies whether timestamp information is added to the trace data to be collected. Specify [Yes]
when you want timestamp to be output.

Cautions 1.  [E1(Serial) [RX200 Series]]
If [Branch] is specified in the [Trace data type] property, timestamp cannot be output. If you
want it to be output, specify [Data access].
2. [E1[RX100 Series]]
This property is fixed to [No] because these microcontrollers do not support the output of
timestamp information.

(e) [Trace clock count source[MHZz]]
Enter a count source for the timestamp in the range 0.0001 to 999.999.
Note that if this property is blank, the set value of the [Operating frequency[MHZz]] in the [Timer] category is
used in place of the count source.

(2) For [E20]
Make settings in the [Trace] category on the Property panel’s [Debug Tool Settings] tab.
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Figure 2-149. [Trace] Category [E20]

B Trace
I1zaqe of trace function Trace
Operation after trace memary iz full Owenarite brace memary and continue execution
Trace data tupe Branch
Esternal trace autput CPU execution
Trace memary size[MByte] 1
Qutput timestamp Yes

Trace clock count zource[MHz]

(a) [Usage of trace function]
Part of the trace functions and real-time RAM monitor functions (RRM functions) can be used only on a
mutually exclusive basis. Therefore, in this property, specify which function you want to be used preferentially.
Here, select [Trace] from the drop-down list below.

Trace Uses the trace function preferentially (default).

- The real-time RAM monitor function cannot be used.

Real-time RAM Uses the real-time RAM monitor function (RRM) preferentially.

f Note 1 :
monitor - Trace function

Use subject to limitations Note 2

Also, trace-related events are disabled.

Notes 1. [E20(Serial)]
The real-time RAM monitor function is not supported. Therefore, do not specify [Real-time RAM
monitor] for this property value.
2. [E20(JTAG) [RX600 Series]]
Part of the trace function cannot be used.
Following limitations apply.

Operation after trace memory is full [Stop trace] and [Stop] cannot be used. Only [Overwrite
trace memory and continue execution] can be used.

Trace data type [Branch] and [Branch + Data access] cannot be used.

Only [Data access] can be used.

External trace output [Do not output] cannot be used.

[CPU execution] and [Trace output] can be used.

Trace memory size[MByte] Only 1M byte can be used.

(b) [Operation after trace memory is full]
Specify the operation to be performed when the trace memory is filled with collected trace data, from the drop-
down list below.

Overwrite trace When the trace memory is filled, CubeSuite+ continues writing trace data over the old data
memory and (default).
continue execution

Stop trace When the trace memory is filled, CubeSuite+ stops writing trace data (but does not stop
program execution).

Stop When the trace memory is filled, CubeSuite+ stops writing trace data and stops program
execution at the same time.
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(c) [Trace data type]
This property is displayed only when you've selected [Trace] for the [Usage of trace function] property.
Specify the type of trace data to be collected, from the drop-down list below.

Branch Source/destination address information of branching during program execution are collected as
trace data.

Branch + Data Source/destination address information of branching during program execution, as well as data

access™ote ! information on access events that occurred are collected as trace data.

Data accessN°® 2 | Data information on access events that occurred during program execution are collected as
trace data.

Notes 1. [E20(Serial) [RX100, RX200 Series]]
Trace data for [Branch + Data access] cannot be collected. Therefore, this item is not displayed in
the drop-down list.
2. [E20(Serial) [RX100, RX200 Series]]
To collect trace data for [Data access], it is necessary to set address conditions in a point trace. For
details about the point trace, see “2.13.4 Collecting an execution history only when conditions are

»

met”.

(d) [External trace output] [E20(JTAG)]
Specify the method on how the collected trace data should be output from the drop-down list below.

CPU execution CPU execution given priority over trace output.

Trace information may be lost if output.

Trace output Trace output given priority over CPU execution. CPU execution stops during trace output,
affecting real-time performance.

Do not output Only the internal buffer of the microcomputer will be used, with no output of trace information.

Caution If Step in is executed when [CPU execution] or [Trace output] is specified and trace data is
being displayed on the Trace panel, correct trace data may not always be displayed.

(e) [Trace memory size[MByte]] [E20(JTAG)]
Specify the size of memory used to retain trace data from the drop-down list below.
- 1 (default), 2, 4, 8, 16, 32

(f) [Output timestamp]
This property specifies whether timestamp information is added to the trace data to be collected. Specify [Yes]
when you want timestamp to be output.

Cautions 1.  [E20(Serial) [RX200 Series]]
If [Branch] is specified in the [Trace data type] property, timestamp cannot be output. If you
want it to be output, specify [Data access].
2. [E20 [RX100 Series]]
This property is fixed to [No] because these microcontrollers do not support the output of
timestamp information.

(g) [Trace clock count source[MHZz]]
Enter a count source for the timestamp in the range 0.0001 to 999.999.
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Note that if this property is blank, the set value of the [Operating frequency[MHZz]] in the [Timer] category is
used in place of the count source.

(3) For [EZ Emulator]
Make settings in the [Trace] category on the Property panel's [Debug Tool Settings] tab.

Figure 2-150. [Trace] Category [EZ Emulator]

E Trace

Qvenwrite trace memon and continue execution
Branch
Yes

Operation after trace memary iz full
Trace data type

Output timesztamp

Trace clock count zource[MHz]

(a) [Usage of trace function]
Only the trace function can be used.

(b) [Operation after trace memory is full]
Specify the operation to be performed when the trace memory is filled with collected trace data, from the drop-
down list below.

Overwrite trace
memory and
continue execution

When the trace memory is filled, CubeSuite+ continues writing trace data over the old data
(default).

Stop trace When the trace memory is filled, CubeSuite+ stops writing trace data (but does not stop
program execution).
Stop When the trace memory is filled, CubeSuite+ stops writing trace data and stops program

execution at the same time.

(c) [Trace data type]
For this property, specify the type of trace data to be collected from the drop-down list below.

Source/destination address information of branching during program execution are collected as
trace data.

Branch

Source/destination address information of branching during program execution, as well as data
information on access events that occurred are collected as trace data.

Branch + Data

accessNote 1

Note 2 | pata information on access events that occurred during program execution are collected as trace

data.

Data access

Notes 1. [RX100, RX200 Series]]
Trace data for [Branch + Data access] cannot be collected. Therefore, this item is not displayed in
the drop-down list.
2. [RX100, RX200 Series]]

To collect trace data for [Data access], it is necessary to set address conditions in a point trace. For
details about the point trace, see "2.13.4 Collecting an execution history only when conditions are

met".
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(d) [Output timestamp]
This property specifies whether timestamp information is added to the trace data to be collected. Specify [Yes]
when you want timestamp to be output.

Cautions 1.  [RX200 Series]]
If [Branch] is specified in the [Trace data type] property, timestamp cannot be output. If you
want it to be output, specify [Data access].
2. [RX100 Series]]
This property is fixed to [No] because these microcontrollers do not support the output of
timestamp information.

(e) [Trace clock count source[MHz]]
Enter a count source for the timestamp in the range 0.0001 to 999.999.
Note that if this property is blank, the set value of the [Operating frequency[MHz]] in the [Timer] category is
used in place of the count source.

(4) For [Simulator]
Make settings in the [Trace] category on the Property panel’s [Debug Tool Settings] tab.

Figure 2-151. [Trace] Category [Simulator]

E Trace
|1z trace function Mo
Clear trace memory before running Tez
Dperation after trace memory iz full Mon stop and ovenwrite to race memony
Accumulate trace time Mo
Trace memory sizefframes) B4k,

(a) [Use trace function]
Specify from the drop-down list whether or not to use the trace function.
To use the trace function, specify [Yes] (by default, [No] is selected).

(b) [Clear trace memory before running]
Specify from the drop-down list whether or not to clear (initialize) the trace memory once before the trace function
begins.
To clear, specify [Yes] (default).

Remark The trace memory can be forcibly cleared by clicking the button in the Trace panel toolbar.
(c) [Operation after trace memory is full]

Specify the operation to be performed when the trace memory is filled with collected trace data, from the drop-
down list below.

Non stop and overwrite to | When the trace memory is filled, CubeSuite+ continues writing trace data over the old
trace memory data (default).

If you've selected [Yes] for the [Clear trace memory before running] property, when the
program is re-executed, the trace memory is cleared before trace data is written to.

Stop When the trace memory is filled, CubeSuite+ stops writing trace data and stops program
execution at the same time.

If you've selected [No] for the [Clear trace memory before running] property, even when
re-executed, the program is halted and not executed.
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(d) [Accumulate trace time]
Specify from the drop-down list whether or not to use an accumulated display for trace time display.
Specify [Yes] to use an accumulated display for trace time display, or [No] to use a difference display (default).

(e) [Trace memory size[frames]]
Specify from the drop-down list the size of trace memory (number of trace frames).
Note that a trace frame is a unit for the trace data, and that fetch, write and read operations each use one trace
frame.
The drop-down list shows the number of trace frames as follows:
64K (default), 128K, 256K, 512K, 1M, 2M, 3M

2.13.2 Collecting an execution history up to a halt

The debug tool has a preinstalled function to collect an execution history of the program from when it starts running to
when it stops.

Thanks to this, when the program starts running, collection of trace data begins automatically, and it is finished at the
same time the program stops.

For details on how to check the collected trace data, see "2.13.6 Displaying an execution history".

Caution [Simulator]
With string manipulation instructions and multiply-and-accumulate instructions, only a history of
the first and final accesses is collected.

Remark This function is actuated by an unconditional trace event, one of the built-in events that are set in the debug
tool by default.
Note that this unconditional trace event and the trace event described later (see "2.13.3 Collecting an
execution history in a section" and “2.13.4 Collecting an execution history only when conditions are met")
are used exclusively of each other. Therefore, if the trace event is Enabled, the unconditional trace event is
automatically Disabled.
When no trace event has been set, trace data is collected even if the checkbox for the unconditional trace
event is deselected (i.e. Disabled).

213.3 Collecting an execution history in a section

By setting a trace event, it is possible to collect only a history of execution in a given section as trace data during
program execution process.

This trace event consists of a trace start event and a trace end event.

To use this function, follow the procedure described below.

(1) Setting a trace start event and a trace end event
(2) Combining multiple events [E1] [E20] [EZ Emulator]
(3) Executing the program

(4) Editing trace start and trace end events

(5) Deleting a trace start or trace end event

Cautions 1.  Also see "2.17.7 Points to note regarding event setting” for details on trace settings, including
the allowable number of valid events.
2. [Simulator]
With string manipulation instructions and multiply-and-accumulate instructions, only a history
of the first and final accesses is collected.
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(1) Setting a trace start event and a trace end event
On the Editor panel or Disassemble panel, set the events at which you want the collection of trace data to start and
finish.

(a) For execution-related events
By setting execution-related events for the trace start and trace end events, it is possible to start and finish the
collection of trace data at any place.
To set an execution-related event as the trace start event, move the caret to the line or address
you want the collection of trace data to start and then choose [Start Tracing] from [Trace Settings] on the
context menu.

Note 5t which

A trace start event is set for the instruction at the beginning address corresponding to the line or address at the
caret position.
Also, when you set an execution-related event as the trace end event, move the caret to the line or

addressNote

at which you want the collection of trace data to finish and then choose [Stop Tracing] from [Trace
Settings] on the context menu.
A trace end event is set for the instruction at the beginning address corresponding to the line or address at the

caret position.

Note Trace start and trace end events cannot be set on lines that have no addresses displayed.

When trace start and trace end events are set, the following event marks are displayed in the event area of the
relevant line or address.

Table 2-14. Trace Start Event and Trace End Event Marks (Execution-related Events)

Type Event mark
Trace start ;I?
Trace end ;I?

Figure 2-152. Example of Trace Start and Trace End Events Set by Using Execution-related Events
(For the Disassemble panel)

Event area
40: wold tutorial (void
/Indicates that a trace start ) ) E J
_tutorlal:
event is set as execution- -» |5 ffffssel Ge6d
related event ffffas5e3 T100ds
J 47 : p_Sam = &g Sample;
fEfff5566 fh7z204100000
(Indicates that a trace end 45: init (p sam) ;
i
event is set as execution- —» L frrfases Ef?ll
ffffetee O5&e70000
\Felated event ) 50: for| i=0; i<l10; i++

(b) For access-related events
By setting access-related events for the trace start and trace end events, it is possible to start and finish the
collection of trace data when a specified access is made to any variable or I/O register.
At this time, it is also possible to limit the values accessed.
The types of access specifiable in access-related events are as follows:
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Table 2-15. Types of Access for Variables

Access Type Description

Read Collection of trace data is started or finished when a specified variable or I/O register is
accessed for read (i.e., to read data from it).

Write Collection of trace data is started or finished when a specified variable or I/O register is
accessed for write (i.e., to write data to it).

Read/write Collection of trace data is started or finished when a specified variable or 1/O register is
accessed for read or write (i.e., to read or write data).

Remark Accesses by DMAC (Direct Memory Access Controller) and DTC (Data Transfer Controller) are not
supported.

- To set events for variables or I/O registers in source text or disassembled text
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembled text
is displayed.
Select any variable or I/O register in the source text or disassembled text and then select the desired
operation from the context menu as described below. However, the variables you can select are only
global variables, static variables inside a function, or static variables inside a file.
Note that when you have performed this operation, it is interrupted as if a trace event (access-related) has
been set for the selected variable or I/O register, and it is managed on the Events panel (see “2.17 Event

Management").

Access type Operation

Read/write [Trace start event]

Choose [Record Start R/W Value] from [Trace Settings] and then hit the [Enter] key.

[Trace end event]

Choose [Record End R/W Value] from [Trace Settings] and then hit the [Enter] key.

If a value is specified in the text box of the menu at this time, collection of trace data is started/
finished only when the specified value is used for the reading or writing. On the other hand, if
no value is specified, reading or writing the selected variable by any value will start/finish the
collection of trace data.

Cautions 1.  Only the variables in current scope are selectable.

2. Notrace event can be set for a variable or I/0 register on a line whose background color
in the event area is grayed (indicating that the line cannot be converted into a
corresponding address). To set this trace event, select a variable or I/O register on a
line whose background color in the event area is white.

3. The types of access that can be set from the source text or disassembled text are only a
read/write. To change the access type to a read or write, after setting trace start and end
events, edit them in a dialog box that opens from the Events panel (see “(4) Editing
trace start and trace end events").

- To set events for registered watch-expressions
Perform this operation on the Watch panel.
After selecting the watch-expression for which you want to set an event (multiple selections not accepted),
perform the following operation from the context menu. However, the watch-expressions you can select
are only global variables, static variables inside a function, static variables inside a file, and I/O registers.
Note that when you have performed this operation, it is interrupted as if a trace event (access-related) has
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been set for the selected watch-expression, and it is managed on the Events panel (see “2.17 Event

Management").

Access type Operation

Read/write

[Trace start event]

Choose [Record Start R/W Value] from [Trace Output] and then hit the [Enter] key.

[Trace end event]

Choose [Record End R/W Value] from [Trace Output] and then hit the [Enter] key.

If a value is specified in the text box of the menu at this time, collection of trace data is started/
finished only when the specified value is used for the reading or writing. On the other hand, if

no value is specified, reading or writing the selected watch-expression by any value will start/
finish the collection of trace data.

Cautions 1.  Only the watch-expressions in current scope are selectable.

To use any watch-expression outside the current scope for a trace event, select a
watch-expression that has its scope specified.

2. The access types that can be set from watch-expressions are only a read/write. To

change the access type to a read or write, after setting trace start and end events, edit
them in a dialog box that opens from the Events panel (see “(4) Editing trace start and
trace end events").

When a trace start event and trace end event are set, they are managed collectively on the Events panel as one

instance of a trace event. (When you click the "+" mark at a trace event item, detailed information on the trace start

and trace end events you've set is displayed.)

Cautions 1.

Remarks 1.

When both the trace start and trace end events have been set, trace data is collected every
time the start condition and end condition are met. However, only the trace data that were
acquired immediately before the program stopped are actually displayed in the Trace panel.
[E20(JTAG) [RX600 Series]]

Do not use the trace start and trace end events if you have enabled [Real-time RAM monitor]
in the [Usage of trace function] property under the [Trace] category. Also delete any events
using the Events panel that have been set.

If either one of the trace start and trace end events set is Enabled, the unconditional trace event
checkbox on the Events panel is automatically deselected, so that the trace data from the trace
start event to the trace end event is collected.

The trace start event may be left unset if it is unnecessary. If the trace start event is not set, trace
data collection starts when program execution starts. Likewise, if the trace end event is not set,
trace data collection ends when program execution stops.

The event mark varies with the set states of events (see “2.17.1 Changing states of setting
(Enabled/Disabled)").

Also, if a new event is set at a place where an event has already been set, the event mark rhﬂ@' is
displayed, indicating that multiple events have been set.

[Simulator]

If either one of the trace start and trace end events set is Enabled, the [Use trace function] property
in the [Trace] category on the Property panel’s [Debug Tool Settings] tab has its specification
automatically changed to [Yes], with the trace function enabled.
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(2) Combining multiple events [E1] [E20] [EZ Emulator]
If there are two or more events set for the trace start event, collection of trace data can be made to start when the
trace start event satisfies the following combination conditions.
Also, if there are two or more events set for the trace end event, collection of trace data is finished when the
condition for any one of trace end events is met.

Table 2-16. Combination Conditions for the Trace Start Event

Combination condition Description

OR Collection of trace data begins when any one of the trace start events
set occurs (i.e., its designated condition is met).

AND Collection of trace data begins when all of the trace start events set
occur, irrespective of time base.

Sequential Collection of trace data begins when the trace start events set occur in
a specified order.

Also, an event, but only one, of trace start events can be registered as
a reset event (R event). When a registered event occurs, the other
trace start events that have had occurred up to that point of time are
all cleared.

To edit a set trace event, choose [Event] from the [View] menu, select the trace event on the Events panel that is
opened, and then click [Edit Condition ...] on the context menu.

Do your editing in a dialog box that is opened by this operation.

For details on how to edit in a dialog box, see “(3) Editing combination conditions of events [E1] [E20] [EZ
Emulator]”.

Cautions 1. When the combination conditions are sequential, access-related events can be specified at
up to the third place in the sequence.
2.  When the combination conditions are sequential, access-related events that have had
address area conditions set can be specified at only the first place in the sequence.
3. The combination condition specifiable for a trace end condition is only OR.

(3) Executing the program
Execute the program (see "2.9 Execute Programs").
Collection of trace data is started or finished when the condition set for a trace start event or trace end event is met.
For details on how to check the collected trace data, see “2.13.6 Displaying an execution history".

(4) Editing trace start and trace end events
To edit a trace start or trace end event you've set, choose [Event] from the [View] menu, select the trace start or
trace end event (execution-related or access-related) displayed in the detailed information on the trace on the
Events panel that is opened, and then click [Edit Condition ...] on the context menu.
Edit the events in a dialog box that is opened by this operation.
For details on how to edit in an execution-related event dialog box, see “(1) Editing execution-related events".
Also, for details on how to edit in an access-related event dialog box, see “(2) Editing access-related events".

(5) Deleting a trace start or trace end event
To delete a trace start or trace end event you've set, right-click the event mark in the event area and select [Delete
Event] from the context menu that is displayed.
You can also delete a trace start or trace end event on the Events panel which opens by selecting [View] menu >>
[Event]. After selecting the trace start or trace end event (execution-related or access-related) displayed in the
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detailed information on the trace in the Events panel, click () button on the toolbar to delete it. (See “2.17.5
Deleting events”.)

Caution If either a trace start or trace end event is deleted from the event marks on the event area, all of

the corresponding event marks are deleted.

2.13.4 Collecting an execution history only when conditions are met

It is possible to collect an execution history of the program only when some conditions are met.

(1) When an access to a variable or I/O register occurred

In cases where a point trace event is set, when and only when a specified access is made to any variable or /0

register, information on that is collected as trace data.

Follow the procedure described below to set a point trace event.

Cautions 1.

Remarks 1.

Also see "2.17.7 Points to note regarding event setting” for details on trace settings,
including the allowable number of valid events.

[Simulator]

With string manipulation instructions and multiply-and-accumulate instructions, only the
first and final data accesses are subjected to the event check.

Accesses by DMAC (Direct Memory Access Controller) and DTC (Data Transfer Controller) are not
supported.

[Simulator]

If either one of the point trace events set is Enabled, the [Usage of trace function] property in the
[Trace] category on the Property panel's [Debug Tool Settings] tab has its specification
automatically changed to [Yes], with the trace function enabled.

When a point trace event and trace start and end events are specified together, the operation
differs depending on the debug tool used.
[E1] [E20] [EZ Emulator]

Only the data that matches the point trace event condition within the section between the specified
trace start and end events is collected as trace data.

[Simulator]

The execution history within the section between the specified trace start and end events and the
data that matches the point trace event condition regardless of the section between the specified
trace start and end events are collected as trace data.

(a) For access to a variable or 1/O register in the source text or disassembled text

Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembled text is

displayed.

Select the variable or I/O register as the subject to access and, according to the access type you specify,

perform the following operation from the context menu. However, the variables you can select are only global

variables, static variables inside a function, or static variables inside a file.

Note that when you have performed this operation, it is interrupted as if a point trace event has been set for the

selected variable or I/O register, and it is managed on the Events panel (see “2.17 Event Management").

Access Type Operation
Read/Write Select [Record Reading Value] from [Trace Settings].
Write Select [Record Writing Value] from [Trace Settings].
Read/write Select [Record R/W Value] from [Trace Settings].
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Remark Only the variables in current scope are selectable.

(b) For access to a registered watch-expression
Perform this operation on the Watch panel.
Select the watch-expression as the subject to access and perform the following operation from the context
menu. (See “2.11.6 Displaying and changing watch-expressions".)
However, the watch-expressions you can select are only global variables, static variables inside a function,
static variables inside a file, and 1/O registers.
Note that when you have performed this operation, it is interrupted as if a point trace event has been set for the
selected watch-expression, and it is managed on the Events panel (see "2.17 Event Management" for

details).

Access Type Operation
Read Select [Record Reading Value] from [Trace Output].
Write Select [Record Writing Value] from [Trace Output].
Read/write Select [Record R/W Value] from [Trace Output].

Remark Only the watch-expressions in current scope are selectable.
To use any watch-expression outside the current scope for a point trace event, select a watch-
expression that has its scope specified.

When you've finished setting a point trace event, execute the program (see "2.9 Execute Programs").

When the condition for the point trace event you've set is met during program execution, information on that is
collected as trace data. For details on how to check trace data, see "2.13.6 Displaying an execution history".
When editing a trace event (access-related) you have set as a point trace event, first open the Events panel by
selecting [View] menu >> [Event]. After selecting the trace event (access-related) displayed in the detailed
information on the point trace event, click [Edit Condition ...] on the context menu. (See “(2) Editing access-related
events”.)

When deleting a trace event (access-related) you have set as a point trace event, first open the Events panel by
selecting [View] menu >> [Event]. After selecting the trace event (access-related) you wish to delete in the detailed
information on the point trace event in the Events panel, click () button on the toolbar to delete it. (See “2.17
Event Management".)

2.13.5 Stopping/Restarting Collection of Execution History [E20] [Simulator]

It is possible to temporarily stop or restart the collection of execution history during program execution.

Cautions 1.  If the trace function is halted or restarted during program execution, realtime capability may be

impaired.

2. This facility cannot be used when a trace start or trace end event is set.

3. [E1] [E20 [RX200 Series]] [EZ Emulator]
The facility to stop or restart the trace function during program execution is not supported.

4. [E20(JTAG) [RX600 Series]]
If [Do not output] is selected in the [External trace output] property in the [Trace] category on
the Property panel's [Debug Tool Settings] tab, this facility cannot be used. To use it, select
[CPU execution] or [Trace output].

5. [E20(JTAG) [RX600 Series]]
If [Real-time RAM monitor] is selected in the [Usage of trace function] property in the [Trace]
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category on the Property panel's [Debug Tool Settings] tab, this facility cannot be used. To use
it, select [Trace].
6. This facility cannot be used when an action event is set.

(1) To temporarily stop collection of execution history
By selecting [Stop Trace] from the context menu on the Trace panel during program execution, it is possible to
temporarily stop collection of trace data.
Use this feature when you want to stop only the trace function without halting the program and check the trace data
that has been collected until you stop it.
(2) To restart collection of execution history
If you've halted the trace function during program execution, you can start collection of trace data again by
selecting [Start Trace] from the context menu on the Trace panel.
Note that the trace data on the Trace panel that has been collected before you restart is cleared once.

2.13.6 Displaying an execution history

To display the collected trace data, use the Trace panel shown below.

Choose [Trace] from the [View] menu.

The trace data is displayed, by default, in a disassembled text and source text mixed mode. By selecting the
appropriate Display mode, it is possible to display either of the two.

For details on how to read each area and about their functionality, see the section where the Trace panel is described.

Figure 2-153. Displaying Trace Data (Trace Panel)
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This section describes the following.

(1) Changing the display mode
(2) Changing the form in which values are displayed

@)

Getting linked to other panels
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(1) Changing the display mode

By clicking one of the toolbar buttons shown below, it is possible to change the display mode as suitable for the

purpose of use.

However, these buttons are disabled while the trace function is in operation.

Table 2-17. Trace Panel Display Modes

Button Display Mode Display Contents
Mixed display mode Instructions (disassemble), label names, source text (corresponding

source lines), and point trace results are displayed (default).

Disassemble display mode | Instructions (disassemble), label names, and point trace results are

displayed.

=

Source display mode

Source text (corresponding source lines) are displayed.

However, if any place that has no debug information is executed, a notice
"<No Debug Information>" is displayed.

Figure 2-154. Example of Source Display Mode (Trace Panel)
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(2) Changing the form in which values are displayed

The form in which values are displayed in the [Line Number/ Address], [Address], and [Data] areas can be freely

changed by using the toolbar buttons shown below.

However, these buttons are disabled during program execution.

Notation

Shows the following buttons that change the form in which values are displayed.

Displays values on this panel in hexadecimal (default).

Displays values on this panel in decimal.

(=]

Displays values on this panel in octal.

[=]] ]| )] =

Displays values on this panel in binary.
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(3) Getting linked to other panels
With the address of the currently selected line referenced as a pointer, it is possible to have the corresponding
place simultaneously displayed on other panels (the focus not moved).
Clicking the toolbar button m starts a linked display on the Editor panel
Clicking the toolbar button starts a linked display on the Disassemble panel.
Clicking the button again stops the linked display.

Remark When you select [Jump to Source] or [Jump to Disassemble] from the context menu, the Editor panel or
Disassemble panel opens, with the caret on it moved to the source line or address corresponding to the
address of the currently selected line (the focus moved).

213.7 Clearing the trace memory

To clear the content of the collected trace data, click the toolbar button .
However, this button is disabled while the trace function is in operation.

Remark [Simulator]
If you've selected [Yes] for the [Clear trace memory before running] property in the [Trace] category on the
Property panel's [Debug Tool Settings] tab, the trace memory is cleared each time the program is run.

2.13.8 Searching for trace data

To search for the collected trace data, use the Trace Search dialog box that is opened by clicking the toolbar button
. (Note that the searching function is disabled during program execution.)

In this dialog box, perform the following operation.

Note that by selecting the appropriate tab in this dialog box, you can choose to search for trace data at the instruction
level or search at the source level.

However, when you search for trace data at the instruction level, be sure that the Trace panel is displayed in the Mixed
display mode or Disassemble display mode.

Also, if you perform a search at the source level, be sure that the Trace panel is displayed in the Mixed display mode or
Source display mode.

Figure 2-155. Searching for Trace Data (Trace Search Dialog Box)

Trace Search @

Tab selection area _[ g'Tﬁ§{F[jEﬁé‘H"['é'{fé‘l"g| Source Level
Search condition
Fetch Address: | v| = | B |
Mnemonic: | w |
focess Address: | v| = | B |
fccess Status ¢ | |
Data: |HEH | = |HEH T |
Search range
MHumber: | w | = | vl
Seatch Backward ] ISearch Forward l [ Caticel ] [ Help
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This section describes the following.

(1)
2)

Searching at the instruction level
Searching at the source level

(1) Searching at the instruction level

Search for trace data at the instruction level.

After selecting the [Instruction Level] tab, follow the procedure below to perform a search.

(a)

(b)

Figure 2-156. Searching for Trace Data at Instruction Level
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Specifying the [Fetch Address]

Specify a fetch address, if needed as the search condition.

Enter an address expression directly in the text box or select an input history item from the drop-down list (up
to 10 history entries).

The fetch address can also be specified as a range of addresses. In this case, enter address values in both the
right and left text boxes to specify a range.

If the right-side text box is blank or labeled "(Input when range is specified)", the fixed address specified in the
left-side text box is used to perform a search.

Note that if any address value greater than the microcontroller's address space is specified, the high-order
address value is masked when a search is performed.

Also, no address values can be specified that are greater than the value representable by 32 bits.

Specify [Mnemonic]

Specify a character string of instruction, if needed as the search condition.

The character string specified here is searched from within the [Source/Disassemble] area of the Trace panel.
Enter an instruction directly in the text box or select an input history item from the drop-down list (up to 10
history entries).

Searches are case-insensitive, and partial matches are also allowed.
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(c)

(d)

(e)

Specifying the [Access Address]

Specify an access address, if needed as the search condition.

Enter an address value in hexadecimal directly in the text box or select an input history item from the drop-
down list (up to 10 history entries).

The access address can also be specified as a range of addresses. In this case, enter address values in both
the right and left text boxes to specify a range.

If the right-side text box is blank or labeled "(Input when range is specified)", the fixed address specified in the
left-side text box is used to perform a search.

Note that if any address value greater than the microcontroller's address space is specified, the high-order
address value is masked when a search is performed.

Also, no address values can be specified that are greater than the value representable by 32 bits.

Specifying the [Access Status]

This item is enabled only when [Access Address] is specified (see “Specifying the [Access Address]”).
Select the type of access (Read/Write, Read, Write, Vector Read and DMA) from the drop-down list.
If you do not limit the type of access, select "(No specification)".

Caution [E1] [E20] [EZ Emulator]
The types of access for which data can be collected on the Trace panel are only Read and
Write. Therefore, do not select Read/Write, Vector Read or DMA from the drop-down list.
[Simulator]
The types of access for which data can be collected on the Trace panel are only Read, Write,
and Vector Read. Therefore, do not select Read/Write or DMA from the drop-down list.

Specifying the [Data]

This item is enabled only when [Access Address] is specified (see “Specifying the [Access Address]”).
Specify an accessed numeric value.

Enter a hexadecimal value directly in the text box or select an input history item from the drop-down list (up to
10 history entries).

The numeric value can be specified as a range of values. In this case, enter data in both the right and left text
boxes to specify a range.

If the right-side text box is blank or labeled "(Input when range is specified)," the fixed numeric value specified
in the left-side text box is used to perform a search.

(f) Specifying the [Number]
Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "last number" are
specified.)
Enter a number in decimal notation directly in the text box or select an input history item from the drop-down
list (up to 10 history entries).
If the left-side text box is blank, the number "0" is assumed.
If the right-side text box is blank, the "last number" is assumed.

(g) Clicking the [Search Backward] or [Search Forward] button
When you click the [Search Backward] button, a search is performed in the direction toward smaller numbers,
with the searched spot put in selected state on the Trace panel.
When you click the [Search Forward] button, a search is performed in the direction toward larger numbers,
with the searched spot put in selected state on the Trace panel.
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(2) Searching at the source level
Search for trace data at the source level.
Select the [Source Level] tab.

Figure 2-157. Search for Trace Data at Source Level
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(a) To specify a source line before performing a search (default)
Select [The execution part is retrieved specifying the source line] in the [Search object] area, then perform the
following operation.

<1> Specifying the [Source and Line]
The character string specified here is searched from within the [Line/Address] area of the Trace panel.
Enter a character string included in the source line you want to search directly in the text box or select an
input history item from the drop-down list (up to 10 history entries).
Searches are case-insensitive, and partial matches are also allowed.

Examples 1. main.c#40
2. main.c
3. main

<2> Specifying the [Number]
Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "/ast
number" are specified.)
Enter a number in decimal notation directly in the text box or select an input history item from the drop-
down list (up to 10 history entries).
If the left-side text box is blank, the number "0" is assumed.
If the right-side text box is blank, the "last number" is assumed.
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<3>

Clicking the [Search Backward] or [Search Forward] button

When you click the [Search Backward] button, a search is performed in the direction toward smaller
numbers, with the searched spot put in selected state on the Trace panel.

When you click the [Search Forward] button, a search is performed in the direction toward larger
numbers, with the searched spot put in selected state on the Trace panel.

(b) To specify a function name before performing a search

(c)

Select [The execution part is retrieved specifying the function] in the [Search object] area, then perform the

following operation.

<1>

<2>

<3>

Specifying the [Function Name]

Enter a function name you want to search directly in the text box or select an input history item from the
drop-down list (up to 10 history entries).

Searches are case-sensitive, and only perfect matches are allowed.

Specifying the [Number]

Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "/ast
number" are specified.)

Enter a number in decimal notation directly in the text box or select an input history item from the drop-
down list (up to 10 history entries).

If the left-side text box is blank, the number "0" is assumed.

If the right-side text box is blank, the "last number" is assumed.

Clicking the [Search Backward] or [Search Forward] button

When you click the [Search Backward] button, a search is performed in the direction toward smaller
numbers, with the searched spot put in selected state on the Trace panel.

When you click the [Search Forward] button, a search is performed in the direction toward larger
numbers, with the searched spot put in selected state on the Trace panel.

To specify a global variable name before performing a search

Select [The execution part is retrieved specifying the global variable] in the [Search object] area, then perform

the following operation.

<1>

<2>

<3>

Specifying the [Variable Name]

Enter a variable name you want to search directly in the text box or select an input history item from the
drop-down list (up to 10 history entries).

Searches are case-sensitive, and only perfect matches are allowed.

Specifying the [Kind]
Select the type of access ([Reference/Substitution] (default), [Reference], or [Substitution]) from the
drop-down list.

Specifying the [Value]

Enter an accessed variable value directly in the text box or select an input history item from the drop-
down list (up to 10 history entries).

The variable value can be specified as a range of values. In this case, enter data in both the right and left
text boxes to specify a range.

If the right-side text box is blank, the fixed variable value specified in the left-side text box is used to
perform a search.
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<4> Specifying the [Number]
Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "/ast
number" are specified.)
Enter a number in decimal notation directly in the text box or select an input history item from the drop-
down list (up to 10 history entries).
If the left-side text box is blank, the number "0" is assumed.
If the right-side text box is blank, the "last number" is assumed.

<5> Clicking the [Search Backward] or [Search Forward] button
When you click the [Search Backward] button, a search is performed in the direction toward smaller
numbers, with the searched spot put in selected state on the Trace panel.
When you click the [Search Forward] button, a search is performed in the direction toward larger
numbers, with the searched spot put in selected state on the Trace panel.

2.13.9 Saving the displayed content of an execution history

The contents of collected trace data can be saved, after specifying a range of data, in a text file (*.txt) or CSV file (*.csv)
format. When saving to a file, the latest information will be retrieved from the debug tool, and saved according to the
display format on this panel.

Choose [Save Trace Data As...] from the [File] menu, and the Data Save dialog box shown below is opened.

In this dialog box, follow the procedure described below to save the data.

Figure 2-158. Saving an Execution History (Data Save Dialog Box)

Data Save — Trace Data (%)
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File Tvpe: | Text files®txt) w
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Save H Cancel ][ Help

(1) Specifying the [File Name]
Specify a file name in which you want to save.
Enter it directly in the text box (specifiable in up to 259 characters) or select an input history item from the drop-
down list (up to 10 history entries).
Also, you can select a file from the Select Data Save File dialog box that is opened by clicking the [...] button.

(2) Specifying the [File Type]
Select the type of file in which you want to save from the drop-down list below.
The selectable file types are as follows:

List display Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
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Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes (" ") in order to avoid illegal
formatting.

(3) Specifying the [Save Range Number]
Specify the "start trace number" and "end trace number" to set a range of data to be saved in a file.
Enter numeric values in decimal notation directly in the respective text boxes or select an input history item from
the drop-down list (up to 10 history entries).
If you want to save all trace data, select [All Trace Data] in the drop-down list on the left side (right-side text box
disabled).
Note that if a range is selected on panel, this selected range is specified, by default, in the text boxes. If no range is
selected, the currently displayed range on panel is specified.

(4) Clicking the [Save] button
Trace data is saved in the specified format to a specified file.

Figure 2-159. Trace Data Output Image When Saved

Number Time Line Number/Address Source/Disassemble Address Data
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2.14 Measuring the Execution Time

This section describes how to measure a program’s execution time.

Cautions 1.  [EZ Emulator [RX200 Series]]
If the reset signal is input through the reset pin, execution time that has been measured is
cleared when the EZ Emulator restarts the execution of the program.

2. [E1/E20/EZ Emulator [RX600 Series]]

The number of times interrupts or exceptions occur and the number of RTE or RTFI instructions
must be the same, so obtaining this balance is a precondition. If the number of times interrupts
or exceptions occur and the number of RTE or RTFI instructions are not the same, that is,
balance has not been obtained, correct measurement of the number of cycles for processing is
not possible. Also, data can only be retained for 16 levels of nesting. Therefore, if nesting of
interrupts or exceptions reaches the 17th level, correct measurement is not possible.

2141  Setting the timer measurement operation [E1] [E20] [EZ Emulator]

For timer measurements to be performed, it is necessary to make the following settings related to timer measurements.
Make the settings in the [Timer] [E1] [E20] [EZ Emulator] category on the Property panel’s [Debug Tool Settings] tab.
Note that properties in this category can only be changed while CubeSuite+ is disconnected from the debug tool.

Caution [RX100 Series]
This category is hidden because these microcontrollers do not support timers.

Figure 2-160. [Timer] Category [RX600 Series]

B Timer
Ilze B4bit counter Mo
Operating frequency[tMHz] 25.0000
Figure 2-161. [Timer] Category [RX200 Series]
B Timer
Operating frequency[MHz] 25.0000

(1) [Use 64bit counter] [RX600 Series]
Specify whether you want the measurement counter to be used in 32 bits x 2 or in 64 bits x 1.
When you select [Yes], a 64-bit measurement counter can be used, in which case, however, measurements can be
taken in only one section.

Caution [RX200 Series]
This property is not displayed because its measurement counter is 24 bits x 1 only.

(2) [Operating frequency[MHz]]
Specify the counter's operating frequency that is referenced when converting count values into time.
Enter a numeric value directly in the range 0.0001 to 999.999 (in MHz units) to specify it.
If no operating frequency is specified, count values are displayed.

Cautions 1.  The result of timer measurement event is calculated based on the operating frequency entered
in this property and count values. Therefore, using a program that switches operating
frequencies while the program is running will result in incorrect measurement result.
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2. Timer measurement proceeds even if the microcontroller is reset. However, the results may not
be correct because the clock settings for measurement have been initialized.

2.14.2 Measuring execution time from start to stop

The debug tool has a preinstalled function to measure a program's execution time from start to stop (Run-Break time).
Therefore, when a program starts running, its execution time is automatically measured.
The measurement result can be confirmed by one of the following methods.

(1) Checking the status bar for confirmation
(2) Checking the Events panel for confirmation

Cautions 1.  The measurement result of the Run-Break timer event includes the time between the start of the
measurement and the program execution as well as the time between the program break and
the measurement break. Note that this result is used only for a reference purpose as it contains
clock error of the measurement clock source.

2. The execution time displayed in the Status bar and the Events panel is the time measured while
the program is being executed. The execution time will be incorrect when Step In, Step Over or
Return Out is performed.

[E1] [E20]
Values smaller than 100 pus are discarded.
3. The EZ Emulator does not support the Run-Break timer function.

Remark This function is actuated by a Run-Break timer event, which is one of the built-in events set in the debug tool
by default.
The Run-Break timer event is always Enabled (settings not changeable).

(1) Checking the status bar for confirmation
When a program has stopped running, the measurement result is displayed in the status bar on the Main window

(While no measurements are made, this status shows "Not measured").

Remark When the EZ Emulator is in use, the status shown in the status bar is always "Not measured" because the
EZ Emulator does not support the Run-Break timer function.

Figure 2-162. Example of a Run-Break Timer Event Measurement Result (Status Bar)

(m)BREAK OeFFFFEE0C | maps EZEII{JTF'.G]I [S_u‘ﬁ

Measurement result displayed in this area

(2) Checking the Events panel for confirmation
When a program has stopped running, the measurement result is displayed as a Run-Break timer event on the
Events panel that is opened by selecting [Event] from the [View] menu.
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Figure 2-163. Example of a Run-Break Timer Event Measurement Result (Events Panel) [E1] [E20]

X ||| |l |5 &3 |59 5 & 8
M arme Dretail Comment

“2 Unconditional Trace :
=2 BunBreak Timer Total:1351300000 ns )

Figure 2-164. Example of a Run-Break Timer Event Measurement Result (Events Panel) [EZ Emulator]

X | |l | B3 | S| 5| 5 %5 OB

Mame Detail Comment
{v] =2 Unconditional Trace ;
( =2 RurBreak Timer Mot measured )

Figure 2-165. Example of a Run-Break Timer Event Measurement Result (Events Panel) [Simulator]

X | 0|6w[E&a]5] = 5 3

M arne Detail
{w| == Unconditional Trace -
( “2 Run-Break Timer Tokal: 103533660 ne Execution Cycle Count @ 10353355 Execution Instruction Count © BEFEI28 )

214.3 Measuring execution time in a section

By setting timer measurement events (timer start event and timer end event) it is possible to measure a program's
execution time in any section in its execution process.
To use this function, follow the procedure described below.

(1) Setting the timer start event and timer end event
(2) Execute the program
(3) Editing a timer measurement event [E1] [E20] [EZ Emulator]
(4) Editing timer start and timer end events
(5) Deleting a timer start event or timer end event
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Cautions 1.  Also see "2.17.7 Points to note regarding event setting" for details on timer measurement

event settings, including the allowable number of valid events.

2. [E1(Serial)/E20(Serial)/EZ Emulator [RX200 Series]]
The timestamp information on the Trace panel is realized using the timer measurement counter.
Therefore, if a timer measurement event is set on the Events panel, expected timestamp
information is not displayed.

3. [E1] [E20] [EZ Emulator]
When a timer start or end event is added or deleted or a timer measurement event is edited, the
result of the next measurement will not be accumulated.
[Simulator]
When a timer start or end event is added, deleted, or edited, the result of the next measurement
will not be accumulated.

(1) Setting the timer start event and timer end event
On the Editor panel, Disassemble panel or Watch panel, set the events at which you want a timer measurement to
start and end.

(a) How to set a timer start event

- To set from the Editor panel/Disassemble panel
Move the caret to the line or address Note 1
[Timer Settings] from the context menu and from it, choose [Start Timer] and then [Set Timer

A timer start event is set for the instruction at the beginning address corresponding to the line or address at the

at which you want a timer measurement to start and then select
+ Note 2]

caret position.
Move the caret to the variable at which you want a timer measurement to start and then select [Timer Settings]
from the context menu and from it, choose [Set Timer Start R/W Value] and then [Set Timer * Note 2].

A timer start event is set for the variable at the caret position.

To set from the Watch panel

Move the caret to the watch-expression Note 3

[Timer Settings] from the context menu and from it, choose [Set Timer Start R/W Value] and then [Set Timer *
Note 2
1.

at which you want a timer measurement to start and then select

A timer start event is set for the watch-expression on the Watch panel.

(b) How to set a timer end event

To set from the Editor panel/Disassemble panel

Note 1 5t which you want a timer measurement to finish and then select
» Note 2]

Move the caret to the line or address
[Timer Settings] from the context menu and from it, choose [Stop Timer] and then [Set Timer
A timer end event is set for the instruction at the beginning address corresponding to the line or address at the
caret position.

Move the caret to the variable at which you want a timer measurement to finish and then select [Timer
Settings] from the context menu and from it, choose [Set Timer End R/W Value] and then [Set Timer * Note 2].

A timer end event is set for the variable at the caret position.

To set from the Watch panel

Note 3

Move the caret to the watch-expression at which you want a timer measurement to finish and then

select [Timer Settings] from the context menu and from it, choose [Set Timer End R/W Value] and then [Set
Timer * Note 2}

A timer end event is set for the watch-expression on the Watch panel.

Notes 1. Timer start event/timer end event cannot be set to lines with no address indication.
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2. [E1] [E20] [EZ Emulator]
The asterisk (*) in the menu [Set Timer *] denotes a channel number as a number for a timer

measurement section.To set timer start and end events in one section, be sure to select the same

channel number.
Note that the selectable channel numbers vary with each microcontroller used and depend on how the
[Timer] [E1] [E20] [EZ Emulator] category on the Property panel’s [Debug Tool Settings] tab is set, as

shown below.

Microcontroller [Use 64bit counter] property Function
RX600 Series No Specifiable from 2 sections (32-bit), [Set Timer 1] and [Set Timer 2]
Yes Only 1 section (64-bit), [Set Timer 1], is specifiable
RX200 Series - Only 1 section (24-bit), [Set Timer 1], is specifiable
[Simulator]

Only one section is available and desired timer channels cannot be specified; the [Set Timer *] menu is

not displayed.
3. This watch-expression can only be a global variable, static variable inside a function, static variable

inside a file, and an 10 register.

Cautions 1.

[E1] [E20] [EZ Emulator]

Timer measurement is possible even if either a timer start or timer end event is set. When

only a timer start event is

set, measurement ends as soon as the program stops running.

When only a timer end event is set, measurement starts as soon as the program starts

running.
[Simulator]

Timer measurement works only when both timer start and end events are specified. If only
one of the start and end events is specified, execution time cannot be measured.

[Simulator]

Only a single event can be specified for each of timer start and end events. Multiple events
cannot be specified in combination.
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Figure 2-166. Example of Setting a Timer Start Event (Access-related) on a Variable in the Source Text [E1] [E20]
[EZ Emulator]

22
23
24
25
26
27 EfffE513
28
29
30
31
32 FIffesfs
33 Efffe5fd
34
35
38
37
38 LIffes64c
39 Ffffe6eh
40 EfffeeT8
41 ELffE693
42
43
44
45
48
47
48 ffffE6el
49
50 LIffeE6ls
51

L GotoHere
@ SetPCtoHere
¥ Jump to Function F1z
E' Tag Jump Shift+F12
leng t© ::'3 Jump to Disassemble
int i, 3, k, gap
Advanced 3
Break Settings 3
Trace Settings »
Timer Sekkings 3 | ,{_?) Start Timer 4
Incsuf F j; 3 stop Timer 4
TaNg. »ald+gapl) {
T = aldil; |,§:r) Sek Timer Skart R Yalue 3 Set Timer 1 q;ﬂxb) |
a {3 s [d+gap]: I Set Timer End Ry Yalue 3 Set Timer 2 Oxb
J+gap. = 7
£ View Result of Timer

}
gap = gap/2;
i
g_CharBuf = (char)g IntBuf & Cx00FF;

[Enter] key.

read from or written to the variable "g_IntBuf".

From the context menu above the variable "g_IntBuf", select
[Timer Settings] >>[Set Timer Start R/W Value]>>[Set Timer

1]. Enter a value in the text box in the menu, then press the

Here, the timer measurement will start when the value "Oxb" is

Figure 2-167. Example of Setting a Timer Start Event (Access-related) on a Variable in the Source Text

22
23
24
25
28
27 fEffE5E3
28
25
30
31
32 ffffesfs
33 ffffE5Ed
34 ffffesc?
35 ffffesls
36 ffffe6ze
37 ffffeess
38 ffffe64c
38 fiffedeb
40 ffffeevs
41 ffffeess
42
43
44
45
48
47
48 ffffegeld
48
50 ffffesfs
51

[Simu

long t©

¥

gap = gap/2:

}

lator]

Set PC to Here
Jurnp ko Funckion F1z

Tag Jump Shift+F12

Jurnp ko Disassemble

) ®k

Advanced 3

Break Settings 3

Trace Settings 3

| Timer Settings 3 | bL':r) Skart Timer

.

a
Ft

Clear Coverage Information 'Y Stap Timer

d
Bus e
(Eqifr,)- . |,§3 Set Timer Start Rjw Value ([oxb) |
IINEEIrald+gap]) s

a[J] = a[j+gapl;

. . ﬁ Wiew Result of Timer
2[i+gap] = t;

T = alil: I3 Set Timer End Rjw Yalue

g_CharBuf = (char]g_IntBuf & 0x00F|the [Enter] key.

From the context menu above the variable "g_IntBuf",
select [Timer Settings] >>[Set Timer Start R/W Value].

Enter a value in the text box in the menu, then press

Here, the timer measurement will start when the value

"Oxb" is read from or written to the variable "g_IntBuf".
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Figure 2-168. Example of Setting a Timer Start Event (Access-related) on a Watch-expression [E1] [E20] [EZ
Emulator]

@ @ H LI!I S | Motation -

Wat ch Talus Type(Byte Size) Address Memo

________ (E_: IntEuf 3 0 (0x00000000) PReekEh 0300001404
Access k »
Trace Cukput 3
| Timer Sektings g m,l?} Set Timer Stark B value 3 m Set Timer 1 ||0xb
Periodic Updating ¥ | [ Set Timer End Rfw value  » SetTimer 2 Oxb

Refresh

Force Read Yalue

2 o

From the context menu above the watch-expression "g_IntBuf", select
[Timer Settings] >> [Set Timer Start R/W Value] >> [Set Timer 1]. Enter
a value in the text box in the menu, then press the [Enter] key.

Here, the timer measurement will start when the value "Oxb" is read

from or written to the watch-expression "g_IntBuf".

Figure 2-169. Example of Setting a Timer Start Event (Access-related) on a Watch-expression [Simulator]

El @ ﬂ LI!I x Mokakion =

Wat ch Talus Type (Byte Size) Address Memo

Ox00001404

P
| Timer Setti g m,Q} Set Timer Start Rjw value | nxb)
o
Periodic Updatin ¥ | I Set Timer End Rjw Value
@ Refresh

gﬂ Force Read Yalue

From the context menu above the watch-expression "g_IntBuf", select
[Timer Settings] >> [Set Timer Start R/W Value]. Enter a value in the
text box in the menu, then press the [Enter] key.

Here, the timer measurement will start when the value "0Oxb" is read

from or written to the watch-expression "g_IntBuf".

When timer start and end events are set, the following event marks are displayed in the event area of the relevant
line, address, or watch-expression.

Also, on the Events panel, they are managed collectively as one instance of a timer measurement event. (By
clicking the "+" mark at a timer measurement event item, it is possible to check information on the timer start and
end events you've set.
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Table 2-18. Event Marks of the Timer Start and End Events

Type Event mark
Timer start s
Timer end 4

Figure 2-170. Example of Timer Start and End Events Set (Disassemble panel)

Event area
Indicates that a timer start fa: chi |'j2|::';
. o aoooo3s? |+6 BOff2E0D0
event is set. T4 }
a00003fe |+a lel?
Indicat.es that a timer end ::1 gggggg;z IE g_g?g
event is set. 75

Caution [Simulator]
If the timer start and end events occur at the same instruction execution, the operation
depends on the measurement state as follows.
- When timer measurement has started:
Timer measurement stops and the measured time is reflected in the resulit.
- When timer measurement has not started:
Timer measurement is not done.

Remark Event marks differ depending on the event state (see "2.17.1 Changing states of setting (Enabled/
Disabled)").
Also, if a new event is set at a place where an event has already been set, the event mark (H,E) is
displayed, indicating that multiple events have been set.

(2) Execute the program
Execute the program (see "2.9 Execute Programs").
When an instruction for which a timer start event or timer end event has been set is executed, a timer
measurement is started or finished.
After execution of the program has stopped, the measurement result can be confirmed as a timer measurement
event on the Events panel that is opened by choosing [Event] from the [View] menu, as shown below.
Note that this timer measurement event is a particular type of event that is displayed on only the Events panel
when either a timer start event or a timer end event has been set.
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Figure 2-171. Example of Measurement Results by Timer Measurement Event
(Timer Start and End Events) [E1] [E20]

X [BlowE@=] < @

M ame Dretail Cormett
“2 Run-Break Timer Totall ns
= 5% Timer Result] Taotal:0ns Start/End:2 M
Tatal Fazs Count Average M ax tin
|EI nz a Ons Ons Ons |
Detail

Start After Execution sort.c18 OxffffE5e4
End ReadMiite g_IntBuf 01404 - 021407 == 0x5

Mame Detail Comment )
= LS Timer Fiesult2 Taotal :0ne Start/End:2
Total Fazs Count Average bdax Pin
|D ns a Ons Ons Ons |
Detail

Start Read/wfrite g_CharBuf 0x1000 - 0x1000 == Oxa
End &fter E secution sort. cH1E 0=fifB5d3

M arme Detail Carmnment

=2 Unconditional Trace

Figure 2-172. Example of Measurement Results by Timer Measurement Event
(Timer Start and End Events) [EZ Emulator]

Events

X || M0 [m|&| 0S5 B S F

Detal Comrment

Mame
=2 Run-Break Timer Mot measured
= [¥] 5% Timer Result Taotal :0 rs Start/End: 2
Total Pazs Count Average
| 0k n 0 ri

Dretail
Start ReadMafrite g_IntBuf Ox1404 - 0wl 407 == Oxb
End After Execution sort. cH35 Owifff35de

M ame Dretail
=2 Unconditional Trace
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Figure 2-173. Example of a Measurement Result by Timer Measurement Event
(Timer Start and End Events) [Simulator]

X Mm@ @|a][=] o @
Mame Detail Comrment
v] = Run-Break Timer Total 4000 ns Execution Cycle Count : 400 Execution Instruction Count © 768
El [¥] 5 Timer Result Taotal :Ons Start/End:2
Total Pazz Count Average (L™ kit
|EI na i} Ons Ona Ons
Detail
Start Before Execution sort. c#18 OufffiS5ed
\_ End ReadMwfite g_IntBuf Ox1404 - 01407 == 0x5
Mame Detail Comrment
“2 |Unconditional Trace

(3) Editing a timer measurement event [E1] [E20] [EZ Emulator]

To edit detailed information on a timer measurement event that has had start and end events set, use the Detailed

Settings of Timer Measurement dialog box [E1] [E20] [EZ Emulator]. This dialog box is opened by selecting the

timer measurement event you wish to edit on the Events panel then selecting [Edit Condition ...] from the context

menu.

(a) To edit a measurement item

In the Detailed Settings of Timer Measurement dialog box, a measurement item can be specified from the

following.

Measurement item

Function

Execution cycle Note

Measures the number of elapsed cycles (ICLK) in a specified
section.

Execution cycle (Supervisor mode)

Measures the number of elapsed cycles (ICLK) while operating in
supervisor mode.

Exception and interrupt cycle

Measures the number of cycles (ICLK) needed to process interrupts
(including exceptions).

Exception cycle

Measures the number of cycles (ICLK) needed to process
exceptions.

Interrupt cycle

Measures the number of cycles (ICLK) needed to process
interrupts.

Execution count

Measures the number of instructions that have their execution
completed.

Exception and interrupt count

Measures the number of times interrupts, including exceptions, were
accepted.

Exception count

Measures the number of times exceptions occurred.

Interrupt count

Measures the number of times interrupts were accepted.

Note [RX200 Series]

Only [Execution cycle] is displayed for the measurement item.
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(b) To edit the [Execution only once] property
When you specify [Yes] for the [Execution only once] property, the timer measurement is finished by
measuring a specified section only once. If you want to measure a total number of times a specified section
has been passed, be sure to specify [No].

Remark [RX600 Series]
While the measurement listed below is performed, even if the start event and end event occur, if
the condition for measurement is not satisfied even once, the results of measurement will not be
displayed.
- Execution count
- Exception and interrupt count
- Exception count
- Interrupt count

Caution [RX600 Series]
If you specify [Yes], the timer measurement will be suspended when the timer start event
occurs twice even though the timer end event has not occurred.

(4) Editing timer start and timer end events
To edit a timer start or timer end event you've set, choose [Event] from the [View] menu, select the timer start or
timer end event (execution-related or access-related) displayed in the detailed information on the timer result on
the Events panel that is opened, and then click [Edit Condition ...] on the context menu.
Perform the editing in a dialog box that is opened by this operation.
For details on how to edit in an execution-related event dialog box, see "(1) Editing execution-related events".
Also, for details on how to edit in an access-related event dialog box, see "(2) Editing access-related events".

(5) Deleting a timer start event or timer end event
To delete a timer start event or timer end event you've set, right-click the event mark in the event area and then
select [Delete Events] on the context menu that is displayed.
You can also delete a timer start or timer end event on the Events panel which opens by selecting [View] menu >>
[Event]. After selecting the timer start or timer end event (execution-related or access-related) displayed in the
detailed information on the timer result in the Events panel, click (}(|) button on the toolbar to delete it (see "2.17.5
Deleting events").

Caution If either a timer start or timer end event is deleted from the event marks on the event area, all of
the corresponding event marks are deleted.

2.14.4 Range of measurable time

There is a finite range of measurable time for timer measurements by Run-Break timer events (see "2.14.2 Measuring
execution time from start to stop") or timer measurement events (see "2.14.3 Measuring execution time in a section"), as
shown below.
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Table 2-19. Range of Measurable Time

Debug tool Run-Break timer event Timer measurement event
E1(Serial))E1(JTAG)/ Min 100 microseconds Min -
E20(Serial)/E20(JTAG
( ) ( ) Max Approx. 72 hours Max Depends on CPU clock frequency

RX600 Seri
[ eries] 32-bit counter x 2 channels

or
64-bit counter x 1 channel
Overflow detection available

E1(Serial))E1(JTAG)/ Min 100 microseconds Min -
E20(Serial)/E20(JTAG)
[RX200 Series]

Max Approx. 72 hours Max Depends on CPU clock frequency
24-bit counter x 1 channel

Overflow detection available

Simulator Depends on CPU clock frequency Depends on CPU clock frequency
64-bit counter 64-bit counter
Overflow detection available Overflow detection available
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2.15 Measure Coverage [Simulator]

This section describes coverage measurements that are conducted using the coverage facility.

There are several kinds of coverage measurement methods. Of these, CubeSuite+ performs, in areas designated
below, a code coverage measurement of fetch-related operations on source lines and functions (CO coverage) and a data
coverage measurement of access-related operations on variables.

The areas in which CubeSuite+ performs coverage measurements are as follows:

Table 2-20. Subject Areas of Coverage Measurements

Debug Tool Subject area

Simulator Internal ROM/RAM, emulation ROM/RAM

Remark CO coverage refers to an instruction coverage rate (statement coverage).
For example, if all instructions (statements) in code are executed at least once, then CO = 100%.

2.15.1 Configure the coverage measurement

To use the coverage facility, it is necessary to make coverage measurement-related settings in advance.
Make settings in the [Coverage] [Simulator] category on the [Debug Tool Settings] tab on the Property panel.

Figure 2-174. [Coverage] Category [Simulator]

El Coverage
|ze coverage function Yes
Reuse coverage result Mo

(1) [Use coverage function]
Specify by a drop-down list whether or not you want to use the coverage function.
To use the coverage function, select [Yes]. (By default, [No] is selected.)

(2) [Reuse result]
This property is displayed only when [Use coverage function] property is set to [Yes].
Specify from the drop-down list whether to automatically save the acquired code coverage measurement result
when disconnecting from the debug tool and reproduce it next time you connect to the debug tool.
To reproduce the contents of the last obtained code coverage measurement results, select [Yes]. (By default, [No]
is selected.)

2.15.2 Display coverage measurement results

Coverage measurement starts (ends) automatically with the start (end) of the program execution.
(1) Code coverage rates

(a) Display of code coverage rates for source lines and disassemble lines
The code coverage rates are indicated on the Editor panel or Disassemble panel that is displaying the target
program.
On each panel, the target source text lines and disassembled result lines are shown in color-coded
background (see Table 2-22.) according to their code coverage rate that was calculated based on the formula
described in Table 2-21..
The results are not shown when disconnected from the debug tool or during the program execution.
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Selecting [Clear coverage information] from the context menu will reset all the coverage information acquired,
including the color coding on each panel.

Table 2-21. Calculating Code Coverage Rates for Source Lines and Disassemble Lines

Panel Calculation method

Editor panel Number of bytes executed in the address area corresponding to the source line /
Total number of bytes present in the address area corresponding to the source line

Disassemble panel Number of bytes executed in the address area corresponding to the disassembled
result line / Total number of bytes present in the address area corresponding to the
disassembled result line

Table 2-22. Color-coded Code Coverage Measurement Results (Default)

Code Coverage Background Color
100 % Source text/ disassembled results
11099 % Source text/ disassembled results
0 % (not executed) Source text/ disassembled results

Remarks 1.  The code coverage measurement result displayed on each panel is updated at every program

break.

2. The above color coding rule is determined according to the settings in [General - Font and
Color] category category in the Option dialog box.

3.  The above color coding rule does not apply to the lines that are outside the target area (see
"Table 2-20. Subject Areas of Coverage Measurements").

4. The Editor panel will not display the code coverage measurement result in cases where the
source file currently displayed is updated after the update of the downloaded modules.

Figure 2-175. Example of Code Coverage Measurement Results (Editor Panel)

2B Ifffafsd void main (void)

29 =14

30 long a[l10]:

31 int i:;

32 char tmpl[2]:

33 int ret;

34 char isnuminput;

35

38 while (1) {

37

aE EE o= = " . = B

;;’ frrfafes printf ("### Da Code on this line executed at 100%

40 LfffafTc for({ i=0; i<10; ¥ TT

41 fEffa£a3 printf ("a[%d]=",1):

42 Ifffafad afil= 0Or

a3 SEEFASO0 ' i anuminyg Code on this line executed at 0% (Not

44 while {1]| executed)

45 ffffafsz ret canf ("Ec", &stmp) ;

45 Efffafac if {ret != EOF}) {

47 ffffafal if{ tmp[0] '= LF }{
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Figure 2-176. Example of the Code Coverage Measurement Result (Disassemble Panel)

(=

K1=H

40:

41:

42

435

45:

46:

47

_main:
fEErf5Eod T1lo0cd4 ADD #-ZCH, RO, RO
ffffafe0 fho274d5EfEfE Mo . L #-0000Z A2CH, R12
ffffafees eflikh MoW. L EO,E11
ffffafes fhaz hd5EfEfff Mo . L #-0000zZ A25H, B10
printf ("### Data Input ### Code on this line executed at 100%
ffffafee fhize0d5EEfE MoW. L
ffffatf~y4 Teald FUSH.L E3
ffffafve OSed030o0 ESE. L _printf
ffffaf7a G240 ADT #4H, RO
for({ i=0; i<10; i++ )4
ffffatfye GE07 Mo . L HOH, BT
ffffaf e 710504 ADTD #04H, RO, RS
ffffafsl efgo MoW. L ES,E9
printf(Malszd]=",1):
ffffafE3 Tea’ FUSH.L E7
fEffFf5E55 Teac FUSH.L RElz
ffffafs"y O5do0300 ESE. L _printf
fEfff5ESh 6250 ADD #5H, RO
ali]l= 0O:
ffffafad fa9600 MoV . L #O0OH, [E9]
isnuminput = FAL3IE;
TL£r5190 6606 HOV. L Codeont&sﬁneexeaﬂedato%(Nm
ret = scanf ("o, &Tp
fEEERE92 Tesh PUSH. L executed)
ffffafog Teaa FUSH.L E10
ff£ffafo6 OS5fe0300 ESE. L _scanf
ffffaf9a GZE0 ADT H#5H, RO
if(ret != EOQOF){
ffff3foc 7EO1ff CMFP #-01H, R1
ffffafof 2074 BEQ.E _main+B6H
if{ tmp[0] '= LF }{

(b) Display of code coverage rates for each function

Check the [Code Coverage[%]] item in the Function List panel of the analysis tool for the code coverage rates

of each function (i.e., function coverage rates).

For details on the "code coverage ratio of functions," see the separate edition "CubeSuite+ Integrated

Development Environment User's Manual: Analysis."

(2) Data coverage rates

Check the [Data Coverage[%]] item in the Variable List panel of the analysis tool for the data coverage rates of

each variable.

For details on the "data coverage ratio of variables," see the separate edition "CubeSuite+ Integrated Development

Environment User's Manual: Analysis."
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2.16 Set an Action into Programs

This section describes how to set the specified action into the program.

2.16.1 Insert printf

Setting the Printf event as one of action events allows you to output the value of the specified variable expression to the
Output panel. This can be done by executing a printf command after temporarily stopping the program at an arbitrary
position.

To use this function, follow the steps below.

1) Set a Printf event

-(1)

- (2) Execute the program

- (3) Check the output result
- (4) Edit Printf event

Cautions 1.  Also see "2.17.7 Points to note regarding event setting" for details on Printf event settings,
including the allowable number of valid events.
2. No Printf events occur during step execution ( / / ) or execution ignoring break-
related events ().

(1) Set a Printf event
Set a Printf event to the position where you want to execute the printf command in the Editor panel/Disassemble
panel.
In the Editor panel/Disassemble panel, move the caret to the line/addressN°® at which you want to set a Printf
event and then select [Register Action Event...] from the context menu to open the following Action Events dialog
box.

In this dialog box, follow the steps below.

Note Printf events cannot be set to lines with no address indication.
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(a)

(b)

(c)

Figure 2-177. Set Printf Event (Action Events Dialog Box: [Printf event] Tab)

Action Events fgl

Frirtf event | [rtermupt Event S etting

Dutput zting: Example] S ample:

“Wariable expresszion:  Example] aaa, bbb, coo

Address;
| CATest A |

Example for Dutput panel]
Sample: aaa =10, bbb =20, cec =30

| Cancel |[ Help

Specify [Output string]
Directly enter from the keyboard the characters to add when output to the Output panel.
Characters must be in one line (spaces allowed).

Specify [Variable expression]

Specify the variable expression for the Printf event to take place.

Type a variable expression directly into the text box (up to 1024 characters).

You can specify up to 10 variable expressions for a single Printf event by separating them with commas ",".

If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the
selected variable expression appears as the default.

For the basic input format that can be specified as variable expressions and the values output by Printf event,

see "Table A-14. Relationship between Variable Expressions and Output Value (Printf Event)".

Remark By holding down [Ctri]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").

Specify [Address]

Designate an address that specifies the Printf event.

By default, the presently specified address is displayed.

When editing, you can either type an address expression directly into the text box (up to 1024 characters), or
select one from the input history from the drop-down list (up to 10 items).

Remark By holding down [Ctri]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").
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(d) Click the [OK] button
Set the Printf event to the line at the caret position in the Editor panel/Disassemble panel.
When the Printf event is set, the .‘0 mark is displayed in the event area on the Editor panel/Disassemble
panel, and the set Printf event is managed in the Events panel (see "2.17 Event Management").

(2) Execute the program
Execute the program (see "2.9 Execute Programs").
By executing the program, the program momentarily stops immediately before executing the instruction at the
location where this event is set, and the value of the variable expression specified in this dialog box is output to the
Output panel.

(3) Check the output result
The following figure shows how the value of the specified variable expression is output to the [Debug Tool] tab of
the Output panel (see “Figure A-51. Output Result Format of Printf Event®).

Figure 2-178. Example of Output Result of Printf Event

Sample™ global _a=10(0xa
Stopped by user operation.J
[EOF] [Variable expression]: global_a

[Output string]: Sample=

Output result when the above is

specified

Al Messages

X

(4) Edit Printf event
You can edit a Printf event which has already been set.

When editing, click the target Printf event in the Events panel and select [Edit Condition---] from the context menu.
This will open the Action Events dialog box in which you can edit the items. When finished, click [OK].

2.16.2 Insert an interrupt event [Simulator]

Setting an interrupt event as one of the action events allows you to generate an interrupt at a desired location while the
program is running. To use this function, follow the steps below.

- (1) Setan interrupt event
- (2) Execute the program
- (3) Editinterrupt event

Caution Also see "2.17.7 Points to note regarding event setting" for details on interrupt event settings,
including the allowable number of valid events.

(1) Set an interrupt event
In the Editor panel/Disassemble panel, set an interrupt event at a location where you want an interrupt request to
be generated.

In the Editor panel/Disassemble panel, move the caret to the line/addressN°te

at which you want to set an interrupt
event and then select [Register Action Event...] from the context menu to open the following Action Events dialog
box, then select the [Interrupt event setting] tab [Simulator].

In this dialog box, follow the steps below.
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Note Interrupt events cannot be set to lines with no address indication.

Figure 2-179. Set Interrupt Event (Action Events Dialog Box: [Interrupt Event Setting] Tab

Action Events r'5_<|

Printf evant | |ntermupt Event Setting |

[nterrupt Yectar:

Pricrity:

Cancel | [ Help

(a) Specify [Interrupt Vector]
Specify the interrupt vector by directly entering a corresponding number between 0 and 255.

(b) Specify [Priority]

Specify an interrupt's priority level.

- [RX610 Group]
Specify the priority order by directly entering a number between 1 and 8.
When 8 is specified, the event is handled as a fast interrupt.

- [Non-RX610 Group]
Specify the priority order by directly entering a number between 1 and 16.
When 16 is specified, the event is handled as a fast interrupt.

(c) Click the [OK] button
Set the interrupt event to the line at the caret position in the Editor panel/Disassemble panel.
When the interrupt event is set, the ."3' mark is displayed in the event area on the Editor panel/Disassemble
panel, and the set interrupt event is managed in the Events panel (see "2.17 Event Management").

(2) Execute the program
Execute the program (see "2.9 Execute Programs").
When the program is executed, the interrupt request will occur immediately before the execution of the instruction
at which the interrupt event has been set. Once the interrupt request is accepted by the CPU, interrupt exception
will take place.
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Cautions 1.  Once the generated interrupt request is accepted and interrupt exception executed, the
interrupt request will be cleared.
2. If an interrupt request is made by another event while the generated interrupt request is being
reserved, one with higher interrupt priority will be valid.

(3) Edit interrupt event
You can edit an interrupt event which has already been set.
When editing, click the target interrupt event in the Events panel and select [Edit Condition---] from the context
menu. This will open the Detailed Settings of Interrupt Events dialog box [Simulator] in which you can edit the
items. When finished, click [OK].

(a) Edit [Pass Count]
Directly enter a value between 1 and 16383.
The event will be encountered when the event conditions meeting the number of specified passages are
satisfied.

(b) Edit [Interrupt]
You can edit an interrupt vector and the priority order. The procedure for editing is the same as that for
[Interrupt event setting] tab [Simulator] in the Action Events dialog box (see "(a) Specify [Interrupt
Vector]"and" (b) Specify [Priority]").
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2.17 Event Management

An event refers to a specific state of the microcontroller in debugging like "the address 0x1000 was fetched" or "data
was written to the address 0x2000."

CubeSuite+ uses this event as an action trigger of the debug function to break at a given place, start or stop a trace
operation, or start or stop a timer measurement.

This section describes how to manage those events.

The events are managed collectively on the Events panel shown below.

Choose [Event] from the [View] menu.

The Events panel permits you to check detailed information on the currently set events in list form, as well as delete
events, switch the state of settings (enabled or disabled), display detailed information, and change settings.

For details on how to read each area and about their functionality, see the section in which the Events panel is
described.

Remark When multiple load module files are downloaded, the load module names are displayed as the detailed
information on the Events panel.

Figure 2-180. Displaying the Set Events (Events Panel) [E1] [E20]
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Figure 2-181.

Toolbar {

LRI EIEIEIRE S

Displaying the Set Events (Events Panel) [EZ Emulator]
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Figure 2-182. Displaying the Set Events (Events Panel) [Simulator]
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2171 Changing states of setting (Enabled/Disabled)

By checking or unchecking the checkbox of an event name concerned, it is possible to change the set state of that
event. (When the set state of an event is changed, its Event mark is changed accordingly.)
There are following types for the set states of events.

Figure 2-183. Event Name Checkbox

W Hardware Break0oo1

f

Check box Event mark Event name

Table 2-23. Set States of Events

Enabled When a specified condition is met, the enabled event occurs.

The event can be disabled by unchecking its checkbox.

|:| Disabled Even when a specified condition is met, the disabled event does not occur.

The event can be enabled by checking its checkbox.

|:| Pending A specified condition cannot be set in the program to be debugged. The checkbox of any event
in this state cannot be manipulated.

Remarks 1.  The Run-Break timer event (not supported by the EZ Emulator) cannot be disabled or made pending.
2. The state of an event can also be changed by enabling or disabling it from the menu that is displayed
by right-clicking its Event mark on the Editor panel or Disassemble panel.
3. The enabled/disabled settings of an unconditional trace event and other trace events are controlled
exclusively of each other. Therefore, although the unconditional trace event, one of the built-in events,
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is enabled by default, when either a trace start event or a trace end event is set, it is automatically
disabled at the same time, in which case, the trace start and trace end events are enabled together as
one instance of a trace event.

Conversely, when the set trace event is disabled, the unconditional trace event is automatically re-
enabled.

2.17.2 Displaying only a specific type of event

By clicking one of the following toolbar buttons, it is possible to display only a specific type of event.

Displays hardware break-related events.

& &

Displays software break-related events.
[E1] [E20] [EZ Emulator]

Displays trace-related events.

Displays timer-related events.

Displays action events (Printf event, interrupt event [Simulator]).

) [ [\ [

Displays built-in events (unconditional trace event or Run-Break timer event). Note

Note The EZ Emulator does not support Run-Break timer events.

217.3 Jump to an event address
By clicking one of the following buttons, it is possible to jump to the relevant panel corresponding to the address of a
currently selected event.

However, these buttons are disabled when a trace event, timer measurement event, or a built-in event (unconditional
trace event or Run-Break timer event) is selected.

The Editor panel opens, with the caret on it moved to the source line corresponding to the
address at which a selected event is set.

The Disassemble panel opens, with the caret on it moved to the disassembled result
corresponding to the address at which a selected event is set.

The Memory panel opens, with the caret on it moved to the memory value corresponding to the
address at which a selected event is set.

2.17.4 Editing detailed settings of events

This section describes how to edit detailed settings of various events. For information on editing of timer measurement
events, see "(3) Editing a timer measurement event [E1] [E20] [EZ Emulator]". For information on editing of action
events (Printf events and interrupt events), see "2.16 Set an Action into Programs".

(1) Editing execution-related events
(2) Editing access-related events
(3) Editing combination conditions of events [E1] [E20] [EZ Emulator]

(1) Editing execution-related events
It is possible to edit the condition for the number of times an execution-related event has passed.
To edit execution-related events, use the Detailed Settings of Execution Events dialog box that is displayed by
performing the following operation on the Events panel.
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Hardware Break Move the caret to a hardware break you want to edit and then select [Edit Condition ---] from the
context menu.

Trace Move the caret to an execution-related event in a trace you want to edit and then select [Edit
Condition ---] from the context menu.

Combination Break Move the caret to an execution-related event in a combination break you want to edit and then
[E1] [E20] [EZ Emulator] select [Edit Condition ‘-] from the context menu.

Timer Result Move the caret to an execution-related event in a timer result you want to edit and then select

[Edit Condition ---] from the context menu.

Caution Address values of execution-related events cannot be changed in the Detailed Settings of
Execution Events dialog box. To change address values, delete the subject event and then set a
new event.

(a) Editing the pass count (or the number of times passed)
Enter a numeric value in decimal notation for the [Pass count] property in the [Pass Count] category and then
click the [OK] button. The relevant event occurs when the event condition is satisfied as many times as the
entered pass count.
The specifiable value for the pass count differs with each debug tool as follows:
- [E1] [E20] [EZ Emulator]
1 to 256
- [Simulator]
110 16,383

Cautions 1.  [E1] [E20] [EZ Emulator]
The pass count can be specified by any value other than 1 for only one event among all
events (including access-related events).
If a pass count of other than 1 is specified for two events, an error results.
2. [E1(Serial)/E20(Serial)/)EZ Emulator [RX100, RX200 Series]]
No values other than 1 can be specified for the pass count.

(2) Editing access-related events
The address condition and data condition for access-related events can be edited.
For details on how to edit the pass count, see "(a) Editing the pass count (or the number of times passed)".
To edit access-related events, use the Detailed Settings of Access Events dialog box that is displayed by
performing the following operation on the Events panel.

Trace Move the caret to an access-related event in a trace you want to edit and then select [Edit
Condition --+] from the context menu.

Point Trace Move the caret to an access-related event in a point trace you want to edit and then select [Edit
Condition --+] from the context menu.

Combination Break Move the caret to an access-related event in a combination break you want to edit and then
[E1] [E20] [EZ Emulator] select [Edit Condition -] from the context menu.

Timer Result Move the caret to an access-related event in a timer result you want to edit and then select [Edit
Condition --+] from the context menu.

Caution Address values of access-related events cannot be changed in the Detailed Settings of Access
Events dialog box. To change address values, delete the subject event and then set a new
event.
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(a) Editing address conditions
In the [Compare condition] property in the [Address Condition] category, specify a comparison condition from
the drop-down list.
Depending on the specified comparison condition, the following address conditions can be set in combination
with the address values displayed in the [Address] property in the [Address] category.

<1> When [No conditions] is specified
The address value is made the condition. WWhen an access to the address value occurs, the condition
holds true.

<2> When [Address area] is specified [E1] [E20] [EZ Emulator]
The address value is made the start address. Enter an end address value in the [End address] property
that is added in the [Address Condition] category. When access to any place in the range of start and end
addresses set occurs, the condition holds true.
Also, in the [Area condition] property that is added the same way, it is possible to set "outside" of the
address range for the address condition.

Cautions 1. [RX100, RX200 Series]
Comparison conditions based on an address area are not supported.
2. [RX600 Series]
You can specify "Address area"” as the comparison condition only to one event.
3.  [Simulator]
Address conditions cannot be specified.

<3> When [Compare with address mask] is specified [E1] [E20] [EZ Emulator]
A mask value can be set for the address value. Enter an address mask value in hexadecimal notation in
the [Address mask] property that is added in the [Address Condition] category. When an access to the
address that matches the masked address occurs, the condition holds true.
Also, in the [Compare] property that is added the same way, it is possible to set "Any other value (I=)" for
the address comparison condition.

Caution The address value to be used as the condition is masked bit-wise with a mask value
for which "0" is specified.
Example) To set an address condition of 0x1000 to O0x1FFF
Address value: 0x1000
Mask value: 0xF000

(b) Editing data conditions

<1> [Access type]
Specify one of the following items for the access type

Read When a read access occurs, the condition holds true.
Write When a write access occurs, the condition holds true.
Read/Write When a read or write access occurs, the condition holds true.

<2> [Access size]
Specify one of the following items for the access size.
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No conditions When an access in any size occurs, the condition holds true.

Byte When an access in byte size occurs, the condition holds true.
Word When an access in word size occurs, the condition holds true.
Long word When an access in long word size occurs, the condition holds true.

<3> [Compare condition]
Specify a data comparison condition.
The comparison condition differs with each debug tool as follows:

[E1] [E20] [EZ Emulator] Specified value (== When data comparison conditions match, the
condition holds true.

Any other value (!=) When data comparison conditions do not match, the
condition holds true.

[Simulator] Equal (== When data and specified value match, the condition
holds true.

Not equal (!=) When data and specified value do not match, the
condition holds true.

Inverse sign Note 1

When the sign is inverted between the previously
accessed data and the data accessed this time, the

condition holds true.

Difference Note 1

When the difference between the previously
accessed data and the data accessed this time

exceeds a specified value, the condition holds true.

Greater than (>) When data is greater than a specified value, the
condition holds true.

Less Than (<) When data is smaller than a specified value, the
condition holds true.

Greater than or equal to (>=) When data is equal to or greater than a specified
value, the condition holds true.

Less Than or equal to (<=) When data is equal to or smaller than a specified
value, the condition holds true.

Inside the range (<=Values<=) When data is within the range of specified values, the
condition holds true.
([Compare data 1] <= data <= [Compare data 2])

Outside the range !(<=Values<=) When data is outside the range of specified values,
the condition holds true.
(data < [Compare data 1] || [Compare data 2] < data)

No conditions Comparison data is not specified.

Notes 1. For [Inverse sign] and [Difference], since comparison is made with the previous data, the
condition never holds true after a reset and in the first determination of whether condition is
true.

Remark [Simulator]
This property is not displayed only when you've specified [No conditions] in the [Access size]
property.
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<4>

<5>

<6>

<7>

<8>

<9>

[Compare data] [E1] [E20] [EZ Emulator]
Specify a data value with a hexadecimal number.

[Compare data1] [Simulator]

Specify a data value in hexadecimal.

This property is displayed when you've specified one of the following items in the [Compare condition]
property.

[Equal (==)], [Not equal (!=)], [Greater than (>)], [Less Than (<)], [Greater than or equal to (>=)], [Less
Than or equal to (<=)], [Inside the range (<=Values<=)], [Outside the range !(<=Values<=)]

[Compare data2] [Simulator]

Specify a data value with a hexadecimal number.

This property is displayed only when you've specified [Inside the range (<=Values<=)] or [Outside the
range !(<=Values<=)] in the [Compare condition] property.

[Specify the data mask]
When you entered a comparison data value, this property is displayed, allowing you to specify whether
or not a mask value for the data value be specified. If you specify [Yes], the data mask can be specified.

Remark [Simulator]
This property is displayed when you've specified one of the following items in the [Compare
condition] property.
[Equal (==)], [Not equal (!=)], [Greater than (>)], [Less Than (<)], [Greater than or equal to
(>=)], [Less Than or equal to (<=)], [Inside the range (<=Values<=)], [Outside the range
I(<=Values<=)]

[Mask value]

This property is displayed when you've specified [Yes] in the [Specify the data mask] property. Enter a
data mask value in hexadecimal, so that when a data access that matches the masked data and
comparison condition occurs, the condition holds true.

[Difference] [Simulator]
Specify comparison data with a hexadecimal number.
This property is displayed when you've specified [Difference] in the [Compare condition] property.

<10> [Sign] [Simulator]

Specify whether or not the data to compare has a sign.

This property is displayed when you've specified one of the following items in the [Compare condition]
property.

[Difference], [Greater than (>)], [Less Than (<)], [Greater than or equal to (>=)], [Less Than or equal to
(<=)], [Inside the range (<=Values<=)], [Outside the range !(<=Values<=)]

(3) Editing combination conditions of events [E1] [E20] [EZ Emulator]
Edit the combination condition for a combination break comprised of multiple events set or for a trace. The
combination condition for a trace can be set by specifying a condition for start and for end, respectively, by
switching tabs.
To edit the combination condition of events, use the Combination Condition dialog box [E1][E20] [EZ Emulator] that

is displayed by the following operation on the Events panel.
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Caution [EZ Emulator]
If the reset signal is input through the reset pin, information of events that have been
encountered up to that poin is cleared when the EZ Emulator restarts the execution of the

program.
Combination break Move the caret to combination break and then select [Edit Condition ...] from the
context menu.
Trace Move the caret to a trace and then select [Edit Condition ...] from the context
menu.

(a) Editing the combination condition
Select the combination condition between [OR], [AND] or [Sequential] from the pull-down menu. For the
explanation of operation per combination condition, see "2.10.5 Set multiple break events in combination
(Combination break) [E1] [E20] [EZ Emulator]”, and "(2) Combining multiple events [E1] [E20] [EZ Emulator]".

Figure 2-184. [Combination] item

Combinatian: ] w
AMD
Sequential

Cautions 1.  For trace events, the combination condition available for a trace end event is only [OR].
2. [AND] cannot be used as the combination condition for both the combination break and
trace start event. Similarly, [Sequential] cannot be used as the combination condition
for both the combination break and trace start event.
When [AND] and [Sequential] are selected as the combination condition for either of the
combination break or trace start event, only [OR] can be selected for the other.

(b) Editing the subject event
Change the order of events in the Object event list using the [Up] or [Down] button. These buttons are enabled
only when you've selected Sequential for the combination condition and moved the caret to an event in the
Object event list.
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Figure 2-185. Changing the Order of Events in the Object Event List (Sequential)
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(c) Editing the reset event
To register a reset event, click the [R Event] button. This button is enabled only when you've selected

Sequential for the combination condition and moved the caret to an event in the Object event list.

Also, if you want to clear registration of a reset event, click the [Release] button. This button is enabled when

you move the caret to an event in the Reset event list

Cautions 1.

Only one reset event is specifiable.

If you click the [R Event] button with the reset event registered, the event selected in the
Object event list and the registered reset event will replace each other.

If you change the combination condition from [Sequential] to [OR] or [AND] with the
reset event registered, the event in the Reset event list cannot be included in the Object
event list. In order to include it in the Object event list, you need to first cancel the reset
event registration before making changes to the combination conditions.

An event for which the pass count has been specified cannot be registered as the reset
event. The pass count cannot be specified for an event that has been registered as the
reset event.

[RX600 Series]

An event for which the address area has been specified cannot be registered as the
reset event. The address area cannot be specified for an event that has been registered
as the reset event.
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Figure 2-186. Registering a Reset Event (Sequential)

Combination Condition

Break |

Combination: QSequential

Ohbject event;

Ma. Event
After Execution sort. cH33 OxfrrEE5SF

After Execution sort. ol 36 OxffFEEDe

1
3 Fead g_CharBuf 0=1000 - 01000 == 0x55
4 Write g_|ntBuf O0x1 420 - Ox142f == Oxb

X
g
Up

A Event

Reset event:

Event

Releaze

] H Canicel H Help ]

Figure 2-187. Releasing Registration of a Reset Event (Sequential)

Combination Condition

Break, |

Combination: QSequential

Object event;
Mo. Ewvent p
1 After Execution sort.cH33 OxfrEaE5f
2 Read g_CharBuf 021000 - 01000 == 0«55 Do
3 wWrite q_|ntBuf Ox1 420 - 0wl 42f == Oxb
A Event

Reszet event:

Event

After Execution sort. cH36 OxfffEEle

FReleaze

] H Canicel H Help ]

2.17.5 Deleting events

To delete any event you've set, select the subject event and then click the toolbar button .
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When an event is specified by a combination of multiple events, each event in the detailed information can be deleted
independently.

However, you cannot delete the unconditional trace event and Run-Break timer event, which are the built-in events of
the debug tool.

Remarks 1.  For the timer start and end events, and trace start and end events, you can also delete an event by
selecting [Delete Event(s)] from the context menu displayed by right-clicking the event mark that is
displayed on the Editor panel or Disassemble panel.

2.  For the software/hardware break and the trace event consisting of execution-related events, you can
delete an event by clicking their event mark that is displayed on the Editor panel or Disassemble panel.
3. To delete all of the events you've set at a time, select [Select All] on the context menu and then click the

button (not including the built-in events).

2.17.6 Entering comments for events
For any event you've set, you can enter a comment freely as you wish.
To enter a comment, select an event for which you want to enter a comment, click in the [Comment] area, and then
enter any text directly from the keyboard. (Pressing the [Esc] key cancels the edit mode.)
After editing a comment, press the [Enter] key or move the focus to other than the editing area to complete your editing.
A comment can be entered in up to 256 characters, which is saved as the setting of the current user.

2.17.7 Points to note regarding event setting

Here, the points to note when you make settings of various events are described.

(1) Allowable number of valid events
(2) Types of events that can be set or removed during execution
(3) Other precautions

(1) Allowable number of valid events
The number of events that can be set as valid (or Enabled) events at the same time are subject to the following
limitations.
Therefore, if this limit is exceeded when you set one or more new valid events, some of the events that are already
set need to be Disabled before you can set a new one.

Table 2-24. Allowable Number of Valid Events [RX600 Series]

Debug tool
Type of event E1(Serial JE1(JTAG) Simulator
E20(Serial JE20(JTAG)
EZ Emulator
Software break 256Noted 0
Hardware break (execution-related: gNotet Jo2aNotes
before execution)
Break event (execution-related: after gNotet 0
execution)
Break event (access-related: Read, 4Note1 Note3 1024
Write, Read/Write)
Combination break g+4Note1 Note2 Note5 0
Trace (trace start, trace end) g+4Note1 Note2 Note6 256
Point trace 4Note1 Note3 256
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Debug tool
Type of event E1(SerialyE1(JTAG) Simulator
E20(Serial/E20(JTAG)
EZ Emulator

Timer result (timer start, timer end) g+4Note1 Note2 Note6 1Note?
Action (Printf event) 256Noted 1024Note8
Action (Interrupt event) 0 256

Table 2-25. Allowable Number of Valid Events [RX200 Series]

Debug tool
Type of event E1(Serial) Simulator
E20(Serial)
EZ Emulator
Software break 256Noted 0
Hardware break (execution-related: 4Noted 10p4Notes
before execution)
Break event (execution-related: after 4Noted 0
execution)
Break event (access-related: Read,
: ( . 2Note4 1024
Write, Read/Write)
Combination break 4+pNoted 0
Trace (trace start, trace end) 4+2Noted Note5 Note6 256
Point trace 4Noted 256
Timer result (timer start, timer end) 4+2Noted Note6 1Note?
Action (Printf event) 256Noted 1024Note8
Action (Interrupt event) 0 256

Table 2-26. Allowable Number of Valid Events [RX100 Series]

Mar 01, 2013

Debug tool
Type of event E1(Serial) Simulator
E20(Serial)
EZ Emulator
Software break 256Noted 0
Hardware break (execution-related: 4Noted 10p4Note8
before execution)
Break event (execution-related: after 4Noted 0
execution)
Break event (access-related: Read
ak event (ac ’ 2Noted 1024
Write, Read/Write)
Combination break 4+pNoted 0
Trace (trace start, trace end) 4+Noted Note5 Note6 256
Point trace 4Noted 256
Timer result (timer start, timer end) 0 1Note?
Action (Printf event) 256Noted 1024Noted
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Notes 1.

Debug tool
Type of event E1(Serial) Simulator
E20(Serial)
EZ Emulator
Action (Interrupt event) 0 256

There are 8 execution-related events and 4 access-related events, which are shared by multiple
functions.
For an event combination, up to 8 events can be set.
[E20(JTAG)]
The trace function and the real-time RAM monitor function (RRM function) in part are usable exclusively
of each other. Therefore, while the RRM function is in use, the point trace cannot be used. Also, the
access event is usable only when the RRM block has free space.
There are 4 execution-related events and 2 access-related events, which are shared by multiple
functions.
If the combination condition for the combination break is Sequential, the maximum number of events
that can be set differs with each microcontroller used, as shown below.

- [RX600 Series]

7 events + reset event (R event)
- [RX100, RX200 Series]
3 events + reset event (R event)

If the maximum number of execution-related events have already been used as trace start/trace end
events or timer start/timer end events, [Go to Here] in the context menu of the Editor panel or
Disassemble panel is not usable. Also, it is not possible to run the program to the address of a specified
symbol after the CPU has been reset.
For each of timer start and end events, only a single execution-related event or access-related event
can be specified.
Hardware breaks (execution-related: before execution) and actions (Printf events) are shared by
multiple functions.
Software breaks and actions (Printf events) are shared by multiple functions.

(2) Types of events that can be set or removed during execution

Types of events that can be set or removed during execution of the program or during execution of the tracer/timer

are as follows:

Table 2-27. Types of Events that Can Be Set or Removed during Execution

Debug tool
Type of event E1(Serial JE1(JTAG) Simulator
E20(Serial)/E20(JTAG)
EZ Emulator

Software break Note1 Note2 -
Hardware break (execution-related: Note2

before execution) O
Break event (execution-related: after Note2

execution) -
Break event (access-related: Read, Note2 O
Write, Read/Write)

Trace (trace start, trace end) X O
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Debug tool
Type of event E1(SerialJE1(JTAG) Simulator
E20(Serial JE20(JTAG)
EZ Emulator
Point trace X O
Timer result (timer start, timer end) X X
Action (Printf event) Note1 Note2 O
Action (Interrupt event) — O

: Possible
: Possible if program execution is momentarily halted
: Impossible during tracer execution

gk O

: Not supported
: Impossible

X

Notes 1. Internal RAM area only

2. Events cannot be set while the microcontroller is in a power-down mode.

(3) Other precautions
- No events can be set to local variables.

- No events occur during step execution (including Return Out), as well as during program execution actuated

by selecting [Go to Here] from the context menu.

- If the program to be debugged is downloaded again and the position at which some existing event is set

happens, as a consequence of it, to be in the middle of an instruction, the relevant event needs to be reset.

Here is the method for doing it.
- When debug information is available:

The event set position always moves to the beginning of source text lines.

- When no debug information is available:

The position depends on how the [Automatic change method of event setting position] property in the
[Download] category on the Property panel's [Download File Settings] tab is set.
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2.18 Setting Up the Hook Process

This section describes how to set up hooks in the debug tool by using the hook transaction function.

By setting up hook transaction, it is possible to automatically change the I/O register and CPU register values before or
after downloading a load module or after resetting the CPU.

You can configure hook transaction in the [Hook Transaction Settings] category of the [Hook Transaction Settings] tab
on the Property panel.

Remark You can increase the download speed by configuring the 1/O register in the [Before download] property.
Equally, you can facilitate downloading to external RAM by the setting in this category.

Figure 2-188. [Hook Transaction Settings] Category

E Hook Transaction Settnes

Before download Befare download[0]

after download ffter download[0]

After CPU rezet under breaking #fter GPU reset under breaking[0]
Befare running Befare running[0]

&fter breaking fifter breaking[0]

Table 2-28. Properties of the [Hook Transaction Settings] Category

Properties Timing
Before download Performs a specified process immediately before load module files are downloaded.
After download Performs a specified process immediately after load module files are downloaded.
After CPU reset under breaking Performs a specified process immediately after the CPU is reset.
Before running Performs a specified process immediately before program execution starts.
After breaking Performs a specified process immediately after program execution breaks.

Each property in the [Hook Transaction Settings] category shows the timing with which a hook transaction is
performed. The numeral shown in bracket [ ] for each property value indicates the number of currently specified
transactions. (No hook transactions are set by default.)

Follow the procedure below to perform hook transaction on the desired property.

To specify the transaction, select the desired property and click the [...] button that appears on the right end of the
column. This will open the Text Edit dialog box in which you can specify the transaction.

Figure 2-189. Text Edit Dialog Box Opened

Before dovinload Befare download[0]

ffter dovenload ffter download[0]

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 211 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

Figure 2-190. Configuring Hook Transaction (Text Edit Dialog Box)

Text Edit 3]

Text:

CF, H Cancel H Help

In this dialog box, enter the desired transaction directly from the keyboard.
You can use one of the following formats for specifying the desired transaction.

[Format: 1]
Overwrites the I/O register contents with numeric values.

I/0 register name Numeric value

[Format: 2]
Overwrites the CPU register contents with numeric values.

CPU register name Numeric value

[Format: 3]
Executes a script file designated by Python script path (absolute path or relative path using project folder as a
base).

Source Python script path

Remarks 1.  When specifying the transaction, add "#" at the top of the line to comment it out.
2. The space can be substituted by a tab character.

You can enter up to 64 characters for one transaction and can specify up to 128 transactions for each property. (One
line in the [Text] area in the Text Edit dialog box corresponds to one transaction.)
When finished with specifying the transaction, click [OK] to reflect it in the Property panel.
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Figure 2-191. Example of Hook Transaction Setting

Text Edit 3]

Text:

CRC.CRCDOR 0=0000

(0] 4 H Cancel H Help
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2.19 Using the Debug Console

This section describes how to use the debug console for standard 1/O.
To perform some operation using a program's internal standard library functions, such as the scanf function for reading

the data entered from the keyboard or the printf function for outputting data, use the Debug Console panel shown below.

Figure 2-192. Debug Console Panel

Debug Console

For details about each functionality of the debug console, see the section in which the Debug Console panel is

described.

Before standard 1/0 based on the Debug Console panel can be used in a C/C++ program, there must be a low-level

interface routine in the program.

CubeSuite+ comes with sample project "RX610_Tutorial_DebugConsole" for the E1/E20, which has the following files

for debug console functions.

- Low-level interface routine files (C language part) (lowsrc.c and lowsrc.h)
- Low-level interface routines: open, close, read, write, and Iseek
Called by standard 1/O.

- Initialize 1/0 libraries: _ INIT_IOLIB
- Close all open functions: CLOSEALL
Each called by the internal initialization routine "PowerON_Reset_PC" of the initialization routine file

resetprg.c.

- Low-level interface routine file (assembly language part) (lowlvl.src)
- Function to output 1 character: _charput
- Function to input 1 character: _charget
Called by low-level interface routines "write" and "read," respectively.

- Source file including the main function (DebugConsole_Sample.c)
- Callls the standard library functions scanf and printf in the main function.

Caution [E1] [E20] [EZ Emulator]
To use the debug console, do not switch the system clock in the charput and charget functions of
the program. Switching of the system clock may adversely affect the communication between the
emulator and microcontroller, hampering normal transmission or reception of data.
When the debug console is used, real-time performance of the user program is affected due to

transmission or reception of data.
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Remarks 1. For details about the low-level interface routines, see Chapter 7, "Startup," in the separate edition,

"CubeSuite+ Integrated Development Environment User's Manual: RX Coding."
2. [Simulator]

As a method for executing standard 1/0, an emulator-like method and a simulator-inherent method are
supported. In a simulator-inherent method, file I/O, not just standard 1/O, can also be used.
Each supported method changes from one to another as you specify in the [Select stream 1/0O mode]
property in the [Stream |/O] [Simulator] category on the Property panel's [Debug Tool Settings] tab.
For details about the simulator's 1/0 functions, see "APPENDIX B /O FUNCTIONS."

To use sample projects with debug console functions, follow the procedure described below.

(1) Loading a sample project
From [Open Sample Project] on the Start panel of CubeSuite+, load sample project
"RX610_Tutorial_DebugConsole" for the E1/E20.

Remark For details about the "Start panel," see the separate edition, "CubeSuite+ Integrated Development
Environment User's Manual: Start."

(2) Editing the low-level interface routine file (assembly language part) [Simulator]
To execute stream I/O in simulator mode, you need to edit the content of a file (lowlvl.src) for low-level interface
routines (assembly language part) to make it usable for a simulator.
Replace the contents of "lowlvl.src" with the following sample code for the simulator.
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.GLB charput
.GLB charget
SIM IO  .EQU Oh
.SECTION P, CODE
; charput
charput
MOV.L #IO_BUF,R2
MOV.B R1, [R2]
MOV.L #1220000h,R1
MOV.L #PARM, R3
MOV. L R2, [R3]
MOV.L R3,R2
MOV.L #SIM_IO,R3
JSR R3
RTS
; charget
charget
MOV.L #1210000h,R1
MOV.L #IO_BUF,R2
MOV.L #PARM, R3
MOV. L R2, [R3]
MOV.L R3,R2
MOV.L #SIM_IO,R3
JSR R3
MOV.L #IO_BUF,R2
MOVU.B [R2],R1
RTS
;  I/0 Buffer
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 1
.SECTION B_1,DATA
IO BUF: .BLKB 1
.END

(3) Selecting the debug tool to be used

To select or switch the debug tool, use the context menu shown by right clicking on the [Microcontroller type Debug

tool name (Debug Tool)] node on the Project Tree panel.

Remark For the details of debug tool selection, see "2.3.1

Select the debug tool to use".
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(4)

)

(6)

(7)

(8)

Changing settings in the Property panel [Simulator]
When the simulator is to be used, the following settings must be made in the [Stream 1/O] [Simulator] category on
the [Debug Tool Settings] tab of the Property panel.

Figure 2-193. [Stream 1/O] Category

E Streaml/0
Select stream | /0 mode Simulator mode
Ize stream |0 function Mo

Stream 1/0 address [Fe] 0

(a) [Select stream 1/0 mode]
To use files for the same low-level interface routines (assembly language part) as the emulator, specify
[Emulator mode]. (By default, [Simulator mode] is specified.)

(b) [Use stream /O function]
This property is displayed only when [Simulator mode] is specified in the [Select stream I/O mode] property.
If you intend to perform standard I/O or file 1/O, select [Yes] (default selection: [No]).

(c) [Stream I/O address]
This property is displayed only when [Simulator mode] is specified in the [Select stream I/O mode] property.
If you have replaced the low-level interface routines (assembly-language part) with the sample code for the
simulator, enter "0" (default).

Executing a download
Choose [Build & Download] from the [Debug] menu on the Main window. Then, when connected with the debug
tool, perform a build and a download (see "2.5.1 Execute downloading").

Opening the Debug Console panel
Open the Debug Console panel.

Executing the program
Execute the program (see "2.9 Execute Programs").

Performing data I/0 on Debug Console panel

By executing the program, perform data 1/0 on the Debug Console panel.

This program reads 10 entries of data that have been entered from the keyboard onto the panel by the scanf
function and then sorts the input data in ascending order. It then outputs data onto the panel using the printf
function.
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Debug Conzole

#itH Data Input HHH
al0H

- The element names of the array "a" in which data is stored are output onto the panel by the printf function in

the main function.

- When data is entered from the keyboard onto the panel, the data is read in by the scanf function in the main

function.

Debug Conzole

#itH Data Input HHHE
a[0]=0
a[1]=21468

a[3]=2410
al0)=0

#itH Data Input #H4E
a[0]=

- The sorted data is output onto the panel by the printf function in the main function.
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Remark [f you disable the local echo back function in [Echo Back] selected from the Debug Console panel's
context menu, the character strings you have entered will not be displayed (local echo back will not be
performed.)
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2.20 About Input Value

This section describes consideration to take when inputting values in each panel and dialog box.

2.20.1 Input rule

Following is the rules for input to each panel and dialog box.

(1) Character set

Character sets that are allowed to input are as follows:

Table 2-29. List of Character Set

Character Set Outline
ASCII 1- byte alphabets, numbers, symbols.
Shift-JIS 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.
EUC-JP 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.
UTF-8 2-byte alphabet, number, symbol, Hiragana, Katakana, Kaniji (include Chinese

characters) and 1-byte Katakana.

UTF-16 (Unicode)

2-byte alphabet, number, symbol, Hiragana, Katakana, Kaniji (include Chinese
characters) and 1-byte Katakana.

(2) Escape sequence

Escape sequences that are allowed to input are as follows:

Table 2-30. Escape Sequence List

Escape sequence Value Description
\0 0x00 null character
\a 0x07 Alert
\b 0x08 Backspace
\t 0x09 Horizontal tab
\n 0x0A New line
\v 0x0B Vertical tab
\f 0x0C Form feed
\r 0x0D Carriage return
\" 0x22 Double-quotation mark
\' 0x27 Single-quotation mark
\? O0x3F Question mark
handled as a question mark if ? is entered.
\ 0x5C Backslash
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(3) Number

Notations allowed when entering numbers are as follows:

Table 2-31. Notation List

Notation Outline

Binary number Starts with Ob and continues with the numbers from 0 to 1.
(Case insensitive for alphabets)

Octal number Starts with 0 and continues with the numbers from 0 to 7.

Decimal number Starts without 0 and continues with the numbers from O to 9.

Hexadecimal number Starts with 0x and continues with the numbers from 0 to 9 and alphabets a to f.
(Case insensitive for alphabets)
In the input area with the mark, prefix 0x is not needed.

(4) Expression and operator

Expression represents constants, CPU register name, /O register name and symbols and those connected with

operators.

An expression comes in two types: an address expression and a watch-expression. The expression that requires

the address of a symbol is referred to as an address expression, and the one that requires the value of a symbol is

referred to as a watch-expression.

(a) An address expression and operators

With an address expression, the address of a symbol is used to perform operations. Only when a CPU register

name is written, the value of the symbol is used to perform operations.

The basic input formats of address expressions are as follows:

Table 2-32. Basic Input Format of Address Expressions

Expression

Description

C/C++ variable name Note 1No 2

Address of a C/C++ variable

Expression [ExpressionN°te 3]

Address of an array

Expression.Member nameN°te 4

Address of a structure/union/class member

Expression->Member nameNote 4

Address of a structure/union/class member that is pointed to

Watch-expression.*Cast expression

Address of the pointer to a member variable

Watch-expression->*Cast expression

Address of the pointer to a member variable

CPU register name

Value of a CPU register

I/O register name

Address of an /O register

Label nameN°® 5 EQU symbol name
[immediate value]

Note 5

Address of a label, a value of an EQU symbol, and an immediate
address

Integer constant

Address

Notes 1. It represents C89, C99 and C++ variables.

2. If the register is assigned the value of a C variable, an error results.

3. The expression that is input as an index to an array is parsed as a watch-expression.

4. To specify a member variable of base class, specify scope before a member name.

(Example: variable.BaseClass::member)
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5. If a label name or EQU symbol name contains a "$," enclose the name in braces "{ }."
(Example: {$Label})
When you specify the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the
keyword "I" that indicates an imaginary number.

From "Table 2-32. Basic Input Format of Address Expressions”, the following address expressions with

operator can be constructed.

Table 2-33. Construction of Address Expressions with Operators

Expression Description
(Expression) Specifies the order in which operations are performed
-Expression Inverts sign
|Expression Logical negation
~Expression Bit inversion
Expression * ExpressionN°te Multiplication
Expression | ExpressionN°te Division

Expression % ExpressionNOte Remainder calculation
Expression + ExpressionN°te Addition
Expression - ExpressionN°te Subtraction

Expression & ExpressionN°t®

Bit-wise logical AND

Expression » ExpressionN°te

Bit-wise logical exclusive OR

Expression | ExpressionN°te

Bit-wise logical (inclusive) OR

Note Variables and functions can be combined by an operator only with variables, functions and integer
constants. (Example: C variable name + 1/O register name)

(b) Watch-expression and operator
With watch-expression, the value of a symbol is used to perform operations. Only when the value does not
exist, the address of the symbol is used to perform operations. (Example: main( ) + 1)
The basic input formats of watch-expressions are as follows:

Table 2-34. Basic Input Format of Watch-expressions

Expression

Description

C/C++ variable nameNote 1

Value of a C/C++ variable

Expression[Expression]

Element values of an array

Expression.Member nameNote 2

Member values of a structure/union/class

Expression->Member nameNote 2

Member values of the structure/union/class pointed to by a pointer

Watch-expression.*Cast expression

Value of a pointer to member variable

Watch-expression->*Cast expression

Value of a pointer to member variable

*Expression

Value of pointer variable

&Expression

Location address

CPU register name

Value of a CPU register
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Expression Description
I/O register name Value of an I/O register
Label nameN°® 3 EQU symbol nameNot© 3, Value of a label, value of an EQU symbol, value of an immediate
[immediate value] address
Integer constant Constant value of an integer
Floating constant Constant value of a floating point
Character constant Constant value of a character

Notes 1. It represents C89, C99 and C++ variables.

2. To specify a member variable of base class, specify scope before a member name.
(Example: variable.BaseClass::member)

3. If alabel name or EQU symbol name contains a "$," enclose the name in braces "{ }."
(Example: {$Label})
Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*l). When you specify
the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the keyword "I" that
indicates an imaginary number.

From "Table 2-34. Basic Input Format of Watch-expressions", the following watch-expressions with operator
can be constructed. For the operators listed in the table below, the expression is parsed according to C

language specifications.

Table 2-35. Construction of Watch-expressions with Operators

Expression Description
(Expression) Specifies the order in which operations are performed
|Expression Logical negation
~Expression Bit inversion
Expression * ExpressionN°te Multiplication
Expression | ExpressionN°te Division

Note

Expression % Expression Remainder calculation

Expression + ExpressionN°te Addition

Note

Expression - Expression Subtraction

Note

Expression & Expression Bit-wise logical AND

Note

Expression ™ Expression Bit-wise logical exclusive OR

Note

Expression | Expression Bit-wise logical (inclusive) OR

Note Variables and functions can be combined by an operator only with variables, functions and integer
constants. (Example: C variable name + 1/O register name)

2.20.2 Symbol name completion function

This function helps users input data by selecting one of the listed symbol names that exist in the program, when
specifying an address expression and so on.

The list of symbol names appears by pressing the [Ctrl] + [Space] keys when a part of the target symbol name is being
input in the text box that supports this function. In this list, double-click the target symbol name (or press the [Space]/
[Enter] key after selecting it by using the [Up]/[Down] key) to complement the symbol name currently being input.
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At this time, if a key other than the [Space]/[Enter] key is pressed or the focus moves to outside the panel/dialog box
currently being operated, then the list of symbol names will disappear (the symbol name completion will not be
performed).

Cautions 1.  If there are no character strings in the text box or there are no candidates of the symbol, then
the list of symbol names will not appear.
2. Optimization by the compiler may convert the type of a function parameter to be different from
that defined in the program (e.g. func (class Foo obj); -> func (class Foo *obj);). If this is the
case, the symbol name completion provides the function names after optimization.

Remark See the explanation of the corresponding panel/dialog box as to whether this function can be used or not
when inputting a symbol name.

Figure 2-194. Symbol Name Completion Function
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2.20.3 Icons for invalid input

In some of the dialogs provided by CubeSuite+, the () icon will appear at a point where incorrect characters are
entered as a warning sign.

Remark Placing the cursor over the (J icon will pop up the information that indicates the characters to be entered.
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2.21 Differences between the MCU and the Emulator

(1) Register Initial Value

When the emulator system is initiated, it initializes the general registers and part of the control registers as shown
in Table 2-36.. The initial values of the MCU are undefined.

Table 2-36. Register Initial Values at Emulator Link Up

Register Emulator at Link Up
RO (SP) 00000000h

R1to R15 00000000h

USP 00000000h

ISP 00000000h

PSW 00000000h

PC Value of the SP in the power-on reset vector table
INTB 00000000h

BPSW 00000000h

FINTV 00000000h
FPSwNote 2 00000100h
AccNote 1 00000000h

Notes 1. Bits 15 to 0 in the ACC register are always read as 0. Attempts at writing to those bits will be

ignored.

2. The RX111 RX210 RX21A and RX220Group MCUs do not have the floating point status word

(FPSW).

Caution If register values are changed in the [CPU Register] panel, it is immediately before the user

program starts running that the changes are actually reflected in the registers. The same

applies when the Debugger.Register.SetValue command is used to change register values. If,

after register values are changed in the [CPU Register] panel or with the

Debugger.Register.SetValue command, the CPU is reset without executing the user program

even once, the changed register values have no effect.

(2) Low-Power States

When the emulator is used, release from power-down modes can be accomplished by a source for release or by
pressing the [STOP] button, causing a break to occur.

(3) Reset Signals

If, while the user program remains halted, a reset is asserted by means of a pin reset, the reset signal is masked

off during a JTAG connection. Note, however, that during a FINE connection, it is not masked and the MCU is

reset.

Caution Do not break the user program when the RES#, or WAIT# signal is being low. A TIMEOUT error

will occur. If the WAIT# signal is fixed to low during break, a TIMEOUT error will occur at

memory access.
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(4) Direct Memory Access Controller (DMAC)
The DMAC operates even during breaks in execution. Therefore, when a data transfer request is generated, the
DMAC executes DMA transfer. Also, refer to section 2.22.7 DMAC and DTC.

(5) Using WDT
Counting by the watchdog timer is suspended during breaks in execution. When execution of the user program is
restarted, the counting is also resumed.

(6) Contention between Clock Generator Circuit-Related Register Modifications and Debug Functions
Do not change the values of clock generator circuit-related registers while the user program is under execution. For

details about the clock generator circuit-related registers, refer to the hardware manual for the MCU you’ re using.

(7) Notes on Maskable Interrupts

- Even if a user program is not being executed (including when run-time debugging is being performed), timers and
other peripherals do not stop running. If a maskable interrupt is requested when the user program is not being
executed (including when runtime debugging is being performed), the maskable interrupt request cannot be
accepted, because the emulator disables interrupts. The interrupt request is accepted immediately after the user
program execution is started.

- Take note that when the user program is not being executed (including when run-time debugging is being
performed), a peripheral I/O interruption is not accepted.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 226 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 CHAPTER 2 FUNCTIONS

2.22 Other Notes on Usage [E1] [E20] [EZ Emulator]

2.221 Internal Flash ROM

Microcontrollers that are connected to E1/E20/EZ Emulator and used in debugging are placed under stress by
repeated programming of flash memory during emulation. Do not use microcontrollers that were used in debugging in
mass-production for end users.

2.22.2 FINE interface

- The external trace output and real-time RAM monitor functions via FINE interface are not supported.
- Hot plug-ins via FINE interface are not supported.
[RX630, RX631, RX63N, RX63T]
- The FINE interface supports only a two-wire system making use of FINEC and MD/FINED pins. One-wire systems
are not supported.
[RX210, RX21A, RX220, RX111]
- The FINE interface supports a one-wire system making use of MD/FINED pin.

2.22.3 Endian select registers (MDEB, MDES) [RX630, RX631, RX63N, RX63T, RX210, RX21A, RX220, RX111]

The endian select registers (MDEB, MDES) are such that endian information you set in the [Endian] property in the
[Operating Modes of CPU] [E1] [E20] [EZ Emulator] category on the Property panel's [Connect Settings] tab (or the
[Endian of CPU] property in the [Endian] [Simulator] category on the Property panel's [Connect Settings] tab for the
simulator) is written to the register corresponding to the operation mode in which you perform debugging.

When debugging in single-chip mode, you cannot modify the endian select register S (MDES) in the Memory panel,
etc. When debugging in the user boot mode, you cannot modify the endian select register B (MDEB) in the Memory
panel, etc.

2.22.4 Option function select register 1 (OFS1) setting [RX630, RX631, RX63N, RX63T, RX210, RX21A, RX220]

- When option function select register 1 (OFS1) is modified by an operation other than downloading (e.g. editing
through the Memory panel or line assembling), the following steps are necessary to make the new setting take
effect.

(1) Modify OFS1.

(2) Start user program execution (write access to OFS1 occurs).

(3) Reset the CPU.

When OFS1 is modified by downloading, the new setting takes effect when the CPU is reset after the
downloading.

- Option function select register 1 (OFS1) allows you to enable or disable a voltage monitoring 0 reset and set a
voltage detection level. This register is located in the flash memory, so be aware that depending on settings, it may
not be controlled by E1/E20/EZ Emulator. When the flash ROM contents are modified (by downloading or through
the Memory panel), if option function select register 1 (OFS1) is set to a condition that generates a voltage
monitoring O reset, an error will occur. See the hardware manual of the microcontroller for the details of the option
function select register 1 (OFS1).

2.22.5 Option function select register 1 (OFS1) setting [RX111]

- When option function select register 1 (OFS1) is modified by an operation other than downloading (e.g. editing
through the Memory panel or line assembling), the following steps are necessary to make the new setting take
effect.

(1) Modify OFS1.
(2) Start user program execution (write access to OFS1 occurs).
(3) Reset the CPU.
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When OFS1 is modified by downloading, the new setting takes effect when the CPU is reset after the
downloading.

- The voltage monitoring 1 reset function cannot be used.
When the flash ROM contents are modified (by downloading or through the Memory panel), if the voltage
monitoring 1 reset is enabled in the option function select register 1 (OFS1), an error will occur.

2.22.6 Register values after the flash memory has been programmed

When programming of flash memory takes place (e.g. downloading of a program, setting a software breakpoint, or
modifying a value in the Memory panel), the values of the flash-memory-related registers are also rewritten by the
debugger.

2.22.7 DMAC and DTC

Do not attempt the following operations if a DMAC or DTC request is generated to the microcontroller's internal flash
ROM (the origin of the transfer) while execution of the user program is stopped.
- Setting a software breakpoint in the microcontroller's internal flash ROM area
- Writing to the microcontroller's internal flash ROM area from the Memory panel or Python console panel
- Downloading to the microcontroller's internal flash ROM area

2.22.8 High-speed clock oscillator (HOCO) [RX210, RX21A, RX220, RX111]

- The emulator uses a device’s internal high-speed clock oscillator (hereafter the HOCO) to achieve
communications with the device. Therefore, the HOCO is always in an oscillating state no matter how the HOCO-
related registers are set.

- If there is a contention between switching of the HOCO frequency and memory access, the memory access
operation is not guaranteed.

2.22.9 Lock bits [For microcontrollers with lock bits]]

(1) Clearing the lock bit before downloading
If the user program is to be downloaded into a flash ROM area for which a lock bit is set, E1/E20/EZ Emulator
clears the lock bit of the block that contains download data before it starts downloading.

(2) Restoring the lock bit after downloading
The behavior of the emulator depends on the setting of the [Debug the program re-writing the on-chip PROGRAM
ROM] property in the [System] [E1] [E20] [EZ Emulator] category on the [Debug Tool Settings] tab of the Property
panel.

<1> [Yes]:
The lock bits are restored after downloading.

<2> [No]:
The lock bits remain cleared even after downloading.

2.22.10 Flash shield window [For microcontrollers that support the flash shield window]

(1) Disabling the flash shield window before downloading
The E1/E20/EZ Emulator disables the flash shield window when it is to download a user program in the flash ROM
area that is protected from programming by the flash shield window.
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(2) Restoring the flash shield window after downloading
The behavior of the emulator depends on the setting of the [Debug the program re-writing the on-chip PROGRAM
ROM] property in the [System] [E1] [E20] [EZ Emulator] category on the [Debug Tool Settings] tab of the Property
panel.

<1> [Yes]:
The flash shield window is restored after downloading.

<2> [No]:
The flash shield window remains disabled even after downloading.

2.22.11 Operating frequency [RX630, RX631, RX63N, RX63T, RX210, RX21A, RX220, RX111]

The minimum operating frequency of the microcontrollers which can be debugged with E1/E20/EZ Emulator is 32.768
kHz.

2.22.12 Boot swap function [RX100]]

- If you wish to debug a user program that involves swapping of the boot area, select [Yes] for the [Debug the
program re-writing the on-chip PROGRAM ROM)] property in the [System] [E1] [E20] [EZ Emulator] category on
the [Debug Tool Settings] tab of the Property panel.

- If the emulator has issued the system reset signal during debugging of the user program that involves swapping of
the boot area, download the user program again before resuming debugging.

- After calling the R_FCL_ChangeSwapState function during the execution of the user program to swap the boot
area, input of the reset signal through the reset pin is not possible while the program execution is halted. Input of
the reset signal through the reset pin is only possible while the program is running.

- After calling the R_FCL_ChangeSwapFrag function during the execution of the user program, CPU reset, reset
input through the pin, and internal reset are not possible. Debugging with the swapped boot area is possible after
closing and restarting the debugger.

2.22.13 Access to the MPU area [For microcontrollers with memory-protection unit (MPU)]

The MPU area can be referred to and written to only while program execution is stopped.
If an attempt is made to access the MPU area during program execution,

- the read data will be shown as 0x00, or

- an error will occur if write access is attempted.

The following operations cannot be done in the MPU area.
- Line assembly
- Memory search
- Memory copy
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APPENDIX A WINDOW REFERENCE

This appendix describes in detail the windows, panels and dialog boxes used when debugging with CubeSuite+.

A.1 Description

The table below lists the windows, panels and dialog boxes associated with debugging.

Table A-1.

List of Window, Panel and Dialog Box

Window, panel and dialog-box names

Functional description

Main window

Controls program execution and opens each panel.

Project Tree panel

Selects the debug tool to be used.

Property panel

Displays detailed information on a debug tool selected on the Project Tree
panel and changes settings.

Editor panel

Displays or edits a text file and performs source-level debugging.

Memory panel

Displays memory values and changes values.

Disassemble panel

Displays disassembled result of memory values and performs line assembly
and instruction-level debugging.

CPU Register panel

Displays contents of CPU registers (program and system registers) and
changes values.

IOR panel

Displays contents of 1/O registers and changes values.

Local Variables panel

Displays contents of local variables and changes values.

Watch panel

Displays contents of registered watch-expressions and changes values.

Call Stack panel

Displays information on call stack used in function calls.

Trace panel

Displays trace data acquired from the debug tool.

Events panel

Displays detailed information on set events, chooses to enable or disable
events, and deletes events.

Output panel

Displays messages output by the build tool, debug tool or each plug-in, or
displays result of global search performed in Find and Replace dialog box.

Debug Console panel

Performs standard /0.

Memory Mapping dialog box

Sets memory mapping.

Download Files dialog box

Selects a file to be downloaded and sets download condition.

Text Edit dialog box

Enters or edits plural lines of text.

Action Events dialog box

Sets action events.

Encoding dialog box

Selects file encoding.

Save Settings dialog box

Sets file encoding and new-line code.

Bookmarks dialog box

Displays or deletes bookmarks.

Column Number Settings dialog box

Ses the number of view columns of memory values on the Memory panel.

Address Offset Settings dialog box

Ses an offset value for the address display on the Memory panel.

Memory Initialize dialog box

Initializes memory.

Memory Search dialog box

Searches memory.
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Window, panel and dialog-box names

Functional description

Print Address Range Settings dialog box

Sets a print range on the Disassemble panel.

Print Preview window

Previews the source file before printing.

Trace Search dialog box

Searches for trace data.

Combination Condition dialog box [E1][E20]
[EZ Emulator]

Displays the conditions for event combination and modifies the settings.

Detailed Settings of Timer Measurement dialog
box [E1] [E20] [EZ Emulator]

Displays the detailed information on timer events and modifies the settings.

Detailed Settings of Execution Events dialog
box

Displays the detailed information on execution-related events and modifies
the settings.

Detailed Settings of Access Events dialog box

Displays the detailed information on access-related events and modifies the
settings.

Detailed Settings of Interrupt Events dialog box
[Simulator]

Displays the detailed information on interrupt events and modifies the set-
tings.

Port Setting dialog box

Sets COM port in the Debug Console panel.

Scroll Range Settings dialog box

Sets a scroll range on the Memory panel/Disassemble panel.

Go to Line dialog box

Moves the caret to a specified line.

Go to the Location dialog box

Moves the caret to a specified position.

Data Save dialog box

Saves displayed content of each panel and upload data.

Progress Status dialog box

Displays progress of processing.

Option dialog box

Sets various environment parameters.

External flash memory dialog box [E1] [E20]

Selects external flash definition files (USD files).

Open Log File dialog box

Selects log files.

Select Download File dialog box

Selects a download file.

Open Watch Expression Data File dialog box

Selects a file for importing watch-expressions.

Open File dialog box

Selects a file to open.

Save As dialog box

Saves the content of a file or panel under a new name.

Select Data Save File dialog box

Selects a file in which to save data.

Open Option Setting File dialog box

Selects the option setting file to import to the Option dialog box.

Save Option Setting File dialog box

Saves the set contents of the Option dialog box to an option setting file.
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Main window

This is the first window that opens when you launch CubeSuite+.
When debugging a program, use this window to control program execution and opening of each panel.

Figure A-1. Main Window
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This section describes the following.
- [How to open]
- [Description of each area]

[How to open]

- Choose [All Programs] from Windows' [Start] menu and then select [Renesas Electronics CubeSuite+] and then
[CubeSuite+].
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[Description of each area]

(1) Menu bar
The debug-related menu items are described below.

Remark The items drawn from each menu can be customized using the User Settings dialog box.

(a) [View]
Each item on [View] menu and their functionality are as follows (default).

Watch Shows the following cascaded menu to open the Watch panel.
However, this item is disabled when CubeSuite+ is disconnected from the debug tool.
Watch1 Opens the Watch panel (Watch1).
Watch2 Opens the Watch panel (Watch2).
Watch3 Opens the Watch panel (Watch3).
Watch4 Opens the Watch panel (Watch4).
Local Variable Opens the Local Variables panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Call Stack Opens the Call Stack panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Memory Shows the following cascaded menu to open the Memory panel.
However, this item is disabled when CubeSuite+ is disconnected from the debug tool.
Memory1 Opens the Memory panel (Memory1).
Memory2 Opens the Memory panel (Memory2).
Memory3 Opens the Memory panel (Memory3).
Memory4 Opens the Memory panel (Memory4).
IOR Opens the IOR panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

CPU Register Opens the CPU Register panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Trace Opens the Trace panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Disassemble Shows the following cascaded menu to open the Disassemble panel.
However, this item is disabled when CubeSuite+ is disconnected from the debug tool.
Disassemble1 Opens the Disassemble panel (Disassemble1).
Disassemble2 Opens the Disassemble panel (Disassemble2).
Disassemble3 Opens the Disassemble panel (Disassemble3).
Disassemble4 Opens the Disassemble panel (Disassemble4).
Event Opens the Events panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Debug Console Opens the Debug Console panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.
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Show Current PC
Location

Displays the current PC position (PC register value) on the Editor panel.

However, this item is disabled when CubeSuite+ is disconnected from the debug tool.

Back to Last Cursor
Position

Moves the caret back to where it was before it jumped to a defined place (see "(7)
Jumping to functions" and "(4) Moving to a symbol definition part").

Forward to Next Cursor
Position

Moves the caret back to where it was before [Back to Last Cursor Position] was executed.

Tag Jump

If, on Editor panel or Output panel, there is file name or line/column information on the line
at which the caret exists, this menu causes a jump to the relevant line/column in the
relevant file (see "(8) Jumping to a desired line (tag jump)").

(b) [Debug]

Each item of the [Debug] menu and their functionality are as follows (default).

Download

Downloads a specified file to the debug tool currently selected in the active project.

If CubeSuite+ is disconnected from the debug tool at this time, it is automatically
connected to the debug tool before a download is executed.

However, this item is disabled during program execution or when [Build & Download] is
under execution.

Build & Download

Builds a project and executes a download to the debug tool currently selected in the
active project after the build is complete.

If CubeSuite+ is disconnected from the debug tool at this time, it is automatically
connected to the debug tool before a download is executed.

However, if a build fails, no download is executed.

Connect to Debug Tool

Connects to the debug tool currently selected in the active project.

However, if already connected with the debug tool, this item is disabled.

Hot Plug-in Hot-plugs in to the debug tool currently selected in the active project in order to debug the
[E1(JTAG)] target system currently under execution (see Section "2.4.3 Connect the debug tool to
[E20(JTAG)] CubeSuite+ using hot plug-in [E1(JTAG)] [E20(JTAG)]").

However, if already connected with the debug tool, this item is disabled.
Upload... Opens the Data Save dialog box to save memory contents to a file.

However, this item is disabled during program execution, when [Build & Download] is
under execution, or when disconnected from the debug tool.

Disconnect from Debug
Tool

Terminates communication with the currently connected debug tool.

However, this item is disabled when [Build & Download] is under execution or when
already disconnected from the debug tool.

Stop Forcibly halts the currently executed program.
However, this item is disabled when the program is already halted or disconnected from
the debug tool.

Go Runs the program from the current PC position and when the condition for a set break

event holds true, stops the program under execution.

However, this item is disabled during program execution, when [Build & Download] is
under execution, or when disconnected from the debug tool.

Ignore break and go

Runs the program from the current PC position and continues running it ignoring the
break and action events set.

However, this item is disabled during program execution, when [Build & Download] is
under execution, or when disconnected from the debug tool.
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Note 4 a time,

Step In Runs the program from the current PC position by executing one step
updating the content of each panel.

For a function call, the program stops at the beginning of a called function.

However, this item is disabled during program execution, when [Build & Download] is

under execution, or when disconnected from the debug tool.

Note

Step Over Runs the program from the current PC position by executing one step at a time,

updating the content of each panel.

For a function call by a jump to subroutine instruction, all of the source lines or instructions
in that function are executed successively in one step until a place is reached at which
control returns from the function (step execution will continue until the same nest is
formed as when a jump to subroutine instruction has been executed).

For other than a jump to subroutine instruction, the same operation as [Step In] is
selected is performed.

However, this item is disabled during program execution, when [Build & Download] is
under execution, or when disconnected from the debug tool.

Return Out Runs the program until control returns from the currently executed function (until control

returns to the calling function)Note.

However, this item is disabled during program execution, when [Build & Download] is
under execution, or when disconnected from the debug tool.

CPU Reset Resets the CPU (program is not executed).

However, this item is disabled when [Build & Download] is under execution or when
disconnected from the debug tool.

Restart Resets the CPU once and then starts running the program from the reset address.

However, this item is disabled when [Build & Download] is under execution or when
disconnected from the debug tool.

Note Step execution can be performed either at the source level or at the instruction level.
For details, see Section "2.9.3 Execute programs in steps".

(2) Debug toolbar
The debug toolbar comprises buttons each representing a command for controlling program execution.
Each button and their functionality are as follows (default).

Remarks 1.  The buttons in each toolbar can be customized using the User Settings dialog box. Also, this same
dialog box can be used to create a new toolbar.
2. Right-clicking on the toolbar displays a context menu, which allows selection of a group to be
displayed in or hidden from the toolbar.

i‘; Builds a project and, after building, downloads the file to the active project's debug tool.

If CubeSuite+ is disconnected from the debug tool at this time, it is automatically connected to the debug
tool before a download is executed.

However, if a build fails, no download is executed.

This is the same as selecting [Build and download to the debug tool] from the [Debug] menu.

— Downloads a specified file to the active project's debug tool.

If CubeSuite+ is disconnected from the debug tool at this time, it is automatically connected to the debug
tool before a download is executed.

However, this item is disabled during program execution or when [Build & Download] is under execution.

This is the same as selecting [Download] from the [Debug] menu.
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Resets the CPU (program is not executed).

However, this item is disabled when [Build & Download] is under execution or when disconnected from the
debug tool.

This is the same as selecting [CPU Reset] from the [Debug] menu.

Forcibly halts the currently executed program.
However, this item is disabled when the program is already halted or disconnected from the debug tool.

This is the same as selecting [Stop] from the [Debug] menu.

Runs the program from the current PC position and when the condition for a set break event holds true,
stops the program under execution.

However, this item is disabled during program execution, when [Build & Download] is under execution, or
when disconnected from the debug tool.

This is the same as selecting [Go] from the [Debug] menu.

(1)) Runs the program from the current PC position and continues running it ignoring the break and action
events set.

However, this item is disabled during program execution, when [Build & Download] is under execution, or
when disconnected from the debug tool.

This is the same as selecting [Ignore break and go] from the [Debug] menu.

Resets the CPU once and then starts running the program from the reset address.

However, this item is disabled when [Build & Download] is under execution or when disconnected from the
debug tool.

This is the same as selecting [Restart] from the [Debug] menu.

&= Runs the program from the current PC position by executing one stepN°te

of each panel (Step In execution).

at a time, updating the content

For a function call, the program stops at the beginning of the called function.

However, this item is disabled during program execution, when [Build & Download] is under execution, or
when disconnected from the debug tool.

This is the same as selecting [Step In] from the [Debug] menu.

L= Runs the program from the current PC position by executing one stepN°te at a time, updating the content
of each panel (step-over execution).
For a function call by a jump to subroutine instruction, all of the source lines or instructions in that function
are executed successively in one step until a place is reached at which control returns from the function
(step execution will continue until the same nest is formed as when a jump to subroutine instruction has
been executed).
For other than a jump to subroutine instruction, the same operation as the button is clicked is
performed.
However, this item is disabled during program execution, when [Build & Download] is under execution, or
when disconnected from the debug tool.
This is the same as selecting [Step Over] from the [Debug] menu.

&= Runs the program until control returns from the currently executed function (until control returns to the
calling function)N°® (Return Out execution).
However, this item is disabled during program execution, For other than a jump to subroutine instruction,
the same operation as the when [Build & Download] is under execution, or when disconnected from the
debug tool.
This is the same as selecting [Return Out] from the [Debug] menu.

Terminates communication with the currently connected debug tool.
However, this item is disabled when [Build & Download] is under execution or when already disconnected
from the debug tool.
This is the same as selecting [Disconnect from Debug Tool] from the [Debug] menu.
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Note Step execution can be performed either at the source level or at the instruction level.

For details, see Section "2.9.3 Execute programs in steps".

(3) Panel display area

This area displays various panels available.

For details about displayed contents, see the section in which the relevant panel is described.

(4) Status bar
The status bar displays the information shown below.

Figure A-2. Status Bar

IExecutes CPU reset. 3lne  1cColumnReadonly |(m)BREAK | pow Off | [ Oxffifesac | BoRXE1(TAG) | (B1.1215 E I

(a)

(b)

(c)

(d)

f T

(@) (b) (c) (d) (e) U] 9 (h)

Status message
Displays the following messages.
- Simple description of a selected menu item
- Message to notify that a value input in the panel/dialog is invalid
- Message to notify that the character string specified in the Find and Replace dialog box could not be
found
- Message to identify the cause of program break (see Section "2.10 Stop Programs (Break)")

Focus panel status information

Displays status information on the currently focused panel (e.g., information about caret position or overwrite/
insertion mode).

However, this status is hidden for panels that do not have status information.

Execution status
Shows the current execution status of a program using the following icons and character strings.
However, this status is hidden when CubeSuite+ is disconnected from the debug tool.

Program status Displayed Content
Under execution IE RUN
Now halted (m|BREAK
Step execution in progress IE STEP

CPU status [E1(JTAG)][E20(JTAG)]

Displays the current CPU status of the debug tool.

If the CPU is in several different status at the same time, each status is shown separated by "&".
However, this status is hidden when CubeSuite+ is disconnected from the debug tool.
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Debug Tool Displayed Content CPU Status
E1(JTAG) Reset Reset state
E20(JTAG) . )
Pow Off Target not supplied with power
Sleep Now in sleep mode
Standby Now in standby mode

(e)

Remark Nothing is displayed here when the CPU is in status other than those listed above.

Current PC position

Displays a hexadecimal value representing the current PC position.

Clicking this area moves the caret to the current PC position on the Editor panel.

Note that the content displayed during program execution changes according to settings in the [Register]
category on the Property panel's [Debug Tool Settings] tab, as follows:

Program state State of [PC display during the Displayed content
execution] property
While halted -- Current PC position
During execution Yes Current PC position at update intervals set in [Display

update interval for PC[ms]] property Note 1

No “Running®

Placing the cursor over this area will pop up the following information.
- Current PC: 0x current PC value (source name # number of lines
However, this status is hidden when CubeSuite+ is disconnected from the debug tool.

Note 2 )

Notes 1. [RX100 Series]
PC values are hidden because these microcontrollers do not support display of the PC value in the

status bar during program execution.
2. If this information cannot be obtained, it is substituted for by "Symbol name + Offset value".

(f) Connection status with the debug tool
Shows the current status of connection with the debug tool using the following icons and character strings.
Connection Status Displayed content
Currently connected @3 Debug tool name
Currently disconnected :=><|_- DISCONNECT
(g) Run-Break timer result
Displays the results of measurements by the Run-Break timer (see Section "2.14.2 Measuring execution
time from start to stop"). The display unit is determined by the measurement results.
However, this status is hidden when CubeSuite+ is disconnected from the debug tool.
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Status Displayed content
No measurements mode Not measured
Measurement in progress Measuring
When overflowed OVERFLOW

Remark When the EZ Emulator is in use, the status shown in the status bar is always “Not measured”
because the EZ Emulator does not support the Run-Break timer function.

(h) Debug tool status

Displays the current status of each function of the debug tool using the following icons.
However, this status is hidden when CubeSuite+ is disconnected from the debug tool.

Function In operation Not in operation (Enable) Disable

Trace

¥y ¥y

Timer

,@ ."3 -

Coverage

[Simulator]

Jd4 Jdd4
dd4d dd4
Haa mdd

Cautions 1.

[E1] [E20] [EZ Emulator]

The trace function does not go to a "Disable" state even when you click the subject
icon.

[E20(JTAG)]

When you click the icon of the trace function, the contents set in the [Usage of trace
function] property in the [Trace] category on the Property panel’s [Debug Tool Settings]
tab is toggled between Trace and Realtime RAM monitor.

[Simulator]

When the program is halted, you can click the subject icons of the trace and coverage
functions to change their "Enable™ or "Disable" state.

Also, the set contents of the following properties on Property panel’s [Debug Tool
Settings] tab toggle between Yes and No.

- [Use trace function] property in the [Trace] category

- [Use coverage function] property in the [Coverage] [Simulator] category
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Project Tree panel

This panel shows the constituent elements of the project (e.g., microcontroller, build tool, and debug tool) in tree form.
Note that the debug tools used are selected or switched from one to another on this panel.

Figure A-3. Project Tree Panel

Project Tree

[Toolbar] —

A CC-R (Build Taol)
o, R E161TAG) (Debug Tool)
g
::' Program Analyzer (Analyze Tool)
=[P File

ﬂ Tutorial.c

ﬂ dbsct.c
1 — ﬂ intprg.c
ﬂ resetprg.c
ﬂ shrk.c

ﬂ sork.c

ﬂ vecttbl.c

This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Context menu]

[How to open]

- Choose [Project Tree] from the [View] menu.
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[Description of each area]

(1) Project tree area

This area displays the project's constituent elements in tree form at the following nodes.

Node

Description

Microcontroller type Debug tool name (debug tool) - Microcontroller type
Shows the type name of a selected microcontroller (RX).

- Debug tool name

Shows the debug tool name used in the project (E1(Serial),
E1(JTAG), E20(Serial), E20(JTAG), EZ Emulator, or Simulator).
When a new project is created, "Simulator"” is set.

When a node is selected, its detailed information (properties) is displayed on the Property panel allowing the set-

tings on it to be changed. (If this panel is not open yet, double-click a node to open it.)

[Toolbar]

Displays category nodes and file names sorted in order of name (character code).

Ascending display/ descending display are switched over each time the button is clicked.

Indicates that displayed elements are not sorted in order of name (default).

Indicates that elements are displayed in descending order.

Indicates that elements are displayed in ascending order.

Displays category nodes and file names sorted in order of timestamp.

Ascending display/ descending display are switched over each time the button is clicked.

Indicates that displayed elements are not sorted in order of timestamp (default).

Indicates that elements are displayed in descending order.

Indicates that elements are displayed in ascending order.

ENEY

Displays category nodes and file names in the order specified by the user.

Indicates that elements are not displayed in customized order.

Indicates that elements are displayed in customized order (default).

Drag-and-drop a category node or file name to customize the order in which they are displayed.
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[Context menu]

Using Debug Tool Shows a cascaded menu to select the debug tool used.
Note that the debug tools displayed here differ with the microcontroller type selected
for the project (see "Table 2-1. Relationship between Types of Microcontroller and
Connectable Debug Tools").
Microcontroller type E1(Serial) Uses E1 in serial communication mode.
Microcontroller type E1(JTAG) Uses E1 in JTAG communication mode.
Microcontroller type E20(Serial) Uses E20 in serial communication mode.
Microcontroller type E20(JTAG) Uses E20 in JTAG communication mode.
Microcontroller type EZ Emulator Uses EZ Emulator.
Microcontroller type Simulator Uses the simulator.
Property Displays the properties of the selected debug tool on the Property panel.
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Property panel

This panel displays per-category detailed information about a debug tool selected on the Project Tree panel and
changes the setting made in it.

Figure A-4. Property Panel (Example When E20(JTAG) is Selected)

Property

(1){ &5 R E20[TAG] Property B

E Internal ROM/ARAM

E Clock
Main clock frequencyltiHz] 12.5000
Allow changing of the clock source on writing internal flash memony Mo
E Connection with Emulator
Ermulator serial Mo, E20: 3L5000012

EH Connectionwith T arget Board

JTAG clock[MHz] 165
E Flash
Input Mode of ID code Specify the ID code ag an ASCIl code within 16 characters
1D code
wiork FAM start address 1000

= Dperating Modes of CPU

Single-chip mode

On-chip ROM enabled extended mode w
Little-endian data

E External Flash
Esternal flash defirition fil [4]

Regizter seting
Select the operating mode which iz selected by the register setting.

3) 417 ', Connect Settings 4 Debug Tool Settings ;( Download File Settings ,{ Hoak Transackion Settings / -

This section describes the following.
- [How to open]
- [Description of each area]
- [[Edit] menu (Property Panel-Only Items)]
- [Context menu]

[How to open]

- On the Project Tree panel, select the [Microcontroller type Debug tool name (Debug Tool)] node that you use, and
then choose [Property] from the [View] menu or select it on the context menu.
- On the Project Tree panel, double-click the [Microcontroller type Debug tool name (Debug Tool)] node that you use.

Remark [f this panel is already open, detailed information on a selected debug tool is displayed on it when you select
the [Microcontroller type Debug tool name (Debug Tool)] node that you use on the Project Tree panel.

[Description of each area]

(1) Subject name area
This area displays the name of a debug tool that is selected on the Project Tree panel.
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(2) Detailed information display/change area

This area displays detailed information on a debug tool selected on the Project Tree panel in list form classified by
category, allowing you to change settings directly.
The [&] mark denotes that all property items included in the category concerned are expanded. The mark

denotes that the property items in the category are collapsed. The display can be switched between expanded and

collapsed views by clicking either of these marks or by double-clicking a category name.

Note that the mark displayed in each property item setting column denotes that the text box marked with it is

used exclusively for hexadecimal input.

For details about the displayed contents of categories and those of property items included therein, and on how to

set them, see the section in which the relevant tab is described.

(3) Tab selection area

Each time you select a tab in this area, the category for which detailed information is displayed changes from one

to another.

The following tabs are accommodated on this panel. (For details about the displayed contents on each tab, and on

how to set them, see the section in which the relevant tab is described.)

- [Connect Settings] tab
- [Debug Tool Settings] tab
- [Download File Settings] tab

- [Hook Transaction Settings] tab

[[Edit] menu (Property Panel-Only ltems)]

Undo Cancels the editing work on a property value that you've done immediately before.

Cut Cuts a selected character string and moves it to the clipboard, if you use this menu while editing a
property value.

Copy Copies the character string of a selected property value to the clipboard.

Paste Inserts the content of the clipboard into place, if you use this menu while editing a property value.

Delete Deletes a selected character string, if you use this menu while editing a property value.

Select All Selects the whole character string representing the value of a selected property, if you use this
menu while editing a property value.

[Context menu]

[Except when editing a character string]

Reset to Default

Reverts the set value of a selected property item to the default.

Reset All to Default

Reverts all set values on the currently selected tab to the default.
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[When editing a character string]

Undo Cancels the editing work on a property value that you've done immediately before.

Cut Cuts a selected character string and moves it to the clipboard, if you use this menu while editing a
property value.

Copy Copies the character string of a selected property value to the clipboard.

Paste Inserts the content of the clipboard into place, if you use this menu while editing a property value.
Delete Deletes a selected character string, if you use this menu while editing a property value.

Select All Selects the whole character string representing the value of a selected property, if you use this

menu while editing a property value.
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[Connect Settings] tab

The [Connect Settings] tab displays detailed information for each category shown below and changes settings made on

it.
(1) [Internal ROM/RAM]
(2) [Endian] [Simulator]
(3) [Clock]
(4) [Connection with Emulator] [E1] [E20]
(5) [Connection with Target Board] [E1] [E20] [EZ Emulator]
(6) [Flash] [E1] [E20] [EZ Emulator]
(7) [Operating Modes of CPU] [E1] [E20] [EZ Emulator]
(8) [External Flash] [E1] [E20]
(9) [Peripheral Function Simulation] [Simulator]
Figure A-5. Property Panel: [Connect Settings] Tab [E1(Serial)]
Property (]
S5 R E1(Serial) Fropety (- )(+]
1) > E Internal R OM/FAM
) —»E Clock
tain clock source ExTal
tain clock frequency(tMHz]
Allow changing of the clock zource on writing intemal flash memory Ma
(4) —» |2 Connection with Emulator
Ermnulatar zenial Ma. SR
®) _> E Connection with Target Board
Power target from the emulator [Mae 200md) Mo
FIME baud rate[bps] 2000000
(6) —»I&E Flash
Input Mode of 1D code Specify the ID code az a 32-digit hexadecimal
D code [F=4] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Wwiork Bak start address [Fe=] 1000
(7) —’ E Dperating Modes of CPU
Mode ping zetting Single-chip mode
Reqister zetting Single-chip made
Endian Litle-endian data
8) — ) E External Flash
Euternal flazh definitian file [4]
Size of internal ROM[KB ytes]
Size of the internal RO
S ‘Connect Settings: | Debug Tool Settings ,f Cowwnload File Settings ,f Hook Transaction Settings f -
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Figure A-6. Property Panel: [Connect Settings] Tab [E1(JTAG)]

Property
=2 RB¥E1[UTAG) Property

() —» = Clock

tain clock frequency(bMHz]

Allow changing of the clock zource on writing internal flash memary
4) —» | & Connection with Emulator

Ermulator zerial Mo,

(5) —> E Connection with T arget Board

Power target from the emulator [Mas 200ma)

JTAG clock[MHz]

(6) —» & Flash

Input Mode of ID code
D code

Wiork Bakd start address

() —»la Operating Modes of CPU
tode ping zetting
Fieqister setting

Endian
(8) —» & ExtemalFlash

Mo

B b R M
Mo

165

Specify the 1D code as a 32-digit heradecimal
[FE<] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF

[F==] 1000

Single-chip mode
Single-chip mode
Little-endian data

External flash definition file: [4]
Internal ROM/ARAM
Connect Settings 4 Debug Tool Settings /{’ Download File Settings ,f Hook Transaction Settings f -

Figure A-7. Property Panel: [Connect Settings] Tab [E20(Serial)]

Property

(3) — = Clock

Main clock zource

Main clock frequency{tHz]

Allows changing of the clock source on wiiting internal flash memary
4) — 2 Connection with Emulator

Ernulatar zerial Mo,

() —p | & Connection with T arget Board

FIME baud rate[bps]

(6) —p- 8 Flash

|nput Mode of 1D code
|0 code

Wwiork Bakd start address

(7) —> E Operating Modes of CPU
Mode ping zetting

Fegister zetting

Endian

(8) —pp- B Extemal Flash

Esternal flask definition file

Internal BOM/HAM

EXTAL
Mo

E20: 30 KM HH K

2000000

Specify the ID code az a 32-digit heradecimal
[&<] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF

[FE2] 1000

Single-chip mode
Single-chip made
Little-endian data

41

Connect Settings /  Debug Tool Settings ,{/ Download File Settings {{’ Hook, Transaction Settings f -
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Figure A-8. Property Panel: [Connect Settings] Tab [E20(JTAG)]

Property
= B E20[TAG] Property
B Internal ROMMAAM

E Clock

b ain clock source

b ain clock frequency(MHz]

Allow changing of the clock zource on writing internal flash memary
E Connection with Emulator

Emulator zerial Ho.
E Connection with T arget Board

JTAG clock[MHz]
E Flash
Ihput Mode of ID code
D code
Work, BaM start address

E 0Operating Modesz of CPU
tode pins zetting
Register setting
Endian

B External Flash

External flash definition file

Internal R OM/RAM

EWTAL

Mo

E20: MM MK MR

16.5

Specify the 1D code az & 32-digit hexadecimal

[F==] FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF

[#E=] 1000

Single-chip mode
Single-chip mode
Litle-endian data

41

.-,litnng_gg;__gettin 5:  Debug Tool Settings /{’ Download File Settings ,f Hook Transaction Settings

/

R20UT2350EJ0100 Rev.1.00 RENESAS

Mar 01, 2013

Page 248 of 506



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Figure A-9. Property Panel: [Connect Settings] Tab [EZ Emulator)]

Property ®

= R EZ Emulator Property E]

(1) —p = Internal ROMMAM

) —» I3 Clock
Main clock zource ExTAL
Main clock frequencylkHz]
Allow changing of the clock zource on wiiting internal flash memony Mo
(5) —pp |2 Connection with Target Board
Uszer Vieo[W]
FIMNE baud rate[bpsz] 1000000
(6) —pp-|E Flash
Input Mode of ID code Specify the |D code az a 32-digit hexadecimal
1D code IE' FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
otk Fah start address [FE=] 1000

(7) —pp|E Operating Modes of CPU

Endian Lite-endian data
(8) —Jpp |2 ExtemnalFlash
Esternal Hlash definition file [4]

Internal ROM/RAM

l'\-,E‘.l;_l_:_l_ll'.ll[_I_gE_I_:llg_g.l;.ll.:_i_[llgE;_..{ Debug Toaol Settings ,f Download File Settings ,{ Hook Transaction Settings / -

Figure A-10. Property Panel: [Connect Settings] Tab [Simulator]

Property

=5 B Simulator Property
(1) —»§E Internal ROMMRAM

(2) —» = Endian
Endian of CPU Little-endian data
() —» & Clock
System clock [ICLE) frequency[MHz] a0
(9) —pfE Peripheral Function Simulation
Peripheral function zsimulation module
Peripheral clock rate

Size of internal ROM[KBytes]
Dizplays the gzize of the internal ROM.

'\ i Connect Sf_-l:l:inu_:;sé_,-:;r Debug Tool Settings f Download File Sett... ,f Hook Tramsaction ... ,.f ¥
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[Description of each category]

(1) [Internal ROM/RAM]
Displays detailed information on internal ROM/RAM.

Size of internal Displays the internal ROM size of a selected microcontroller.
ROMI[Kbytes] L
Default - For products with internal ROM
Internal ROM size of a selected microcontroller
- For ROM-less products
0
How to Not changeable
change
Size of internal Displays the internal RAM size of a selected microcontroller.
RAM[Kbytes] ) ;
Default Internal RAM size of a selected microcontroller
How to Not changeable
change
Size of DataFlash Displays the size of the data flash memory area of a selected microcontroller.
memory[Kbytes] ) )
Default Data flash memory size of a selected microcontroller
[E1] [E20] [EZ
Emulator] How to Not changeable
change

(2) [Endian] [Simulator]
Displays detailed information on CPU endian and modifies its settings.

Endian of CPU Displays the microcontroller's endian.

The endian information set in properties of the build tool is acquired for display here.

Default Little-endian data
How to - For the build & debug tool
change Not changeable

- For the debug tool only

By selecting from the drop-down list
However, changeable only when disconnected from the debug tool

Specifiable - One of the following as selected from the drop-down list:
value Little-endian data or Big-endian data
R20UT2350EJ0100 Rev.1.00 RRENESAS Page 250 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

(3) [Clock]
This category displays detailed information on clock and changes clock settings.

Main clock source - For products with internal HOCO
[E1] [E20] [EZ Specify the main clock from the EXTAL frequency and internal HOCO.
Emulator]

- For products without internal HOCO
Displays EXTAL frequency as the main clock.

Default EXTAL
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable EXTAL Main clock operates as EXTAL frequency.
value
HOCO Main clock operates as internal HOCO.
Main clock Specify EXTAL frequency in MHz units.
frequency[MHz] Note that this property is enabled only when [EXTAL] is specified in the [Main clock source [E1]
[E1][E20] [EZ [E20] [EZ Emulator]] property.
Emulator]
Default Blank
How to By entering directly from the keyboard
change However, changeable only when disconnected from the debug tool
Specifiable 0.0001 to 99.9999 (in MHz)
value
Allow to change the Specify whether or not to allow manipulation of the main clock source by debugger when internal

clock source on writing | flash memory is rewritten.
internal flash memory

Default No
[E1] [E20] [EZ
Emulator] How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable Yes Manipulation of the main clock source is allowed.
value
No Manipulation of the main clock source is not allowed.

System clock (ICLK) Specify the CPU's operating clock frequency.

f MH
requency[MHz] Default - [RX600 Series]
[Simulator]
100
- [Other microcontrollers]
50
How to By entering directly from the keyboard
change However, changeable only when disconnected from the debug tool
Specifiable An integer in the range 1 to 1,000. (in MHz)
value
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(4) [Connection with Emulator] [E1] [E20]

Emulator serial No.

Select the serial No. of the emulator to be connected.

Note

Default Serial No. of the connected emulator

How to By selecting from the drop-down list

change However, changeable only when disconnected from the debug tool
Specifiable Depends on the emulator used.

value

Note When E1(JTAG) or E1(Serial) is selected in the debug tool used, serial Nos. of E1 emulator are

enumerated. Similarly, when E20(Serial) or E20(JTAG) is selected, serial Nos. of E20 emulator are

enumerated.

(5) [Connection with Target Board] [E1] [E20] [EZ Emulator]

This category displays detailed information on a state of connection with the target board and changes connection

settings.
Power target from the Specify whether power is supplied from E1 to the target system.
emulator (MAX 200mA) | The E20 does not support the power supply function. Therefore, the displayed property value is
[E1] [E20] [Nol.
Default No
How to - For [E1]
change By selecting from the drop-down list
However, changeable only when disconnected from the debug tool
- For [E20]
Not changeable
Specifiable Yes Power is supplied.
value . .
No Power is not supplied.
Supply voltage Specify the voltage supplied from E1 to the target board.
[E1] Note that this property is displayed only when you selected [Yes] in the [Power target from the
emulator (MAX 200mA) [E1] [E20]] property.
Default 3.3V
How to By selecting from the drop-down list.
change However, changeable only when disconnected from the debug tool.
Specifiable - One of the following as selected from the drop-down list: Note
value 3.3V, 5.0V
User Vcc[V] Specify the value of the microcontroller’s operating voltage that is actually supplied to the user
[EZ Emulator] board.
Default Blank
How to By entering directly from the keyboard
change However, changeable only when disconnected from the debug tool.
Specifiable 0.0001 to0 9.9999 (in V)
value
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Communication
method

Displays the communication method to be connected when communication between the emulator
and the CPU on target system is performed.

Default - [E1(JTAG)] [E20(JTAG)]
JTAG
- [E1(Serial)] [E20(Serial)] [EZ Emulator]
FINE
How to Not changeable
change

JTAG clock [MHz]
[E1(JTAG)]
[E20(JTAG)]

Specify JTAG communication speed between the emulator and the CPU on target system.

Note that this property is displayed only when [JTAG] is specified in the [Communication method]

property.

Default 16.5

How to By selecting from the drop-down list

change However, changeable only when disconnected from the debug tool
Specifiable - One of the following as selected from the drop-down list:

value

16.5, 12.38, 6.188, 3.094, 1.547

FINE baud rate[bps]

[E1(Serial)]
[E20(Serial)] [EZ
Emulator]

Specify FINE communication speed between the emulator and the CPU on target system.

Note that this property is displayed only when [FINE] is specified in the [Communication method]

property.
Default - [E1(Serial)] [E20(Serial)]

2000000

- [EZ Emulator]

1000000
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable - One of the following as selected from the drop-down list:
value

- [E1(Serial)] [E20(Serial)]

2000000, 750000, 500000, 250000
- [EZ Emulator]

1000000, 500000, 250000

Note The specifiable voltage value differs with each selected microcontroller.

(6) [Flash] [E1] [E20] [EZ Emulator]

This category displays detailed information on flash memory rewriting and changes rewrite settings.

Input Mode of ID code

Specify ID code input mode.

Default ID code specified in 32 hexadecimal digits
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable Specify the ID code Enter ID code in 32 hexadecimal digits.
value as a 32-digit

hexadecimal

Specify the ID code Enter ID code within 16 ASCII characters.
as an ASCII code

within 16 characters
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ID code

Specify ID code that is used when code in memory is read out.

Default - For [Specify the ID code as a 32-digit hexadecimal]
FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
- For [Specify the ID code as an ASCII code within 16 characters]
Blank
How to By entering directly from the keyboard
change However, changeable only when disconnected from the debug tool
Specifiable - For [Specify the ID code as a 32-digit hexadecimal]
value

32 hexadecimal digits
- For [Specify the ID code as an ASCII code within 16 characters]

16 ASCII code characters (if less than 16 characters, Os are added)

Work RAM start
address

Specify the location address of the work RAM used by the debugger.

Specify an address value that is a multiple of four bytes. If the entered value is not a multiple of four
bytes, the value is automatically corrected.

Specified bytes of space from the specified work RAM location address are used by the debugger

firmware. Note

Default Depends on the selected microcontroller

How to By entering directly from the keyboard

change However, changeable only when disconnected from the debug tool

Specifiable Address value that matches the internal RAM area of the selected microcontroller
value

Work RAM size[bytes]

Displays the size of the work RAM used by the debugger.

Default Depends on the selected microcontroller
How to Not changeable
change

Note Although this area can also be used in the user program because memory contents are saved and restored

to and from the memory of the host machine by the debugger firmware, do not specify this area as the

source or destination of transfer for the DMA or DTC function.

(7) [Operating Modes of CPU] [E1] [E20] [EZ Emulator]

Displays detailed information on the microcontroller's operation modes or changes settings made in it.

Mode pins setting

Specify the operation mode set by mode pins.

Mar 01, 2013

Default Single-chip mode
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable - One of the following as selected from the drop-down list: Note 1
value - [E1] [E20]
Single-chip mode or user boot mode
- [EZ Emulator]
Single-chip mode
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Allow erasing the USB

boot program

Specify whether to erase the USB boot program in the user boot area when you are starting up the
emulator in the user boot mode by using a microcontroller in which the USB boot program is stored.

[E1] [E20] This property is displayed only when [User boot mode] is selected for the [Mode pins setting]
property.
Default No
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable Yes Allows erasing the USB boot program in the user boot area
value
No Does not allow erasing the USB boot program in the user boot area
Register setting Specify the operation mode set by registers.
Default Single-chip mode
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable - One of the following as selected from the drop-down list: Note 1
value - [E1] [E20]
Single-chip mode, on-chip ROM enabled extended mode or on-chip ROM
disabled extended mode
- [EZ Emulator]
Single-chip mode
. : I .. Note 2
Endian Displays the project's endian.

Default Little-endian data
How to - For the build & debug tool
change Not changeable
- For the debug tool only

By selecting from the drop-down list

However, changeable only when disconnected from the debug tool
Specifiable - One of the following as selected from the drop-down list:
value

Little-endian data or big-endian data

Notes 1. The specifiable operation mode differs with each selected microcontroller.

2. If a microcontroller with an MDE pin is selected, be sure that the project's endian and the

microcontroller's MDE pin state match. If endians are different, the project and microcontroller cannot
be connected correctly.
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(8) [External Flash] [E1] [E20]
Displays detailed information on external flash or changes settings made in it.

External flash definition | Specify an external flash definition file. Note
file The number of external flash definition files that can be registered is displayed as a main property.
This property is expanded to display the file name, address range and download conditions as sub-
properties. If no external flash definition files are registered, sub-properties other than File are not
displayed.
Default - Main item
4
- Sub-items
Blank
How to - Main item
change Not changeable
- Sub-items
<File>
By selecting in the External flash memory dialog box [E1] [E20]
The External flash memory dialog box is opened by clicking the [...] button that is
displayed at the right edge in the column of this property when it is selected.
<Start address>
Not changeable
<End address>
Not changeable
<Erase external flash ROM before download>
By selecting from the drop-down list
However, changeable only when disconnected from the debug tool
Specifiable Yes The external flash ROM is erased before downloading.
value No The external flash ROM is not erased before downloading.
Display - Main item
content Number of external flash definition files
- Sub-items
By clicking the "+" mark of an external flash definition file, the definition file name,
start and end addresses, and whether to erase the external flash ROM before
downloading are displayed for each index ([1] to [4]).

Note Any settings made in this section are not reflected when the microcontroller is operating in single-chip
mode.
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(9) [Peripheral Function Simulation] [Simulator]
Displays detailed information on peripheral function simulation or changes settings made in it.

Peripheral function Displays usable peripheral function simulation modules, allowing to specify whether or not to use.

imulation modul
simiation moctle Default - Main item

<Number of usable peripheral function simulation modules>
- Sub-items

<Peripheral function simulation module name>

Not use
How to - Main item
change Not changeable
- Sub-items

Peripheral function simulation module names not changeable

Whether or not to use a peripheral function simulation module is specified by
selecting from the drop-down list

However, changeable only when disconnected from the debug tool

Specifiable Use Peripheral function simulation module is used.

value
Not Peripheral function simulation module is not used.
Use

Display - Main item

content Number of usable peripheral function simulation modules
- Sub-items

Peripheral function simulation module name
Usage status of peripheral function simulation module

Peripheral clock rate Specify the ratio of peripheral clock to internal clock (how many internal clocks one peripheral clock

is equivalent).
Default 1
How to By selecting from the drop-down list
change
Specifiable - One of the following as selected from the drop-down list:
value 1,2,3,4,6,8 12, 16, 24, 32, 64
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[Debug Tool Settings] tab

The [Debug Tool Settings] tab displays detailed information for each category shown below and changes settings made

on it.

[Memory]
[Access Memory While Running]
[Register]
[Break] [E1] [E20] [EZ Emulator]
[System] [E1] [E20] [EZ Emulator]
[Trace]
[Timer] [E1] [E20] [EZ Emulator]
[Coverage] [Simulator]
[Stream 1/0O] [Simulator]

) [Execution Mode] [Simulator]

al

N~ o~ N N~ N~~~ o~ o~
~N O
A O T =TT = —

1
1

Figure A-11.

Property [:

= A% E1(Serial Property

(1 ) —» E Memory
temory mappingz

“Werify on writing to memory
(2) —> B Access MemoryWhile Bunning
Access by stopping execution
Update the dizplay during execution
Update intervallms]
(3) _> E Register
PC dizplay during the execution
Diigplay update interval for PClmz]

(4) _> E Break
(5) —’ E System

Type of breakpaints to be preferentially used

) [Instruction Decode Cache] [Simulator]

Debug the program re-writing the on-chip PROGRAM ROM

Drebug the program re-wiiting the on-chip DATA FLASH
Execute the specified routing immediately before execution of the user program
Fioutine to run immediatelp before execution starts
Execute the specified routine immediately after the user program stops
Fioutine ta mn immediately after execution stops
E Trace

Operation after trace memary iz full
Trace data type
Olutput time stamp
Trace clock count zource[kHz]
E Timer
Use Babit counter
Operating frequency[MHz]

Timer

Property Panel: [Debug Tool Settings] Tab [E1(Serial) [RX600 Series]]

L

[231
Yes

Mo
Yes
500

Yes
500

Hardware break.
Mo

Mo

Yes

Yes

Ovenarite trace memony and continue execution
Branch
Yes

3]

Download File Settings ,{ Hook Transackion Settings /
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Figure A-12. Property Panel: [Debug Tool Settings] Tab [E1(Serial) [RX100, RX200 Series]]

2 R E1(Serial] Property

(1) —> E Memory

kemorny mappingz [23]

‘Werify on wiiting to memorny Yes
(2) —> E AccessMemory W hile Bunning

Access by stopping execution Mo

Update the dizplay during execution Yes

Update intervallms] 500
(3) —> =l Register

PC dizplay during the execution Yes

Dizplay update interval for PClms] 500

(4) —» El Break

Type of__breakpoints to be preferentially used Hardware break,
6) —p = '

Debug the program re-wiiting the on-chip PROGRAM ROM Mo
Debug the program re-wiiting the on-chip DATA FLASH Mo
Execute the specified routine immediately before execution of the user program Yes
Routine to run immediately before execution starts

Execute the zpecified routine immediately after the user program stops Yes

Routing to run immediately after execution stops

(6) —} E Trace

Operation after trace memory is full Owvenwrite trace memorny and continue execution
Trace data type Branch

(7) —» B Timer

Operating frequency[MHz]

System

\  Connect Settings ,- Debug Tool Settings Download File Settings ,{ Hook Transaction Settings / -

Figure A-13. Property Panel: [Debug Tool Settings] Tab [E1(JTAG) [RX600 Series]]

Property

24 B E1UTAG] Property E]
(1) _’ E Memory

Memony mappings [20]

“erify on writing to memaory Yes
(2) —pJ| B AccessMemory While Running

Access by stopping execution Mo

Update the display during execution Yes

Update intervallms] R00
(3) —’ = Register

PC display during the execution Yes

Display update interval for PClms] 500
(4) _’ E Break

Tupe of breakpoints ta be preferentially used Hardware break
(5) —’ E System

Debug the program re-writing the on-chip PROGRARM ROM Mo

Debug the program re-writing the on-chip DATA FLASH Mo

Execute the specified routing immediately before execution of the user pragram Yes

Foutine to run immediately before execution starts

Execute the specified routing immediately after the user program stops Yes

Routing to run immediately after execution stops

Operation after trace memory iz full Owenwrite trace memony and continue execution
Trace data type Branch
Output timestamp Yes
Trace clock count source[MHz] 12.5000
(7) —P#E Timer

Uze Bdbit counter Mo
Operating frequency[MHz] 25.0000

Trace

'\ Conneck Settings ,- Debug Tool Settings 4 Download File Settings X Haook Transaction Settings / -
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Figure A-14. Property Panel: [Debug Tool Settings] Tab [E20(Serial) [RX600 Series]]

Property
@, P E20(5 enial] Property

(1) _» E Memory

M emomny mappings
Werify on writing to mermary

(2) _’ E Access MemoryWhile Running

Access by stopping execution

Update the dizplay during execution

Update intervallms]

Enable the automatic update of realtime display

(3) —> = Register

PC dizplay during the execution
Dizplay update interval far PClms]

(4) _’ = Break

Tupe of breakpoints to be preferentially uzed

(5) —> = System

Debug the program re-writing the on-chip PROGRAM ROM
Debug the program re-writing the on-chip DaTa FLASH

Foutine to run immediately before execution starts
Execute the specified routing immediately after the user program stops
Fouting to run immediately after execution stops

(6) —> El Trace

Usage of trace function

External trace output

(7) —’ E Timer

Execute the specified routing immediately before execution of the user pragrarni Yes

3]
)

[23]
Yes

Hardware break
Mo

Mo

Yes

Real-time RAM monitor

CPU execution

Output timestamp Yes
Trace clock count zource[bHz] 12.5000
Usze B4bit counter Mo
Operating frequencutMHz] 25.0000
Usage of trace function
Select whether the trace function should be used for realtime Fakd monitoring or not.
\ Connect Settings Download File Settings ,( Hook Transaction Setkings / -

Figure A-15. Property Panel: [Debug Tool Settings] Tab [E20(Serial) [RX100, RX200 Series]]

Property
=2 AR E20[Senial) Property

(1) —P |2 Memory

tMemorny mappingz
“Werify on wiiting to memorng

(2) —> E AccessMemory W hile Bunning

Access by stopping execution
Update the display during execution
Update intervalims]

(3) —> El Register

PC dizplay during the execution
Display update interval for PC[ms]

(4) _> B Break

Type of breakpoints to be preferentially used

(5) —’ E System

Debug the program re-wiiting the on-chip PROGRARM ROM
Debug the program re-writing the on-chip DATA FLASH

Foutine to mn immediately before execution starts
Execute the specified routine immediately after the user program stops
Routine to run immediately after execution stops

Usage of trace function

Operation after trace memaony iz full
Trace data type

Esternal trace output

Trace memory size[MByte]

Output timestamp

(7) —’ E Timer

Operating frequency{Hz]

Trace

Execute the specified routine immediately before execution of the user program Yes

[23]
Tes

Hardware break

Mo
Mo

Yes

Trace

Ovwenarite trace memomn and continue execution
Data access

CPU execution

1

Mo

'\ Connect Settings ,a Debug Tool Settings

Download File Settings ,{/ Hook Transaction Settings

/ B
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Figure A-16. Property Panel: [Debug Tool Settings] Tab [E20(JTAG) [RX600 Series]]

Property
25 A E20[TAG) Property

Memory

Memary mappings

Werify on writing o memary

(2) —’ E Access Memory While Running
Access by stopping execution
Update the display during execution
Update intervallms]

Enable the automatic update of realtime display
(3) _> = Register

PC digplay during the execution
Dizplay update interval for PC[me]

(4) _» = Break

Type of breakpaints to be preferentially used

(5) —> El System

1 —p

HO

Routine to rn immediately after execution stops

Usage of hiace function

Extemal iace output

Output timestamp
Trace clock count zourcetHz]

(7) —’ E Timer

Use Bdbit counter
Operating frequency[MHz]

Trace

Debug the program re-wiiting the on-chip PROGRAM ROM Mo
Debug the program re-wiiting the on-chip DATA FLASH No
Erecute the specified routing immediately before execution of the user program Yes
Routing to n immediately before erecution starts

Execute the specified routine immediately after the user program stops Yes

[20]
Yeg

No

‘es
500
e

Yes
500

Hardware break.

Real-time RAM monitor

CPU execution

Yes
12.5000

No
25.0000

'\, Connect Settings , Debug Tool Settings 4 Download File Settings ,( Hook Transaction Settings

7 -

Figure A-17. Property Panel: [Debug Tool Settings] Tab [EZ Emulator [RX600 Series]]

Property
23, R EZ Emulator Property
(1) ’ E Memory
tdemory mappings 71
“erify an writing ta memary Yes
(2) _> B Access MemoryWhile Running
Access by stopping execution Mo
Update the display during execution Yes
Update intervallms] 500
(3) ’ = Register
PC display during the execution Yes
Dizplay update interval for PClms] 500
(4) —p |E Break
Type of breakpoints to be preferentially used Hardware break
(5) ’ = System
Diebug the program re-writing the on-chip PROGRAM ROM No
Diebug the program re-writing the on-chip DATA FLASH No
Execute the specified routing immediately before execution of the uger program Yes
Foutine to run immediately before execution starts
Execute the specified routine immediately after the user program stops Yes
Foutine to run immediately after execution stops
‘work RAM start address for executing & specified routine DDo

(6) _’ E Trace

Operation after trace memany iz full

(7) _> E Timer

Owenarite trace memary and continue execution

Trace data type Branch
Output timestamp Yes
Trace clock count source[tMHz] 12.5000
Uze B4bit counter No
Operating frequency[kHz] 25.0000
Memory
\ Connect Settings Download File Settings Hook Transaction Settings -
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Figure A-18. Property Panel: [Debug Tool Settings] Tab [EZ Emulator [RX100, RX200 Series]]

(3) —P

(4) —p
(5) —p

(6) —p

(7) —

Property
2, R EZ Emulator Property

B Memory
temary mappings
“Werify on writing ta memary
B Access Memory'While Running
Access by stopping execution
Update the display during execution
Update intervallms]
= Reagister
PC display during the execution
Dizplay update interval for PClms]
El Break
Type of breakpoints to be preferentially used
= Spstem
Debug the program re-writing the on-chip PROGRAM BOM
Diebug the program re-writing the on-chip DATA FLASH
Execute the specified routine immediately before execution of the user program
Fioutine to un immediately before execution starts
Execute the specified routing immediately after the user program stops
Routing to un immediately after execution stops
‘wiork R start address for executing a specified routine

E Trace

Operation after trace memory is full
Trace data twpe
Output timestamp
Trace clack count source[tHz]
E Timer
Operating frequencykHz]

Memory

9]
e

No
Yes
500

Yes
500

Hardware break.
No

No

Yes

Yes

Doo

Owvenwrite trace memary and continue execution
Data access

Yes

12.5000

250000

'\ Connect Settings Debug Tool Set Download File Settings ,(‘

Hook Transaction Settings /

Update dizplay during the execution
Display update intervallms]

FC dlsplé} during the execution
Dizplay update interval for PClms]

E Trace

Use trace function

Clear trace memary befare running
Operation after trace memary iz full
Accumulate trace time

Trace memory size[frames]

(8) —pp|= Coverage

Usze coverage function
Feuse coverage result

(9) —pplE Streami/n

Select stream 1/0 mode
Use stream /0 function
Stream 1/0 address

(1 O)—> E Execution Mode

(11—

Select execution mode

Stop when undefined instruction exception occurs
Stop when privileged instruction exception occurs
Stop when floating-point exception occurs

Stop when intermupt ocours

Stop IMT ingtruction is executed

Stop BRK instruction iz executed

E Instruction Decode Cache

Cache the resultz of decoding instructionz and accelerate simulation

Reqgister

Property
2% P Simulator Property B

E Memory
temary mappings
E Access MemoryWhile R unning

[16]

Yes
500

Yes
500

Yes
YVes
Mon stop and ovenwrite to trace memary
Yes
Bk

Yes
Mo

Simulator mode
Mo
=] 0

'\ Conneck Settings ,a Debug Tool Settings /4  Download File Settings ,{ Hook Transaction Settings /
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Figure A-20. Property Panel: [Debug Tool Settings] Tab [Simulator [RX100, RX200 Series]]

Property ]
2 B Simulatar Property B
(1) —» ¥
Memary mappings [19]
(2) —> E AccessMemory While Runnng
Update dizplay during the execution Tes
Display update intervallms] a00
3) —Pp| = Registes
PC dizplay during the execution Yes
Dizplay update interval for PClms] 500
(6) —> = Trace
Usze trace function Mo
Clear trace memary before running Tes
Operation after trace memory is full Mon stop and ovenwiite to trace memary
Accumulate trace time Mo
Trace memary sizelframes] B4k,
(8) —pp|E Coverage
Uze coverage function Yes
Reuse coverage result Mo
9) —p|E Stream1/0
Select stream |40 mode Simulator mods
Usze stream [/0 function Mo
Stream /0 address [FE=] 0
(1 O)_> E Execution Mode
Select execution mode Stop
Stop when undefined instruction exception occurs Yes
Stop when privileged instruction exception occurs Tes
Stop when intermipt occurs Yes
Stop INT instruction iz executed Yez
Stop BRE instruction iz executed Yes
(11 )—> = Instruction Decode Cache
Cache the results of decoding instructions and accelerate simulation MHao
Memory
'\ Cannect Settings ,.a Debug Tool Settings 4  Download File Settings 4 Hook Transaction Settings -

[Description of each category]

(1) [Memory]

This category displays detailed information on memory and changes memory settings.

For details about the displayed types of memory, see the section where the Memory Mapping dialog box is

described.

Note 1

Memory mappings

Displays the current state of memory mapping per type

of memory area.

Default [Sum total by microcontroller's inherent type of memory mapped area]

How to Specification by Memory Mapping dialog box

change The Memory Mapping dialog box is opened by clicking the [...] button that is
displayed at the right edge in the column when this property is selected.
(It is not possible to change mapping on this panel.)

Display Displays the state of memory mapping per type of memory area.

Contents

Note that when the "+" mark for each memory type is clicked, the next detailed
information is displayed.

- Memory type
- Start address
- End address

- Access width[bits] [E1] [E20] [EZ Emulator]
Note 2 Note 3

Note 2

- Endian
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Verify on writing to

Specify whether or not to perform a verify check when memory values are initialized.

memory
[E1] [E20] [EZ

Emulator]

Default Yes
How to By selecting from the drop-down list
change
Specifiable Yes A verify check is performed.
value . .

No A verify check is not performed.

Notes 1.

(2) [Access Memory While Running]

- /O register area

This refers to the type of memory-mapped areas registered in a device file.

The access width and the endian can only be changed when [Memory type] is an external area and the
debug tool is disconnected. Also, the specifiable value differs with each selected microcontroller.

The endian information differs in displayed contents and specifiable values depending on [Memory

- External area [E1] [E20] [EZ Emulator]
Specify one of the following by selecting from the drop-down list:
Same as MCU endian or different from MCU endian

One of the following is displayed:
Little-endian data or big-endian data
- Emulation ROM area and emulation RAM area [Simulator]
Specify one of the following:
Little-endian data or big-endian data
- Areas other than the above
No endian information is displayed.

This category displays detailed information on memory access during program execution and the realtime display

update function (see “(4)

memory access settings.

Displaying and changing memory contents during program execution”) and changes

Access by stopping
execution

For a memory area not accessible during program execution, specify whether access to the area is

[E1] [E20] [EZ
Emulator]

permitted.
Default No
How to By selecting from the drop-down list
change
Specifiable Yes Execution is temporarily halted before a read or write is performed.
value . ) .
No Memory is not accessed during execution.

Update display during
the execution

Specify whether or not to update the displayed content of the Watch panel/Memory panel during
program execution.

Default Yes
How to By selecting from the drop-down list
change
Specifiable Yes Display is updated during execution.
value ) . . .
No Display is not updated during execution.
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Display update Specify the interval in 100 ms unit to update the displayed contents of the Watch panel or Memory
interval[ms] panel while executing a program.

Note that this property is displayed only when you selected [Yes] in the [Update display during the
execution] property.

Default 500
How to By entering directly from the keyboard
change

Specifiable An integer in the range 100 to 65500 (Unit: fractions below 100 ms rounded up)
value

Enable the automatic Specify whether RRM area is automatically set.

update of realtime Note that this property is displayed only when [Realtime RAM Monitor] is specified in the [Usage of
display trace function] property and also [Yes] is specified in the [Update display during the execution]
[E20(JTAG) [RX600 property.
Series]]

Default Yes

How to By selecting from the drop-down list

change

Specifiable Yes Realtime display update is automatically set.

value ) ) )

No Realtime display update is not set.

(3) [Register]
Change PC value display in the Status bar and display updating intervals during program execution.

PC display during the Specify whether the PC value is displayed Note during program execution.
execution
Default No
How to By selecting from the drop-down list
change
Specifiable Yes PC value is displayed in the Status bar during execution.
value
No PC value is not displayed in the status bar during execution.
"Running" is displayed in the Status bar.

Display update interval | Specify an update interval in 100 ms units for the PC value which is displayed in the Status bar
for PC[ms] during program execution.

Note that this property is displayed only when you've selected [Yes] in the [PC display during the
execution] property.

Default 500
How to By entering directly from the keyboard.
change

Specifiable An integer in the range 100 to 65500 (Unit: fractions below 100 ms rounded up)
value

Note [RX100 Series]
PC values are hidden because these microcontrollers do not support display of the PC value in the status
bar during program execution.
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(4) [Break] [E1] [E20] [EZ Emulator]
This category displays detailed information on the break function and changes break settings.

Type of breakpoints to
be preferentially used

Specify the type of breakpoint that will be used first before the other when you set a breakpoint at the
source line or execution address by clicking once with the mouse on the Editor panel/Disassemble

panel.

Default Hardware break

How to By selecting from the drop-down list

change

Specifiable Software break A software breakpoint is set first.
value

Hardware break

A hardware breakpoint is set first.

(5) [System] [E1] [E20] [EZ Emulator]
Displays detailed information on emulation system or changes settings made in it.

Debug the program re-
writing the on-chip
PROGRAM ROM

Specify whether or not to debug a program that involves rewriting the on-chip program ROM (e.g., a
program making use of ROM P/E mode).

Note 1, Note 2, Note 3

writing the on-chip

Default No
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable Yes A program that involves rewriting the on-chip program ROM is
value debugged.
No A program that involves rewriting the on-chip program ROM is not
debugged.
Debug the program re- | Specify whether or not to debug a program that involves rewriting the on-chip data flash (e.g., a

program making use of data flash P/E mode).

Note 1, Note 2, Note 3

Mar 01, 2013

DATA FLASH
Default No
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool
Specifiable Yes A program that involves rewriting the on-chip data flash is debugged.
value
No A program that involves rewriting the on-chip data flash is not debugged.
Execute the specified Specify whether or not to run a specified routine immediately before program execution.
routine immediately
) Default No
before execution of the
user program How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes A specified routine is run immediately before program execution.
value
No A specified routine is not run immediately before program execution.
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Routine to run Specify the address to be executed immediately before program execution.
immediately before This property is displayed only when [Yes] is specified in the [Execute the specified routine
execution starts immediately before execution of the user program] property.

Default Blank

How to By entering directly from the keyboard

change However, changeable only when program execution is halted

Specifiable Depends on selected microcontroller

value

Execute the specified Specify whether or not to run a specified routine immediately after the program breaks.
routine immediately

Default No
after the user program
stops How to By selecting from the drop-down list

change However, changeable only when program execution is halted

Specifiable Yes A specified routine is run immediately program breaks.

value

No A specified routine is not run immediately after program breaks.

Routine to run Specify the address to be executed immediately after the program breaks.
immediately after This property is displayed only when [Yes] is specified in the [Execute the specified routine
execution stops immediately after the user program stops] property.

Default Blank

How to By entering directly from the keyboard

change However, changeable only when program execution is halted

Specifiable Depends on selected microcontroller

value
Work RAM start Specify the address where the work RAM for use in execution of the specified routine starts.

address for executing Specify an address value that is a multiple of four bytes. If the entered value is not a multiple of four
a specified routine bytes, the value is automatically corrected.

This property is displayed only when you have selected [Yes] either for the [Execute the specified
routine immediately before execution of the user program] or [Execute the specified routine
immediately after the user program stops] property.

Default ox1000 Note 4

How to By entering directly from the keyboard

change However, changeable only when program execution is halted
Specifiable Address in the internal RAM of the microcontroller in use
value

Work RAM size [bytes] | Indicates the size of the work RAM for use in execution of the specified routine.

for executing a This property is displayed only when you have selected [Yes] either for the [Execute the specified
specified routine routine immediately before execution of the user program] or [Execute the specified routine
immediately after the user program stops] property.

Default Depends on selected microcontroller

How to Not changeable
change

Notes 1. [E1] [E20] [EZ Emulator]
If you wish to use the Memory panel, for example, to reference data in the on-chip flash ROM (program
ROM area) that has been programmed through the user program, select [Yes] for the [Debug the
program rewriting the on-chip PROGRAM ROM] property. It is not possible to reference the latest
values when this property is set to [No].
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In the case of referencing data in the data flash area, also select [Yes] for the [Debug the program
rewriting the on-chip PROGRAM ROM] property.
2. [E1] [E20] [EZ Emulator]
While the user program is running, do not attempt to reference data (e.g. via the Memory panel) in the
on-chip flash ROM (program ROM area or data flash area) that has been programmed through the user
program. If this is attempted, incorrect values will be read out.
3. [E1/E20 [RX630(FINE), RX210, RX21A, RX220, RX111]] [EZ Emulator [RX210, RX220, RX111]]
After changing the value of the OFS1 register through the user program, resetting of the CPU, reset
input through the reset pin, and internal reset are not possible. The emulator cannot control the CPU.
4. The default value varies with the microcontroller.

(6) [Trace]
This category displays detailed information on the trace function and changes trace settings.

Caution [E20(JTAG) [RX600 Series]]
Part of the trace functions and real-time RAM monitor functions (RRM functions) can be used
only on a mutually exclusive basis.

Usage of trace function | Specify whether the trace function is used as real-time RAM monitor function (RRM function).
[E1] [E20] [EZ Default Trace
Emulator]
How to - [E1(Serial)] [E1(JTAG)] [E20(Serial)] [EZ Emulator]
change Not changeable
- [E20(JTAG)]
By selecting from the drop-down list
However, changeable only when program execution is halted
Specifiable Trace Trace function is used preferentially.
value
Realtime RAM monitor Real-time RAM monitor function (RRM function) is
used preferentially.
Use trace function Specify whether or not to use the trace functionNOte 1.
[Simulator] Default No
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes The trace function is used.
value L
No The trace function is not used.
Clear trace memory Specify whether or not to clear the trace memory before execution.
before running
Default Yes
[Simulator]
How to By selecting from the drop-down list
change
Specifiable Yes The trace memory is cleared before execution.
value
No The trace memory is not cleared before execution.
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Operation after trace Specify the operation after the trace memory is full with the collected trace data.
memory is full )
Default Non stop and overwrite to trace memory
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Non stop and overwrite Continues overwriting trace data even after trace
value to trace memory memory is used up.
Stop trace Stops overwriting trace data when trace memory is
[E1] [E20] [EZ used up.
Emulator]
Stop Stops running the program and overwriting trace data
when trace memory is used up.

Trace data type Specify the type of data to be acquired from trace.

[E1] [E20] Default Branch

[EZ Emulator]
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable One of the following as selected from the drop-down list:
value - RX600 Series

Branch, branch + data access, or data access
- RX100, RX200 Series

Branch or data access

External trace output Specify the method for trace output to external device.
[E20(JTAG) [RX600 Default CPU execution
Series]]
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable CPU execution CPU execution has priority over trace output.
value
Trace output Trace output has priority over CPU execution.
Do not output Trace information is not output.
Trace memory Specify the size of trace memory.
size[MByte
[MByte] Default 1
[E20(JTAG) [RX600
Series]] How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable - One of the following as selected from the drop-down list:
value 1,2,4,8, 16, 32
Output timestamp Specify whether timestamp information is added to the collected trace dataNOte 3.
[E1] [E20] This property is selectable only when you've specified [Trace] in the [Usage of trace function]
[EZ Emulator] property.
Default No
How to By selecting from the drop-down list
change Changeable only when program execution is halted, however.
Specifiable Yes Timestamp information is added.
value ) ; L
No Timestamp information is not added.
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Trace clock count
source[MHz]

[E1] [E20]

[EZ Emulator]

Enter a count source with which a timestamp is calculated from a count value.

However, this item is displayed only when you've selected [Yes] in the [Output timestamp] property.

Default Blank

How to By entering directly from the keyboard.
change

Specifiable 0.0001 to 999.999

value

Accumulate trace time

[Simulator]

Specify a display method by which the trace time on the Trace panel is displayed.

Trace memory
size[frames]

[Simulator]

Default No

How to By selecting from the drop-down list

change However, changeable only when program execution is halted
Specifiable Yes The trace time is displayed by an integral value.
value No The trace time is displayed by a differential value.
Specify the size of memory that holds trace data by a number of trace frames Note 2.
Default 64K

How to By selecting from the drop-down list

change

Specifiable - One of the following as selected from the drop-down list:
value

64K, 128K, 256K, 512K, 1M, 2M, 3M

Notes 1. If [Start Tracing] or [Stop Tracing] on the context menu is selected on the Editor panel/Disassemble

panel, this property is automatically changed to [Yes].

2. The trade frame represents one unit of trace data.

One trace frame is used for a fetch, write, read, etc., respectively.

3. This property is fixed to [No] when an RX100-series microcontroller is in use. Timestamp information is

not included in trace data.

(7) [Timer] [E1] [E20] [EZ Emulator]
This category displays detailed information on the timer function and changes timer settings.

Use 64bit counter
[RX600 Series]

Specify whether or not to use a 64-bit measurement counter.

However, if [Yes] is specified, measurement is performed in only one section.

Default No
How to By selecting from the drop-down list
change
Specifiable Yes One 64-bit measurement counter is used.
value _
No Two 32-bit measurement counters are used.

Operating
frequency[MHz]

Specify the operating clock frequency that is referenced when count values are converted into time.

Default Blank

How to By selecting from the drop-down list
change

Specifiable 0.0001 to 999.999 (in MHz)

value
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Caution

The RX100 Series does not support timers.

(8) [Coverage] [Simulator]

Use coverage function | Specify whether or not to use the coverage function.

Default No
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes The coverage function is used.
value L
No The coverage function is not used.

Reuse coverage result | Specify whether the coverage measurement result is loaded or saved when connected to or

disconnected from the debug tool.

This property is displayed only when you selected [Yes] in the [Use coverage function] property.

Default No

How to By selecting from the drop-down list

change

Specifiable Yes The coverage measurement result is loaded or saved.
value No The coverage measurement result is not loaded or saved.

(9) [Stream 1/O] [Simulator]

Select stream 1/0 Specify stream /O mode.
mode )
Default Simulator mode
How to By selecting from the drop-down list
change Changeable only when disconnected from the debug tool, however.
Specifiable Simulator mode A simulator-inherent I/O method is used. Standard 1/0
value and file I/O can be used.
Emulator mode An emulator-like I/0O method is used.
Only standard 1/O can be used.
Use stream 1/0 Specify whether or not to use the stream I/O function.
function This property is displayed only when [Simulator mode] is specified in the [Select stream 1/0 mode]
property.
Default No
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stream 1/O function is used.
value
No Stream 1/O function is not used.
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(10)

Stream 1/O address

Specify the start position of a stream I/O that is used to perform standard 1/O or file I/O from the user
program.

This property is displayed only when [Simulator mode] is specified in the [Select stream 1/O mode]
property.

Default 0
How to By entering directly from the keyboard
change However, changeable only when program execution is halted
Specifiable Hexadecimal number in the range 0x0 to OXFFFFFFFF
value

[Execution Mode] [Simulator]

Select execution mode

Specify whether or not to stop execution of the user program when a simulation error or an
exception occurs.

Default Stop
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Stop Stops simulation.
value ) ) . .
Continue Continues simulation.

Stop when undefined
instruction exception
occurs

Specify whether or not to stop execution of the user program when an undefined instruction
exception occurs.

This property is displayed only when [Stop] is specified in the [Select execution mode] property.

Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value . .
No Does not stop simulation.

Stop when privileged
instruction exception
occurs

Specify whether or not to stop execution of the user program when a privileged instruction exception
occurs.

This property is displayed only when [Stop] is specified in the [Select execution mode] property.

Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value } .
No Does not stop simulation.

Stop when access
exception occurs

Specify whether or not to stop execution of the user program when an access exception occurs.

This property is displayed only when there is MPU module in the [Peripheral function simulation
module] property and also [Stop] is specified in the [Select execution mode] property.

Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value . .
No Does not stop simulation.
R20UT2350EJ0100 Rev.1.00 -ZENESAS Page 272 of 506

Mar 01,

2013




CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Stop when floating- Specify whether or not to stop execution of the user program when a floating-point exception occurs.

point exception occurs | This property is displayed only when [Stop] is specified in the [Select execution mode] property.

[RX600 Series]
Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value
No Does not stop simulation.
Stop when interrupt Specify whether or not to stop execution of the user program when an interrupt occurs.
occurs This property is displayed only when [Stop] is specified in the [Select execution mode] property.
Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value - .
No Does not stop simulation.

Stop INT instruction is Specify whether or not to stop execution of the user program when an NT instruction is executed.

executed This property is displayed only when [Stop] is specified in the [Select execution mode] property.
Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value . )
No Does not stop simulation.

Stop BRK instruction is | Specify whether or not to stop execution of the user program when a BRK instruction is executed.

executed This property is displayed only when [Stop] is specified in the [Select execution mode] property.
Default Yes
How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Stops simulation.
value . .
No Does not stop simulation.

(11) [Instruction Decode Cache] [Simulator]

Cache the results of Specify whether or not to use the instruction decode cache function.
decoding instructions
Default No
and accelerate
simulation How to By selecting from the drop-down list
change However, changeable only when program execution is halted
Specifiable Yes Uses the decode cache function.
value .
No Does not use the decode cache function.
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[Download File Settings] tab

The [Download File Settings] tab displays detailed information for each category shown below and changes download
file settings.

For details on how to download, see "2.5 Download and Upload."

(1) [Download]
(2) [Debug Information]

Figure A-21. Property Panel: [Download File Settings] Tab

Property
= R E200TAG) Property

EH Download
Dowvrload files [11

CPU Reszet after dowvnload Yes

Eraze flazh ROM before download Mo

Eraze data flazh ROM before download Mo

Automnatic change method of event setting position Suspend event
El DebugInformabon

Ewecute tothe specified symbol after CPL Reset ez

Specified syrmbol _main

Download files

Specifies the file to be downloaded. The download file dialog box is opened by
preszing the [..] button. In the download file dialog box, specify the file to be downlo...

\ Connect Settings ,{’I Debug Tool Sett...}. Download Fil.. _,{Ir Hook. Transactiu:u..._}"' ¥

[Description of each category]

(1) [Download]
This category displays detailed information on download and changes download settings.

Download files Specify a file to be downloadedN"‘)te 1.

This property is expanded to display the file names to be downloaded and download conditions as a
sub-property.

Default [Number of files to be downloaded)]
How to By selecting in the Download Files dialog box.
change The Download Files dialog box is opened by clicking the [...] button that is

displayed at the right edge in the column when this property is selected. (No
download files can be specified on the Property panel.)
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CPU Reset after Specify whether or not to reset the CPU after a download.
download

Default Yes

How to By selecting from the drop-down list

change

Specifiable Yes The CPU is reset after a download.

value )

No The CPU is not reset after a download.

Erase flash ROM Specify whether or not to erase the flash ROM (program ROM) before a download.
before download

Default No
[E1] [E20] [EZ
Emulator] How to By selecting from the drop-down list

change

Specifiable Yes The flash ROM is erased before a download.

|
value No The flash ROM is not erased before a download.

Erase data flash ROM | Specify whether or not to erase the data flash ROM before a download.
before download

Default No
[E1] [E20] [EZ
Emulator] How to By selecting from the drop-down list
change
Specifiable Yes The data flash ROM is erased before a download.
value
No The data flash ROM is not erased before a download.
Automatic change Specify a method of how the set position (address) of a currently set event will be reset when it
method of event happens to be in the middle of an instruction as a result of reloadN':)te 2
setting position
ap Default Suspend event
How to By selecting from the drop-down list
change
Specifiable Move to the head of The subject event is reset to the start address of an
value instruction instruction.
Suspend event The subject event is held pending.

Notes 1. The files specified to be the subject of a build process in the main project or a subproject cannot be
removed from the subject files to be downloaded. (They are, by default, automatically registered as the
download files.)

For details about the downloadabile file formats, see “Table 2-2. Downloadable File Formats."
2. This applies to only the event set position without debug information. If debug information is available,
the event set position always moves to the beginning of a source text line.

(2) [Debug Information]
This category displays detailed information on debug information and changes debug settings.

Execute to the Specify whether or not to execute the program up to a specified symbol position after the CPU is
specified symbol after reset.
CPU Reset

Default Yes

How to By selecting from the drop-down list

change

Specifiable Yes The program is executed up to a specified symbol position.

value

No The program is not executed after the CPU is reset.
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Specified symbol Specify the position at which the program executed after the reset of the CPU is halted.

Note that this property is displayed only when you've selected [Yes] in the [Execute to the specified
symbol after CPU Reset] property.

Default _main
How to By entering directly from the keyboard
change
Specifiable 0 to "end address of address space" address expression
value
Specify the debugged If the downloaded load module has overlay sections in it, select the section to debug.
overlay section -
Default - When the load module has no overlay sections
No
- When the load module has overlay sections
Yes
How to Not changeable
change
Overlay sections Displays address groups in which overlay sections are present. From the overlay sections defined in

each address group, select the section to debug (priority section).

Note that this property is displayed only when [Yes] is specified in the [Specify the debugged overlay
section] property item.

Default None
How to - [File], [Start address], [End address] items
change Not changeable

- [Priority section] item

By selecting from the drop-down list

Display Clicking the "+" mark on any address group number displays the following detailed
content information.

The section name selected in the [Priority Section] item is the section to be
debugged.

- File
- Start address

- End address

- Priority section

Cautions 1.  The contents of overlay section-related settings are not saved in a project file. After
downloading the load module, reset the section to be debugged.
2. The information changed by an alteration of the [Priority Section] item is only debug
information. The debugger does not copy data of the subject section.
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[Hook Transaction Settings] tab

The [Hook Transaction Settings] tab displays detailed information for each category shown below and changes hook

process settings.
For details on how to set the hook process, see "2.18 Setting Up the Hook Process."

(1) [Hook Transaction Settings]

Figure A-22. Property Panel: [Hook Transaction Settings] Tab

Property
= A E20UTAG] Property

B Hook Tranzaction S
Before download Before download[0]
After download After download[0]
After CPU reset under breaking After CPU reset under breaking[0]
Before running Befare running[0]
After breaking After breaking[0]

Hook Tranzaction Settngs

Connect Setkings ,.{"I Debug Tool Settings ,.{"I Download File Setti... ,.= Hook Transactio... / ¥

[Description of each category]

(1) [Hook Transaction Settings]
This category displays detailed information on hook process and changes hook process settings.
To set properties on this tab, use the Text Edit dialog box that is opened by clicking the [...] button that is displayed
at the right edge in the column when you select any property. (Settings cannot be changed on this panel.)

Caution Up to 64 characters per process can be entered, and up to 128 processes per property can be
specified. (One line in the [Text] area of the Text Edit dialog box corresponds to one process.)
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Before download Specify a process to be executed immediately before load module files are downloaded.

Default Before download [0] (The value in "[ ]" denotes a currently specified number of
processes.)

How to By specifying in the Text Edit dialog box.
change

Format One of the following:
- I/O register name + (single byte) space + numeric value

[Process] The content of an I/O register is automatically rewritten with a numeric
value.

- CPU register name + (single byte) space + numeric value

[Process] The content of the CPU register is automatically rewritten with a
numeric value.

- Source + (single byte) space + Python script path
[Process] A script file specified by Python script path is executed.

After download Specify a process to be executed immediately after load module files are downloaded.

Default After download [0] (The value in "[ ]" denotes a currently specified number of
processes.)

How to By specifying in the Text Edit dialog box.
change

Format One of the following:
- I/O register name + (single byte) space + numeric value

[Process] The content of an 1/O register is automatically rewritten with a numeric
value.

- CPU register name + (single byte) space + numeric value

[Process] The content of the CPU register is automatically rewritten with a
numeric value.

- Source + (single byte) space + Python script path
[Process] A script file specified by Python script path is executed.

After CPU reset under | Specify a process to be executed immediately after the CPU is reset during a break.

breaking Default After CPU reset under breaking [0] (The value in "[ ]" denotes a currently specified
number of processes.)
How to By specifying in the Text Edit dialog box.
change
Format One of the following:
- I/O register name + (single byte) space + numeric value
[Process] The content of an 1/O register is automatically rewritten with a numeric
value.
- CPU register name + (single byte) space + numeric value
[Process] The content of the CPU register is automatically rewritten with a
numeric value.
- Source + (single byte) space + Python script path
[Process] A script file specified by Python script path is executed.
R20UT2350EJ0100 Rev.1.00 RENESAS Page 278 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Before running Specify a process to be executed immediately before the program is started to run.

Default Before running [0] (The value in "[ ]" denotes a currently specified number of
processes.)

How to By specifying in the Text Edit dialog box.
change

Format One of the following:
- I/O register name + (single byte) space + numeric value

[Process] The content of an I/O register is automatically rewritten with a numeric
value.

- CPU register name + (single byte) space + numeric value

[Process] The content of the CPU register is automatically rewritten with a
numeric value.

- Source + (single byte) space + Python script path
[Process] A script file specified by Python script path is executed.

After breaking Specify a process to be executed immediately after the program execution is made to break.

Default After breaking[0] (The value in "[ ]" denotes a currently specified number of
processes.)

How to By specifying in the Text Edit dialog box.

change
Format One of the following:
- I/O register name + (single byte) space + numeric value
[Process] The content of an 1/O register is automatically rewritten with a numeric
value.
- CPU register name + (single byte) space + numeric value
[Process] The content of the CPU register is automatically rewritten with a
numeric value.
- Source + (single byte) space + Python script path
[Process] A script file specified by Python script path is executed.
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Editor panel

This panel is used to display and edit files.

The source level debugging, instruction level debugging (see "2.9.3 Execute programs in steps"), and the code
coverage measurement result display [Simulator] (see "2.15 Measure Coverage [Simulator]") can be performed when
connected to the debug tool and the downloaded source file is opened in this panel.

By displaying this panel in the mixed display mode, it is also possible to display the instruction code, label, and
disassembled text corresponding to a source code (see "(1) Changing the display mode").

When opened the file encoding and newline code is automatically detected and retained when it is saved. You can
open a file with a specific encoding selected in the Encoding dialog box. If the encoding and newline code is specified in
the Save Settings dialog box then the file is saved with those settings.

This panel can be opened multiple times (max. 100 panels).

Remarks 1. When a project is closed, all of the Editor panels displaying a file being registered in the project are
closed.
2.  When afile is excluded from a project, the Editor panel displaying the file is closed.
3. A message is shown when the downloaded load module file is older than the source file to be opened.
This is due to the debug information not matching the source code being viewed.

Figure A-23. Editor Panel
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Figure A-24. Editor Panel (When Code Coverage Measurement Result Is Displayed) [Simulator]
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Figure A-25. Editor Panel (When Mixed Display Mode is Selected)
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This section describes the following.
- [How to open]
- [Description of each area]
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- [[File] menu (Editor panel-dedicated items)]

- [[Edit] menu (Editor panel-dedicated items)]

- [[Window] menu (Editor panel-dedicated items)]
- [Context menu]

[How to open]

- Automatically opens after downloading the load module file with debug information.

- On the Project Tree panel, double-click the file.

- On the Project Tree panel, select a source file, and then select [Open] from the context menu.

- On the Project Tree panel, select [Add] >> [Add New File...] from the context menu, and then create a text file or
source file.

- On the Disassemble panel, Call Stack panel, Trace panel, or Events panel, select [Jump to Source] from the
context menu.

- Automatically opens if there is a source text line correspond to the current PC value when the current PC value is
forcibly changed or the program stops executing.

[Description of each area]

(1) Title bar
The name of the opened text file or source file is displayed.
Marks displayed at the end of the file name indicate the following:

Mark Description

* The text file has been modified since being opened.

! Update time and date of the source file opened are later than the one of the downloaded load module
file.
Note that this mark is valid only when CubeSuite+ is connected to the debug tool and the
downloaded source file is opened.

[RECYCLE] The recycle mode (see "(3) Displaying multiple source files in a single panel") is valid.
Note that this mark is valid only when CubeSuite+ is connected to the debug tool and the
downloaded source file is opened.

(Read only) The opened text file is read only.

(2) Column header
The title of each column on the Editor panel is displayed. Hovering the mouse cursor over this area displays the

title name.
Display Title Name Description

Line Line Shows line numbers (see "(4) Line number area").

(No display) | Selection Color coded to indicate different line modification statuses (see "(4) Line number
area").
Note that this column is not displayed in the mixed display mode.

(No display) | Out of Date Module Colored to indicate that the source file has been updated more recently than the

Indicator corresponding load module file (see "(4) Line number area").
Note that this column is not displayed when disconnected from the debug tool or in
the mixed display mode.
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Display Title Name Description

ﬂj Coverage Shows coverage information (see "(5) Coverage area").

Note that this column is not displayed when disconnected from the debug tool.
Address Address Shows addresses (see "(6) Address area").

Note that this column is not displayed when disconnected from the debug tool.
Op Code Op Code Shows instruction codes (see "(7) Op code area").

Note that this column is displayed only in the mixed display mode.
Label Label Shows labels (see "(8) Label area").

Note that this column is displayed only in the mixed display mode.
,E Event Sets events (see "(9) Event area").

Note that this column is not displayed when disconnected from the debug tool.
T Main Sets breakpoints (see "(10) Main area").

Note that this column is not displayed when disconnected from the debug tool.

Remark The column header can be shown or hidden by selecting the menu on the toolbar.

(3) Splitter bars

The Editor panel can be displayed in split form by using the vertical and horizontal splitter bars. The Editor panel

can be split in up to two divisions vertically, and two divisions horizontally.

- To split this panel, drag the splitter bar down or to the right to the desired position, or double-click any part of

the splitter bar.

- To remove the split, double-click any part of the splitter bar.

Caution

display mode removes the split).

Figure A-26. Editor Panel (Vertical/Horizontal Two-way Split View)

j main.c

il
1]

|

The split is enabled only when this panel is in the normal display mode (setting to the mixed

BE void main (void) . 105 woid funecl () ~
90 [ * Start user 107 UINT i:
52 TMES Start(}: 109 for (i = 0; i
93 TMP1 Start(): 110 funcla
94 RD Start (}: 111 }
95 112
98 while (10T} v 113 "
0 ' 3 |[EE i >
122 roid funcz () -~ 140 & = kglobal ch A
123 [ 141
124 TUINT i: 142 [ f* Comment */
125 143 [ f* Comment */
126 for (i = 0: 1 144 [= /* Comment */
127 funcia 145
128 } 146 global a++;
125 147 global b++;
130 v 148 global c++; "
< > < >
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(4) Line number area
This area displays the line number of the opened text file or source file.
On each line there is an indicator that shows the line modification status.

0
(=]

void main (void)

—
—_
—

3 OO
10
1

/* Start user code. Do not

B
1

92 TMPO Start(}:
93 TMP1 Start(}:
34 BD Start (}:
96 while (177}

Furthermore, when the debug tool is connected and the downloaded source file is opened, the following mark will
be displayed if the update time and date of the source file opened is later than the one of the downloaded load
module file (the color of the mark depends on the "Warning" color of the [General - Font and Color] category of the
Option dialog box).

1

vold main{wvoid)

tart 1

L

fe£faedl 39 W, TMEC_ Star

(1) This means new or modified line but unsaved.

(2) This means new or modified line and saved.

To erase this mark, close the panel, and then open this source file again.

(3) I This means that the downloaded load module file is out of date.

To erase this mark, run a build and then download the load module file again.

(5) Coverage area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
When the coverage function is valid, lines corresponding to the specified coverage measurement area are shown
highlighted based on the code coverage measurement result that is acquired by executing the program (the color
depends on the configuration in the [General - Font and Color] category of the Option dialog box).
See "2.15 Measure Coverage [Simulator]" for details on the coverage measurement.
Hovering the mouse cursor over this area displays the area title "Coverage".
This area is provided with the following function.

(a) Clearing the coverage information via the menu
When you right-click in this area, the following menu below is displayed:

Clear Coverage Clears all the coverage measurement results currently being stored in the debug tool.

Information Note that this item appears only when the debug tool used supports the coverage function.

(6) Address area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
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This area shows the address corresponding to where the function is located in the memory space of the selected
microcontroller.

The format of this area is fixed as hexadecimal number notation.

The address width corresponds to the one in memory space of the specified microcontroller in the project.

(7) Op code area
This area is valid only when connected to the debug tool and the downloaded source file is opened in the mixed
display mode.
This area shows the instruction code corresponding to the source code.
Hovering the mouse cursor over this area (but not over a specific code) displays the area title "OpCode".

(8) Label area
This area is valid only when connected to the debug tool and the downloaded source file is opened in the mixed
display mode.
This area shows the label name when a label is defined for the address. Hovering the mouse cursor over this area
(but not over a specific label) displays the area title "Label".

(9) Event area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
Trace or timer events can be set at lines that have valid addresses.
In addition, the Event mark corresponding to an event that has been currently set is displayed.
Hovering the mouse cursor over this area (but not over a specific event mark) displays the area title "Event".
This area is provided with the following functions.

(a) Configuring events via the menu
When you right-click in this area, the following menu below is displayed:

Set Timer Start Event Sets a Start Timer event to start measuring the execution time of the program when the
line at caret is executed (see "2.14.3 Measuring execution time in a section").

Set Timer End Event Sets a Stop Timer event to stop measuring the execution time of the program when the
line at caret is executed (see "2.14.3 Measuring execution time in a section").

Set Trace Start Event Sets a Start Tracing event to start collecting the trace data when the line at the caret is
executed (see "2.13.3 Collecting an execution history in a section").

Set Trace End Event Sets a Stop Tracing event to stop collecting the trace data when the line at the caret is
executed (see "2.13.3 Collecting an execution history in a section").

Register Action Event... Opens the Action Events dialog box to set an action event to the corresponding
address of the line at the caret position.

(b) Changing the status of events via the menu
The events status can be changed from the following menu displayed by right-clicking the event mark.

Enable Event(s) Changes all events state to an Enabled state.
When an event is enabled and its condition is met, the event occurs.

Note that if the event mark rh_,@ denoting that there are multiple events set is selected,
all of the set breakpoints are enabled.

Disable Event(s) Changes all events state to a Disabled state.
When an event is disabled and its condition is met, the event will not occur.

Note that if the event mark rh_,Q denoting that there are multiple events set is selected,

all of the set events are disabled.
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Delete Event(s) Deletes all events.

Note that if the event mark h.il@ denoting that there are multiple events set is selected,
all of the set events are deleted.

View Details in Event Panel | Opens the Events panel to display the detailed information of the selected event.

(c) Pop-up display
By hovering the mouse cursor over the Event mark, the name of the event, the detailed information for the
event and the comments added to the event are a pop-up displayed.
When multiple events have been set in the applicable place, information for each event, up to a maximum of
three events, is listed and displayed.

Remark The detailed information about the set event is reflected in the Events panel.

(10) Main area
This area is valid only when the user is connected to the debug tool and the downloaded source file is opened.
Breakpoints can be set at lines that have valid addresses.
In addition, the Event mark corresponding to a breakpoint that has been currently set is displayed.
The current PC mark ( ) that corresponds to the current PC position (PC register value) is displayed.
Note that the current PC mark is only displayed if the current PC value corresponds to the source text line, when
the current PC position is modified or the state of the debug tool is changed from execution to stop.
Hovering the mouse cursor over this area (but not over a specific event mark) will display the area title "Main".
This area is provided with the following functions.

(a) Setting/deleting breakpoints
By clicking where you want to set a breakpoint with mouse, the breakpoints can be set easily.
The breakpoint is set to the instruction at the start address corresponding to the clicked line.
Once a breakpoint is set, an Event mark is displayed at the line that is set. In addition, the detailed information
about the set breakpoint is reflected in the Events panel.
When this operation is performed at a place where any one of the event marks is already being displayed, that
event is deleted and the setting of breakpoints cannot be done.
See "2.10.2 Stop the program at the arbitrary position (breakpoint)" for details on how to set the breakpoint.

(b) Configuring breakpoints via the menu
When you right-click in this area, the following menu below is displayed:

Set Breakpoint Sets a breakpoint to the line at the caret position (see "2.10.2 Stop the program at the
arbitrary position (breakpoint)").

[E1] [E20] [EZ Emulator]

By default the debug tool will set a hardware break when resources are available.

This behavior can be customized by using the "Hardware Break First [E1] [E20] [EZ
Emulator]" or "Software Break First [E1] [E20] [EZ Emulator]" menu items.

Set Hardware Breakpoint Sets a breakpoint (Hardware Break event) to the line at the caret position.
[E1] [E20] [EZ Emulator]

Set Software Breakpoint Sets a breakpoint (Software Break event) to the line at the caret position.
[E1] [E20] [EZ Emulator]

Hardware Break First The type of break that can be set by a one click operation of the mouse is set as a
[E1] [E20] [EZ Emulator] hardware breakpoint (this is reflected in the setting of the [Type of breakpoints to be
preferentially used] property in the [Break] [E1] [E20] [EZ Emulator] category from the
[Debug Tool Settings] tab on the Property panel).
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Software Break First The type of break that can be set by a one click operation of the mouse is set as a
[E1] [E20] [EZ Emulator] software breakpoint (this is reflected in the setting of the [Type of breakpoints to be
preferentially used] property in the [Break] [E1] [E20] [EZ Emulator] category from the
[Debug Tool Settings] tab on the Property panel).

(c) Changing the status of breakpoints via the menu
The events status can be changed from the following menu displayed by right-clicking the Event mark.

Enable Breakpoint Changes the selected breakpoint state to an Enabled state.
The program breaks when the specified condition is met.

When the event mark (,hi,@ ) which indicates that multiple events have been set is
selected, all of the breakpoints that have been set are enabled.

Disable Breakpoint Changes the selected breakpoint state to a Disabled state.
The program does not break when the specified condition is met.

When the event mark (,hi,@' ) which indicates that multiple events have been set is
selected, all of the breakpoints that have been set are disabled.

Delete Breakpoint Deletes the selected breakpoint.

When the event mark (,hi,@ ) which indicates that multiple events have been set is
selected, all of the breakpoints that have been set are deleted.

View Details in Event Panel | Opens the Events panel to display the detailed information of the selected breakpoints.

(d) Pop-up display
By hovering the mouse cursor over the Event mark, the name of the event, the detailed information for the
event and the comments added to the event are a pop-up displayed.
When multiple events have been set in the applicable place, information for each event, up to a maximum of
three events, is listed and displayed.

Remark The detailed information about the set event is reflected in the Events panel.

(11) Characters area
This area displays character strings of text files and source files and you can edit it.
This area has the following functions.

(a) Code outlining
This allows you to expand and collapse source code blocks so that you can concentrate on the areas of code
which you are currently modifying or debugging. This is only available for only C and C++ source file types.
This is achieved by clicking the plus and minus symbols to the left of the Characters area.
Types of source code blocks that can be expanded or collapsed are:

Open and close braces ('{' and '}) Hi ...}
Multi-line comments ('/*' and /') | ==
Pre-processor statements (if', 'elif', 'else’, 'endif') H#if|[Preprocessor block])
H$elif|{[Preprocessor block]|
H$else|[Preprocessor block]|
fendif

Caution This will be disabled for source files larger than 1MB.
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(b) Characters editing
Characters can be entered from the keyboard.
Various shortcut keys can be used to enhance the edit function.

(c) Tag jump
If the information of a file name, a line number and a column number exists in the line at the caret position,
selecting [Tag Jump] from the [View] menu or from the context menu opens the file in the Editor panel and
jumps to the corresponding line and the corresponding column (if the target file is already opened in the Editor
panel, you can jump to the panel).
See "Table 2-4. Operation of Tag Jump" for details on the operation of the tag jump.

(d) Current PC line display
When the current PC position (PC register value) corresponds to the source text lines, those lines are shown
highlighted (the highlighting color depends on the configuration in the [General - Font and Color] category of
the Option dialog box).
This function is only enabled when connected to the debug tool and the source file is opened.

(e) Lines with breakpoints display
Lines where the breakpoints are set are shown highlighted (the highlighting color depends on the configuration
in the [General - Font and Color] category of the Option dialog box).
This function is only enabled when connected to the debug tool and the source file is opened.

(f) Code coverage measurement result display [Simulator]
When the coverage function is valid, lines corresponding to the specified coverage measurement area are
shown highlighted based on the code coverage measurement result that is acquired by executing the program
(the highlighting color depends on the configuration in the [General - Font and Color] category of the Option
dialog box).
See "2.15 Measure Coverage [Simulator]" for details on the coverage measurement.
This function is only enabled when connected to the debug tool and the source file is opened.

(g) Pop-up display of variables
When hovering the mouse cursor over a variable in the source text, a pop-up that shows the name and value
of the variable is displayed ("<variable name>=<variable value>").
The display format of the variable value is same as "Table A-10. Display Form of Watch-expressions
(Default)" depending on the type of the variable.
This function is only enabled when connected to the debug tool and the source file is opened.

(h) Setting of various events
Various events can be set to the addresses or lines where the caret currently exists by selecting [Break
Settings], [Trace Settings] or [Timer Settings] from the context menu.
The corresponding Event mark is displayed in the Main area or Event area by setting the event. In addition, the
detailed information about the set event is reflected in the Events panel.
This function is only enabled when connected to the debug tool and the source file is opened.
See the following for details on how to set events.
-"2.10.3 Stop the program at the arbitrary position (break event) [E1] [E20] [EZ Emulator]"
-"2.10.4 Stop the program with the access to variables/I/O registers"
- "2.13.3 Collecting an execution history in a section"
- "2.13.4 Collecting an execution history only when conditions are met"
- "2.14.3 Measuring execution time in a section"
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Remark A breakpoint can be set or deleted easily in the Main area as well (see "(a) Setting/deleting
breakpoints").

(i) Registering watch-expression
Variable names of C/C++ language, CPU registers, 1/O registers, and assembler symbols can be registered in
the Watch panel as watch-expressions.
See "(1) Registering watch-expressions" for details on how to operate it.
This function is only enabled when connected to the debug tool and the source file is opened.

(j) File monitor
The following function for monitoring is provided to manage source files.
- A message is displayed when the downloaded load module file is older than the source file to open.
- If the contents of the currently displayed file have been changed without using CubeSuite+, a message
will appear asking you whether you wish to save the file or not.

(k) Selecting blocks
You can select a block that consists of multiple lines by any one of the following methods:
- Drag the left-mouse button while holding down the [Alt] key.
- Press the [Right], [Left], [Up], or [Down] key while holding down the [Alt] + [Shift] key

1
I

void main (wvoid

= /* Start user code. Do not

TMPO Start():
TMP1 Start(}):
BD Start ():

while (1T7)

Remark Editing of the selected block can be done by using [Cut], [Copy], [Paste], or [Delete] in the [Edit]
menu.

() Zoom in or out on a view
You can zoom in and out of the editor view by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).

Remark The following items can be customized by setting the Option dialog box.
- Display fonts
- Tab interval
- Show or hide whitespace marks
- Colors of reserved words/comments
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[Toolbar]

Toggles between normal (default) and mixed display mode, as the display mode of this panel (see
"(1) Changing the display mode"). Clicking this button sets to the mixed display mode.

Note that this item is enabled only when connected to the debug tool and the downloaded source
file is opened in this panel.

Toggles between source (default) and instruction level, as the unit in which the program is step-
executed (see "2.9.3 Execute programs in steps"). Clicking this button sets the unit of a step
execution to instruction level (the current PC mark will be moved to a disassembled text line).
Note that this item is enabled only when connected to the debug tool and the mixed display mode
is selected.

D Displays the current PC position.

Note that this item is enabled only when connected to the debug tool.

Forwards to the position before operating [Context menu] >> [Back To Last Cursor Position].
Note that this item is disabled when the mixed display mode is selected.

Goes back to the position before operating [Context menu] >> [Jump to Function].

Note that this item is disabled when the mixed display mode is selected.
Columns The following items are displayed to show or hide the columns or marks on all of the Editor panels.
Remove the check to hide the items (all the items are checked by default).
Line Number Shows the line number, in the line number area.
Selection Shows the mark that indicates the line modification status, in the line number area.
Out of date module Shows the mark that indicates the update status of the downloaded load module file, in the line
indicator number area.
Note that this item is enabled only when connected to the debug tool.
Coverage Shows the coverage area.
Note that this item is enabled only when connected to the debug tool.
Address Shows the address area.
Note that this item is enabled only when connected to the debug tool.
Op Code Shows the instruction code area.
Note that this item is enabled only when connected to the debug tool and the mixed display mode
is selected.
Label Shows the label area.
Note that this item is enabled only when connected to the debug tool and the mixed display mode
is selected.
Event Shows the event area.
Note that this item is enabled only when connected to the debug tool.
Main Shows the main area.
Note that this item is enabled only when connected to the debug tool.
Column Header Shows the column header.
R20UT2350EJ0100 Rev.1.00 -ZEN ESNS Page 290 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

[[File] menu (Editor panel-dedicated items)]

The following items are exclusive for the [File] menu in the Editor panel (other items are common to all the panels).

Close file name Closes the currently editing Editor panel.

When the contents of the panel have not been saved, a confirmation message is shown.

Save file name Overwrites the contents of the currently editing Editor panel.

Note that when the file has never been saved or the file is read only, the same operation is applied
as the selection in [Save file name As...].

Note that this item is disabled when this panel is in the mixed display mode.

Save file name As... Opens the Save As dialog box to newly save the contents of the currently editing Editor panel.

Note that this item is disabled when this panel is in the mixed display mode.

File name Save Opens the Save Settings dialog box to change the encoding and newline code of the file being
Settings... opened in the currently editing Editor panel.

Print... Opens the Windows dialog box for printing the contents of the currently editing Editor panel.
Print Preview Opens the Print Preview window to preview the file contents to be printed.

[[Edit] menu (Editor panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Editor panel (other items are all invalid).

Undo Cancels the previous operation and restores the characters and the caret position (up to 100
times).

Note that this item is disabled when this panel is in the mixed display mode.

Redo Cancels the previous [Undo] operation and restores the characters and the caret position.

Note that this item is disabled when this panel is in the mixed display mode.

Cut Cuts the selected character string and copies it to the clipboard.
If there is no selection, the entire line is cut.

Note that this item is disabled when this panel is in the mixed display mode.

Copy Copies the contents of the selected range to the clipboard as character string(s).

If there is no selection, the entire line is copied.

Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied on the clip
board into the caret position.

Note that this item is disabled when the contents of the clipboard are not recognized as characters or
this panel is in the mixed display mode.

Delete Deletes one character at the caret position.
When there is a selection area, all the characters in the area are deleted.

Note that this item is disabled when this panel is in the mixed display mode.

Select All Selects all the characters from beginning to the end in the currently editing text file.

Note that this item is disabled when this panel is in the mixed display mode.

Find... Opens the Find and Replace dialog box, with its [Quick Find] tab selected.

Replace... Opens the Find and Replace dialog box, with its [Quick Replace] tab selected.

Note that this item is disabled when this panel is in the mixed display mode.

Go To... Opens the Go to Line dialog box to move the caret to the specified line.
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Outlining

Displays a cascading menu for controlling expand and collapse states of source file outlining (see
"(a) Code outlining").

Note that this item is disabled when this panel is in the mixed display mode.

Collapse to Definitions

Collapses all nodes that are marked as implementation blocks (e.g. function definitions).

Toggle Outlining
Expansion

Toggles the current state of the innermost outlining section in which the cursor lies when you are in a
nested collapsed section.

Toggle All Outlining

Toggles the collapsed state of all outlining nodes, setting them all to the same expanded or
collapsed state.

If there is a mixture of collapsed and expanded nodes, all nodes will be expanded.

Stop Outlining

Stops code outlining and remove all outlining information from source files.

Start Automatic Starts automatic code outlining and automatically displayed in supported source files.
Outlining
Advanced Displays a cascading menu for performing an advanced operation for the Editor panel.

Note that this item is disabled when this panel is in the mixed display mode.

Increase Line Indent

Increases the indentation of the current cursor line by one tab.

Decrease Line Indent

Decreases the indentation of the current cursor line by one tab.

Uncomment Lines

Removes the first set of line-comment delimiters from the start of the current cursor line, appropriate to the
current language (e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Comment Lines

Places line-comment delimiters at the start of the current cursor line, appropriate to the current language
(e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Convert Tabs to Spaces

Converts all tabs on the current cursor line into spaces.

Convert Spaces to Tabs

Converts each set of consecutive space characters on the current line to tab characters, but only for those
sets of spaces that are at least equal to one tab size.

Tabify Selected Lines

Tabifies the current line, causing all spaces at the start of the line (prior to any text) to be converted to tabs
where possible.

Untabify Selected Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to be converted to
spaces.

Make Uppercase

Converts all letters within the selection to uppercase.

Make Lowercase

Converts all letters within the selection to lowercase.

Toggle Character
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selection.

Capitalize

Capitalizes the first character of every word within the selection.

Delete Horizontal

Deletes any excess white space either side of the cursor position, leaving only one whitespace character

Whitespace remaining.

If there the cursor is within a word or not surrounded by whitespace, this operation will have no effect.
Trim Trailing Deletes any trailing whitespace that appears after the last non-whitespace character on the cursor line.
Whitespace
Delete Line Completely delete the current cursor line.

Duplicate Line

Duplicates the cursor line, inserting a copy of the line immediately after the cursor line.

Delete Blank Lines

Deletes the line at the cursor if it is empty or contains only whitespace.
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[[Window] menu (Editor panel-dedicated items)]

The following items are exclusive for the [Window] menu in the Editor panel (other items are common to all the panels).

Split Splits the active Editor panel horizontally.
Only the active Editor panel can be split. Other panels will not be split. A panel can be split up to
two times.

Remove Split Removes the split view of the Editor panel.

[Context menu]
[Title bar area]
Close Panel Closes the currently selected panel.
Close All but This Closes all other panels being displayed in the same panel display area as the selected panel,

except for the currently selected panel.

Save file name Saves the contents of the opened text file.

Copy Full Path Copies the full path of the opened text file to the clipboard.

Open Containing Folder Opens the folder where the text file is saved in Explorer.

New Horizontal Tab The area for the display of active panels is evenly divided into two areas in the horizontal direction,
Group and the panels are displayed as a new group of tabbed pages. Only one panel is active in the new
group. The area may be divided into up to four panels.

This item is not displayed in the following cases.
- Only one panel is open.
- The group has already been divided in the vertical direction.

- The group has already been divided into four panels.

New Vertical Tab Group The area for the display of active panels is evenly divided into two areas in the vertical direction,
and the panels are displayed as a new group of tabbed pages. Only one panel is active in the new
group. The area may be divided into up to four panels.

This item is not displayed in the following cases.
- Only one panel is open.
- The group has already been divided in the horizontal direction.

- The group has already been divided into four panels.

Go to Next Tab Group When the display area is divided in the horizontal direction, this moves the displayed panel to the
group under that displaying the selected panel.

When the display area is divided in the vertical direction, this moves the displayed panel to the
group to the right of that displaying the selected panel.

This item is not displayed if there is no group in the given direction.

Go to Previous Tab Group | When the display area is divided in the horizontal direction, this moves the displayed panel to the
group over that displaying the selected panel.

When the display area is divided in the vertical direction, this moves the displayed panel to the
group to the left of that displaying the selected panel.

This item is not displayed if there is no group in the given direction.
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[Characters area (when disconnected from the debug tool]

Cut Cuts the selected character string and copies it to the clipboard.
If there is no selection, the entire line is cut.
Copy Copies the contents of the selected range to the clipboard as character string(s).
If there is no selection, the entire line is copied.
Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied on the clip
board into the caret position.
When the contents of the clipboard are not recognized as characters, the operation is invalid.
Find... Opens the Find and Replace dialog box, with its [Quick Find] tab selected.
Go To... Opens the Go to Line dialog box to move the caret to the specified line.

Forward to Next Cursor
Position

Forwards to the position before operating [Back To Last Cursor Position].

Back to Last Cursor
Position

Goes back to the position before operating [Jump to Function].

Jump to Function

Jumps to the function that is selected or at the caret position regarding the selected characters and
the words at the caret position as functions (see "(7) Jumping to functions").

Tag Jump

Jumps to the corresponding line and column in the corresponding file if the information of a file
name, a line number and a column number exists in the line at the caret position (see "(c) Tag

jump?).
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Advanced

Displays a cascading menu for performing an advanced operation for the Editor panel.

Increase Line Indent

Increases the indentation of the current cursor line by one tab.

Decrease Line Indent

Decreases the indentation of the current cursor line by one tab.

Uncomment Lines

Removes the first set of line-comment delimiters from the start of the current cursor line, appropriate to the
current language (e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Comment Lines

Places line-comment delimiters at the start of the current cursor line, appropriate to the current language
(e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Convert Tabs to Spaces

Converts all tabs on the current cursor line into spaces.

Convert Spaces to Tabs

Converts each set of consecutive space characters on the current line to tab characters, but only for those
sets of spaces that are at least equal to one tab size.

Tabify Selected Lines

Tabifies the current line, causing all spaces at the start of the line (prior to any text) to be converted to tabs
where possible.

Untabify Selected Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to be converted to
spaces.

Make Uppercase

Converts all letters within the selection to uppercase.

Make Lowercase

Converts all letters within the selection to lowercase.

Toggle Character
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selection.

Capitalize

Capitalizes the first character of every word within the selection.

Delete Horizontal

Deletes any excess white space either side of the cursor position, leaving only one whitespace character

Whitespace remaining.

If there the cursor is within a word or not surrounded by whitespace, this operation will have no effect.
Trim Trailing Deletes any trailing whitespace that appears after the last non-whitespace character on the cursor line.
Whitespace
Delete Line Completely delete the current cursor line.

Duplicate Line

Duplicates the cursor line, inserting a copy of the line immediately after the cursor line.

Delete Blank Lines

Deletes the line at the cursor if it is empty or contains only whitespace.

[Characters area/Line number area (when connected to the debug tool)]

Register to Watch1

Registers a selected character string or a word at the caret position to the Watch panel (Watch1)
as a watch-expression (the judgment of the word depends on current build tool).

Note that this item becomes invalid when no corresponding address exists in the line at caret.

Register to Analysis Chart

Registers a selected character string or a word at the caret position to the Analysis Chart panel of
the analysis tool as a variable. If variables have been already registered to all channels, a
message is displayed and this operation will have no effect.

Note that this item is disabled when the active project does not support a plug-in of the analyze
tool.

Register Action Event...

Opens the Action Events dialog box to set an action event to the corresponding address of the line
at the caret positionNote 1,

Note that this item becomes invalid when no corresponding address exists in the line at caret.
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Cut Cuts the selected character string and copies it to the clipboard.
If there is no selection, the entire line is cut.

Note that this item is disabled when this panel is in the mixed display mode.

Copy Copies the contents of the selected range to the clipboard as character string(s).

If there is no selection, the entire line is copied.

Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied on the clip
board into the caret position.

Note that this item is disabled when the contents of the clipboard are not recognized as characters or
or this panel is in the mixed display mode.

Find... Opens the Find and Replace dialog box, with its [Quick Find] tab selected.

Go To... Opens the Go to Line dialog box to move the caret to the specified line.

Forward To Next Cursor Forwards to the position before operating [Back To Last Cursor Position].

Position Note that this item is disabled when this panel is in the mixed display mode.

Back To Last Cursor Goes back to the position before operating [Jump to Function].

Position Note that this item is disabled when this panel is in the mixed display mode.

Go to Here Executes the program from the address indicated by the current PC value to the address

corresponding to the line at the caret positionN°te 1.

If the corresponding address of the line at the caret position does not exist, the program is
executed to the corresponding address of the lower valid line.

Note that this item becomes invalid during execution of a program/[Build & Download].
Note 1

Set PC to Here Sets the address of the line at the current caret position to the current PC value

Note that this item becomes invalid when no corresponding address exists in the line at caret, or
during execution of a program/[Build & Download].

Jump to Function Jumps to the function that is selected or at the caret position regarding the selected characters and
the words at the caret position as functions (see "(7) Jumping to functions").

Tag Jump Jumps to the corresponding line and column in the corresponding file if the information of a file
name, a line number and a column number exists in the line at the caret position (see "(c) Tag
jump”).

Jump to Disassemble Opens the Disassemble panel and jumps to the address corresponding to the line at the caretNote 1.

Note that this item becomes invalid when no corresponding address exists in the line at caret.
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Advanced

Displays a cascading menu for performing an advanced operation for the Editor panel.

Note that this item is disabled when this panel is in the mixed display mode.

Increase Line Indent

Increases the indentation of the current cursor line by one tab.

Decrease Line Indent

Decreases the indentation of the current cursor line by one tab.

Uncomment Lines

Removes the first set of line-comment delimiters from the start of the current cursor line, appropriate to the
current language (e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Comment Lines

Places line-comment delimiters at the start of the current cursor line, appropriate to the current language
(e.g. C++).

This operation will only be available when the language of the current source file has line-comment
delimiters specified (e.g. C++).

Convert Tabs to Spaces

Converts all tabs on the current cursor line into spaces.

Convert Spaces to Tabs

Converts each set of consecutive space characters on the current line to tab characters, but only for those
sets of spaces that are at least equal to one tab size.

Tabify Selected Lines

Tabifies the current line, causing all spaces at the start of the line (prior to any text) to be converted to tabs
where possible.

Untabify Selected Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to be converted to
spaces.

Make Uppercase

Converts all letters within the selection to uppercase.

Make Lowercase

Converts all letters within the selection to lowercase.

Toggle Character
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selection.

Capitalize

Capitalizes the first character of every word within the selection.

Delete Horizontal

Deletes any excess white space either side of the cursor position, leaving only one whitespace character

Whitespace remaining.

If there the cursor is within a word or not surrounded by whitespace, this operation will have no effect.
Trim Trailing Deletes any trailing whitespace that appears after the last non-whitespace character on the cursor line.
Whitespace
Delete Line Completely delete the current cursor line.

Duplicate Line

Duplicates the cursor line, inserting a copy of the line immediately after the cursor line.

Delete Blank Lines

Deletes the line at the cursor if it is empty or contains only whitespace.
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Break Settings The following cascade menus are displayed to set the break-related event.

Note that events can be set only for lines for which events can be set (see "(9) Event area").

Set Hardware Break Sets a breakpoint (Hardware Break event) to the line at the caret position (see "2.10.2 Stop the
program at the arbitrary position (breakpoint)")Nme 1

Set Software Break Sets a breakpoint (Software Break event) to the line at the caret position (see "2.10.2 Stop the

[E1] [E20] [EZ program at the arbitrary position (breakpoint)“)Note 1.

Emulator]

Set Read Break to Sets a break event with read access condition to the line at the caret or the selected variable

[Simulator] (global variable/static variable inside a function/static variable inside a file)/I/O register (see "(1)

Set a break event (access-related) to a variable/l/O register").

Set Write Break to Sets a break event with write access condition to the line at the caret or the selected variable
[Simulator] (global variable/static variable inside a function/static variable inside a file)/I/O register (see "(1)
Set a break event (access-related) to a variable/I/O register").

Set R/W Break to Sets a break event with read/write access condition to the line at the caret or the selected variable
[Simulator] (global variable/static variable inside a function/static variable inside a file)/I/O register (see "(1)
Set a break event (access-related) to a variable/I/O register").

Set Combination Break | Sets a break at the caret position's address or the caret position or a selected variable (global
[E1] [E20] [EZ variable, static variable inside a function, static variable inside a file) or I/O register as the condition
Emulator] for a combination break event (see "(1) Set a beak event (execution-related)").

Set Read Combination Sets a break event by a read access to the caret position or a selected variable (global variable,

Break to static variable inside a function, static variable inside a file) or I/O register as the condition for a
[E1] [E20] [EZ combination break (see "(1) Set a break event (access-related) to a variable/I/O register").
Emulator]

Set Write Combination Sets a break event by a write access to the caret position or a selected variable (global variable,

Break to static variable inside a function, static variable inside a file) or I/O register as the condition for a
[E1] [E20] [EZ combination break (see "(1) Set a break event (access-related) to a variable/I/O register").
Emulator]
Set R/W Combination Sets a break event by a read/write access to the caret position or a selected variable (global
Break to variable, static variable inside a function, static variable inside a file) or /O register as the condition
[E1] [E20] [EZ for a combination break (see "(1) Set a break event (access-related) to a variable/I/O register").
Emulator]
Break Option Opens the Property panel to set the break function.
R20UT2350EJ0100 Rev.1.00 -ZENESAS Page 298 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Trace Settings The following cascade menus are displayed to set the trace-related event.

Note that events can be set only for lines for which events can be set (see "(9) Event area").

Start Tracing Sets a Start Tracing event to start collecting the trace data when an instruction of an address at the
caret position is executed (see "(1) Setting a trace start event and a trace end event") Note 1.
[Simulator]

In addition, the selecting of the [Use trace function] property in the [Trace] category from the

[Debug Tool Settings] tab on the Property panel is automatically set to [Yes].

Stop Tracing Sets a Stop Tracing event to stop collecting the trace data when an instruction of an address at the
caret position is executed (see "(1) Setting a trace start event and a trace end event") Note 1.
[Simulator]

In addition, the selecting of the [Use trace function] property in the [Trace] category from the

[Debug Tool Settings] tab on the Property panel is automatically set to [Yes].

Record Reading Value Sets a Point Trace event to record the access value as the trace data when the address at the
caret or the selected variable (global variable/static variable inside a function/static variable inside
a file)/I/O register is read accessed (see "(1) When an access to a variable or /O register
occurred").

Record Writing Value Sets a Point Trace event to record the access value as the trace data when the address at the
caret or the selected variable (global variable/static variable inside a function/static variable inside
a file)/I/O register is write accessed (see "(1) When an access to a variable or I/O register
occurred").

Record R/W Value Sets a Point Trace event to record the access value as the trace data when the address at the
caret or the selected variable (global variable/static variable inside a function/static variable inside
a file)/I/O register is read/ write accessed (see "(1) When an access to a variable or I/O register
occurred").

Record Start R/W Value | Sets a trace event that causes trace recording to start upon read/write access to the caret position or a
selected variable (global variable, static variable inside a function, static variable inside a file) or /0
register

(see"(1) Setting a trace start event and a trace end event").

Record End R/W Value | Sets a trace event that causes trace recording to end upon read/write access to the caret position or a
selected variable (global variable, static variable inside a function, static variable inside a file) or /O
register

(see "(1) Setting a trace start event and a trace end event").

Show Trace Result Opens the Trace panel and displays the last line of the acquired trace data.

Trace Settings Opens the Property panel to set the trace function.

However, this is disabled while the tracer is operating.
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Timer SettingsN°te 2 The following cascade menus are displayed to set the timer-related event (see "2.14.3 Measuring
execution time in a section").
Note that events can be set only for lines for which events can be set (see "(9) Event area").
Start timer Sets a Start Timer event to start measuring the execution time of the program when the line at
caret is executedN°te 1 (see "(a) How to set a timer start event").
Stop timer Sets a Stop Timer event to stop measuring the execution time of the program when the line at
caret is executedN°te 1 (see "(b) How to set a timer end event").
Set Timer Start R/'W Sets a timer start event that causes a measurement of the program's execution time to start upon
Value read/write access to the caret position or a selected variable (global variable, static variable inside
a function, static variable inside a file) or I/O register (see "(a) How to set a timer start event").
Set Timer <N> Specify a channelN°te 3 in which a timer start event is set.
[E1] [E20] [EZ
Emulator]
Set Timer End R/W Sets a timer end event that causes a measurement of the program's execution time to finish upon
Value read/write access to the caret position or a selected variable (global variable, static variable inside
a function, static variable inside a file) or I/O register (see "(b) How to set a timer end event").
Set Timer <N> Specify a channelN°t® 3 in which a timer start event is set.
[E1] [E20] [EZ
Emulator]
View Result of Timer Opens the Events panel and displays only timer-related events.
Clear Coverage Clears all the coverage measurement results currently being stored in the debug tool.
Information Note that this item appears only when the debug tool used supports the coverage function.
[Simulator]

Notes 1. A message is displayed if these items are selected when the downloaded load module file is older than the
opened source file.
2. [E1] [E20] [EZ Emulator]
The RX100 Series does not support timers.
3. The specifiable number of channels differs between the RX600 and RX200 Series, as shown below.
RX600 Series; 2 (32 bits * 2) or 1 (64 bits * 1)
RX200 Series: 1 (24 bits * 1)
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Memory panel

This panel displays or changes memory contents (see Section "2.11.1 Displaying and changing memory contents").

Up to four memory panels can be opened at a time, with each panel discriminated by the name in their title bar,
"Memory 1," "Memory 2," "Memory 3," or "Memory 4."

When memory values change after execution of the program, the display is automatically updated. (During step
execution, the display is successively updated each time a step is executed.)

Also, if the Realtime display update function is enabled, the display of values can be updated in real time, even while
the program is under execution.

Note that this panel can only be opened when CubeSuite+ is connected with the debug tool.

Remark In a Scroll Range Settings dialog box that is opened by selecting [View] and then clicking the
button in the toolbar, it is possible to set the scroll range of the vertical scroll bar of this panel.

Figure A-27. Memory Panel
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (Memory panel-Only ltems)]
- [[Edit] menu (Memory panel-Only Items)]
- [Context Menu]

[How to open]

- Choose [Memory] from the [View] menu and then select [Memory 1-4].

[Description of each area]

(1) Display position specification area
By specifying an address expression, it is possible to specify the display start position of memory values.
Make the following specifications in order.
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(a) Specify address expressions

Enter an address expression for the address of the memory value to be displayed directly in the text box. Input

expressions in up to 1,024 characters each can be specified, with their calculation result handled as a display

start position.

However, address expressions greater than the microcontroller's address space cannot be specified.

Remarks 1.

By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the

present caret position (see "2.20.2 Symbol name completion function").

In cases where the specified address expression represents a symbol and the size is known, a

range of memory from the start address to end address of that symbol is selected when displayed.

(b) Specify whether to evaluate address expression manually or automatically

The [Move when Stop] checkbox and the [Move] buttons are used to determine the timing with which the

display start position is changed.

[Move when Stop]

The address expression is automatically evaluated after the program has halted and the
caret moves to the address derived from that calculation.

O

The address expression is not automatically evaluated after the program has halted. In this
case, the address expression is evaluated by clicking the [Move] button.

[Move] button

If the [Move when Stop] checkbox is not checked, the address expression is evaluated
by clicking this button and the caret moves to the address derived from that calculation.

(2) Address area
This area displays memory addresses (always in hexadecimal).

The display starts from address 0x0 by default.

However, an offset value of the start address can be set via the Address Offset Settings dialog box that is opened

by selecting [Address Offset Value Settings...] from the context menu.

The address width matches that of the microcontroller's memory space specified in the project.

This area cannot be edited.

Caution The offset value that has been set is automatically changed in accordance with the number of

view columns in the Memory value area.

(3) Memory value area

This area displays or changes memory values for the program mapped to the microcontroller.

To specify the display notation, display width of memory values, and the number of view columns, use the toolbar

buttons or select [Notation], [Size Notation], and [View] from the context menu, respectively (see “(2) Changing

the display form of values®).

The following table describes the meaning of marks and colors used to represent memory values (The colors in

which text and backgrounds are displayed depend on how the [General - Font and Color] category of the Option

dialog box is set.).

(Underlined)

Example display (default) Description
on Text color Blue Memory values that have been changed by the user (Pressing the
[Enter] key will write them into the target memory)
Background color | Standard color
ag Text color Standard color | Memory values at addresses for which symbols are defined

Background color

(Watch-expressions can be registered.) (See Register watch-

Standard color )
expressions.)
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Example display (default) Description
on Text color Sienna Memory values that have changed as a result of program execution
Note 1
Background color | LightYellow :
Clicking the [@&] button in the toolbar resets the highlighting.
oo Text color DeepPink Memory values for which the Realtime display update function is
enabled
Background color | Standard color
(] Text color Standard color | Read/ Current access condition of the memory value when
Fetch the Realtime display update function is enabled
Background color | PaleGreen pay up
oo Text color Standard color | Write
Background color | Orange
oo Text color Standard color | Read and
) Write
Background color | PaleTurquoise
Text color White Lost
Background color | LightGray
oo Text color Gray Memory values of not-readable area
Background color | Standard color
7 Text color Gray Areas not memory-mapped or areas not rewritable (e.g., 10 register
and I/O protection areas N 2) or when acquisition of memory
Background color | Standard color )
values failed
> Text color Standard color | When areas other than the Realtime display update area are
selected for display during program execution or when acquisition
Background color | Standard color ]
of memory values failed

Notes 1. Applicable only to the memory values in the address area that was displayed on the Memory panel
immediately before the program execution. As the comparison is made before and after the program
execution, highlighting will not be used if the value remained unchanged.

2. [E1][E20] [EZ Emulator]
The value of each I/O protection area is displayed as 00.

Caution The number of view columns is automatically changed in accordance with the set value of [Size
Notation] of the context menu.

This area has the following features.

(a) Popup display
When the mouse cursor is placed on top of a memory value, the following content is displayed in a popup box,
relative to the symbol nearest in forward direction to the address indicated by the mouse cursor.
However, if symbol information is nonexistent (i.e., if the memory value is not underlined), no popup is

displayed.
variable + 0x14
Symbol name Offset value
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(b)

(c)

(d)

(e)

Symbol name A symbol name is displayed.

Offset value If the address has no symbols defined, an offset from the symbol nearest in forward to it is
displayed (always in hexadecimal).

Realtime display update function

Using the realtime display update function, it is possible to display or change memory values even while the
program is under execution, not just when the program is halted.

For details about the realtime display update function, see "(4) Displaying and changing memory contents
during program execution."”

Edit memory values

You can edit a memory value directly from the keyboard by simply moving the caret to the memory value you
wish to change.

When a memory value is edited, the altered part of it changes in display color. While in this state, hit the [Enter]
key, and the changed value is written into the target memory (Pressing the [Esc] key before pressing [Enter]
key cancels editing.).

For details on how to change memory values, see "(3) Changing memory contents."

Search and initialize memory values

Open the Memory Search dialog box in which you can search memory contents in the specified address area
by selecting [Find...] from the context menu (see "(5) Searching for memory contents").

Also, selecting [Fill...] from the context menu will open the Memory Initialize dialog box in which you can
collectively modify memory contents in the specified address range (see "(6) Collectively changing
(initializing) memory contents").

Copy and paste

By selecting a range of memory values with the mouse, you can copy the content of the selected part as a
character string to the clipboard, and then paste it to the caret position.

To perform these operations, select the appropriate item from the context menu or from the [Edit] menu.
Note that pasting is possible only when the display format (notation and bit width) of the character string
matches that of the area to which it is pasted (A message will appear if the formats do not agree).

The following table shows the character code and character strings that can be used in this area (A message
will appear when a character string other than those listed here is pasted.).

Character code ASCII

Character string 0,1,2,3,4,5,6,7,8,9,a,b,c,d,e,f, A,B,C,D,E, F

(f) Register watch-expressions

A memory value at the addresses for which symbol is defined is underlined to indicate that it can be registered

as a watch-expression.

Select this underlined memory value, or while the caret is positioned at one of such memory values, select

[Register to Watch1] from the context menu, and the symbol name at the specified address is registered as a

watch-expression on the Watch panel (Watch1).

Caution Memory values with no underlines cannot be registered as watch-expressions.
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(9)

(h)

Save memory values

Choosing [Save Memory Data As...] from the [File] menu opens the Data Save dialog box, allowing the
contents of this panel to be saved to a text file (*.txt) or CSV file (*.csv).

For details on how to save memory values, see "(7) Saving displayed memory contents".

Zoom in or out on a view
To zoom in and out of the Memory panel view, change the zoom ratio by using the drop-down list on the
toolbar of the Main window while the focus is placed in the Memory panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).

(4) Character string area

This area displays memory values converted into character code.

To specify character code, click the appropriate toolbar button or select [Encoding] from the context menu (ASCII

code is selected by default).

Furthermore, in this area, memory values converted into a floating-point value can be displayed as character

strings. To do this, select the following item from [Encoding] of the context menu.

Iltem Display Format Size
Float Single-precision floating-point value 32-bit
Numeric value <sign><mantissa>e<sign><exponent>
Infinite number Inf, and -Inf
Not a number NaN
Example +1.234567e+123
Double Double-precision floating-point value 64-bit
Numeric value <sign><mantissa>e<sign><exponent>
Infinite number Inf, and -Inf
Not a number NaN
Example +1.2345678901234e+123
Float Complex Complex number of single-precision floating-point 64-bit

<Single-precision floating-point value> <Single-precision floating-point value> * |

Double Complex Complex number of double-precision floating-point 128-bit

<Double-precision floating-point value> <Double-precision floating-point value> * |

Float Imaginary Imaginary number of single-precision floating-point 32-bit

<Single-precision floating-point value> * |

Double Imaginary Imaginary number of double-precision floating-point 64-bit

<Double-precision floating-point value> * |
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Caution Nothing is displayed when the minimum size of a character code or a floating-point value is

greater than "the number of bytes of display width of memory values™ x "the number of view
columns”.

This area has the following features.

(a) Edit character strings
Character strings can be changed only when [ASCII] is specified for the character code.

You can edit a character string directly from the keyboard by simply moving the caret to the character string
you wish to change.

When a character string is edited, the altered part of it changes in display color. While in this state, hit the

[Enter] key, and the changed value is written into the target memory. (Pressing the [Esc] key before pressing
[Enter] key cancels editing.)

Caution Character strings displayed as floating-point values cannot be edited.

(b) Searching character strings

The Memory Search dialog box is opened to search for character strings by selecting [Find...] from the context
menu (see "(5) Searching for memory contents").

(c) Copying and pasting
By selecting a range of character strings with the mouse, you can copy it to the clipboard as character strings
and then paste it to the caret position.
To perform these operations, select the appropriate item from the context menu or from the [Edit] menu.

Note that pasting is possible only when [ASCII] is specified for the character code (If any other character code
is specified, a message is displayed.).

[Toolbar]
E]| Obtains latest information from the debug tool and updates display.
Resets the highlighting that indicates the spot whose value has changed as a result of program execution.
However, this button is disabled during program execution.
Notation Shows the following buttons that change the form in which memory values are displayed.
However, these buttons are disabled during program execution.
Displays memory values in hexadecimal (default).
Displays memory values in signed decimal.
Displays memory values in unsigned decimal.
Displays memory values in octal.
Displays memory values in binary.
Size Notation Shows the following buttons that change the form in which memory value size is displayed.
However, these buttons are disabled during program execution.
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Displays memory values in 4-bit width.
Displays memory values in 8-bit width (default).
Displays memory values in 16-bit width.

The value is converted according to the endian in the target memory area.

E Displays memory values in 32-bit width.

The value is converted according to the endian in the target memory area.

Displays memory values in 64-bit width.

The value is converted according to the endian in the target memory area.

Encoding Shows the following buttons that change the encoding in which character strings are displayed.

However, these buttons are disabled during program execution.

Displays character strings in ASCII code (default).

Displays character strings in Shift_JIS code.

Displays character strings in EUC-JP code.

Displays character strings in UTF-8 code.

Displays character strings in UTF-16 code.

Displays character strings as a single-precision floating-point value.

Displays character strings as a double-precision floating-point value.

Displays character strings as a complex number of single-precision floating-point.

Displays character strings as a complex number of double-precision floating-point.

Displays character strings as an imaginary number of single-precision floating-point.

'?..'.’,,i: Displays character strings as an imaginary number of double-precision floating-point.
View Shows the following buttons that change the display form.
5] Opens the Scroll Range Settings dialog box to set the scroll range.
Column Opens the Column Number Settings dialog box to set the number of view columns in the Memory value area.
Number
Settings...
Address Opens the Address Offset Settings dialog box to set an address and an offset value for addresses displayed
Offset in the Address area.
Value
Settings...

[[File] menu (Memory panel-Only Items)]

The [File] menu used exclusively for the Memory panel is as follows. (The other items are shared.)
However, all of these items are disabled during program execution.

Save Memory Data Saves memory contents to a text file (*.txt) or CSV file (*.csv) that has been saved previously (see
"(g) Save memory values").

If this item is selected for the first time after startup, the same operation as [Save Memory Data As
...] will be performed.

Save Memory Data As... Opens the Data Save dialog box in order to save memory to a specified text file (*.txt) or CSV file
(*.csv) (see "(g) Save memory values").
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[[Edit] menu (Memory panel-Only Items)]

The [Edit] menu used exclusively for the Memory panel is as follows. (All other items are disabled.)
However, all of these items are disabled during program execution.

Copy Copies a selected range as character string to the clipboard.

Paste Pastes the copied character string from the clipboard to the caret position.
- To paste in the memory value area, see "(e) Copy and paste".

- To paste in the character string area, see "(c) Copying and pasting”.

Find... Opens the Memory Search dialog box.

A search is performed within the Memory value area or the Character string area whichever has
the caret in it.

[Context Menu]

Register to Watch1 Registers the symbol at the caret position on the Watch panel (Watch1).

When symbols are registered as watch-expressions, they are registered as variable names.
Because of this, displayed symbol names vary by scope.

However, if the address corresponding to the memory value at the caret position has no symbols
defined, this menu is disabled (see "(f) Register watch-expressions").

Find... Opens the Memory Search dialog box.

A search is performed within the Memory value area or Character string area (unless the floating-
point value display is selected) whichever has the caret in it.

However, this menu is disabled during program execution.

Fill... Opens the Memory Initialize dialog box.
Refresh Obtains latest information from the debug tool and updates the display.
Copy Copies a selected range as character string to the clipboard.

However, this menu is disabled during program execution.

Paste Pastes the copied character string from the clipboard to the caret position.
However, this menu is disabled during program execution.
- To paste in the memory value area, see "(e) Copy and paste".

- To paste in the character string area, see "(c) Copying and pasting”.

Notation Shows the following cascaded menu to specify the display notation in the memory value area.

However, this menu is disabled during program execution.

Hexadecimal Displays memory values in hexadecimal (default).
Signed Decimal Displays memory values in signed decimal.
Unsigned Decimal Displays memory values in unsigned decimal.
Octal Displays memory values in octal.
Binary Displays memory values in binary.
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Size Notation

Shows the following cascaded menu to specify the display width in the memory value area.

However, this menu is disabled during program execution.

4 Bits Displays memory values in 4-bit width.
1 Byte Displays memory values in 8-bit width (default).
2 Bytes Displays memory values in 16-bit width.
The value is converted according to the endian in the target memory area.
4 Bytes Displays memory values in 32-bit width.
The value is converted according to the endian in the target memory area.
8 Bytes Displays memory values in 64-bit width.
The value is converted according to the endian in the target memory area.
Encoding Shows the following cascaded menu to specify the display form in the character string area.
However, this menu is disabled during program execution.
ASCII Displays character strings in ASCII code (default).
Shift_JIS Displays character strings in Shift_JIS code.
EUC-JP Displays character strings in EUC-JP code.
UTF-8 Displays character strings in UTF-8 code.
UTF-16 Displays character strings in UTF-16 code.
Float Displays character strings as a single-precision floating-point value.
Double Displays character strings as a double-precision floating-point value.
Float Complex Displays character strings as a complex number of single-precision floating-point.
Double Complex Displays character strings as a complex number of double-precision floating-point.
Float Imaginary Displays character strings as an imaginary number of single-precision floating-point.
Double Imaginary Displays character strings as an imaginary number of double-precision floating-point.
View Shows the following cascaded menu to change the display form.
Settings Scroll Range... | Opens the Scroll Range Settings dialog box to set the scroll range.
Column Number Opens the Column Number Settings dialog box to set the number of view columns in the Memory
Settings... value area.
Address Offset Value Opens the Address Offset Settings dialog box to set an offset value for addresses displayed in the
Settings... Address area.

Highlight Accessed

Checking this menu will highlight the memory value which has been changed due to program
execution (default).

However, this menu is disabled during program execution.

Periodic Updating

Shows the following cascaded menu to set realtime display updates (see "(b)
update function").

Realtime display

Periodic Updating
Options

Opens the Property panel to comprehensively set the Realtime display update.
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Disassemble panel

This panel displays the disassembled results of memory contents (disassembled text), as well as displays the results of
line assemble (see "2.6.4 Performing line assembly"), instruction-level debugging (see "2.9.3 Execute programs in
steps"), and code coverage measurements [Simulator] (see "2.15 Measure Coverage [Simulator]").

Up to four instances of this panel can be displayed at a time. Each panel is discriminated by the name "Disassemble1,"
"Disassemble2," "Disassemble3," and "Disassemble4" in the title bar.

By displaying this panel in mixed display mode, it is also possible to display the source text in a source file
corresponding to code data (default).

Note that this panel can only be opened when Cube Suite+ is connected with the debug tool.

Caution If a program is stepped through while the focus exists on this panel, the program is executed one
instruction at a time. (See "2.9.3 Execute programs in steps.")

Remarks 1.  In a Scroll Range Settings dialog box that is opened by selecting [View] and then clicking the
button in the toolbar, it is possible to set the scroll range of the vertical scroll bar of this panel.
2. By choosing [Print...] from the [File] menu, it is possible to print the picture image currently being
displayed on this panel.

Figure A-28. Disassemble Panel (When Displayed in Mixed Display Mode)
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[Tombaﬂ—{:

Figure A-29. Disassemble Panel (When Mixed Display Mode is Turned Off)
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Figure A-30. Disassemble Panel (When Code Coverage Measurement Result is Displayed) [Simulator]
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Disassemble Panel-Only ltems)]

- [[Edit] menu (Disassemble Panel-Only Items)]

- [Context menu]
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[How to open]

- Choose [Disassemble] from the [View] menu and then select [Disassemble 7 - 4]

[Description of each area]

(1) Event area
The lines where an event can be set are displayed against a white background. (If a line is displayed against a gray
background, it means that no events can be set on that line.)
If there is a currently set event on a line, an Event mark denoting the type of event is displayed on the line.
This area has the following features:

(a) Setting/clearing a breakpoint
Click a place with the mouse where you want to set a breakpoint. That way, it is possible to set a breakpoint
easily.
A breakpoint is set in an instruction at the beginning address corresponding to the line position you've clicked.
When a breakpoint is set, an Event mark is displayed on the line where you've set the breakpoint. Also,
detailed information on the set breakpoint is reflected on the Events panel.
Note that if you've done this operation at a place where any event mark is already displayed, the event is
deleted and no breakpoint is set.
Also note that an event can be set on only a line that is displayed against a white background.
For details on how to set a breakpoint, see "2.10.2 Stop the program at the arbitrary position (breakpoint)."

(b) Altering states of various events
Right-clicking any event mark brings up the menu shown below, allowing you to change the state of a selected
event.

Enable Event Changes the state of a selected event to an Enabled state.
When a specified condition is true, the event concerned occurs.

Note that if the event mark rh_,@ denoting that there are multiple events set is selected,
all of the set events are enabled.

Disable Event Changes the state of a selected event to a Disabled state.
Even when a specified condition is true, the event concerned does not occur.

Note that if the event mark rh_,Q denoting that there are multiple events set is selected,
all of the set events are disabled.

Delete Event Deletes a selected event.

Note that if the event mark rh_,@ denoting that there are multiple events set is selected,
all of the set events are deleted.

View Details in Event Panel | Opens an Events panel that shows detailed information on a selected event.

(c) Popup display
When the mouse cursor is hovered over an Event mark, the event name of the event, detailed information on
it, and the comment added to the event are displayed in a popup box.
Note that if there are multiple events set at the relevant place, information on each event, for up to three, is
enumerated.

(2) Address area
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This area displays the beginning address of disassembly on each line (always displayed in hexadecimal).

Also, the current PC mark (I ») denoting the current PC position (PC register value) is displayed.

The address width is equal to that of the memory space of the microcontroller that is specified in the project.

Note that, for the source text line during mixed display mode, a line number (xxx:) in a source file corresponding to
the beginning address is displayed.

This area has the following features:

(a) Popup display
When the mouse cursor is hovered over an address/source line number, the following information is displayed
in a popup box.

Address Format: <load module name>N°®$<jabel name> + <offset value>
Example1: test1.out$main + 0x10

Example2: sub function + 0x20

Source line number Format: <load module name>N°€$<file name> # <line number>

Example1: test1.out$main.c#40

Example2: main.c#100

Note The load module name is displayed only when there are multiple load module files that have been
downloaded.

(3) Disassemble area
Following the source text line concerned, a disassembled result line is displayed as shown below.

Figure A-31. Contents of Displayed Disassemble Area (When Displayed in Mixed Display Mode)

woid change [ long *a)
Label line —p| change:
Current PC line —p 7F100ds ADD #-25H, RO, RO
for(i=0; i<10; i++) 4
Breakpoint set line —p|+3 G622 Mo . L #OLH, RZ
+5 =ef03 MO . L RO, B3
+7 =f14 MOV, L S
Source text line—_ twp[il = alil:
+9 fdZzads MO, L [Fd+] , B5
Disassembled result line { +o £dzZ=235 MOWT . L RE5, [R3+]
+1 601z SUE #1H, RZ
Offset value Instruction code Instruction
Label line Shows a label name, if a label is defined at the address, and highlights the entire line in pale
green color.
Current PC line Highlights a line corresponding to the address of the current PC position (PC register
vaIue).N°te 1
Breakpoint set line Highlights a line where a breakpoint is set.Note 1
Source text line Shows source text corresponding to code data.Note 2
Disassembled | Offset value Shows an offset value from the nearest label, if no labels are defined at the address.Note 3
result line ) ) . .
Instruction Shows the code that was disassembled in hexadecimal.
code
Instruction Shows an instruction resulting from disassembly. The mnemonic is highlighted in blue.
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Notes 1. The highlighting color depends on how the [General - Font and Color] category in the Option dialog box

are set.

2. By clicking the button (toggle) in the toolbar or unchecking [Mixed Display] on the context menu, it
is possible to hide the source text. (By default, this menu item is checked.)

3. The offset value is, by default, not displayed. To show it, click the button in the toolbar or select
[Show Offset] on the context menu.

This area has the following features:

(a)

(b)

(c)

(d)

(e)

Line assembly
The displayed instruction/code can be edited (assembled in-line).
For details on how to do it, see "2.6.4 Performing line assembly."

Program execution at instruction level

By stepping through a program while the focus exists on this panel, it is possible to control program execution
at the instruction level.

For details on how to do it, see "2.9.3 Execute programs in steps."

Setting various events
By selecting [Break Settings], [Trace Settings] or [Timer Settings] on the context menu, it is possible to set
various events at the address or line at which the caret currently exits.
When an event is set, the corresponding Event mark is displayed in the Event area. Also, detailed information
on the set event is reflected on the Events panel.
However, events can only be set on a line that is displayed against a white background in the event area.
For details on how to set an event, see the following sections:

- "2.10.3 Stop the program at the arbitrary position (break event) [E1] [E20] [EZ Emulator]"

-"2.10.4 Stop the program with the access to variables/I/O registers"

- "2.13.3 Collecting an execution history in a section"

- "2.13.4 Collecting an execution history only when conditions are met"

- "2.14.3 Measuring execution time in a section"

Remark Breakpoints can also be set or cleared easily in the Event area. (See "(a) Setting/clearing a
breakpoint.")

Registering a watch-expression

The displayed C variable, CPU register, I/O register or assembler symbol can be registered as a watch-
expression in the Watch panel.

For details on how to do it, see "(1) Registering watch-expressions."

Moving to a symbol defined location

While the caret has been moved to an instruction that references a symbol, click the button in the toolbar
or select [Go to Symbol] on the context menu. The caret position is moved to the address at which the symbol
at the caret position is defined.

Also, following this operation, click the button in the toolbar or select [Back to Address] on the context
menu. The caret position is returned to the instruction that was referencing the symbol before the caret was
moved. (Address denotes the address value of the instruction that references the symbol.)
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(f) Jumping to a source line/memory value
When [Jump to Source] on the context menu is selected, the Editor panel is opened, with the caret on it moved
to a source line corresponding to the address of the current caret position. (If the Editor panel is already open,
CubeSuite+ jumps to it directly.)
Similarly, when [Jump to Memory] on the context menu is selected, the Memory panel (Memory1) is opened,
with the caret on it moved to a memory value corresponding to the address of the current caret position. (If the
Memory panel is already open, CubeSuite+ jumps to it directly.)

(g) Displaying a code coverage measurement result [Simulator]
If the coverage function is enabled, the lines included in the area that was subjected to coverage measurement
are highlighted based on the code coverage measurement result acquired by program execution.
For details about coverage measurement, see "2.15 Measure Coverage [Simulator]."

(h) Saving disassembled data
By choosing [Save Disassemble Data As...] from the [File] menu, it is possible to open the Data Save dialog
box and save the content of this panel in a text file (*.txt) or CSV file (*.csv).
For details on how to save disassembled data, see "(5) Saving the displayed contents of disassembled
results.”

(i) Zoom in or out on a view
To zoom in and out of the Disassemble panel view, change the zoom ratio by using the drop-down list on the
toolbar of the Main window while the focus is placed in the Disassemble panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
25%).

Remark The following items can be customized by setting the Option dialog box.
- Display fonts
- Colors of reserved words/comments

[Toolbar]
El| Gets latest information from the debug tool to update the display.
Selects mixed display mode that shows the correspondence between disassembled result and source text
(default).
Specifies that the caret position track the current PC value.
“': Moves the caret to the position at which a selected symbol is defined.
Moves the caret to a position (address) at which it was immediately before being moved with the 5%
button.
View Shows the following buttons that change the form in which a disassemble area is displayed.
,_j Displays the offset value of a label. If no labels are defined at the address, the offset value from the
nearest label is displayed.
248 Displays an address value in the form "symbol + offset value" (default).
However, if the address value has a symbol defined in it, only the symbol is displayed.
Opens the Scroll Range Settings dialog box to set a scroll range.
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[[File] menu (Disassemble Panel-Only Items)]

The [File] menu used exclusively for the Disassemble panel is as follows. (The other items are shared.)

However, all of these items are disabled during program execution.

Save Disassemble Data

Saves the disassembled content to a text file (*.txt) or CSV file (*.csv) that has been saved
previously (see "(h) Saving disassembled data").

Note that if this item is selected for the first time after startup, the same operation as [Save
Disassemble Data As...] would have been selected is performed.

Save Disassemble Data
As...

Opens the Data Save dialog box to save the disassembled content to a specified text file (*.txt)
or CSV file (*.csv) (see "(h) Saving disassembled data").

Print...

Opens the Print Address Range Settings dialog box to print the content of this panel.

[[Edit] menu (Disassemble Panel-Only Items)]

The [Edit] menu used exclusively for the Disassemble panel is as follows. (All other items are disabled.).

Copy Copies the content of a selected line as a character string to the clipboard, if a line is selected.
When in edit mode, a selected character string is copied to the clipboard.

Rename Goes to edit mode to edit the instruction or instruction code at the caret position (see "2.6.4
Performing line assembly").
However, this is disabled during program execution.

Find... Opens the Find and Replace dialog box, with its [Find in Files] tab selected.

Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.

Go To... Opens the Go to the Location dialog box to move the caret to a specified address.

[Context menu]

[Disassemble area and Address area]

Register to Watch1

Registers a selected character string or a word at the caret position as a watch-expression in
the Watch panel (Watch1). (Word determination depends on the current build tool.)

When registered as a watch-expression, they are registered as a variable name, so that the
displayed symbol name varies with scope.

Register Action Event...

Opens the Action Events dialog box to set an action event at an address at the caret position.

Go to Here

Executes the program from an address indicated by the current PC value to an address
corresponding to the line where the caret is positioned.

However, this is disabled during program execution or when [Build & Download] is under
execution.

Set PC to Here

Changes the current PC value to an address of the line where the caret currently exists.

However, this is disabled during program execution or when [Build & Download] is under

execution.
Go To... Opens the Go to the Location dialog box to move the caret to a specified address.
Go to Symbol Moves the caret to the position where a selected symbol is defined.
Back to Address Moves the caret to a position (address) at which it was immediately before being moved by

[Go to Symbol].

However, this is disabled when no symbol names are displayed at address.
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Break Settings

Shows the following cascaded menu to set break-related events.

Note that events can only be set on event settable lines (see "(1) Event area").

Set Hardware Break

Sets a breakpoint (hardware break event) at the address where the caret is positioned (see
"2.10.2 Stop the program at the arbitrary position (breakpoint).”

Set Software Break
[E1] [E20] [EZ Emulator]

Sets a breakpoint (software break event) at the address where the caret is positioned (see
"2.10.2 Stop the program at the arbitrary position (breakpoint)."

Set Read Break to

[Simulator]

Sets a break event for read access at the caret position or in a selected variable (global
variable, static variable inside a function or static variable inside a file) or an I/O register (see
"(1) Set a break event (access-related) to a variable/l/O register").

Set Write Break to

[Simulator]

Sets a break event for write access at the caret position or in a selected variable (global
variable, static variable inside a function or static variable inside a file) or an I/O register (see
"(1) Set a break event (access-related) to a variable/l/O register").

Set R/W Break to

[Simulator]

Sets a break event for read/write access at the caret position or in a selected variable (global
variable, static variable inside a function or static variable inside a file) or an I/O register (see
"(1) Set a break event (access-related) to a variable/l/O register").

Set Combination Break
[E1] [E20] [EZ Emulator]

Sets a break at the caret position's address or the caret position or a selected variable (global
variable, static variable inside a function, static variable inside a file) or I/O register as the
condition for a combination break event (see "(1) Set a beak event (execution-related)").

Set Read Combination
Break to

[E1] [E20] [EZ Emulator]

Sets a break event by a read access to the caret position or a selected variable (global
variable, static variable inside a function, static variable inside a file) or I/O register as the
condition for a combination break (see "(1) Set a break event (access-related) to a variable/I/
O register").

Set Write Combination
Break to

[E1] [E20] [EZ Emulator]

Sets a break event by a write access to the caret position or a selected variable (global
variable, static variable inside a function, static variable inside a file) or I/O register as the
condition for a combination break (see "(1) Set a break event (access-related) to a variable/I/
O register").

Set R/W Combination Break
to

[E1] [E20] [EZ Emulator]

Sets a break event by a read/write access to the caret position or a selected variable (global
variable, static variable inside a function, static variable inside a file) or I/O register as the
condition for a combination break (see "(1) Set a break event (access-related) to a variable/I/
O register").

Break Option

Opens the Property panel to set a break function.
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Trace Settings Shows the following cascaded menu to set a trace-related event.

Note that events can only be set on event settable lines (see "(1) Event area").

Start Tracing Sets a trace start event that causes collection of trace data indicating a program execution
history to start when an instruction at the address where the caret exists is executed (see "(1)
Setting a trace start event and a trace end event").
[Simulator]
The setting of the [Use trace function] property in the [Trace] category on the Property panel
is automatically set to [Yes].

Stop Tracing Sets a trace end event that causes collection of trace data indicating a program execution
history to end when an instruction at the address where the caret exists is executed (see "(1)
Setting a trace start event and a trace end event").
[Simulator]
The setting of the [Use trace function] property in the [[Trace]] category on the Property
panel is automatically set to [Yes].

Record Reading Value Sets a point trace event that, when the caret position or a selected variable (global variable,
static variable inside a function or static variable inside a file) or an I/O register is accessed for
read, causes the accessed value to be recorded in trace memory (see "(1) When an access
to a variable or I/O register occurred").

Record Writing Value Sets a point trace event that, when the caret position or a selected variable (global variable,
static variable inside a function or static variable inside a file) or an I/O register is accessed for
write, causes the accessed value to be recorded in trace memory (see "(1) When an access
to a variable or I/O register occurred").

Record R/W Value Sets a point trace event that, when the caret position or a selected variable (global variable,
static variable inside a function or static variable inside a file) or an I/O register is accessed for
read/write, causes the accessed value to be recorded in trace memory (see "(1) When an
access to a variable or I/O register occurred").

Record Start R/W Value Sets a trace event that causes trace recording to start upon read/write access to the caret position or
a selected variable (global variable, static variable inside a function, static variable inside a file) or I/O
register

(see"(1) Setting a trace start event and a trace end event").

Record End R/W Value Sets a trace event that causes trace recording to end upon read/write access to the caret position or
a selected variable (global variable, static variable inside a function, static variable inside a file) or I/O
register

(see "(1) Setting a trace start event and a trace end event").

Show Trace Result Opens the Trace panel and displays acquired trace data.

Trace Settings Opens the Property panel to set the trace function.

However, this is disabled while the tracer is operating.
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Timer SettingsN°te 1 Shows the following cascaded menu to set a timer-related event (see "2.14.3 Measuring

execution time in a section").
Note that events can only be set on event settable lines (see "(1) Event area").

Start Timer Sets a timer start event that causes measurement of program execution time to start when an
instruction at the address where the caret exists is executed (see "(a) How to set a timer start
event").

Stop Timer Sets a timer end event that causes measurement of program execution time to end when an

instruction at the address where the caret exists is executed (see "(b) How to set a timer end
event").

Set Timer Start R/W Value

Sets a timer start event that causes a measurement of the program's execution time to start
upon read/write access to the caret position or a selected variable (global variable, static
variable inside a function, static variable inside a file) or 1/O register (see "(a)
timer start event”).

How to set a

Set Timer <N>
[E1] [E20] [EZ Emulator]

Specify a channelN°t 2 in which a timer start event is set.

Set Timer End R/W Value

Sets a timer end event that causes a measurement of the program's execution time to finish
upon read/write access to the caret position or a selected variable (global variable, static
variable inside a function, static variable inside a file) or I/O register (see "(b) How to seta
timer end event").

Set Timer <N>
[E1] [E20] [EZ Emulator]

Specify a channelN°t® 2 i which a timer start event is set.

View Result of Timer

Opens the Events panel to display only timer-related events.

Clear Coverage Information

[Simulator]

Clears all of the code coverage measurement results that the debug tool currently holds.

However, this item is not displayed if the debug tool used does not support the coverage
function.

Edit Disassemble

Goes to edit mode to edit an instruction at the line where the caret is positioned (see "2.6.4
Performing line assembly").

However, this is disabled during program execution.

Edit Code Goes to edit mode to edit an instruction code at the line where the caret is positioned (see
"2.6.4 Performing line assembly").
However, this is disabled during program execution.
View Shows the following cascaded menu to set the contents displayed in the disassemble area.
Show Offset Displays the offset value of a label. If no labels are defined at the address, the offset value
from the nearest label is displayed.
Show Symbol Displays an address value in the form "symbol + offset value" (default).

However, if the address value has a symbol defined in it, only the symbol is displayed.

Settings Scroll Range...

Opens the Scroll Range Settings dialog box to set a scroll range.

Mixed Display

Selects mixed display mode that shows the correspondence between disassembled result
and source text (default).

Jump to Source

Opens the Editor panel, with the caret on it moved to a source line corresponding to the
address at the caret position.

Jump to Memory

Opens the Memory panel (Memory1), with the caret on it moved to a memory value
corresponding to the address at the caret position.

Notes 1.

[E1] [E20] [EZ Emulator]

The RX100 Series does not support timers.
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2. The specifiable number of channels differs between the RX600 and RX200 Series, as shown below.
RX600 Series: 2 (32 bits * 2) or 1 (64 bits * 1)
RX200 Series: 1 (24 bits * 1)

[Event area] ([E1] [E20] [EZ Emulator])

Hardware Break First Defines the type of break that can be set by clicking the mouse once to be a hardware breakpoint
(reflected in the setting of the [Type of breakpoints to be preferentially used] in the [Break] [E1]
[E20] [EZ Emulator] category on the Property panel.

Software Break First Defines the type of break that can be set by clicking the mouse once to be a software breakpoint
(reflected in the setting of the [Type of breakpoints to be preferentially used] in the [Break] [E1]

[E20] [EZ Emulator] category on the Property panel).
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CPU Register panel

This panel displays the contents of the CPU registers (general-purpose and control registers) and change register
values (see "2.11.2 Displaying and changing the CPU registers")
Note that this panel can be opened only when CubeSuite+ is connected with the debug tool.

Remark By double-clicking a line delimiting each area on the panel, it is possible to change the relevant area to the
smallest displayable width without omitting the content in it.

Figure A-32. CPU Register Panel

CPU Reqgister
(] | motation~ | e

Degister Name
[# (] General Pegisters —
=Y Cotbrol Pegisters
£ Iz 0x00001538
] usp 0x000016dS
£ nTE OxfffEa15d
=l rc Oxffffaadd
®E] pamw 0x00130004
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£l Brsw 000000000
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] Menu (CPU Register Panel-Only Items)]
- [[Edit] Menu (CPU Register Panel-Only Items)]
- [Context menu]

[How to open]

- Choose [CPU Register] from the [View] menu.

[Description of each area]

(1) [Register Name] area
This area displays register names in list form, with the types of registers classified by category (folder).
The meaning of each icon displayed here is described below.
Note that the category names or register names displayed here cannot be edited nor deleted.

[‘_|:r Indicates that the register names belonging to this category are displayed. Double-clicking the icon or
clicking the

mark closes the category and hides the register names.

& Indicates that the register names belonging to this category are hidden. Double-clicking the icon or clicking
the "+" mark opens the category and displays register names.
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J Shows a register name. Double-clicking the icon or clicking the "+" or "-" mark displays or hides the low-
level register names (names representing part of a register).

= Shows a register name (name representing part of a register).

The displayed category and register names are as follows. (The number of the "+" marks at the beginning of each

register name denotes the depth of the hierarchical level of displayed registers.)

Table A-2. [General Registers] Category and Register Names [RX]

Register name (alias) Bit width Register name (alias) Bit width
+RO 32 +R8 32
+R1 32 +R9 32
+ R2 32 +R10 32
+R3 32 +R11 32
+ R4 32 +R12 32
+R5 32 +R13 32
+ R6 32 +R14 32
+ R7 32 +R15 32
Table A-3. [Control Registers] Category and Register Names [RX]
Register name (alias) Bit width Register name (alias) Bit width

+ISP 32 + FPSwNote 2 32
+ USP 32 ++ FS 1
+INTB 32 ++ FX 1
+PC 32 ++ FU 1
+ PSW 32 ++ FZ 1

++ IPL 4Note 1 ++FO 1

++ PM 1 ++ FV 1

++ U 1 ++ EX 1

++ 1 1 ++ EU 1

++ 0O 1 ++ EZ 1

++ 8 1 ++ EO 1

++Z 1 ++ EV 1

++C 1 ++ DN 1
+ BPC 32 ++ CE 1
+ BPSW 32 ++ CX 1
+ FINTV 32 ++ CU 1
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Register name (alias) Bit width Register name (alias) Bit width
++ CZ 1
++ CO 1
++ CV 1
++ RM 2
+ACC 64

Notes 1. The bit width is 3 bits for the RX610 Group.
2. FPSW register is not supported by the RX210 Group.

This area has the following features.

(a) Registration of watch-expressions
CPU registers or categories can be registered as watch-expressions in the Watch panel.
For details on how to do it, see "(1) Registering watch-expressions."

Remarks 1.  If watch-expressions are registered for a category as the subject of registration, all CPU
registers belonging to the category are registered as watch-expressions.
2. The registered watch-expressions will have scope specification automatically added.

(2) [Value] area
This area displays the value of each CPU register and changes register values.
The desired notation (numerical representation) can be selected by clicking the appropriate toolbar button or by
selecting from a context menu. Also, it is possible to select a display form that always adds hexadecimal
equivalents to the ordinary display.
The meaning of marks displayed as CPU register values and their colors are as follows. (The colors in which text
and backgrounds are displayed depend on how the [General - Font and Color] category of the Option dialog box is

set.)
Example display (default) Description
00 Text color Blue Values of CPU registers which have had their values changed by the
user (Written into the target memory by hitting the [Enter] ke
Background color | Standard color ( g vy & [ Tkey)
Q=0 Text color Sienna Values of CPU registers whose values have changed as a result of
) program execution
Background color | LightYellow
Highlighting is reset by reexecuting the program.

This area has the following features:

(a) Alternation of CPU register values
To change the value of a CPU register value, select the CPU register value you want to change and click it
again, and then enter a new value directly from the keyboard. (Pressing the [Esc] key cancels the editing
mode.)
When you've finished editing the value of a CPU register, press the [Enter] key or move the focus to other than
the edit area. The value you've changed is written into the register of the debug tool.
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(b)

(c)

Saving of CPU register values

By choosing [Save CPU Register Data As...] from the [File] menu, it is possible to open the Save As dialog box
and then save the entire content of this panel to a text file (*.txt) or CSV file (*.csv).

For details on how to save the CPU register values, see "(3) Saving the displayed CPU register contents."

Zoom in or out on a view
To zoom in and out of the CPU Register panel view, change the zoom ratio by using the drop-down list on the
toolbar of the Main window while the focus is placed in the CPU Register panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel will
open at the changed zoom ratio).

[Toolbar]
E | Acquires latest information from the debug tool to update the display.
However, this is disabled during program execution.
Notation Shows the following buttons for changing the form in which values are displayed.

Displays the value of a selected item (including a low-level item) in predetermined notation (default).

Displays the value of a selected item (including a low-level item) in hexadecimal.

Displays the value of a selected item (including a low-level item) in signed decimal.

Displays the value of a selected item (including a low-level item) in unsigned decimal.

Displays the value of a selected item (including a low-level item) in octal.

Displays the value of a selected item (including a low-level item) in binary.

20| =) 1) [ ) [

2

Displays the character string of a selected item (including a low-level item) in ASCII code. If the subject to be
displayed consists of 2 bytes or more, characters of 1 byte each are displayed in a row.

B
=)

Displays a selected item in Float.

Except for 4-byte data, however, they are displayed in predetermined notation.

Displays a selected item in Double.

Except for 8-byte data, however, they are displayed in predetermined notation.

Adds a hexadecimal equivalent for the displayed value at the end of it, with the equivalent enclosed in
parentheses "()".

[[File] Me
The [File

nu (CPU Register Panel-Only Items)]

] menu used exclusively for the CPU Register panel is as follows. (The other items are shared.)

However, all of these items are disabled during program execution.

Save CPU Register Data | Saves the content of this panel to a text file (*.txt) or CSV file (*.csv) that has been saved

previously (see "(b) Saving of CPU register values").

If this item is selected for the first time after startup, the same operation as [Save CPU Register
Data As...] would have been selected is performed.

Save CPU Register Data Opens the Save As dialog box in order to save the content of this panel to a specified text file (*.txt) or

As... CSV file (*.csv) (see "(b) Saving of CPU register values").
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[[Edit] Menu (CPU Register Panel-Only Items)]

The [Edit] menu used exclusively for the CPU Register panel is as follows. (All other items are disabled.)

Cut Cuts a selected range of character string and copies it to the clipboard.
However, this is enabled only when character strings are being edited.

Copy When in editing mode, copies a selected character string to the clipboard.
If a line is selected, a register or category on the line is copied to the clipboard.
Note that a copied item can be pasted to the Watch panel.

Paste Pastes a copied character string from the clipboard to the caret position.
However, this is enabled only when character strings are being edited.

Select All Selects all items.

Find... Opens the Find and Replace dialog box, with its [Find in Files] tab selected.

Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.

[Context menu]

Register to Watch1 Registers a selected register name or category to the Watch panel (Watch1).
Copy When in editing mode, copies a selected character string to the clipboard.
If a line is selected, a register item or category on the line is copied to the clipboard.
Note that a copied item can be pasted to the Watch panel.
Notation Shows the following cascaded menu to specify the form in which values are displayed.
AutoSelect Displays the value of a selected item (including a low-level item) in predetermined notation
(default).
Hexadecimal Displays the value of a selected item (including a low-level item) in hexadecimal.

Signed Decimal

Displays the value of a selected item (including a low-level item) in signed decimal.

Unsigned Decimal

Displays the value of a selected item (including a low-level item) in unsigned decimal.

Octal Displays the value of a selected item (including a low-level item) in octal.

Binary Displays the value of a selected item (including a low-level item) in binary.

ASCII Displays the character string of a selected item (including a low-level item) in ASCII code. If the
subject to be displayed consists of 2 bytes or more, characters of 1 byte each are displayed in a
row.

Float Displays a selected item in Float.

Except for 4-byte data, however, they are displayed in predetermined notation.

Double Displays a selected item in Double.

Except for 8-byte data, however, they are displayed in predetermined notation.

Include Hexadecimal
Value

Adds a hexadecimal equivalent for the displayed value at the end of it, with the equivalent
enclosed in parentheses "()".
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IOR panel

This panel displays the contents of I/O registers and changes their values (see Section"2.11.3 Displaying and

changing the 1/O registers").

Note that this panel can only be opened when CubeSuite+ is connected with the debug tool.

Caution

reads, so that no values are read from those registers ([Value] marked with "?").

The /O registers that get the microcontroller actuated by a read operation are protected against

To obtain the contents of the /O registers protected against reads, select [Forcibly Load Values]

from the context menu.

Remark

smallest displayable width without omitting the content in it.

Figure A-33.

IOR Panel

By double-clicking a line delimiting each area on panel, it is possible to change the relevant area to the
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (IOR Panel-Only Items)]
- [[Edit] menu (IOR Panel-Only ltems)]
- [Context Menu]
[How to open]
- Choose [IOR] from the [View] menu.
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[Description of each area]

(1) Search area
This area performs a search of I/O register names.

Specify the character string to be searched (not case-sensitive).

Enter a character string directly from the keyboard (specifiable in up to 512 characters) or select
an input history item from the drop-down list (up to 10 history entries).

Searches for I/O register names that include the character string specified in the text box in
upward direction, with the search result placed in selected state.

Searches for /O register names that include the character string specified in the text box in
downward direction, with the search result placed in selected state.

Remarks 1.  The I/O register names that are hidden as classified by category (folder) also are searched
(expanded and placed in selected state).
2.  After entering the character string to be searched, press the [Enter] key and the same option as
would be when the button is clicked is performed, or press the [Shift] + [Enter] keys and the
same operation as would be when the button is clicked is performed.

(2) [IOR] area
This area displays I/O register names in list form as classified by type of I/O register as category (folder).
The meaning of each displayed icon is as follows.

Indicates that names of 1/O registers in this category are currently displayed. Double-clicking this icon or
clicking "-" will close the category and hide the names of corresponding I/O registers.

Note that categories are, by default, nonexistent. If necessary, create a new category and then Edit the
tree.

Indicates that names of /O registers in this category are currently hidden. Double-clicking this icon or
clicking "+" will open the category and display the names of corresponding I/O registers.

Note that categories are, by default, nonexistent. If necessary, create a new category and then Edit the
tree.

%j Displays I/O register names.

Remark By clicking the header part of this area, it is possible to sort category names in order of character code.
(The I/O register names in each category are sorted in the same way.)

This area has the following features.

(a) Edit the tree
The tree form can be edited by classifying each I/O register by any category (folder).
To create a new category, move the caret to the |/O register name for which a category is to be created and
click the button in the toolbar or select [Create Category] from the context menu. Then enter any category
name (specifiable in up to 1,024 characters).
To remove a category, select the category to be removed and click the button in the toolbar or select
[Remove] from the context menu. Note, however, that only blank categories can be removed.
Also, to edit a category name, select the category name to edit and follow one of the following procedures:
- Click the category name again and edit it directly from the keyboard
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- Choose [Change Name] from the [Edit] menu and then edit the category name directly from the keyboard
- Press the [F2] key and then edit the category name directly from the keyboard

When a category is created, drag-and-drop 1/O register names directly into the category. That way, I/O register
names can be displayed in tree form classified by category.

Similarly, the order in which categories or I/O register names are displayed (one above or below another) can
be freely changed by a drag-and-drop operation.

Cautions 1. A category cannot be created within another category.
2. /O registers cannot be added or removed.

(b) Registration of watch-expressions
I/O registers or categories can be registered as watch-expressions on the Watch panel.
For details on how to do it, see "(1) Registering watch-expressions".

Remarks 1.  If a watch-expression is registered for a category, all of the 1/O registers belonging to that
category are registered as watch-expressions.
2. The registered watch-expressions have their scope specification automatically given.

(c) Zoom in or out on a view
To zoom in and out of the IOR panel view, change the zoom ratio by using the drop-down list on the toolbar of
the Main window while the focus is placed in the IOR panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).
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(3) [Value] area
This area displays or changes /O register values.
The notation (numeral representation) in which values are displayed can be selected using the appropriate toolbar
button or selecting from the context menu. Also, it is possible to select a display form that always adds
hexadecimal equivalents to the ordinary display.
The meaning of marks displayed as |/O register values and their colors are as follows (The colors in which text and
backgrounds are displayed depend on how the [General - Font and Color] category of the Option dialog box is

set.).
Example display (default) Description
=0 Text color Blue The value of the I/O register that the user is changing (press the [Enter]
key to write to the target memory).
Background color Standard color
0x0 Text color Sienna The value of the 1/O register that has been changed because of the

execution of a program

To reset the highlighting, select the button on the toolbar or [Reset
Color] from the context menu.

Background color LightYellow

Text color Gray Values of I/O registers protected against read Note

Background color Standard color

Note This refers to the 1/O registers that get the microcontroller actuated by a read operation.
To read the value of read-protected I/O register, select [Force Read Value] from the context menu.

Caution The 1-byte or 2-byte I/O registers and the 1-bit I/O registers mapped to those 1-byte or 2-byte 1/0
registers differ in timing with which values are retrieved. Therefore, while a value from the same
1/0 register is being displayed, it is possible that the displayed value is different.

Remark The values are sorted in ascending order of numeric value by clicking the header part of this area.

This area has the following features.

(a) Alteration of I/O register values
When changing /O register values, select the target 1/O register value and then click it again to edit it directly
from the keyboard. (Pressing the [Esc] key cancels the edit mode.)
After editing an 1/O register value, hit the [Enter] key or move the focus to other than the edit area. The edited
value is written into the debug tool's target memory.
For details on how to edit I/O register values, see "(4) Changing the contents of I/O registers".

(b) Saving of I/O register values
Choosing [Save IOR Data As ...] from the [File] menu opens the Save As dialog box, making it possible to save
all content of this panel to a text file (*.txt) or CSV file (*.csv).
For details on how to save I/O register values, see "(6) Saving the displayed I/O register contents".

(4) [Type (Byte Size)] area
This area displays the type information of each 1/O register in the form shown below.
- <Type of I/O register> [<Access attribute> <All accessible sizes>](<Size>)
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Access attribute One of the following is displayed as access attribute.
R Read only
\W Write only
R/W Read/Write

All accessible sizes Accessible sizes, in bit units, are enumerated in increasing order by separating each with a

comma ,".

Size Shows the size of each /O register.

If displayable in byte units, the size is shown in bytes, if displayable in bit units, the size is shown in
bits, with the respective units given.

Examples 1. For the "IOR [R/W 1.8] (1 byte)" case
This refers to an 1/O register that is read/writable, accessible in 1 bit and 8 bits, and 1 byte in size.
2. Forthe "IOR [R/W 1] (1 bit)" case
This refers to an 1/O register that is read/writable, accessible in 1 bit, and 1 bit in size.

Remark The type information is sorted in order of character code by clicking the header part of this area.

(5) [Address] area
This area displays the addresses to which the I/O registers are mapped (always shown in hexadecimal).
However, the bit registers displayed here are given bit offset values, as shown in the examples below.

Examples 1. For the "OxFF40" case
This register is mapped to "0xFF40".
2. For the "0xFF40.4" case
This is a bit register mapped to bit 4 of the address "OxFF40".

Remark The addresses are sorted in ascending order of numeric value by clicking the header part of this area.

[Toolbar]

E]| Obtains latest information from the debug tool and updates the display.
No data are reloaded for the 1/O registers protected against read.
However, this button is disabled during program execution.

Resets the highlighting for a selected I/O register, which indicates that its value has changed as a result of
program execution.
However, this button is disabled during program execution.

Adds a new category (folder). Enter a category name directly in the text box.
While you can create any number of new categories, note that a category cannot be created within another
category.
However, this button is disabled during program execution.

Deletes a selected range of character string.
If a blank category is in selected state, the category is deleted (I/O registers cannot be deleted.).

R20UT2350EJ0100 Rev.1.00 RENESAS Page 330 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Notation Shows the following buttons that change the form in which values are displayed.

Displays the value of a selected item in hexadecimal (default).

Displays the value of a selected item in signed decimal.

Displays the value of a selected item in unsigned decimal.

Displays the value of a selected item in octal.

Displays the value of a selected item in binary.

5 =) =) [ [

Displays the value of a selected item in ASCII code.

Adds a hexadecimal equivalent for the displayed value of a selected item at the end of it, with the equivalent
enclosed in parentheses ().

[[File] menu (IOR Panel-Only Items)]

The [File] menu used exclusively for the IOR panel is as follows (The other items are shared.).
However, all of these items are disabled during program execution.

Save IOR Data Saves the content of this panel to a text file (*.txt) or CSV file (*.csv) that has been saved
previously (see "(b) Saving of I/O register values").

If this item is selected for the first time after startup, the same operation as [Save IOR Data As -]
would have been selected is performed.

Save IOR Data As... Opens the Save As dialog box in order to save the content of this panel to a specified text file (*.txt)
or CSV file (*.csv) (see "(b) Saving of I/O register values").

[[Edit] menu (IOR Panel-Only Iltems)]

The [Edit] menu used exclusively for the IOR panel is as follows (All other items are disabled.).

Cut Cuts a selected range of character string and moves it to the clipboard (No 1/O registers and
categories can be cut.).

Copy Copies a selected range of character string to the clipboard.
If an 1/O register or category is in selected state, that item is copied.

Note that the copied item can be pasted to the Watch panel.

Paste Pastes the content of the clipboard to the caret position when text is in editing mode (1/O registers
and categories cannot be pasted.).

Delete Deletes a selected range of character string.

If a blank category is in selected state, that item is deleted (No I/O registers can be deleted.).

Select All Selects all character strings whose text is in edit mode.

If the text is in other than edit mode, all I/O registers and categories are placed in selected state.

Rename Edits the name of a selected category.

Find... Moves the focus to the text box in the search area.

Go To... Opens the Go to the Location dialog box to move the caret to a specified I/O register.
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[Context Menu]

Register to Watch1 Registers the selected I/O register or category to the Watch panel (Watch1).

Refresh Obtains latest information from the debug tool and updates the display.
No data are reloaded for the I/O registers protected against read.

However, this button is disabled during program execution.

Force Read Value Forcibly loads a value once for I/O registers protected against read.
Go To... Opens the Go to the Location dialog box.
Create Category Adds a new category (folder). Enter a category name directly into the text box.

While you can create any number of new categories, note that a category cannot be created within
another category.

However, this button is disabled during program execution.

Copy Copies a selected range of character string to the clipboard.
If an 1/O register or category is in selected state, that item is copied.

Note that the copied item can be pasted to the Watch panel.

Delete Deletes a selected range of character string.

If a blank category is in selected state, that item is deleted (No I/O registers can be deleted.).

Notation Shows the following cascaded menu to specify the form in which values are displayed.
Hexadecimal Displays the value of the selected item in hexadecimal (default).
Signed Decimal Displays the value of the selected item in signed decimal.
Unsigned decimal Displays the value of the selected item in unsigned decimal.
Octal Displays the value of the selected item in octal.
Binary Displays the value of the selected item in binary.
ASCII Displays the value of the selected item in ASCII code.
Include Hexadecimal Adds a hexadecimal equivalent for the displayed value of a selected item at the end of it, with the
Value equivalent enclosed in parentheses ().
Reset Color Resets the highlighting for a selected I/O register, which indicates that its value has changed as a

result of program execution.
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Local Variables panel

This panel displays the contents of local variables and changes their values (see "2.11.5 Displaying and changing
local variables").
Note that this panel can only be opened when CubeSuite+ is connected with the debug tool.

Cautions 1.  During program execution, nothing is displayed on this panel. The contents of each area on
this panel are displayed at the time the program has stopped running.
2. Because of optimization by a compiler, for blocks where variables, or the subject to be operated
on, are not in use, there may be no variable data in the stack and registers. In this case, no
variables are displayed that are the subject to be operated on.

Remark By double-clicking a line delimiting each area on panel, it is possible to change the relevant area to the
smallest displayable width without omitting the content in it.

Figure A-34. Local Variables panel
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (Local Variables Panel-Only Items)]
- [[Edit] menu (Local Variables Panel-Only ltems)]
- [Context menu]

[How to open]

- Choose [Local Variable] from the [View] menu.

[Description of each area]

(1) Scope area
This area selects the scope of local variables to be displayed from the drop-down list.
The selectable items are as follows.
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Item Operation
Current Displays local variables at scope of the current PC value.
<depth> <Function name() [file namettline Displays local variables at scope of the calling function.
numbel’PNOte After the program execution, the scope selected here is retained as long
as the selected scope exists.

Note It shows the function caller displayed on Call Stack panel.

(2) [Name] area
Displays local variable names or function names. Function parameters are also displayed as local variables.
Also, arrays, pointer-type variables, and structures/unions have their hierarchical structure displayed in tree form.
This area cannot be edited.
The meaning of each icon displayed here is as follows.

. Denotes a variable.
Auto variables, internal static variables, and register variables are also displayed Note
Arrays, pointer-type variables, and structures/unions have their hierarchical structure displayed in tree form.

If a variable is marked with "+" at the beginning, clicking it expands the next part of the variable (After
expansion, the mark changes to "-".).

Array All elements in the array
Pointer-type Variable at the destination pointed to by the pointer
variables Note that if the destination pointed to by the pointer is a pointer, it is further assigned a

"+" mark. Clicking it shows the other part that is referenced.

However, if the value pointed to by the pointer is unknown, it is marked with "?".

Structure/union All members of the structure/union

Denotes a parameter.

= Denotes a function.

Note To display auto variables, be aware that the exact values of local variables cannot be displayed at the
prolog of functions ("{" in functions) and epilog of functions ("}" in functions). (The addresses of auto
variables are relative addresses from the stack pointer (SP), so that they are indefinite until the SP value is
fixed in the function. As the SP is manipulated at the prolog and epilog, its value is indefinite. Therefore,
exact values cannot be displayed at the prolog and epilog.)

This area has the following features.

(a) Registration of watch-expressions
C variables can be registered in the Watch panel as watch-expressions.
For details on how to register, See "(1) Registering watch-expressions”.

Remark The registered watch-expressions have their scope specification automatically given.

(b) Jump to memory
Selecting [Jump to Memory] from the context menu opens the Memory panel (Memory1) with the caret moved
to the address at which a selected local variable is located (If the Memory panel (Memory1) is already open,
CubeSuite+ jumps to it directly.).
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(c) Zoom in or out on a view
To zoom in and out of the Local Variables panel view, change the zoom ratio by using the drop-down list on
the toolbar of the Main window while the focus is placed in the Local Variables panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).

(3) [Value] area
This area displays or changes the values of local variables.
The notation of a data value and encoding of character strings can be selected using the toolbar buttons or from
the context menu. Also, it is possible to select a display form where hexadecimal display is always added.
The meaning of marks displayed as values of local variables and their colors are as follows (The colors in which
text and backgrounds are displayed depend on how the [General - Font and Color] category of the Option dialog
box is set).

Example display (default) Description

0 Text color Blue Local variable values that have been changed by the user. Press [Enter]
to write them to the target memory.

Background color | Standard color

=0 Text color Sienna Local variable values that have been changed due to program execution
Note

Background color | LightYellow
Executing the program again will reset the highlighting color.

Text color Gray Local variable values that could not be acquired.

Background color | Standard color

Note Applicable only to cases where the displayed variable names remained same from the program start point
to the break point while their values were changed.

This area has the following features.

(a) Alteration of local variable and parameter values
To change a local variable value and parameter value, select the local variable value to be changed first and,
after clicking it again, enter directly new values from the keyboard. (Pressing the [Esc] key cancels the edit
mode.)
The edited local variable values and parameter values are written into the debug tool's target memory by
pressing the [Enter] key or moving the focus to other than the edit area.
For details on how to change local variable and parameter values, see "(2) Changing the contents of local
variables".

(b) Saving of local variable values
Choosing [Save Local Variables Data As ...] from the [File] menu opens the Save As dialog box, making it
possible to save all content of this panel to a text file (*.txt) or CSV file (*.csv).
For details on how to save local variable values, see "(3) Saving the displayed contents of local variables".
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(4) [Type (Byte Size)] area
This area displays the type names of local variables. They are displayed in forms conforming to C language
description.
Arrays have the number of their elements added in "[ ]" and functions have their size (in bytes) added in "( )" when
they are displayed.
Note that this area cannot be edited.

(5) [Address] area
This area displays the addresses of local variables. If variables are assigned to registers, the register names are
displayed.
This area cannot be edited.

[Toolbar]

Each button in the toolbar are disabled during program execution.

E | Obtains latest information from the debug tool and updates display.

Notation Shows the following buttons that change the form in which values are displayed.

a Displays values on this panel in per-variable predetermined notation (default).

Displays values on this panel in hexadecimal.

Displays values on this panel in decimal.

Displays values on this panel in octal.

Displays values on this panel in binary.

Displays array indexes on this panel in decimal (default).

Displays array indexes on this panel in hexadecimal.

() () ) =) ) |

-]

Displays values on this panel in Float.

Note that non-4 byte data and data with type information are displayed in default notation.

Displays values on this panel in Double.

Note that non-8 byte data and data with type information are displayed in default notation.

Adds the hexadecimal equivalent in bracket "( )" at the end of the value.

Encoding Shows the following buttons that change the encoding in which string variables are displayed.

k-3

]| =) =] [

Displays string variables in ASCII code.

Displays string variables in Shift_JIS code (default).

Displays string variables in EUC-JP code.

[ Displays string variables in UTF-8 code.
[”T’e'] Displays string variables in UTF-16 code.
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[[File] menu (Local Variables Panel-Only Items)]

The [File] menu items listed below are provided exclusively on the Local Variables panel (Other menu items are shared
with other panels.).
However, all of these items are disabled during program execution.

Save Local Variables Overwrites the last-saved text file (*.txt) or CSV file (*.csv) with the contents of this panel (see "(b)
Data Saving of local variable values").

If you select this item for the first time after the start of the program, the operation will be the same
as selecting [Save Local Variables Data As...].

Save Local Variables Opens the Save As dialog box in order to save the contents of this panel to a specified text file
Data As... (*.txt) or CSV file (*.csv) (see "(b) Saving of local variable values").

[[Edit] menu (Local Variables Panel-Only ltems)]

The [Edit] menu items listed below are provided exclusively on the Local Variables panel. (All the other menu items are
disabled.)

Copy Copies the content of a selected line or a character string to the clipboard.
Select All Puts the item into all selected state.
Rename Goes to edit mode in order to change the value of a selected local variable (see "(2) Changing the

contents of local variables").

However, this item is disabled during program execution.

Find... Opens the Find and Replace dialog box, with the [Find in Files] tab selected.

Replace... Opens the Find and Replace dialog box, with the [Replace in Files] tab selected.

[Context menu]

All the items in the context menu are disabled during program execution.

Register to Watch1 Registers a selected local variable in the Watch panel (Watch1).

Copy Copies the content of a selected line or a character string to the clipboard.

Notation Shows the following cascaded menu to specify the form in which values are displayed.
AutoSelect Displays values on this panel in per-variable predetermined notation (default).
Hexadecimal Displays values on this panel in hexadecimal.

Decimal Displays values on this panel in decimal.
Octal Displays values on this panel in octal.
Binary Displays values on this panel in binary.
Decimal Notation for Displays array indexes on this panel is decimal (default).
Array Index
Hexadecimal Notation Displays array indexes on this panel is hexadecimal.
for Array Index
Float Displays values on this panel in Float.
Note that non-4 byte data and data with type information are displayed in default notation.
Double Displays values on this panel in Double.
Note that non-8 byte data and data with type information are displayed in default notation.
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Include Hexadecimal Adds the hexadecimal equivalent in bracket "( )" at the end of the value.
Value
Encoding Shows the following cascaded menu to specify character code.
ASCII Displays string variables in ASCII code.
Shift_JIS Displays string variables in Shift_JIS code (default).
EUC-JP Displays string variables in EUC-JP code.
UTF-8 Displays string variables in UTF-8 code.
UTF-16 Displays string variables in UTF-16 code.
Jump to Memory Opens the Memory panel (Memory1), with the caret moved to the address indicated by the
selected line.
R20UT2350EJ0100 Rev.1.00 RENESAS Page 338 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Watch panel

This panel displays the content of a registered watch-expression or changes the displayed value (see "2.11.6
Displaying and changing watch-expressions").

Up to four instances of this panel can be opened at a time. Each panel is discriminated by the name "Watch1,"
"Watch2," "Watch3" or "Watch4" in the title bar, allowing you to register, delete or move a watch-expression
independently of the panel.

Watch-expressions can also be registered from the Editor panel, Disassemble panel, Memory panel, CPU Register
panel, Local Variables panel or IOR panel, as well as from this panel.

If a panel that has watch-expressions registered in it is closed, the panel is hidden, but information on its registered
watch-expressions is retained. (When the panel is reopened, it opens, with those watch-expressions registered in it as
they were.)

When the value of any watch-expression changes after the program is executed, the display is updated. (During step
execution, the display is updated successively as the program is stepped through.)

Also, if the Realtime display update function is enabled, the display of values can be updated in real time, even during
program execution.

Note that this panel can only be opened when CubeSuite+ is connected with the debug tool.

Caution It is not possible to display or change the CPU register contents during program execution.

Remark By double-clicking a line delimiting each area on the panel, it is possible to change the relevant area to the
smallest displayable width without omitting the content in it.

Figure A-35. Watch Panel
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] Menu (Watch Panel-Only ltems)]
- [[Edit] Menu (Watch Panel-Only ltems)]
- [Context menu]

[How to open]

- Choose [Watch] from the [View] menu and then select [Watch 7-4].
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[Description of each area]

(1) [Watch] area
This area displays registered watch-expressions in list form.
By clicking the table title part of this area, it is possible to sort the watch-expressions in the list in alphabetical order.
Also, it is possible to create a category (folder) as desired and display the watch-expressions, as classified by
category, in tree form (see "(a) Editing a tree").
The meaning of each displayed icon is as follows:

Indicates a state that the watch-expressions belonging to this category are displayed. When you double-

click the icon or click the "-" mark, the category is closed to hide the watch-expressions.

Indicates a state that the watch-expressions belonging to this category are hidden. When you double-
click the icon or click the "+" mark, the category is opened to display the watch-expressions.

. Indicates that the watch-expression is a variable.

The watch-expression indicating an array, pointer type variable or a structure/union is marked with a "+"
or "-" at the beginning, so that when the sign is clicked, the expression expands or collapses (see “(b)
Expanding/collapsing the display”).

= Indicates that the watch-expression is a function.

| Indicates that the watch-expression is an immediate.

Indicates that the watch-expression is an expression.

Indicates that the watch-expression is an 1/O register.

| @[z

Indicates that the watch-expression is a CPU register.

The watch-expression having a lower level register (part of a register) is marked with a "+" or "-" at the
beginning, so that when the sign is clicked, the expression expands or collapses (see “(b) Expanding/
collapsing the display”).

This area has the following features:

(a) Editing a tree
Watch-expressions can be classified by category (folder) for display in tree form.
To create a new category, move the caret to the position where you want to create and click the button in
the toolbar or select [Create Category] on the context menu, and then enter any category name.
If the need arises to delete a category, select the category you want to delete, click the button in the
toolbar or select [Delete] on the context menu.
Also, if you want to edit a category name you created, select the category name you want to edit and follow
one of the following methods:
- Click the category name again and then edit it directly from the keyboard.
- Choose [Rename] from the [Edit] menu and then edit the category name directly from the keyboard.
- Press the [F2] key and then edit the category name directly from the keyboard.

After creating a category, drag-and-drop the registered watch-expressions into the category. The watch-
expressions are displayed in tree form classified by category.

Similarly, the order in which categories or watch-expressions are displayed (one above or below the other) can
be changed as desired by a drag-and-drop operation.

Cautions 1.  No other categories can be created within a category.
2. Up to 64 categories can be created in one Watch panel. (If an attempt is made to create
more categories exceeding this limit, a message is displayed.)
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Remark |If categories or watch-expressions in a Watch panel are drag-and-dropped into another Watch
panel (Watch1 to Watch4), the categories or watch-expressions are copied into the target Watch
panel.

(b) Expanding/collapsing the display
The watch-expression indicating an array, pointer type variable, a structure/union/class or a register (only
those that bear a name representing a part) is marked with a "+" at the beginning, so that when you click the
sign, the next entry is expanded for display (when expanded, the sign changes to a "-").

Watch-expression Contents when expanded

Array All elements in an array.

They can be displayed as a character string by selecting [Notation] and then [ASCII] on
the context menu (up to 256 characters displayable).

However, if not displayable because of encoding type, a "." or "?" is displayed.

Pointer type variable A variable at the destination pointed to by a pointer.
Structure/union/class All members of a structure/union/class.
Register The name of a bit or bit string that comprises a register.

Example: For PSW register
IPL register, PM register, U register, | register, O register, S register, Z register, C
register

(c) Registering a new watch-expression
There are following three methods of registering a new watch-expression.

<1> Registering a watch-expression from another panel
On another panel, perform one of the following operations on the subject that you want to register as a
watch-expression:
- Select the subject character string and then drag-and-drop it directly into this area on any Watch
panel (Watch1 to Watch4) (except for the Editor panel).
- Select the subject character string or move the caret to one of subject character strings (the subject
being automatically selected), and then select [Register to Watch1] on the context menu.
- Choose [Copy] from the [Edit] menu to copy the subject character string and then choose [Paste]
from the [Edit] menu in this area on any Watch panel (Watch1 to Watch4).

The table below shows the relationship between the panels for which this operation is possible and the
subjects that are registrable as watch-expressions.

Table A-4. Relationship between Panels and Subjects Registrable as Watch-expressions

Panel name Subjects registrable as watch-expressions

Editor panel C/C++ variablesN°®® 1 CPU registers, I/0 registers, and
assembler symbols

Disassemble panel C/C++ variablesN°t¢ 1 cpu registers, 1/O registers, and
assembler symbols

CPU Register panel CPU registers Note 2
Local Variables panel C/C++ variablesN°®® 1 (local variables)
IOR panel 1/0 registersNote 2
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Notes 1. It represents C89, C99 and C++ variables.
2. Scope specification is automatically added to the watch-expression.

<2> Direct registration on Watch panel
On any Watch panel (Watch1 to Watch4), click the button in the toolbar or select [Add New Watch]
on the context menu. An entry box for new watch-expressions is displayed at the bottom of this area.
In the [Watch] area of the entry box, enter a watch-expression directly from the keyboard and then press
the [Enter] key.
The form in which watch-expressions are entered this way is as follows:
Table A-5. Watch-expression Input Form

Watch-expression Displayed value
C/C++ variable name Note ! Value of a C/C++ variable
Watch-expression [Watch expression] Element values of an array
Watch-expression. Member name Note 2 Member values of a structure/union/class
Watch-expression-> Member name Note 2 Member values of the structure/union/class

pointed to by a pointer
Watch-expression.* Cast expression Value of a pointer to member variable
Watch-expression->* Cast expression Value of a pointer to member variable
* Watch-expression Variable value of a pointer
& Watch-expression Location address
(Type name) Watch-expression Value cast to specified type
CPU register name Value of a CPU register
1/0 register name Value of an /O register
Label nameN°® 3 EQU symbol nameN°® 3, | Value of a label, value of an EQU symbol, value of
[immediate value] an immediate address
Integer constant Constant value of an integer
Floating constant Constant value of a floating point
Character constant Constant value of a character
Notes 1. It represents C89, C99 and C++ variables.

2. To specify a member variable of base class, specify scope before a member name.
(Example: variable.BaseClass::member)

3. If alabel name or EQU symbol name contains a "$," enclose the name in braces "{ }."
(Example: {$Label})
If there is an imaginary number, multiply it by the uppercase letter "I" (example: 1.0 + 2.0*l). The
letter "I" constitutes a keyword, so that when you specify "I" of a CPU register, add ":REG"
(example: :REG).

Also, scope can be specified for a watch-expression when it is registered. When a watch-expression is
registered by specifying scope, it is handled as shown below.
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Table A-6. Handling of a C/C++ Variable when Registered in Watch by Specifying Scope

Scope specification Load module Source file Function Subject to be
nameNote ! nameNote ! nameote 2 searched
prog$file#func prog file func Static functions
prog$func prog Global func Global functions
file#func Current file func Static functions
func Current Current func AlNote 2
Notes 1. If a load module name or file name contains a space or one of the following symbols, enclose the

name in double-quotes (" "). (Example: "c:\folder\prog.abs" $file.c#func)
SHGC)HLL&N~ %+ =512,
A search is made for static functions and global functions from the scope of the current PC value in

[\ <>

that order. Static functions out of scope are not searched for.

To specify a function defined in a name space, do not write scope. (Example: Scope::func)
Also, if functions with the same name exist, write the type of parameter expressly. (Example:
func(int, int))

Table A-7. Handling of a C Variable when Registered in Watch by Specifying Scope

Scope specification Load module Source file Function Function Subject to be searched
nameNote 1 nameNote 1 nameNote 2 nameNote 2

prog$file#tfuncttvar prog file func var Static variables inside a
static functionNote 2.3

prog$file#tvar prog file Global var Static variables inside a
file

prog$var prog Global Global var Global variables

file#func#var Current file func var Static variables inside a
static functionNote 2.3

file#tvar Current file Global var Static variables inside a
file

var Current Current Current var AlNote 4

Notes 1. If a load module name or file name contains a space or one of the following symbols, enclose the

name in double-quotes (" "). (Example: "c:\folder\prog.abs" $file.c#func#var)
$.#.(G)LL&N~ %, +, -5 L2\ <, >,

To specify a function and variable defined in a name space, be sure to write scope. (Example:
Scope::func)

Also, if functions with the same name exist, write the type of parameter expressly. (Example:
func(int, int))

If the current PC value exists in a specified function, the local variables that are not declared as
static also comprise the subject to be searched.

A search is made for local variables, static variables inside a file and global variables from the
scope of the current PC value in that order. The local variables and the static variables inside a file
that are out of scope are not searched for.
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Table A-8. Handling of a CPU Register when Registered in Watch by Specifying Scope

Scope specification Register bank CPU register name

R10:REG (None) R10

Table A-9. Handling of an I/O Register when Registered in Watch by Specifying Scope

Scope specification 1/0 register name
ADO.ADCR:IOR ADO0.ADCR
ADO0.ADCR ADO.ADCR

Remarks 1. A symbol name at the current caret position can be supplemented by pressing the [Ctrl]
and [Space] keys together in this area. (See "2.20.2 Symbol name completion
function.")

2. Immediates are handled as a numeric value. Also, operators can be used for
immediates.

3. Arithmetic expressions using a symbol can be specified as watch-expressions.
If there exist a C/C++ variable, a CPU register and an I/O register with the same name
that are registered without specifying scope, the symbols are resolved in the order given
below, to display values.

C/C++ variable > CPU register > 1/O register

5. If there exist a local variable and a global variable with the same name that are
registered by only a symbol name without specifying scope, the symbols are resolved
based on the scope of the current PC value, to display values.

6. If a watch-expression is registered from the IOR panel or CPU Register panel, the watch-
expression will have scope specification automatically added to it.

7. If the letter "I" alone is specified as a watch-expression, it is interpreted as an imaginary
keyword. To acquire the value of a register "I," add ":REG" after the register.

<3> Registering from another application
Select a character string representing a C/C++ variable, CPU register, 1/0 register or assembler symbol
from an external editor or the like, and then perform one of the following operations:
- Drag-and-drop the subject character string into this area on any Watch panel (Watch1 to Watch4).
- Copy the subject character string to the clipboard and then select [Paste] on the [Edit] menu in this
area on any Watch panel (Watch1 to Watch4).

Cautions 1.  Up to 128 watch-expressions can be registered in one Watch panel. (If an attempt is
made to register more watch-expressions exceeding this limit, a message is displayed.)
2. In ablock where a variable that is the subject of operation is not used, variable data
may not always exist in the stack or register, due to optimization by a compiler. In this
case, even when a variable that is the subject of operation is registered as a watch-
expression, the displayed value remains marked with "2."

Remarks 1.  Watch-expressions registered on each Watch panel (Watch1 to Watch4) are managed
separately from each other and are saved as user information on the project.
2. More than one watch-expression with the same name can be registered.
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(d) Editing a watch-expression
To edit a registered watch-expression, double-click the subject watch-expression to put it into edit mode and
then enter the content of editing directly from the keyboard. (Pressing the [Esc] key cancels the edit mode.)
When you've finished editing a watch-expression, press the [Enter] key to complete the editing.

(e) Deleting a watch-expression
Click the button in the toolbar or select [Delete] on the context menu to delete a selected watch-
expression.

(f) Setting various events

By selecting [Access Break] or [Trace Output] on the context menu, it is possible to set various events in a
selected watch-expression.
When an access-related break event is set, the icon of the watch-expression changes shape. (An event mark
for break events is displayed additionally below the icon of the watch-expression.) If the event you set is a
trace event, there are no changes to the mark of the watch-expression.
When an event is set, detail information on the set event is reflected in the Events panel.
However, events can be set only when the watch-expression for which you're going to set an event is a global
variable, a static variable inside a function, a static variable inside a file, or an I/O register.
For details on how to set an event, see the sections listed below.

- "2.10.4 Stop the program with the access to variables/I/O registers"

- "2.13.4 Collecting an execution history only when conditions are met"

- “2.14.3 Measuring execution time in a section®

(g) Jumping to a memory definition address
Selecting [Jump to Memory] on the context menu opens the Memory panel (Memory1), with the caret on it
moved to the address where a selected watch-expression is defined. (If the Memory panel (Memory1) is
already open, CubeSuite+ jumps to it directly.)
However, if multiple watch-expressions are selected at the same time or an I/O register or CPU register is
selected, this operation has no effect.

(h) Zoom in or out on a view
To zoom in and out of the Watch panel view, change the zoom ratio by using the drop-down list on the toolbar
of the Main window while the focus is placed in the Watch panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).

(2) [Value] area
This area displays or changes the value of a registered watch-expression.
Note that if the watch-expression is a function pointer, a function name is displayed.
The display notation (numeral representation) and encoding can be selected using a toolbar button or from the
content menu. Also, it is possible to select a display form that always adds hexadecimal equivalents to the ordinary

display.
Note that the default display form is automatically determined depending on the type of watch-expression, as
follows:
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Table A-10. Display Form of Watch-expressions (Default)

Type of watch-expression Display form

char, signed char, unsigned char Hexadecimal value added in "( )" following ASCII
character

short, signed short, short int, signed short int, int, signed, | Hexadecimal value added in "( )" following signed decimal
signed int, long, signed long, long int, signed long int value

unsigned short, unsigned short int, unsigned, unsigned Hexadecimal value added in "( )" following unsigned
int, unsigned long, unsigned long int decimal value

float, float _Complex, float Imaginary Float value (when 4 bytes in size) Not®

double, long double, double Complex, long double | Double value (when 8 bytes in size) N

_Complex, double _Imaginary, long double

_Imaginary

Pointer to char, singed char, unsigned char String
Encoding: Shift_JIS

Pointer to other than char, singed char, unsigned char Hexadecimal

Array of type char, signed char, unsigned char String
Encoding: Shift_JIS

bit, boolean, _boolean Hexadecimal value added in "( )" following unsigned
decimal value

Enumeration type Hexadecimal value added in "( )" following enumerated
constant

Label, immediate address, EQU symbol Hexadecimal value added in "( )" following signed decimal
value

Bit symbol Hexadecimal value added in "( )" following unsigned
decimal value

Other Hexadecimal

Note The values of floating and complex types are rounded to an approximate value (nearest whole value) before
being displayed.

The meaning of marks displayed as values of watch-expressions and their colors are as follows. (The colors in
which text and backgrounds are displayed depend on how the [General - Font and Color] category of the Option
dialog box is set.)

Example display (default) Description

0x0 Text color Blue Values of watch-expressions which have had their values changed by
the user (Written into the target memory by hitting [Enter] key)

Background color | Standard color

i Text color DeepPink Values of watch-expressions which have their display updated in real
time (Realtime display update function)

Background color | Standard color
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Example display (default) Description

=0 Text color Sienna Values of watch-expressions whose values have changed as a result of
program execution

Highlighting is reset by clicking the button in the toolbar or selecting
[Reset Color] on the context menu.

Background color | LightYellow

? Text color Gray When nonexistent variables are registered as watch-expressions, or
when values of watch-expressions could not be acquired (e.g., variables
gotten out of scope)

Background color | Standard color

Remarks 1.  The I/O registers that may get the microcontroller operated unintentionally by a read operation are
protected against reads, so that they are not loaded with values. To load the contents of the I/O
registers protected against reads, select [Force Read Value] on context menu.

2. Watch-expressions have their values acquired in the order they are registered.
Therefore, if two or more of the same 1/O register are registered, their displayed values may not
always the same, because their values are acquired with different timing.

3. If hexadecimal equivalents are added, the value in specified notation and its hexadecimal
equivalent are read out separately.
Therefore, the value in specified notation and its hexadecimal equivalent may not always agree,
because they are acquired with different timing.

This area has the following features:

(a) Realtime display update function
By using the realtime display update function, it is possible to display or change the value of a registered
watch-expression, not only when the program is halted, but also when it is under execution.
For details about the realtime display update function, see "(4) Displaying and changing memory contents
during program execution."

(b) Changing the value of a watch-expression
To change the value of a watch-expression, select the value of the subject watch-expression and click on it
again. Then enter a new value directly from the keyboard. (Pressing the [Esc] key cancels the edit mode.)
When you've finished editing the value of a watch-expression, press the [Enter] key or move the focus to other
than the edit area. The value you've changed is written into the target memory.
For details on how to change the value of a watch-expression, see "(6) Changing the contents of watch-
expressions."

(c) Saving the values of watch-expressions
By choosing [Save Watch Data As...] from the [File] menu, it is possible to open the Save As dialog box and
then save the entire content of this panel to a text file (*.txt) or CSV file (*.csv).
For details on how to save the values of watch-expressions, see "(9) Saving the displayed contents of watch-
expressions."
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(3) [Type (Byte Size)] area

This area displays the type information of watch-expressions in the form shown below.

Watch-expression

Display form

Single CPU register

<Type of CPU register> (<SizeNoe 1)

Single I/O register

<Type of I/O register> (<Access attribute> <Access type><SizeN°te 1>)

Access attribute R: Read only
W: Write only
R/W: Read/write

Access type 1: Accessible in 1 bit
8: Accessible in byte

16:  Accessible in half word
32:  Accessible in word

Not determinable

?

Other than above

<Type of watch-expression as determined by C compilerNo® 2> (<SjzeNote 1)

Notes 1. The sizes of watch-expressions are expressed in byte units.

For bit IORs and C bit fields, however, the sizes are displayed in bit units, with the "bit" notation added

at the end of the value.

2. Watch-expressions are handled as having the type indicated here when they are compiled.

In the case of double/long double type, type name is output in accordance with "Precision of the double

type and long double type" in the [CPU] Category on the [Common Options] Tab in the CC-RX Property

panel. The type name and size are output in float type when "Handles in single precision” is selected

and in double type when "Handles in double precision" is selected.

(4) [Address] area

This area displays the address to which each watch-expression is mapped (always expressed in hexadecimal).

However, if the watch-expression is a single CPU register or not determinable, it is marked with "-" or "?,"

respectively.

Remark If the watch-expression is an 1/O register that is a bit register, a bit offset value is added to its displayed

address, as shown below.

Example For a bit register mapped to bit 4 at the address "OxFF40"
Displayed content: 0OxFF40.4

(5) [Memo] area

This area allows the user to enter a comment on a watch-expression or category, freely as desired.

The contents of comments entered in this area are held separately for each watch-expression and category, and

are saved as user information on the project. Therefore, if one of these watch-expressions or categories is deleted,

the content of its corresponding memo is also discarded.

Note that when an array, register or the like is expanded for display, you cannot enter a comment on any

expanded element.

To edit a comment, double-click the item you want to edit. The selected item is placed in edit mode. (Pressing the
[Esc] key cancels the edit mode.) A character string of up to 256 characters can be entered directly from the

keyboard (new-line code

ignored).

When you've finished editing a character string, press the [Enter] key or move the focus to other than the edit area
to complete the character string editing.
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[Toolbar]
Reacquires all values of registered watch-expressions to update the display.
However, the I/O registers protected against reads are not reloaded.
. Resets the highlighting for a selected watch-expression which indicates that its value has changed as a result
of program execution.
However, this is disabled during program execution.
. Registers a new watch-expression. Enter a watch-expression directly in the text box (see "(c) Registering a

new watch-expression").

Note that up to 128 watch-expressions can be registered in one Watch panel.

]

m Adds a new category (folder). Enter a category name directly in the text box.
Note that up to 64 categories can be created in one Watch panel. (No other categories can be created within
a category.)

. Deletes a selected range of character string.

If a watch-expression or category is selected, the item is deleted.

However, this is disabled when an expanded item of a watch-expression is selected.

Notation Shows the following buttons to change the display form of values.

Displays the value of a selected watch-expression in per-variable predetermined notation (default). (See
"Table A-10. Display Form of Watch-expressions (Default).")

Displays the value of a selected item in hexadecimal.

Displays the value of a selected item in signed decimal.

Displays the value of a selected item in unsigned decimal.

Displays the value of a selected item in octal.

Displays the value of a selected item in binary.

Q
) [=2) [0 [ [ [

3
]

Displays the value of a selected item in ASCII code.

B
=]

Displays the value of a selected item in Float.

However, this is enabled only when a selected watch-expression consists of 4-byte data.

Displays the value of a selected item in Double.

However, this is enabled only when a selected watch-expression consists of 8-byte data.

Adds a hexadecimal equivalent for the displayed value of a selected item at the end of it, with the equivalent
enclosed in "()."

However, this does not apply when the value is displayed in hexadecimal.

[[File] Menu (Watch Panel-Only Items)]

The [File] menu used exclusively for the Watch panel is as follows. (The other items are shared.)
However, all of these items are disabled during program execution.

Save Watch Data Saves the content of this panel to a text file (*.txt) or CSV file (*.csv) that has been saved
previously (see "(c) Saving the values of watch-expressions").

Note that if this item is selected for the first time after startup, the same operation as [Save Watch
Data As...] would have been selected is performed.

Save Watch Data As... Opens the Save As dialog box in order to save the content of this panel to a specified text file (*.txt)
or CSV file (*.csv) (see "(c) Saving the values of watch-expressions").
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[[Edit] Menu (Watch Panel-Only Items)]

The [Edit] menu used exclusively for the Watch panel is as follows. (All other items are disabled.)

Cut Cuts a selected range of character string and copies it to the clipboard.
If a watch-expression or category is in selected state, the item is cut.

However, this is disabled when an expanded item of a watch-expression is selected.

Copy Copies a selected range of character string to the clipboard.
If a watch-expression or category is in selected state, the item is copied.

However, this is disabled when an expanded item of a watch-expression is selected.

Paste Inserts the content of the clipboard into the caret position when text is in edit mode.

If, when text is in other than edit mode, a watch-expression is copied to the clipboard, the copied
watch-expression is registered at the caret position.

Delete Deletes a selected range of character string.
If a watch-expression or category is in selected state, the item is deleted.

However, this is disabled when an expanded item of a watch-expression is selected.

Select All Selects all character strings when text is in edit mode.

If the text is in other than edit mode, all watch-expressions and categories are placed in selected

state.
Rename Edits the name of a selected watch-expression or category.
Find... Opens the Find and Replace dialog box, with its [Find in Files] tab selected.
Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.
[Context menu]
Access Break This item is usable when the selected watch-expression is a global variable, a static variable inside

a function, a static variable inside a file, or an 1/O register (multiple selection not accepted).

Shows the following cascaded menu to set access-related break events (see "(1) Set a break
event (access-related) to a variable/l/O register").

Set Read Break to Sets a read-access break event in a selected watch-expression.

[Simulator]

Set Write Break to Sets a write-access break event in a selected watch-expression.

[Simulator]

Set R/W Break to Sets a read/write-access break event in a selected watch-expression.

[Simulator]

Set Read Combination Sets a read-access break event in a selected watch-expression as the condition for a
Break to combination break event.

[E1] [E20] [EZ Emulator]

Set Write Combination Sets a write-access break event in a selected watch-expression as the condition for a
Break to combination break event.

[E1] [E20] [EZ Emulator]

Set R/W Combination Sets a read/write-access break event in a selected watch-expression as the condition for a
Break to combination break event.

[E1] [E20] [EZ Emulator]
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Trace Output

This item is usable when the selected watch-expression is a global variable, a static variable
inside a function, a static variable inside a file, or an 1/O register (multiple selection not
accepted).

Shows the following cascaded menu to set trace-related events. (see "2.13.3 Collecting an
execution history in a section" and "2.13.4 Collecting an execution history only when conditions
are met").

After an event is set, a watch-expression that is the subject of operation is marked with an Event
mark at the beginning.

Record Reading Value

Sets a point trace event that, when a selected watch-expression is accessed for read, records
the accessed value in trace memory (see "(1) When an access to a variable or I/O register
occurred").

Record Writing Value

Sets a point trace event that, when a selected watch-expression is accessed for write, records
the accessed value in trace memory (see "(1) When an access to a variable or I/O register
occurred").

Record R/W Value

Sets a point trace event that, when a selected watch-expression is accessed for read/write,
records the accessed value in trace memory (see "(1) When an access to a variable or /O
register occurred").

Record Start R/W Value

Sets a trace event that, when a selected watch-expression is accessed for read/write, causes
trace recording to start (see "(1) Setting a trace start event and a trace end event").

Record End R/W Value

Sets a trace event that, when a selected watch-expression is accessed for read/write, causes
trace recording to end (see "(1) Setting a trace start event and a trace end event").

Trace

Opens the Trace panel to display acquired trace data.

Timer SettingsNote !

This item is enabled only when the selected watch-expression is a global variable, a static
variable inside a function, a static variable inside a file, or an I/O register (plural selections not
accepted).

Displays the following cascaded menu to set timer-related events (see "2.14.3 Measuring
execution time in a section").

After an event is set, an event mark is displayed at the beginning of the watch-expression
concerned.

Set Timer Start R/'W
Value

Sets an event that causes the timer to start upon read/write access to a selected watch-

expression (see "(a) How to set a timer start event").

Set Timer <N>

[E1] [E20] [EZ
Emulator]

Specify a channelN°t 2 in which a timer start event is set.

Set Timer End R/W Value

Sets an event that causes the timer to finish upon read/write access to a selected watch-
expression (see "(b) How to set a timer end event").

Set Timer <N>

[E1] [E20] [EZ
Emulator]

|N0te 2

Specify a channe in which a timer end event is set.

Periodic Updating

Shows the following cascaded menu to set realtime display updating (see "(a) Realtime display
update function").

Periodic Updating Options

Opens the Property panel to set the realtime display update function generally.

Refresh

Reacquires all values of registered watch-expressions to update the display.

However, the I/O registers protected against reads are not reloaded.

Force Read Value

Forcibly loads the values of 1/O registers protected against reads once.

However, this is disabled during program execution.
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Add New Watch

Registers a new watch-expression. Enter a watch-expression directly in the text box (see "(c)
Registering a new watch-expression").

Note that up to 128 watch-expressions can be registered in one Watch panel.

Create Category

Adds a new category (folder). Enter a category name directly in the text box.

Note that up to 64 categories can be created in one Watch panel (no other categories can be
created within a category).

Delete

Deletes a selected range of character string.
If a watch-expression or category is in a selected state, the item is deleted.

However, this is disabled when an expanded item of a watch-expression is selected.

Cut

Cuts a selected range of character string and moves it to the clipboard.
If a watch-expression or category is in a selected state, the item is cut.

However, this is disabled when an expanded item of a watch-expression is selected.

Copy

Copies a selected range of character string to the clipboard.

If a watch-expression or category is in a selected state, the item is copied.

Paste

Inserts the content of the clipboard into the caret position when text is in edit mode.

If, when text is in other than edit mode, a watch-expression is copied to the clipboard, the copied
watch-expression is registered at the caret position.

However, this is disabled when an expanded item of a watch-expression is selected.

Rename

Renames the selected watch-expression/category.

Import Watch Expression...

Opens the Open Watch Expression Data File dialog box to import watch-expressions (see "(8)
Exporting/importing watch-expressions").

Notation Shows the following cascaded menu to specify a display form.
AutoSelect Displays the value of a selected watch-expression in per-variable predetermined notation
(default). (See "Table A-10. Display Form of Watch-expressions (Default).")
Hexadecimal Displays a selected item in hexadecimal.

Signed Decimal

Displays a selected item in signed decimal.

Unsigned decimal

Displays a selected item in unsigned decimal.

Octal Displays a selected item in octal.
Binary Displays a selected item in binary.
ASCII Displays a selected item in ASCII code.

Include Hexadecimal
Value

Adds a hexadecimal equivalent for the displayed value of a selected item at the end of it, with
the equivalent enclosed in "( )."

However, this does not apply when the value is displayed in hexadecimal.

Float

Displays a selected item in Float.

However, if a selected watch-expression is not 4-byte data or has type information, the selected
item is displayed in predetermined notation (see "Table A-10. Display Form of Watch-
expressions (Default)").

Double

Displays a selected item in Double.

However, if a selected watch-expression is not 8-byte data or has type information, the selected
item is displayed in predetermined notation (see "Table A-10. Display Form of Watch-
expressions (Default)").

Decimal Notation for
Array Index

Displays the indices of all arrays in decimal.

Hexadecimal Notation for
Array Index

Displays the indices of all arrays in hexadecimal.
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Encoding Shows the following cascaded menu to specify character code.
ASCII Displays a selected item in ASCII code.
Shift_JIS Displays a selected item in Shift_JIS code (default).
EUC-JP Displays a selected item in EUC-JP code.
UTF-8 Displays a selected item in UTF-8 code.
UTF-16 Displays a selected item in UTF-16 code.

Size Notation

Shows the following cascaded menu to specify a size.

1 Bytes Displays a selected item as 8-bit data.

2 Bytes Displays a selected item as 16-bit data.
4 Bytes Displays a selected item as 32-bit data.
8 Bytes Displays a selected item as 64-bit data.

Jump to Memory

Opens the Memory panel (Memory1), with the caret on it moved to the address at which a
selected watch-expression is defined (see "(g) Jumping to a memory definition address").

Reset Color

Resets the highlighting for a selected watch-expression which indicates that its value has

changed as a result of program execution.

However, this is disabled during program execution.

Notes 1. [E1] [E20] [EZ Emulator]
The RX100 Series does not support timers.

2. The specifiable number of channels differs between the RX600 and RX200 Series, as shown below.
RX600 Series: 2 (32 bits * 2) or 1 (64 bits * 1)
RX200 Series: 1 (24 bits * 1)
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Call Stack panel

This panel displays call stack information for function calls (see “2.12.1 Display call stack information").
This panel can only be opened when CubeSuite+ is connected with the debug tool.

Caution This panel is left blank while the program is in execution.
The contents of each area on this panel are displayed at the time the program has stopped running.

Figure A-36. Call Stack Panel

Call 5tack
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Call Stack.
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Here, the following items are explained.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] Menu (Call Stack Panel-Only Items)]
- [[Edit] Menu (Call Stack Panel-Only Items)]
- [Context menu]

[How to open]

- Choose [Call Stack] from the [View] menu.

[Description of each area]

(1) [Depth] area
Displays the depth of calls.
The callers of functions are assigned numbers in order starting from 1, with the line showing the current PC
position assigned a 0.

(2) [Call Stack] area
Displays the current source position and call stack information about the calls placed on the stack (e.g., function
caller position and parameters to each function).
The form in which information is displayed in this area differs depending on the status of which toolbar button,
or , is selected, and which item from the context menu, [Show Parameter] or [Show Module File Name], is
selected, as shown below.
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Condition Display Format
- Show parameters <function>(<parameter>=<parameter valueNote>, ...)J[<xmodule file name>$<file name>#<line
- Show module file names number>] (default)
- Show parameters <function>(<parameter>=<parameter valugNote>, ...)[<file Name>#<line number>)

- Do not show module file names

- Do not show parameters <function>()[<module file name>$<file name>#<line number>]

- Show module file names

- Do not show parameters <function>()[<file name>#<line number>]

- Do not show module file names

Note If the parameter value is a character string, up to 20 characters are displayed.

Remark An array of parameters are passed as a pointer, not as an array (C language specifications). Therefore,
if parameters are comprised of an array, they are handled as pointer when displayed.

This area has the following features:

(a) Jump to the source line/ disassemble line
Selecting [Jump to Source] from the context menu will open the Editor panel, with the caret moved to the
source line from which the function at the current caret position is called. (The view will jump to the Editor
panel if it is already open.)
Similarly, selecting [Jump to Disassemble] will open the Disassemble panel (Disassemble1), with the caret
moved to the disassemble line indicating the address from which the function at the current caret position is
called. (The view will jump to the Disassemble panel (Disassemble1) if it is already open.)

Remark Double-clicking a line will also make you jump to the corresponding source line.

(b) Saving the call stack information
Selecting [Save Call Stack Data As ...] from the [File] menu will open the Save As dialog box in which you can
save all contents of this panel to a text file (*.txt) or CSV file (*.csv).
For details on how to save call stack information, see "(4) Saving the displayed contents of call stack
information".

(c) Zoom in or out on a view
To zoom in and out of the Call Stack panel view, change the zoom ratio by using the drop-down list on the
toolbar of the Main window while the focus is placed in the Call Stack panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).
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[Toolbar]

Each button in the toolbar are disabled during program execution.

E | Obtains latest information from the debug tool and updates display.

Notation Shows the following buttons that change the form in which values are displayed.

a Displays values on this panel in per-variable predetermined notation (default).

Displays values on this panel in hexadecimal.

Displays values on this panel in decimal.

Displays values on this panel in octal.

Displays values on this panel in binary.

E

Shows the following buttons that change the character code in which string variables are displayed.

Displays string variables in ASCII code (default).

3
T o e
B [E) ¢ (E[E B
S
«Q

Displays string variables in Shift_JIS code.

E

Displays string variables in EUC-JP code.

s3]

Displays string variables in UTF-8 code.

3

Displays string variables in UTF-16 code.

Adds a module file name to the information displayed (default).

F i b
[

Adds function call parameters to the information displayed (default).

[[File] Menu (Call Stack Panel-Only Items)]

The [File] menu used exclusively for the Call Stack panel is as follows. (The other items are shared.)
However, all of these items are disabled during program execution.

Save Call Stack Data Saves the contents of this panel to a text file (*.txt) or CSV file (*.csv) that has been saved
previously (see "(b) Saving the call stack information").

If this item is selected for the first time after startup, the same operation as [Save Call Stack Data
As ---] would have been selected is performed.

Save Call Stack Data As... | Opens the Save As dialog box in order to save the contents of this panel to a specified text file
(*.txt) or CSV file (*.csv) (see "(b) Saving the call stack information").

[[Edit] Menu (Call Stack Panel-Only Items)]

The [Edit] menu used exclusively for the Call Stack panel is as follows. (All other items are disabled.)

Copy Copies the content of a selected line as character string to the clipboard.
Select All Puts the item into all selected state.
Find... Opens the Find and Replace dialog box, with its [Find in Files] tab selected.
Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.
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[Context menu]

Each item on the context menu are disabled during program execution.

Copy

Copies the content of a selected line as character string to the clipboard.

Show Module File Name

Adds a module file name to the line when it is displayed (default).

Show Parameter

Adds function call parameters to the line when it is displayed (default)

Notation Shows the following cascaded menu to specify the form in which values are displayed.
AutoSelect Displays values on this panel in per-variable predetermined notation (default).
Hexadecimal Displays values on this panel in hexadecimal.

Decimal Displays values on this panel in decimal.
Octal Displays values on this panel in octal.
Binary Displays values on this panel in binary.

Encoding Shows the following cascaded menu to specify character code.

ASCII Displays string variables in ASCII code (default).
Shift_JIS Displays string variables in Shift_JIS code.
EUC-JP Displays string variables in EUC-JP code.
UTF-8 Displays string variables in UTF-8 code.

UTF-16 Displays string variables in UTF-16 code.

Jump to Disassemble

Opens the Disassemble panel (Disassemble1), with the caret on it moved to the address from
which the function indicated by a selected line is called.

Jump to Source

Opens the Editor panel, with the caret on it moved to the source line from which the function
indicated by a selected line is called.

Jump to Local Variable at
This Time

Opens the Local Variables panel that displays local variables for the function indicated by a
selected line.
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Trace panel

This panel displays the trace data which has had an execution history of the program recorded in it (see "2.13
Collecting an Execution History").

Although the trace data is displayed, by default, in a disassembled text and source text mixed mode, it is possible to
display either one of these text by selecting the desired Display mode.

The display position is automatically updated after program execution is halted, so that the latest trace data will be
displayed.

Note that this panel can be opened only when CubeSuite+ is connected with the debug tool.

Caution [E20(JTAG) [RX600 Series]]
Part of the trace functions and Real-time RAM Monitor (RRM) functions can be used only on a
mutually exclusive basis.

Remark By double-clicking a line delimiting each area on the panel, it is possible to change the relevant area to the
smallest displayable width without omitting the content in it.

Figure A-37. Trace Panel [E1/E20/EZ Emulator [RX200, RX600 Series]]
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Figure A-38. Trace Panel [E1/E20/EZ Emulator [RX100 Series]]
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Figure A-39. Trace Panel [Simulator]
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] Menu (Trace Panel-Only Items)]
- [[Edit] Menu (Trace Panel-Only ltems)]
- [Context menu]

[How to open]

- Choose [Trace] from the [View] menu.
- On the Editor panel or Disassemble panel, select [Trace Settings] and then [Show Trace Result] on the context
menu.
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[Description of each area]

(1) [Number] area

This area displays the trace numbers that correspond to trace frames.

(2) [Time (h:min:s,ms,us,ns)] area

This area displays the time in "hour, minute, second, millisecond, microsecond and nanosecond" units from when

the program started running till when the cause of instruction execution or memory access in any frame occurred.

Remark

[Simulator]

Whether the time is displayed by an integral value or by a differential value depends on how the
[Accumulate trace time] property in the [Trace] category on the Property panel's [Debug Tool Settings]
tab is set.

Cautions 1.  [E1] [E20] [EZ Emulator]

To specify whether timestamp information is added to trace data, use the [Output
timestamp] property in the [Trace] category on the Property panel's [Debug Tool Settings]
tab. (See "2.13.1 Setting up a trace operation.") When an RX100-series microcontroller is in
use, however, the [Output timestamp] property is fixed to [No] so timestamp information is
not included in trace data.

2. [E1] [E20] [EZ Emulator]

The timestamp information displayed here is a time relative to the beginning cycle, and not
a time from the start of program execution.

3. [E1] [E20] [EZ Emulator]

The timestamp information is calculated based on the set value of the [Trace clock count
source[MHz]] property in the [Trace] category on the Property panel's [Debug Tool Settings]
tab and a value counted with the inherent count source of each microcontroller used.
The counter width in bits of each microcontroller series is as follows:

RX600 series: 20 bits

RX200 series: 24 bits
Note that if the count value of the microcontroller overflows, an overflowed content is
corrected before timestamp information is displayed.
However, if an overflow occurs twice or more between successive trace frames, correct
timestamp information will not be displayed in the subsequent trace data.

4. [E1(Serial)/E20(Serial)/EZ Emulator [RX200 Series]]

A timer measurement counter is used for the count source of the microcontroller.
Therefore, if a timer measurement event is set on the Events panel, expected timestamp
information will not be displayed.

5.  [E1] [E20] [EZ Emulator]

The timestamp information differs in count sources with each microcontroller.
- RX610, RX621, RX62N, RX62T, and RX62G Groups
If EXTAL x 8 <= 100 MHz
Count frequency for timestamp information = EXTAL x 8
If EXTAL x 8 > 100 MHz
Count frequency for timestamp information = EXTAL x 4
- RX630, RX631, RX63N, and RX63T Groups

When using EXTAL : Selected clock source /2 or selected clock source x 1
(when division ratio of 1:1 is set by SCKCR.ICK)
When not using EXTAL : Selected clock source x 1
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- RX210, RX21A, and RX220 Groups

ICLK (timer measurement counter used)

(3) [Line/Address] area
This area displays the address of an assembly instruction or a |

ine number in the source file.

The desired notation (numerical representation) or character string encoding can be selected by clicking the

appropriate toolbar button or by selecting from a context menu.
The display form is as follows:

Type of displayed line

Display form

Instruction (disassemble) <Address>

Source text

<File name>#<Line number>

Label

Point trace result

Remark Since the following execution histories are not displayed, the line numbers are not consecutive.

- CPU register access
- Invalid fetch

(4) [Source/Disassemble] area

This area displays collected trace data as shown below.

Note that the items displayed in this area differ with each display mode selected (see "(a) Display mode").

Figure A-40. Contents Displayed in the [Source/Disassemble] Area (Default)

HE-RS )<€—— Instruction (disassembled result)

Source/Dizazzemble
(| Change_P5w_PM_to_UserMode]) «— Source text
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rnair[];
Offset value —> BSR.A _main
Label name—}

tutarnial]];
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Label name

If a label is defined at an address, the label name is displayed.

Offset value

If no label is defined at an address, an offset value from the nearest label is displayed.

If Mixed display mode or Source
text is displayed.

Source text

Information" is displayed.

However, if a location without debug information is executed, the text "No Debug

display mode is selected, the corresponding source

Instruction (disassembled result)
instruction (disassembled result)

If Mixed display mode or Disassemble display mode is selected, the corresponding

is displayed.NOte The mnemonic is highlighted.
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Note |If collection of trace data failed, with some data dropped, the word "(LOST)" is displayed and the whole of
the relevant line is displayed in an error color. (The error color depends on how the [General - Font and
Color] category in the Option dialog box is set.)

This area has the following features:
(a) Display mode

One of the following three display modes can be selected by clicking the appropriate toolbar button or by
selecting from a context menu.

Display mode Displayed content

Mixed display mode Instruction (disassemble), label name and source text (corresponding source line)
are displayed (default).

Disassemble display mode Instruction (disassemble) and label name are displayed.

Source display mode Source text (corresponding source line) is displayed.

However, if a location without debug information is executed, the text "No Debug
Information” is displayed.

(b) Jump to the source line/disassemble line
When [Jump to Source] on the context menu is selected, the Editor panel is opened, with the caret on it moved
to a source line that corresponds to the line where the caret is currently positioned. (If the Editor panel is
already open, CubeSuite+ jumps to it directly.)
Similarly, when [Jump to Disassemble] is selected, the Disassemble panel (Disasemmble1) is opened, with
the caret on it moved to a fetch address on the line where the caret is currently positioned. (If the Disassemble
panel (Disassemble1) is already open, CubeSuite+ jumps to it directly.)

(c) Linkage with other panels
By clicking the or button in the toolbar or selecting [Window Connecting] and then [Connect Source
Window] or [Connect Disassemble Window] on the context menu, it is possible to have data corresponding to
the address at the caret position on this panel displayed in synchronism with it on the Editor panel or
Disassemble panel. (The focus is not moved.)

(d) Popup display
When the mouse cursor is hovered on a line, the data in all areas (items) corresponding to the line are
displayed one below another in a popup window.

(e) Saving of trace data
By choosing [Save Trace Data As...] from the [File] menu, it is possible to open the Data Save dialog box and
then save the content of this panel to a text file (*.txt) or CSV file (*.csv).
For details on how to save trace data, see "2.13.9 Saving the displayed content of an execution history."

(f) Zoom in or out on a view
To zoom in and out of the Trace panel view, change the zoom ratio by using the drop-down list on the toolbar
of the Main window while the focus is placed in the Trace panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
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If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel

will open at the changed zoom ratio).

(5) [Address] area

This area displays the subject address at which a memory access was made.

However, if an access was made to an I/O register, the I/O register name is displayed in place of an address. (If

there are multiple accesses, the rest is displayed on the next line.)

The desired notation (numerical representation) can be selected by clicking the appropriate toolbar button or by

selecting from a context menu.

(6) [Data] area

This area displays an accessed data value and the type of access.
However, this information is not displayed for accesses to the CPU register.

The desired notation (numerical representation) or character string encoding can be selected by clicking the

appropriate toolbar button or by selecting from a context menu.

The display forms of data values and types of access are shown below. (The colors in which text and backgrounds

are displayed depend on how the [General - Font and Color] category of the Option dialog box are set.)

Display example (default)

Type of memory access

R Data value

Text color

Standard color

Background color

PaleGreen

Read access

W Data value

Text color

Standard color

Background color

Orange

Write access

VECTData value Text color Standard color | Vector read access
[Simulator] Background color | PaleGreen
[Toolbar]

E | Acquires latest information from the debug tool to update the display.
However, this is disabled during program execution.

Clears (initializes) the trace memory and also clears the display of this panel.
However, this is disabled during program execution.

Restarts the trace function that was halted during program execution.

However, this is disabled when the program is halted or when tracer operation is underway.

Temporarily stops the trace function during program execution.

However, this is disabled when the program is halted or when the tracer is halted.

Opens the Trace Search dialog box.

Notation

However, this is disabled during program execution.

Shows the following buttons for changing the form in which values are displayed.

Displays values on this panel in hexadecimal (default).

Displays values on this panel in decimal.

o Displays values on this panel in octal.

=7 [0 [0 [

Displays values on this panel in binary.
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Scrolls the Editor panel in synchronism with a selected line.
.;'3 Scrolls the Disassemble panel in synchronism with a selected line.
Changes the display mode to a Mixed display mode (default).

However, this is disabled during program execution.

Changes the display mode to a Disassemble display mode.

However, this is disabled during program execution.

Changes the display mode to a Source display mode.

However, this is disabled during program execution.

[[File] Menu (Trace Panel-Only ltems)]

The [File] menu used exclusively for the Trace panel is as follows. (The other items are shared.)
However, all of these items are disabled during program execution.

Save Trace Data Saves the content of trace data to a text file (*.txt) or CSV file (*.csv) that has been saved
previously (see "(e) Saving of trace data").

If this item is selected for the first time after startup, the same operation as [Save Trace Data As...]
would have been selected is performed.

Save Trace Data As... Opens the Data Save dialog box in order to save the content of trace data to a specified text file
(*.txt) or CSV file (*.csv) (see "(e) Saving of trace data").

[[Edit] Menu (Trace Panel-Only Items)]

The [Edit] menu used exclusively for the Trace panel is as follows. (All other items are disabled.)
However, all of these items are disabled during program execution.

Copy Copies the content of a selected line as a character string to the clipboard (multiple selection not
accepted).
Find... Opens the Trace Search dialog box.

[Context menu]

Clear Trace Clears (initializes) the trace memory and also clears the display of this panel.

However, this is disabled during program execution.

Start Trace Restarts the trace function that was halted during program execution.

However, this is disabled when the program is halted or when tracer operation is underway.

Stop Trace Temporarily stops the trace function during program execution.

However, this is disabled when the program is halted or when the tracer is halted.

Find... Opens the Trace Search dialog box.

However, this is disabled during program execution.

Copy Copies the content of a selected line as a character string to the clipboard (multiple selection not
accepted).

However, this is disabled during program execution.

Mixed View Changes the display mode to a Mixed display mode.

However, this is disabled during program execution.
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Disassemble View Changes the display mode to a Disassemble display mode.

However, this is disabled during program execution.

Source View Changes the display mode to a Source display mode.

However, this is disabled during program execution.

Notation Shows the following cascaded menu to specify notation (numerical representation).

However, this is disabled during program execution.

Hexadecimal Displays values on this panel in hexadecimal (default).
Decimal Displays values on this panel in decimal.
Octal Displays values on this panel in octal.
Binary Displays values on this panel in binary.
Window Connecting Shows the following cascaded menu to link the display with other panels (see "(c) Linkage with

other panels").

Connect Source Scrolls the Editor panel in synchronism with a selected line.
Window

Connect Disassemble Scrolls the Disassemble panel in synchronism with a selected line.

Window

Jump to Disassemble Opens the Disassemble panel (Disassemble1), with the caret on it moved to the fetch address on
a selected line.

Jump to Source Opens the Editor panel, with the caret on it moved to the source line corresponding on a selected
line.

Jump to Memory Opens the Memory panel, with the caret on it moved to the memory value corresponding to the
line where the caret is positioned.
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Events panel

This panel displays detailed information on the events that have been set on the Editor panel, Disassemble panel or
Watch panel, as well as chooses to enable or disable event settings or deletes event settings (see "2.17 Event

Management").
Note that this panel can be opened only when CubeSuite+ is connected with the debug tool.

Remarks 1.  For details about event settings, see "2.17.7 Points to note regarding event setting."
2. The events that have been set on the Function List panel or Variable List panel of the analysis tool are

also managed on this panel.
3. By double-clicking a line delimiting each area on the panel, it is possible to change the relevant area to

the smallest displayable width without omitting the content in it.

Figure A-41. Events Panel [E1] [E20] [Simulator]
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Figure A-42. Events Panel [EZ Emulator]
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[Edit] Menu (Event Panel-Only Items)]
- [Context menu]

[How to open]

- From the [View] menu, select [Event].

- On the Editor panel or Disassemble panel, select [Timer Settings] and then [View Result of Timer] on the context
menu.

- On the Editor panel or Disassemble panel, move the caret to an event mark and then select [View Details in Event
Panel] from the context menu.
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[Description of each area]

(1) [Name] area
This area lists the currently set event names in the form shown below.

5@9 Hardware Break0001
I) T

(@ (€

Remark By selecting the appropriate toolbar button, it is possible to limit the types of events displayed here (see
[Toolbar]).

(a) Checkbox
Clicking the checkbox displays or changes the set state of an event.
Note that when the set state of an event is changed, the Event mark also changes accordingly.

Enabled When a specified condition becomes true, the event concerned with it occurs.

The event can be disabled by unchecking the checkbox.

|:| Disabled Even when a specified condition becomes true, the event concerned with it does not
occur.

The event can be enabled by checking the checkbox.

|:| Pending A specified condition cannot be set in the program to be debugged.

The checkbox cannot be manipulated.

Remarks 1.  The Run-Break timer event (not supported by the EZ Emulator) cannot be disabled or made
pending.

2. The enabled or disabled settings of an unconditional trace event and other trace events are
controlled exclusively of each other. Therefore, although the unconditional trace event, one of
the built-in events, is enabled by default, when either a trace start or a trace end event is set, it
is automatically disabled at the same time, in which case, a trace event (consisting of a trace
start and a trace end event that are combined into one) is enabled.

Conversely, when the set trace event is disabled, the unconditional trace event is
automatically re-enabled.

Caution [Simulator]
For the timer measurement event to be enabled, both timer start and end events should be
specified.
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(b) Event mark

The event mark indicates the type of an event and shows its currently set state.

The displayed event marks and their meanings are as follows:

Table A-11. Event Marks
Type of event Enabled Disabled Pending Remark
Hardware Break {-:j {_)?'.: ”» -
Software Break a5 JT A -
[E1] [E20] [EZ Emulator]
Combination break @ @S ”», -
[E1] [E20] [EZ Emulator]
Unconditional Trace "_53' "_?< None -
Run-Break Timer "_53' None None -
Trace 12 b 2 Displayed on only the Events
panel
Trace start 12 b 2 Displayed on only the Editor
. . anel and Disassemble panel
Trace end g k42 P P
Timer Result fﬁ:ﬁ' fﬁf , Displayed on only the Events
panel
Timer start fﬁ:ﬁ' fﬁf , Displayed on only the Editor
anel and Disassemble panel
Timer end 4] [2: P P
Point Trace §- § -
Printf event 2 -,X - -
Interrupt event 2 -,X - -
[Simulator]
Multiple settings of above [ Note 1 flgi§ Note 2 [[FiNoe 3 | Displayed on only the Editor
events panel and Disassemble panel

Notes 1.

This applies when there is at least one enabled event among multiple events.

2. This applies when there is no enabled event but at least one disabled event among multiple events.
3. This applies when all of multiple events are made pending.
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(c) Event name
The type of an event and its ID number are displayed as an event name.
The ID number is automatically assigned beginning with 0001 for each event type. (Even when an event that
was once set is deleted, the other events are not reassigned ID numbers.)
The displayed event types are as follows:

Table A-12. Event Types

Event Type Description
Hardware Break This event is such that the debug tool successively checks break condition
(BreakN°te1) during program execution and, when the condition is met, causes the program
to break.

->See "2.10.2 Stop the program at the arbitrary position (breakpoint)"

-> See "2.10.4 Stop the program with the access to variables/I/O registers"

Software Break This event is such that instruction code at an address where a break is to
(BreakNote1) occur is rewritten with a break instruction, so that when the instruction is
[E1] [E20] [EZ Emulator] executed, the program is made to break.

-> See "2.10.2 Stop the program at the arbitrary position (breakpoint)"

Combination break When, while the debug tool successively is checking plural break conditions
[E1] [E20] [EZ Emulator] during program execution, the combination condition is met, this event causes
the program to break.

->See “2.10.5 Set multiple break events in combination (Combination break)
[E1] [E20] [EZ Emulator]”

Unconditional Trace Trace data is automatically collected at the same time the program starts
running, and collection of trace data is halted simultaneously when the

program stops.

Since this event is a built-in event Note2

Enabled by default.)

-> See "2.13.2 Collecting an execution history up to a halt"

, it cannot be deleted. (This event is

Run-Break Timer A measurement of the program's execution time automatically begins at the
same time the program starts running, and the measurement of execution
time is halted simultaneously when the program stops. Since this event is a

Note2

built-in event , it cannot be deleted. (This event is Enabled by default.)

-> See "2.14.2 Measuring execution time from start to stop"

Trace This event is such that when the condition set by a trace start and a trace end
event is met, collection of trace data begins and then ends (displayed when
either a trace start or a trace end event is set).

-> See "2.13.3 Collecting an execution history in a section"

Timer ResuItNOte3

This event is such that when the condition set by a timer start and a timer end
event is met, a measurement of the program's execution time begins and then
ends (displayed when either a trace start event or a trace end event is set).

-> See "2.14.3 Measuring execution time in a section”

Point Trace This event is such that when a specified variable or I/O register is accessed
by program execution, the accessed information is recorded in trace memory.

-> See "2.13.4 Collecting an execution history only when conditions are met"

Printf This event is such that program execution is momentarily halted at any
location and then a printf command is executed by a software process (i.e., an
action event).

->See "2.16.1 Insert printf"
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Event Type Description
Interrupt This event generates an interrupt at any place during program execution
[Simulator] (action event).

-> See "2.16.2 Insert an interrupt event [Simulator]"

Notes 1. A breakpoint that is set by clicking the mouse once is displayed as "Break" (see "(2) Seta

breakpoint").

2. This is an event that is set by default in the debug tool.

3. [E1] [E20] [EZ Emulator]
Timer measurement sections are assigned channel numbers for each event type as their
identification numbers (example: Timer Result 1).
The number of sections in which timer measurements are possible differs with each microcontroller
used. Note the RX100 Series does not support timers.
- RX600 Series: Two sections
- RX200 Series: One section
[Simulator]
Only one section is available for timer measurement.

Remark In addition to the above event types, following event types may be displayed if events (breakpoints
or break events) have been set on the Function List panel or Variable List panel of the analysis
tool.

- For breakpoints for a function: "Break at start of function"
- For break events for a variable: "Access break to variable"

(d) Zoom in or out on a view
To zoom in and out of the Event panel view, change the zoom ratio by using the drop-down list on the toolbar
of the Events panel while the focus is placed in the Event panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
50%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).

(2) [Detail] area
This area displays detailed information on each event.
The content of displayed information differs with event type.
The following shows how to read detailed information for each event type.
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Table A-13. Detailed Information by Event Type

Type of event Displayed content Note1

Hardware Break Display <Generation condition> <File name#Line number> <Address>

(Generation condition: form 1
Execution-related)

Display Before Execution main.c#39  0x100

example

Before Execution - 0x300

Execution main.c#39 0x300 [Simulator]
Display <Generation condition> <Symbol + Offset> <Address>
form 2

Display Before Execution funcA + 0x10  0x100

example
P Before Execution - 0x300
Hardware Break Display <Generation condition> <File name#Variable name> <Address(range)>
(Generation condition: form 1 <Comparison condition> <Comparison value>
Access-related) Display Read main.c#ivariable?  0x100 - 0x101 == Ox5
example
P Write sub.c#variable2 0x200 - 0x200 == Ox7
Read/Write sub2.c#variable3  0x300 - 0x303 == 0x8
Display <Generation condition> <File name#Function name#Variable name>
form 2 <Address(range)> <Comparison condition> <Comparison value>
Display Read main.c#func1#variable1  0x100 - 0x101 == 0x10
example
Display <Generation condition> <Variable name> <Address(range)> <Comparison
form 3 condition> <Comparison value>
Display Write variable1 0x100 - 0x101 == 0x10
example
Software Break Display <Generation condition> <File name#Line number> <Address>

[E1] [E20] [EZ Emulator] form1

Display Before Execution main.c#40 0x102
example
P Before Execution sub.c#101  0x204
Display <Generation condition> <Symbol + Offset> <Address>
form 2
Display Before Execution funcA + 0x12 0x102
example
Combination break Display <Combination condition>
(Generation condition: form <Detailed information on combination break>
Execution-related, Access- )
Display OR
related)
example - After execution main.c#100 0x300
[E1] [E20] [EZ Emulator]
- After execution funcA + 0x10 0x100
- Write sub.c#variable2 0x200 - 0x200 == 0x7

- Read/Write sub2.c#variable3 0x300 - 0x303 ==0x8

Unconditional Trace Display -
form
Display -
example
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Type of event Displayed content Note1
Run-Break Timer Display Total: <Total execution time>
form
Display Total:  1000ms
example
P Total: OVERFLOW
Display Total:<Total execution time> Execution Cycle Count:<Total number of
form 2 cycles executed> Execution Instruction Count:<total number of
instructions executed> [Simulator]
Display Total: 3300ns Execution Cycle Count:330 Execution Instruction Count:
example 200
Trace Display Start: <Combination condition for trace start> End: <Combination
(Generation condition: form condition for trace end> Start/End: <Total number of trace start/trace end
. Note2
Execution-related, Access- event>
related) <Start/end> <Detailed information on trace start/frace end>
[E1] [E20] [EZ Emulator] | b0y Start: OR End: OR Start/End: 6
example - Start  After Execution main.c#100  0x300
- Start After Execution funcA + 0x100 0x300
- Start  Write variable1 0x100-0x101==0x10
-End After Execution main.c#200 0x100
-End After Execution funcA + 0x10 0x100
-End Read main.c#variable1 0x100-0x101==0x5
Trace Display Start: OR End: OR Start/End: <Total number of trace start/ trace end
Note2
(Generation condition: form events>
Execution-related, Access- <Start/end><Detailed information on trace start/trace end>
related
) Display Start: OR End: OR Start/End: 6
Simulator
[ ] example - Start Before Execution main.c#100  0x300
- Start Before Execution funcA + 0x100 0x300
- Start  Write variable1 0x100-0x101==0x10
-End Before Execution main.c#200 0x100
-End Before Execution funcA + 0x10 0x100
-End Read main.c#variable1 0x100-0x101==0x5
Timer Result Display Total:<Total execution time > Start/End: <Total number of timer starts/
(Generation condition: form timer ends>N°te 2
Execution-related, Access- - <Total execution time> <Pass count> <Average execution time>
related) <Maximum execution time> <Minimum execution time>
[E1] [E20] [EZ Emulator] - <Start/end> <Detailed information on timer start/timer end>
Display Total: 10ms Start/End: 6
example - Total: 10ms Pass Count: 5  Average: 2ms
Max: 4ms Min: 1ms
- Start After Execution main.c#100 0x300
- Start  After Execution  funcA + 0x30 0x100
- Start  Write variable1  0x100-0x101==0x10
-End After Execution main.c#100 0x300
-End After Execution funcA + 0x50 0x100
-End Read main.c#variable1 0x100-0x101==0x5
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Type of event

Displayed content Note1

Timer Result Display Total:<Total execution time > Start/End: <Total number of timer starts/
(Generation condition: form timer ends>N°te 2
Execution-related, Access- - <Total execution time> <Pass count> <Average execution time>
related) <Maximum execution time> <Minimum execution time>
[Simulator] - <Start/end> <Detailed information on timer start/timer end>
Display Total: 10ms Start/End: 2
example - Total: 10ms Pass Count: 5  Average: 2ms
Max: 4ms Min: 1ms
- Start  Write variable1 0x100-0x101==0x10
-End Before Execution main.c#100 0x300
Point Trace Display <Generation condition> <Variable name> <Address of variable>
(Generation condition: form 1
Access-related) Display Read variable1 0x100
example
Display <Generation condition> <File name#Variable name> <Address of
form 2 variable>
Display Write sub.c#variable2 0x200
example
Format3 <Generation condition> <File name#Function name#Variable name>
<Address of variable>
Display Read/Write sub.c#func1#variabl3 0x300
example
Printf event Display <Generation condition> <File name#Line number> <Address> <Print event
(Action event) form setting>
Display Before Execution main.c#39 0x100 aaa, bbb, ccc
example )
After Execution sub.c#100 0x200 Result of aaa: aaa
Interrupt event Display <Generation condition><File name # line number><Address> interrupt
(Action event) form vector: <Interrupt vector>Priority level: <Interrupt priority>
[Simulator] Display Before execution main.c#39 0x100 Interrupt vector: 1c Priority level: 7
example
Notes 1. Following are the details on the display format.
<Generation One of the following conditions is displayed:
condition>

[E1] [E20]
Execution-related:Before Execution, After Execution
Access-related: Read, Write, Read/Write
[Simulator]
Execution-related:Before Execution,
Access-related: Read, Write, Read/Write
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<File name # Line
number>

A source file name and a line number in the source file are displayed. The display form
is the same as for the scope specification expression of a watch-expression.

If there are multiple load module files that are downloaded, <Load module name$File
namet#Line number> is displayed.

For events set on the Disassemble panel, however, a <Line number> is displayed in
the form <Symbol + Offset>, if the following applies:

- Line information exists and a specified event set position is not at the beginning of
line information.

- No line information exists, but symbol information exists.
Also, a line number is displayed with "-" if the following applies:

- No line information exists, and no symbol information exists.

<Variable name>

A variable name in a source file is displayed. The display form is the same as for the
scope specification expression of a watch-expression.

<Comparison
condition>

A comparison condition (==) is displayed. This is not displayed if no comparison value
is specified.

<Comparison value>

A comparison value is displayed. This is not displayed if no comparison value is
specified.

<Address> The beginning and the end address of a specified variable in a memory area are
displayed (always in hexadecimal).

<Combination One of the following conditions is displayed:

condition> OR, AND, Sequential

<Detailed Detailed information on combination break event is displayed.

information on
combination break>

<Total execution

The total execution time measured by a timer is displayed.

time> The time is expressed in one of ns/us,/ms/s/min units. (However, if expressed in "min,"
a "s" digit is displayed at the same time.)
If the timer has overflowed (see "2.14.4 Range of measurable time") or the value is
invalid, "OVERFLOW" is displayed.

<Combination One of the following conditions is displayed:

condition for trace
start>

OR, AND, Sequential

<Combination
condition for trace
end>

An OR condition is displayed.

<Total number of
trace start/trace end

The total number of trace start and trace end events is displayed.

event>

<Start/end> Displays whether the content of the detailed information is about start event or end
event.

<Detailed Detailed information on trace start and trace end events is displayed.

information on trace
start/trace end>

<Pass count>

The pass count of a timer is displayed.

If the timer has overflowed (see "2.14.4 Range of measurable time") or the value is
invalid, "OVERFLOW" is displayed.
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<Average execution
time>

The average execution time measured by a timer is displayed.

The time is expressed in one of ns/us,/ms/s/min units. (However, if expressed in "min,"
a "s" digit is displayed at the same time.)

<Maximum
execution time>

The maximum execution time measured by a timer is displayed.

The time is expressed in one of ns/us,/ms/s/min units. (However, if expressed in "min,"
a "s" digit is displayed at the same time.)

<Minimum
execution time>

The minimum execution time measured by a timer is displayed.

The time is expressed in one of ns/us,/ms/s/min units. (However, if expressed in "min,"
a "s" digit is displayed at the same time.)

<Total number of
cycles executed>

Displays the total number of cycles executed between Run-Break as the result of
measurements made.

<Total number of
instructions
executed>

Displays the total number of instructions executed between Run-Break as the result of
measurements made.

<Print event
setting>

The <Output character string>: <Variable expression> specified in the Action Events
dialog box is displayed.

<Interrupt vector>

Displays the interrupt vector specified in the Action Events dialog box or Detailed
Settings of Interrupt Events dialog box [Simulator].

<Interrupt priority>

Displays the priority level specified in the Action Events dialog box or Detailed Settings
of Interrupt Events dialog box [Simulator].

(3) [Comment] area

When this line is clicked, detailed information on the lines below that is displayed.

This area permits the user to enter freely a comment on any event that is set.

To enter a comment, select the event for which you want to enter a comment and click in this area or select [Edit

Comment] on the context menu, and then enter any text directly from the keyboard. (Pressing the [Esc] key

cancels the editing mode.)

When you've finished editing a comment, press the [Enter] key or move the focus to other than the edit area to

complete your editing.

Note that a comment can be entered for up to 256 characters each, and the comment is saved as the one set by

the current user.

[Toolbar]

[X]

Deletes a selected event or an event condition.

However, the built-in events (unconditional trace and Run-Break timer events) cannot be deleted.

Displays hardware break-related events (default).

Ellte]

1

i
=

[E20] [EZ Emulator]

Displays software break-related events (default).

Displays trace-related events (default).

Displays timer-related events (default).

Displays action events (Printf event or interrupt event) (default).

Displays built-in events (unconditional trace and Run-Break timer events) (default).

) [ ]| (&3] (=)

Opens the Editor panel, with the caret on it moved to the source line corresponding to the

address where a selected eventNote is set.
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Opens the Disassemble panel (Disassemble1), with the caret on it moved to the disassembled
result corresponding to the address where a selected eventNote is set.
Opens the Memory panel (Memory1), with the caret on it moved to the memory value
Note

corresponding to the address where a selected event is set.

Note This does not include trace events, timer measurement events, and built-in events (unconditional trace and Run-
Break timer events).

[[Edit] Menu (Event Panel-Only Items)]

The [Edit] menu used exclusively for the Events panel is as follows. (All other items are disabled.)

Delete Deletes a selected event.
However, the built-in events (unconditional trace and Run-Break timer events) cannot be deleted.

Select All Selects all of the events displayed on this panel.
Find... Opens the Find and Replace dialog box, with its [Find in Files] tab selected.
Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.
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[Context menu]

Enable Event

Enables a selected event.

However, this is ignored if the selected event is already enabled.

Disable Event

Disables a selected event.

However, this is ignored if the selected event is already disabled.

Delete Deletes a selected event or an event condition.

However, the built-in events (unconditional trace and Run-Break timer events) cannot be deleted.
Select All Selects all of the currently displayed events.
View Select Shows the following cascaded menu to limit the event types to be displayed.

By default, all items are selected.

Hardware Break

Displays hardware break-related events.

Software Break

Displays software break-related events.

Timer Event

Displays timer-related events.

Trace Event

Displays trace-related events.

Action Event

Displays action events (Printf event).

Built-in Event Displays built-in events (unconditional trace and Run-Break timer events).
Timer Settings Shows the following cascaded menu to make timer-related settings.
However, this is enabled only when a timer-related event is selected.
Init Timer Initializes the timer to be used in a selected event (not including the Run-Break timer event).
Nanosecond Displays the result of a selected event measured by a timer in nanosecond (ns) units.

Microsecond

Displays the result of a selected event measured by a timer in microsecond (us) units.

Millisecond Displays the result of a selected event measured by a timer in millisecond (ms) units.
Second Displays the result of a selected event measured by a timer in second (s) units.
Minute Displays the result of a selected event measured by a timer in minute (min) units.

Jump to Memory

Opens the Memory panel (Memory1), with the caret on it moved to the memory value
corresponding to the address where a selected eventNOte'I is set.

Jump to Disassemble

Opens the Disassemble panel (Disassemble1), with the caret on it moved to the disassembled

result corresponding to the address where a selected eventNOte1 is set.

Jump to Source

Opens the Editor panel, with the caret on it moved to the source line corresponding to the address
where a selected eventNOte1is set.

Edit Condition ... Opens the detailed settings dialog box corresponding to a selected eventNOtez.
If a Trace event or combination break is selected, the Combination Condition dialog box [E1][E20]
[EZ Emulator] is opened.
If a Printf event is selected, the Action Events dialog box is opened.

Edit Comment Places a comment on a selected event into editing mode.

If a comment for the event already exists, the whole of its character string is selected.

Notes 1. This does not include trace events, timer measurement events, and built-in events (unconditional trace and

Run-Break timer events).

2. This includes the following events:

- Hardware break/execution-related events, access-related events, and timer measurement events

[E1] [E20]
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Output panel

This facility displays the messages output by various components supplied with CubeSuite+ (e.g., design, build and
analysis tools, including the debug tool), as well as display the results of global searches conducted using the Find and
Replace dialog box and the output results by Printf events (see “2.16.1 Insert printf").

Messages are displayed separately on respective tabs classified by tools from which they are output.

Figure A-43. Output Panel

Build endedi{Success:1 Project=s, Failed:0 Projects) (Thursday,
, 2008 1:1z:28 PM}

Debug Tool ,{ Search &And Replace ,-"’

Here, the following items are explained.
- [How to open]
- [Description of each area]
- [[File] menu (Output Panel-Only ltems)]
- [[Edit] menu (Output Panel-Only Items)]
- [Context menu]

[How to open]

- Choose [Output] from the [View] menu.

[Description of each area]

(1) Message area
Displays the messages output by each tool, search results, and the output results by Printf events.
During display of search results (global search), this area displays a new message after clearing previous
messages each time a search is performed (except for the [All Messages] tab).
Note that messages are displayed in different colors by type of output message, as shown below. (The colors in
which text and backgrounds are displayed depend on how the [General - Font and Color] category of the Option
dialog box are set.

Type of message Display example (Default) Description

Normal message AaBhiCc | Text color Black Displayed when notifying any information.

Background color | White

Warning message AaBtiCc | Textcolor Blue Displayed when notifying any warning for the
operation performed.

Background color | Standard color
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Type of message Display example (Default) Description

Error message AaBlhCc | Textcolor Red Displayed when unable to execute for a fatal

) error or operational mistake.
Background color | WhiteSmoke

This area provides the following facilities.

(a)

(b)

(c)

(d)

(e)

Tag jump

Double-click an output message, or move the caret to a message and then hit the [Enter] key. The Editor panel
is opened, displaying the relevant line number of the relevant file.

This facility permits you to jump to the relevant line in error of the source file from the error messages output,
for example, at build time.

Displaying help
While the caret is present at the line showing a warning or an error message, select [Help for Message] from
the context menu or press the [F1] key. Help for a message on that line is displayed.

Saving logs

Choose [Save Output-tab name As ...] from the [File] menu. The Save As dialog box is opened, allowing you to
save the whole content displayed on the currently selected tab to a text file (*.txt). (Messages on unselected
tabs are not saved.)

Zooming in or out on a view
To zoom in and out of the Output panel view, change the zoom ratio by using the drop-down list on the toolbar
of the Main window while the focus is placed in the Output panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
25%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).

Tab selection area

Select a tab showing the source from which a message is output.

The debug tool uses the following tabs.

Tab name Description

All Messages Displays the messages output by all components supplied with CubeSuite+ (e.g., design, build

and analysis tools, including the debug tool). (This does not apply to the messages associated
with execution of a rapid build.)

Debug Tool Displays only the messages output by the debug tool, out of those output by various
components supplied with CubeSuite+ (e.g., design, build and analysis tools, including the
debug tool).

Search and Replace Displays the results of global searches conducted from the Find and Replace dialog box.

Caution Even when a new message is output on some unselected tab, the panel does not have its tabs

automatically switched to show the new message. In this case, the relevant tab is marked with
an asterisk (*) at the beginning of its name, indicating that a new message has been output.
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[[File] menu (Output Panel-Only Items)]

The [File] menu used exclusively for the Output panel is as follows. (The other items are shared.)
Note that all of these items are disabled during program execution.

Save Output-tab name Saves the contents displayed on the currently selected tab to a text file (*.txt) that has been saved
previously. (See "(c) Saving logs.")
If this item is selected for the first time after startup, the same operation as you've selected [Save
Output-tab name As...] is performed.

This is disabled during build execution.

Save Output-tab name Opens the Save As dialog box to save the contents displayed on the currently selected tab to a
As... specified text file (*.txt). (See "(c) Saving logs.")

[[Edit] menu (Output Panel-Only Items)]

The [Edit] menu used exclusively for the Output panel is as follows. (All other items are disabled.)

Copy Copies a selected character string to the clipboard.

Select All Selects all of the messages displayed on the currently selected tab.

Find... Opens the Find and Replace dialog box, with its [Quick Find] tab selected.
Replace... Opens the Find and Replace dialog box, with its [Replace in Files] tab selected.

[Context menu]

Copy Copies a selected character string to the clipboard.

Select All Selects all of the messages displayed on the currently selected tab.

Clear Clears all of the messages displayed on the currently selected tab.

Tag Jump Opens the Editor panel and jumps to the relevant line number in the file pertaining to the message

at the caret position.

Stop Searching Halts the search currently under execution.

However, this menu is disabled when no searches are being executed.

Help for Message Displays help for a message at the current caret position.

However, this menu applies to only warning and error messages.
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Debug Console panel

This panel exchanges data between the console and program. This is accomplished by executing a program which has
standard library functions implemented in it.
Note that this panel can be opened only when CubeSuite+ is connected with the debug tool.

Figure A-44. Debug Console Panel

Debug Conzole

This section describes the following.
- [How to open]
- [Description of each areal
- [[Edit] menu (Debug Console panel-only items)]
- [Context menu]

[How to open]

- Select [Debug Console] from the [View] menu.

[Description of each area]

(1) 1O area
The standard library functions implemented in the program include, for example, the scanf function for reading the
data entered from the keyboard and the printf function for outputting data.
Also, by specifying a COM port on the panel, it is possible to redirect standard I/O of the program to the specified
COM port.
To use this function, the program must have the low-level interface routines provided by the debug tool
implemented in it (see "2.19 Using the Debug Console").

Remark [Simulator]
For details about the 1/O functions provided by the simulator, see "APPENDIX B /O FUNCTIONS."

(@) Zoom in or out on a view
To zoom in and out of the Debug Console panel view, change the zoom ratio by using the drop-down list on
the toolbar of the Main window while the focus is placed in the Debug Console panel.
You can also change the zoom ratio by using the [Ctrl] key + mouse-wheel combination.
- Using the [Ctrl] key + mouse-wheel forward will zoom into the view, making the contents larger and easier
to see (max. 300%).
- Using the [Ctrl] key + mouse-wheel backward will zoom out of the view, making the contents smaller (min.
25%).
If the panel is closed after the zoom ratio is changed, the changed zoom ratio is retained (next time, the panel
will open at the changed zoom ratio).
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[[Edit] menu (Debug Console panel-only items)]

The [Edit] menu items provided exclusively on the Debug Console panel are as follows. (The other items are shared.)

Copy Copies a selected character string to the clipboard.
Paste Inserts the content of the clipboard into the caret position.
Select All Selects all of the character strings displayed on this panel.

[Context menu]

Copy Copies a selected character string to the clipboard.

Paste Inserts the content of the clipboard into the caret position.

Clear Clears the display of this panel.

Enable/Disable Chooses to enable (default) or disable the debug console (a toggle switch).
Note that when the debug console function is disabled, the panel's background color changes to
gray.

COM Port... Opens the Port Setting dialog box to set a COM port on the host machine to which communication
from the microcontroller is redirected.

Log File... Opens the Open Log File dialog box to save the displayed content of this panel to a specified log
file (*.log).
Logging begins.

Logging Chooses to start (default) or stop logging (a toggle switch).
However, this item is disabled when no log files are specified.

Echo Back Chooses to enable (default) or disable local echoback (a toggle switch).
If local echoback is disabled, the input data is not output to this panel.
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Memory Mapping dialog box

This dialog box sets memory mappings separately for each memory type.

Figure A-45. Memory Mapping Dialog Box [E1] [E20] [EZ Emulator]

Memory Mapping E]

[Function buttons] ~|:

temony type: Addrezs range:
| |/0 protection area V| | HER | | HER |
Access width:
tMemorny mapped list;

Memory type Address range Size Access width
On-chip FAM area Qx00000000 - O0x00001fff & EBytes 2 bits
RBeserwved area Qx0000Z000 - O0x0007fff£f LO4 FEvtes 2 bits

I/0 registers area O0x00080000 - Ox0O0O0S83fff 16 EBEytes 2 bits
RBeserwved area Ox00024000 - 0x00025fff & EBvtes 2 bits

I/0 registers area O0x0002&000 - O0x00087fff 2 EBytes 2 bits

I/0 registers area O0x00022000 - Ox0Q08dfff Z4 EBytes 2 bits
Reserwed area Ox0008e000 - Ox0008ffff & EByvtes 8 bits

I/0 registers area 0x000%0000 - O0x000%ffff &4 EBytes 8 bits

I/0 registers area 0x000a0000 - O0x000bffff 1Z8 EBEvytes 8 bits

I/0 registers area O0x000c0000 - OxO00ff£ff 256 EBEytes 8 bits

Lata flash area 0x00100000 - O0x00101fff & EBytes 8 bits b
< >

[ 0k l [ Cancel ] [ Help ]

Figure A-46. Memory Mapping Dialog Box [Simulator]

Memory Mapping @

Memony type: Address range:
|Emu|ati0n ROM area v | | HER | | HER |
1) :
(1) Access width:
B remory mapped list:
Memory type Address randge Size hrress wideh
Internal PAM area 0x00000000 - Ox0000ffff &4 EBytes & bits
Non-map area 0x00010000 - 0x0007ffff 4483 FBEytes g bits
I/0 registers area 0x00020000 - Ox00022fff 1& KBytes g bits
Non-map area Ox00054000 - 0x0008Efff & EBytes g bits
I/0 registers area 0x00022000 - O0x00087fff 2 FBytes g bits
(2)__ I/0 registers area 0x00088000 - 0Ox0008dfff 4 EBytes 2 bits
Non-map area Ox0002e000 - 0Ox0002£££f 2 EBytes 2 bits
I/0 registers area 0x00090000 - Ox0009f£f£ff &4 EBEvytes 2 bits
I/0 registers area 0x000a0000 - Ox000bEf£f£f 122 EBRytes 2 bits
I/0 registers area 0x000c0000 - Ox000f£f££f EL& EBRytes 2 bits
Internal BOM area 0x00100000 - 0x00101fff 8 EBytes 8 bits= hl
£ >
[Function buttons] { )4 | ’ Help l
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Click the [...] button that is displayed when you select the [Memory mappings] property in the [Memory] category
on the Property panel's [Debug Tool Settings] tab.

Caution This dialog box cannot be opened during program execution.

[Description of each area]

(1) Additional memory mapping specification area
Specify information on a new memory mapping to be added.

(a) [Memory type]
Select the memory type of a memory mapping to be added from the drop-down list shown below. (The items
selected by default depend on the debug tool.)

Emulation ROM area Adds an emulation ROM area.

[Simulator] Uses simulator alternative ROM.

Emulation RAM area Adds an emulation RAM area.

[Simulator] Uses simulator alternative RAM.

I/O protection area Adds an I/O protection area.

[E1] [E20] [EZ Emulator] Specify an address range in the external area that is not to be read by the
debugger.

Cautions 1.  [Simulator]

Memory mapping can be added in the unit of 16 bytes. If you set it outside the 16-byte
boundary, compensation will be made to meet the 16-byte boundary area which
includes the area set after [OK] is clicked.

2. [Simulator]
Both read and write accesses to the memory mapping that has been added take one
cycle each.

3. [E1] [E20] [EZ Emulator]
When the [OK] button is clicked on, each I/O protection area that has been added is
adjusted to the access width of the external area that includes that I/O protection area.

(b) [Address range]

Specify the beginning and the end addresses of a memory mapping to be added. Enter a hexadecimal value
directly in the respective text boxes.
When an emulator is in use, I/O protection areas can be allocated to space that overlaps with external areas.
Each 1/O protection area cannot be allocated to two or more external areas.
When the simulator is in use, you cannot add memory mappings to the areas that overlap the following
memory types. (A message will appear if you click [Add] button in these areas.)

- [Internal ROM area]

- [Internal RAM area]
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- [IO register area]

(c) [Access width]
Access width cannot be specified.

(d) Button

Button Function

Add Adds the content specified in this area to memory mappings.

The added memory mapping is displayed in the [Memory mapped list] area.

Note that the changed content is not set until the [OK] button is pressed.

(2) [Memory mapped list] area

(a) List display
Displays memory mappings added in the Additional memory mapping specification area and information on
the microcontroller's internal memory mappings. This area cannot be edited.

Memory type Following memory types are displayed:

- Internal ROM area

- Internal RAM area

- I/O register area

- External area (CS7/CS6/.../CS0) [E1] [E20] [EZ Emulator]
- Other memory area [E1] [E20] [EZ Emulator]

- Reserved area [E1] [E20] [EZ Emulator]

- 1/O protection area [E1] [E20] [EZ Emulator]

- Emulation ROM area [Simulator]

- Emulation RAM area [Simulator]

- Non-map area [Simulator]

Address range Displays an address range <Start address> - <End address>.

The addresses are always expressed in hexadecimal, with "0x" added.

Size Displays a size in decimal (in byte or Kbyte units).

Access width Displays an access width (in bit units)Not,

Note Since access width is not supported in the simulator, a fixed value (8 bit) will be displayed. The
simulation execution time will not be affected by the access width value.

(b) Button
Button Function
Remove Deletes a memory mapping selected in this area.
When an emulator is in use, only /O protection areas can be deleted.
When the simulator is in use, the memory area that can be deleted is either an Emulation ROM
area or an Emulation RAM area. (The microcontroller's internal memory mappings cannot be
deleted.)
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[Function buttons]

Button Function
OK Sets a currently set memory mapping in the debug tool and then closes this dialog box.
Cancel Nullifies changes made to memory mappings and then closes this dialog box.
Help Displays help for this dialog box.
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Download Files dialog box

This dialog box selects a file to download and sets download conditions (see Section "2.5 Download and Upload").
The files specified in the project (main project or sub-project) as the subject to build are automatically registered as the
subject files to be downloaded (not removable).

Figure A-47. Download Files Dialog Box

Download Files

()

Download file list: Download file property:
Tutorial abs EH Download file information
File
Download object Ve

Download symbal information  ves
Specify the PIC/PID offzet Mo

Ok

File
Specify the file to be downloaded.

I QK. H Cancel H Help }[Function buttons]

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Select the [Download files] property in the [Download] category on the [Download File Settings] tab of the Property
panel and then click the [...] button that is displayed.

Caution This dialog box cannot be opened during program execution.

[Description of each area]

(1) [Download file list] area

(a) Displaying a list
This area displays a list of file names to download. By default, the file names specified in the project (main
project or sub-project) as the subject to build are displayed (not removable).
Files are downloaded in the order in which they are listed here.
To add a new download file, click the [Add] button in this area and then specify the download conditions for the
file to be added in the [Download file property] area.
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(b) Buttons

Button Function

Up Moves a selected file one line up.

However, this button is disabled when the file at the top of the list or a file specified as the subject
to build in the project is selected.

Down Moves a selected file one line down.

However, this button is disabled when the file at the bottom of the list or a file specified as the
subject to build in the project is selected.

Add Adds one blank item ("-") to the list, with the item selected.
In the [Download file property] area, specify the download conditions for the file to be added.

However, this button is disabled when 20 or more files are already registered.

Remove Removes a selected file from the list.

However, the files specified as the subject to build in the project cannot be removed.

Remarks 1.  Place the mouse cursor at a file name, and the path information for the subject file is displayed in a
popup box.
2. The order in which files are listed can be changed by dragging any file name up or down in the list
with the mouse. However, the files specified as the subject to build in the project cannot have their
order in the list changed.

(2) [Download file property] area

(a) [Download file information]
This section displays download conditions or changes of settings made for a file selected in the [Download file
list] area.
Also, if a new download file is added using the [Add] button, this section may be used to specify download
conditions for the file added.

File Specify a file to download
Default File name (However, blank when newly added)
How to change Enter directly from the keyboard, or specify in the Select Download File

dialog box that is opened by clicking the [...] buttonN°te 1 that is displayed
at the right edge of the column when this item is selected.

Specifiable value | See "Table 2-2. Downloadable File Formats".

Specifiable in up to 259 characters

File type Specify the file format of a file to download.
Default Load module file
How to change Select from the drop-down list.

Specifiable value | One of the following:
- Load module file

- Hex file

- S record file

- Binary data file
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Offset

This item is displayed only when the files to download are in hex format or S record files.

Specify an offset value from the address at which download of a specified file begins.

Default 0

How to change Enter directly from the keyboard.

Hexadecimal values from 0x0 to OxFFFFFFFF

Specifiable value

Start address

This item is displayed only when the files to download are in binary data format.

Specify the start address from which a specified file is downloaded.

Default 0

How to change Enter directly from the keyboard.

Hexadecimal values from 0x0 to OxFFFFFFFF

Specifiable value

Download object

This item is displayed only when the files to download are in load module format.

Specify whether or not to download object information from a specified file.

Default Yes

How to change Select from the drop-down list.

Specifiable value | Yes Object information is downloaded.

No Object information is not downloaded.

Download symbol
information

This item is displayed only when the files to download are in load module format.

Specify whether or not to download symbol information from a specified fileNote 2,

Default Yes

How to change Select from the drop-down list.

Specifiable value | Yes Downloads symbol information.

No Does not download symbol information.

Specify the PIC/PID
offset

Specify whether to change the positions of PIC (Position Independent Code) and PID (Position
Independent Data) areas of the load modules to download from those specified during the
creation of load modules. When "Yes" is selected, "PIC Offset" and "PID Offset" will appear as
sub-items.

Default No

How to change Select from the drop-down list.

Specifiable value | Yes PIC/PID offset is specifiedNote 3,

No PIC/PID offset is not specified.

PIC Offset

Input the offset values from the address specified at the time of load module creation.

For instance, if you enter "1000" here when the start address of the program section is 0x1000,
the corresponding section will be downloaded to 0x2000.

Default 0

How to change Enter directly from the keyboard.

Hex number between 0x0 and OxFFFFFFFF

Specifiable value
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PID Offset Input the offset values to the PID register specified at the time of load module creation.
For instance, if you want to set 0x200 to the PID register when executing the load module,
enter "200" here.
Default 0
How to change Enter directly from the keyboard.
Specifiable value | Hex number between 0x0 and OxFFFFFFFF
Notes 1. If any file as the subject to build in the project is selected in the [Download file list] area, or while the

[Function buttons]

program is under execution, the [...] button is not displayed.

Unless symbol information is downloaded, source-level debugs cannot be performed.

Proper debug operation is not guaranteed when you have selected "Yes" for load modules that

were created without using PIC/PID function (see Section "2.7 Usage of PIC/PID Function").

Button Function
OK Terminates download file settings and closes this dialog box.
Cancel Nullifies download file changes made and closes this dialog box.
Help Displays help for this dialog box.
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Text Edit dialog box

This dialog box permits you to enter or edit plural lines of text.

[Function buttons] ~|:

Figure A-48. Text Edit Dialog Box

Text Edit 3]

Text:

(0] 4 H Cancel H Help

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- Click the [...] button that is displayed when you select any property in the [Hook Transaction Settings] category on

the Property panel's [Hook Transaction Settings] tab.

[Description of each area]

(1) [Text] area

This area permits you to edit plural lines of text.

[Function buttons]

Button Function
OK Reflects entered text in the caller of this dialog box and then closes this dialog box.
Cancel Closes this dialog box without having entered text reflected in its caller.
Help Displays help for this dialog box.
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Action Events dialog box

You can set action events in this dialog box (see "2.16 Set an Action into Programs").
This dialog box can be opened only when you are connected to the debug tool.

Caution Also see "2.17.7 Points to note regarding event setting" for details on action event settings,
including the allowable number of valid events.

Figure A-49. Action Events Dialog Box

]

Action Events

(1) = || Printf evert | Interrupt Event Setting

Oukput gtrinag: Example] Sample:

“ariable expreszion;  Example] aaa, bbb, coo

Address;
| CA\Test w |

(2)

Example for Dutput panel]

Sample: aaa =10, bbb = 20, coc =30

[Function buttons]~|: " Cancel |[ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set an action event, then select [Register Action
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set a Printf event, then select
[Register Action Event...] from the context menu.

- On the Events panel, select [Edit Condition...] from the context menu after selecting the action event.
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[Description of each area]

(1) Tab selection area
You can switch action events to be registered by the selection of a tab. This dialog box has the following tabs.

- [Printf event] tab
- [Interrupt event setting] tab [Simulator]

Caution When you open this dialog box by selecting [Edit Condition...] from the context menu, this area
will be hidden.

(2) [Event conditions settings] area
You can set detailed conditions for each action event in this area. See the section of the corresponding tab for the

details of the setting procedure.

[Function buttons]

Button Function
OK Ends the setting of the action event and sets the specified action event at a specified location.
Cancel Cancels the action event setup and closes this dialog box.
Help Displays the help for this dialog box.
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[Printf event] tab

This tab is used to configure Printf events as action events (see "2.16.1 Insert printf").

A Printf event momentarily stops the execution of the program at a specified location, and executes the printf command
via software processing. When a Printf event is set, the program momentarily stops immediately before executing the
command at the location where this event is set, and the value of the variable expression specified in this dialog box is
output to the Output panel.

Figure A-50. Action Events Dialog Box: [Printf Event] Tab

Action Events rz

Printf ewvert | [rtermipt Event Setting

Output string: Esample] Sample:

{ “arable exprezsion:  Example] aaa, bbb, coo

Address:
| ChTest w |

Example for Dutput panel]

Sample: aaa =10, bbb = 20, coo = 30

[Function buttons]{ ¢ Cancel |[ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set a Printf event, then select [Register Action
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set a Printf event, then select
[Register Action Event...] from the context menu.

- On the Events panel, select [Edit Condition...] from the context menu after selecting the Printf event.

[Description of each area]

(1) [Output string] area
Type in the string to add to the Output panel directly via the keyboard (up to 1024 characters).
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Note that the output string can only be one line (spaces allowed).

(2) [Variable expression] area
Specify the variable expression(s) for the Printf event.
Type a variable expression directly into the text box (up to 1024 characters).
You can specify up to 10 variable expressions for a single Printf event by separating them with commas (",").
If this dialog box is opened with a variable expression selected in the Editor panel /Disassemble panel, the
selected variable expression appears as the default.
The basic input format that can be specified as variable expressions and the values output by Printf event are as
follows:

Table A-14. Relationship between Variable Expressions and Output Value (Printf Event)

Variable Expression Output Value

C/C++ variable name Note 1 Value of a C/C++ variable

Variable expression [Variable expression] Element values of an array

Note 2

Variable expression.Member name Member values of a structure/union/class

Note 2

Variable expression -> Member name

Member values of a structure/union/class member pointed to by
a pointer

Variable expression.*Cast expression

Value of a pointer to member variable

Variable expression->*Cast expression

Value of a pointer to member variable

*Variable expression Value of a pointer variable

&Variable expression Location address

(Type name) Variable expression Value cast to a specified type

CPU register name Value of a CPU register

I/O register name Value of an I/O register

Label name N 3 EQU symbol name Nete 3,

[immediate value]

Value of a label, value of an EQU symbol, a value of an
immediate address

Notes 1. C89, C99, or C++ language variable
2. When using a member variable of a base class, specify the scope before the member name (e.g.
variable.BaseClass::member).
3. Ifthe label name or EQU symbol name includes a "$," be sure to enclose the name in "{ }" (Example:
{$Label}).
Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*I). When you specify the
CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the keyword "I".

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").
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(3) [Address] area

Specify the address at which to set the Printf event.
You can either type address expressions directly into the text boxes (up to 1024 characters), or select them from
the input history via the drop-down list (up to 10 items). By default, address of the presently specified location is

displayed.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").

Note that the output result format by the Printf event in the Output panel are as follows:

Figure A-51. Output Result Format of Printf Event

Specified characters

2, Variable expression 3 = Value 3,

Variable expression 1 = Value 1, Variable expression 2 = Value

Specified characters

Characters specified with [Output string]

Variable expression 1- 10 Characters specified with [Variable expression]

Value 1-10

Value of variable corresponds to " Variable expression 1 - 10"

variable expression cannot be acquired.

be displayed, "-" will be shown instead.)

The value is displayed in a format that matches the variable type (see Table A-10.
Display Form of Watch-expressions (Default)). ("?" )will be displayed when the specified

The value is also displayed in hexadecimal in bracket "()". (If a hexadecimal value cannot

[Function buttons]

Button Function
OK Finishes configuring the Printf event, and sets it at the caret position in the Editor panel/
Disassemble panel.
Cancel Cancels the Printf event setup and closes this dialog box.
Help Displays the help for this dialog box.
R20UT2350EJ0100 Rev.1.00 RENESAS Page 397 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

[Interrupt event setting] tab [Simulator]

You can set an interrupt event in this tab (see "2.16.2 Insert an interrupt event [Simulator]").

An interrupt event is a function with which you can generate an interrupt request at a specified point. When an interrupt
event is set, an interrupt request will occur immediately before the execution of an instruction for which the event is set.
Once the interrupt request is accepted by the CPU, interrupt exception will take place.

Figure A-52. Action Events Dialog Box: [Interrupt event setting] Tab

Action Events rg

Printf event | ntemupt Event S etting |

Interrupt Yector:
(1) | |

Pricrity:

Function butt :
[Function bu ons]~|: Cancel | [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set an interrupt event, then select [Register
Action Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set an interrupt event, then select
[Register Action Event...] from the context menu.

- On the Events panel, select [Edit Condition...] from the context menu after selecting the interrupt event.

[Description of each area]

(1) [Interrupt Vector] area
Specify the interrupt vector by directly entering a corresponding number between 0 and 255.
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(2) [Priority] area
- [RX610 Group]

[Function buttons]

Specify the priority order by directly entering a number between 1 and 8.
When 8 is specified, the event is handled as a fast interrupt.

- [Non-RX610 Group]

Specify the priority order by directly entering a number between 1 and 16.
When 16 is specified, the event is handled as a fast interrupt.

Button Function
OK Finishes configuring the interrupt event, and sets it to the line/address at the caret position in the
Editor panel/Disassemble panel.
Cancel Cancels the interrupt event setup and closes this dialog box.
Help Displays the help for this dialog box.
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Encoding dialog box

This dialog box is used to select a file-encoding.

Figure A-53. Encoding Dialog Box

X

main.c - Encoding

¥ Available encodings:

1146: |BM EBCDIC [UK-Eura) ”
1147 1BM EBCDIC [France-Eura)

1143 [BM EBCDIC [International-Eural

1145: 1IBM EECDIC [lcelandic-Euro]

1200 Unicode

1207: Unicode [Big-E ndian)

1260: Central European [windowvs)

1251 Cyrillic Pafindows

M7

[Function buttons]{ [ 0K ] [ Cancel ] [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- From the [File] menu, open the Open File dialog box by selecting [Open with Encoding...], and then click the
[Open] button in the dialog box.

[Description of each area]

(1) [Available encodings]
Select the encoding to be set from the drop-down list.
All code-pages and encodings supported by the OS are displayed in alphabetical order.
Note that the same encoding and encoding which are not supported by the current OS will not be displayed.
The default file-encoding in the [General - Text Editor] category of the Option dialog box is selected by default.

[Function buttons]

Button Function
OK Opens the selected file in the Open File dialog box using a selected file encoding.
Cancel Does not open the selected file in the Open File dialog box and closes this dialog box.
Help Displays help for this dialog box.
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Save Settings dialog box

This dialog box is used to set the encoding and newline code of the file that is being edited on the Editor panel.

Remark The target file name is displayed on the title bar.
Figure A-54. Save Settings Dialog Box

main.c - Save Settings

X

Encode:
1
) |"-.-'-.-"estern European [windowsz]

Mewline code:
2
( ){ ‘windows [CR LF)

(3) —4# | Beload the file with these settings

[Function buttons]{ oK ] I Cancel | [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Focus the Editor panel, and then select [File name Save Settings...] from the [File] menu.

[Description of each area]

(1) [Encode] area
Select the encoding to be set from the drop-down list.
The items of the drop-down list are displayed according to the following sequence.

Note that the same encoding and encoding which are not supported by the current OS will not be displayed.

- Current encoding of the file (default)
- Default encoding of the current OS
- Most recently used encodings (maximum 4)
- Popular encodings for current locale
(e.g. for United States locale it will be:
- Western European (Windows)
- Unicode (UTF-8)
- All other encodings supported by the OS (in alphabetical order)
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(2) [Newline code] area

Select the newline code to be set from the drop-down list.

You can select any of items below.
- Windows (CR LF)
- Macintosh (CR)
- Unix (LF)

An active newline entry is selected by default.

(3) [Reload the file with these settings]

Reloads the file with the selected encoding and newline code when the [OK] button is clicked.

O

Does not reload the file when the [OK] button is clicked (default).

[Function buttons]

Button Function
OK Sets the selected encoding and newline code to the target file and closes this dialog box.
If [Reload the file with these settings] is selected, sets the selected encoding and newline code to
the target file and reloads the file. And then closes this dialog box.
Cancel Nullifies the settings and closes this dialog box.
Help Displays the help for this dialog box.
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Bookmarks dialog box

This dialog box is used to display the position of a registered bookmark or to delete a bookmark.

Figure A-55. Bookmarks Dialog Box

Bookmarks

File Line Mum... = Path Wi
init.c: 17 C:hvsamplehapplihsource

Cihvaample appli source

task.c 22 C:\Samplehappliteource

Bemove
Remove All
Mest

Previous

Help

Cloze

1t i

T
[Function buttons]

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- From the [Edit] menu, select [Bookmarks] >> [List Bookmarks...].

[Description of each area]

(1) Bookmark list area
This area display a list of bookmarks that have been registered.
The bookmarks are listed alphabetically by name of file where the bookmarks are registered. Bookmarks in the
same file are listed in line number order.
When a bookmark is added to the Editor panel, the information of the bookmark is added to the list.
In the bookmark list area, double-clicking on a line moves a caret to the corresponding position for the bookmark.

(a) [File]
Shows the name of the file (without any path) in which a bookmark is registered.

(b) [Line Number]
Shows the number of the line to which the bookmark is registered.

(c) [Path]
Shows the path of the file in which the bookmark is registered.

Caution If the Editor panel is closed, bookmarks registered on the panel will be removed.
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[Function buttons]

Button Function

View Moves a caret to the position of the selected bookmark.

However, this button is disabled when no bookmark is selected, two or more bookmarks are
selected, or no bookmark is registered.

Remove Removes a selected bookmark. When two or more bookmarks are selected, all of those selected
are removed.

However, this button is disabled when no bookmark is selected or no bookmark is registered.

Remove All Removes all the registered bookmarks.

This button is disabled when no bookmark is registered.

Next Moves a caret to the position of the bookmark next to the selected bookmark.
This button is disabled in the following cases.

- A bookmark shown in the last line has been selected.

- No bookmark is selected.

- Two or more bookmarks are selected.

- No bookmark is registered.

- Only one bookmark is registered.

Previous Moves a caret to the position of the bookmark previous to the selected bookmark.
This button is disabled in the following cases.

- A bookmark shown in the first line has been selected.

- No bookmark is selected.

- Two or more bookmarks are selected.

- No bookmark is registered.

- Only one bookmark is registered.

Help Displays the help for this dialog box.
Close Closes this dialog box.
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Column Number Settings dialog box

This dialog box is used to set the number of view columns of memory values on the Memory panel.

Figure A-56. Column Number Settings Dialog Box

Golumn, Humber Settings

(1){ Column Mumber: |16

[Function buttons] { QK l [ Cancel ] [ Help ]

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Column Number Settings...] from the context menu.

[Description of each area]

(1) [Column Number] area
Directly enter a decimal value as the number of columns you want to display.
The settable range depends on [Size Notation] currently being set on the Memory panel, as follows:

Size Notation Settable Range
4 Bits 2-512MN0te
1 Byte 1-256
2 Bytes 1-128
4 Bytes 1-64
8 Bytes 1-32

Note Only an even number is specifiable (if an odd number is specified, then it will be changed to a value one
greater than such odd number).

[Function buttons]

Button Function
OK Displays memory values in the specified number of columns.
Cancel Nullifies settings and then closes this dialog box.
Help Displays the help for this dialog box.
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Address Offset Settings dialog box

This dialog box is used to set an offset value of the start address in the address area on the Memory panel.

Figure A-57. Address Offset Settings Dialog Box

Address Offset Settings

(1) ~|: fddress Offzet Walue: | Hex| ]

[Function buttons] ~|: Ok l [ Cancel ] [ Help ]

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Address Offset Value Settings...] from the context menu.

[Description of each area]

(1) [Address Offset Value] area
Directly enter a hexadecimal value as an offset value for the address display.
The settable range depends on the number of bytes of the memory currently being displayed in a line on the
Memory panel, as follows:
- Settable range: 0xO0 - ("Set value of [Size Notation]' x "The number of view columns") -1

Example When "Set value of [Size Notation]" is 1 byte and "The number of view columns" is 16 columns:

Offset Value Displayed Content of Address Area
0x0 (default) 0000
0010
0020
0x1 0001
0011
0021
0x2 0002
0012
0022
[Function buttons]
Button Function
OK Displays memory addresses with the specified offset value.
Cancel Nullifies settings and then closes this dialog box.
Help Displays the help for this dialog box.
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Memory Initialize dialog box

This dialog box initializes memory values. (See "(6) Collectively changing (initializing) memory contents".)
A pattern of specified initialization data is written into a specified address range of memory repeatedly.

Figure A-58. Memory Initialize Dialog Box

Memory Initialize

Start addressSsymbal End address/zymbal:
w [ - | hput the end address or 2w [w]w

Initialize data:
) { wex {Input the initial data in hexadecimal here. The two or more data  [w]w

[Function buttons] ~|: Cancel ] [ Help ]

Here, the following items are explained.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Choose [Fill...] from the context menu on the Memory panel.

[Description of each area]

(1) Range specification area
Specify an address range of memory whose values need to be initialized in [Start address/symbol] and [End
address/symbol]. Enter address expressions directly in the respective text boxes (specifiable in up to 1,024
characters) or select an input history item from the drop-down list (up to 10 history entries).
The calculation results of the input address expressions are handled respectively as the start address and end
address.
No address values can be specified that are greater than the microcontroller's address space.

Caution Note that an address range that covers areas with different endians cannot be specified.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").

(2) [Initialize data] area
Specify the initialization data to be written into memory.
To specify initialization data, enter a hexadecimal value directly in the text box or select an input history item from
the drop-down list (up to 10 history entries).
To specify multiple pieces of initialization data, specify a maximum of 16 pieces of up-to-4-byte data (8 characters)
by separating each with a space.
Each piece of initialization data are interpreted as comprising 1 byte in units of 2 characters from the tail end of the
character string. If the data consists of an odd number of characters, the first character in it is assumed to be
comprising 1 byte.
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Note that if the data consists of 2 bytes or more, it is converted, before being written into the target memory, to an

appropriate byte sequence that suits the project's endian as shown below.

Input character string (initialization data)

Written-in image (in bytes)

Little endian Big endian
1 01 01
012 0012 0012
00012 345 00 12 00 45 03 00 00 12 03 45

000 12 000345

0000 12 45 03 00

0000 1200 03 45

[Function buttons]

Button Function
OK Writes a pattern of specified initialization data into a specified address range of memory
repeatedly. (If the end address is reached in the middle of this pattern, the write process is
terminated.)
Cancel Nullifies settings for memory value initialization and closes this dialog box.
Help Displays help for this dialog box.
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Memory Search dialog box

This dialog box searches for memory values. (See "(5) Searching for memory contents")
A search is performed in either the Memory value area or Character string area in which the caret on the Memory panel
was present immediately before this dialog box is opened.

Figure A-59. Memory Search Dialog Box

Memory Search [

) { Search Data: | v |

) { Search Range: |Specif;-.-' addrezs range w |

3) { Address: | 00 v | - et v |

[Function buttons] { [ Cancel ] [ Help ]

Here, the following items are explained.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Choose [Find...] from the context menu on Memory panel.

[Description of each area]

(1) [Search Data] area
Specify the data to search.
Enter directly in the text box (specifiable in up to 256 bytes) or select an input history item from the drop-down list
(up to 10 history entries).
If the subject of search is in the Memory value area of the Memory panel, the data needs to be entered in the same
form (numeral system and size) as displayed in that area.
Also, the subject of search is in the Character string area, it is necessary to specify a character string as the data to
search. The specified character string, before being searched, is converted to data in appropriate encoding form in
which data are displayed in that area.
Note that if any memory value was selected immediately before this dialog box was opened, then the selected
value is displayed by default.

(2) [Search Range] area
Select a range in which to search from the drop-down list below.

Specify address range A search is conducted within the address range specified by [Address] area.

Memory mapping A search is conducted within the selected range of memory mapping.

This list item displays memory mappings individually (except non-mapped areas) that are
displayed in the Memory Mapping dialog box.

Display form: <Memory type> <Address range> <Size>
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(3) [Address] area

This item is valid only when [Specify Address Range] is selected in the [Search Range] area.

Specify the "start address" and "end address" to set the address range in which a memory value is searched.

Directly enter address expressions in the respective text boxes (specifiable in up to 1,024 characters) or select an

input history item from the drop-down list (up to 10 history entries).

The calculation results of the entered address expressions are handled respectively as the start address and end

address.

However, searchable addresses are limited to the upper-limit address of the program space (OxFFFFFFFF).

Also, no address values can be specified that are greater than the value representable by 32 bits.

Remarks 1.

[Function buttons]

By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the
present caret position (see "2.20.2 Symbol name completion function").

If the "start address" text box is blank, address "0x0" is assumed.

If the "end address" text box is blank, the upper-limit address of the microcontroller's address
space is assumed.

Button

Function

Search Backward

Performs a search in the direction toward smaller addresses within the range specified in the
[Search Range] area and [Address] area. The searched spot is placed in selected state on
Memory panel.

However, if an invalid value is specified, or when the program is under execution, a message is
displayed and a search for memory value is not performed.

Also, if the Memory panel is hidden, or if focus is moved to this dialog box while focus was present
on another panel, this button is disabled.

Search Forward

Performs a search in the direction toward larger addresses within the range specified in the
[Search Range] area and [Address] area. The searched spot is placed in selected state on
Memory panel.

However, if an invalid value is specified, or when the program is under execution, a message is
displayed and a search for memory value is not performed.

Also, if the Memory panel is hidden, or if focus is moved to this dialog box while focus was present
on another panel, this button is disabled.

Cancel Nullifies settings for a search of memory value and closes this dialog box.
Help Displays help for this dialog box.
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Print Address Range Settings dialog box

When printing the content of the Disassemble panel, specify an address range of the subject to be printed.

Figure A-60. Print Address Range Settings Dialog Box

Print Address Range Settings E|

Select a specifving twpe of the printing addreszes.

(&) iCumrent display area

) Bange of specified

[Function buttons] { [ (1] l ’ Cancel l ’ Help ]

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Disassemble panel, choose [Print...] from the [File] menu.

[Description of each area]

(1) Range specification area
To specify a range to be printed, select one of the option buttons given below.

(a) [Current display area] (default)
Prints only a currently displayed range on the Disassemble panel.

(b) [Current selected area]
Prints only a currently selected range on the Disassemble panel.
However, this is disabled if nothing is selected on the Disassemble panel.

(c) [Range of specified]
Specify an address range of the subject to be printed by [Start address] and [End address].
Enter an address expression directly in the respective text boxes (specifiable in up to 1,024 characters) or
select an input history item from the drop-down list (up to 10 history entries).

Remark By pressing the [Ctrl] + [Space] keys in this text box, it is possible to complement a symbol name at
the current caret position (see "2.20.2 Symbol name completion function").
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[Function buttons]

Button Function

OK Closes this dialog box and opens a Windows printing dialog box to print a specified range of
contents of the Disassemble panel.

Cancel Closes this dialog box ignoring range selection settings.
Help Displays help for this dialog box.
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Print Preview window

This window is used to preview the file currently being displayed in the Editor panel before printing.

Remark This window can be zoomed in and out by moving the mouse wheel forward or backward while holding
down the [Ctrl] key.

Figure A-61. Print Preview Window

!‘ Print Preview

[Toolbar]{ - & = E‘ \:l l:l l:l
—| C¥CubeSuite¥NewPraject¥main.c
75 void main{void)
76 |
7 /#* Start user code. Do not edit comment generated here #/
78
79 TMPO_Start ().
80 TMP1_Start ().
81 AD_Start ().
(1) — 82
B3
B4 while (1U)
85 {
B6 funcl () :
87 func2 () :
8B ]
8O /* End user code. Do not edit comment generated here */
o0 | o
< >

This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Context menu]

[How to open]

- Focus the Editor panel, and then select [Print Preview] from the [File] menu.

[Description of each area]

(1) Preview area
This window displays a form showing a preview of how and what is printed.
The file name (absolute path) and the page number are displayed at the page header and page footer, respec-
tively.
The columns displayed differ according to whether the debug tool is or is not connected, and when it is connected,
to whether the display is in normal display mode or mixed display mode. Note, however, that columns that are hid-
den on the Editor panel are not displayed (these columns are not printed).
When code outlining facility is used in the Editor panel, the lines in the collapsed section are displayed in a print
preview along with the marks indicating the types of source code blocks that are collapsed (see (a) Code outlin-

ing).
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[Toolbar]
Opens the Print dialog box provided by Windows to print the current contents of the Editor panel as shown by the
print preview form.
|__|J Copies the selection into the clipboard.
Increases the size of the content.

Decreases the size of the content.

Displays the preview at 100-percent zoom (default).

Fits the preview to the width of this window.
(8]
o

Displays the whole page.

Displays facing pages.

[Context menu]

Increase Zoom Increases the size of the content.
Decrease Zoom Decreases the size of the content.
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Trace Search dialog box

This dialog box searches for trace data (see Section "2.13.8 Searching for trace data").
Before performing a search, it is possible to choose whether the search is made at the instruction level or source level.

Figure A-62. Trace Search Dialog Box

Trace Search X

— Search condition

Fetch Address:

v - | W |

Mremonic:

2 Access Status ¢

|
|
focess Address: | v| = | M |
|
|

Data: HEH | - |HEH W |

Search range

MNumber: | v| = | v|

[Function buttons] { Search Backward ] [Search FEorward ] [ Cancel ] [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Click the toolbar button on the Trace panel.
- Choose [Find...] from the context menu on the Trace panel.

[Description of each area]

(1) Tab selection area
Selecting a tab switches the level at which a search is performed.
This dialog box has the following tabs:

- [Instruction Level] tab
- [Source Level] tab
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(2) Search condition setting area
Set specific conditions under which a search is performed.
For details about display contents and on how to set, see the section in which the relevant tab is described.

[Function buttons]

Button Function

Search Backward Performs a search in the direction toward smaller addresses within a specified range.

The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified or when the program is under execution, a message is
displayed and a search of trace data is not performed.

Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus was present on
another panel, this button is disabled.

Search Forward Performs a search in the direction toward larger addresses within a specified range.

The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified or when the program is under execution, a message is
displayed and a search of trace data is not performed.

Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus was present on
another panel, this button is disabled.

Cancel Nullifies the setting for a search of trace data and closes this dialog box.
Help Displays help for this dialog box.
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[Instruction Level] tab

The acquired trace data is searched at the instruction level.

Caution If, while the Trace panel is displayed in the Source display mode, an instruction-level search is
performed on this tab, the subject data cannot be searched correctly.
To perform an instruction-level search, make sure the Trace panel is displayed in the Mixed display
mode or Disassemble display mode.

Figure A-63. Trace Search Dialog Box: [Instruction Level] Tab

Trace Search 3]
Ihstructu:unLeve|| Source Level
_ Search condition
Fetch Address: | L | = | b |
Mremonic: | L |
(1) focess Address: | L | = | b |
ficcess Status ¢ | |
Data: |HEH | = |HEH = |
= Search range
(2) MNumber: | v| = | v|
[Function buttons] { Search Backward ] [Search Forward ] [ Cancel ] [ Help
This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]
[How to open]
- Click the toolbar button on the Trace panel.
- Choose [Find...] from the context menu on the Trace panel.
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[Description of each area]

(1) [Search condition] area

(a) [Fetch Address]
Specify a fetch address, if needed as the search condition.
Enter an address expression directly in the text box or select an input history item from the drop-down list (up
to 10 history entries).
The fetch address can also be specified as a range of addresses. In this case, enter address expressions in
both the right and left text boxes to specify a range.
If the right-side text box is blank or labeled [(Input value when range is specified)], the fixed address specified
in the left-side text box is used to perform a search.
Note that if any address value greater than the microcontroller's address space is specified, the high-order
address value is masked when a search is performed.
Also, no address values can be specified that are greater than the value representable by 32 bits.

(b) [Mnemonic]
Specify a character string of instruction, if needed as the search condition.
The character string specified here is searched from within the [Source/Disassemble] area of the Trace panel.
Enter an instruction directly in the text box or select an input history item from the drop-down list (up to 10
history entries).
Searches are case-insensitive, and partial matches are also allowed.

(c) [Access Address]
Specify an access address, if needed as the search condition.
Enter an address expression directly in the text box or select an input history item from the drop-down list (up
to 10 history entries).
The access address can also be specified as a range of addresses. In this case, enter address expressions in
both the right and left text boxes to specify a range.
If the right-side text box is blank or labeled [(Input value when range is specified)], the fixed address specified
in the left-side text box is used to perform a search.
Note that if any address value greater than the microcontroller's address space is specified, the high-order
address value is masked when a search is performed.
Also, no address values can be specified that are greater than the value representable by 32 bits.

(d) [Access Status]
This item is enabled only when [Access Address] is specified.
Select the type of access from the drop-down list below.
When not limiting the type of access, select [No Specification].

(No Specification)

Read/Write

Read

Write

Vector Read [Simulator]

DMA
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Caution [E1] [E20] [EZ Emulator]
The types of access for which data can be collected on the Trace panel are Read and Write.
Therefore, do not select Read/Write, Vector Read or DMA from the drop-down list.
[Simulator]
The types of access for which data can be collected on the Trace panel are only Read, Write,
and Vector Read. Therefore, do not select Read/Write or DMA from the drop-down list.

(e) [Data]
This item is enabled only when [Access Address] is specified.
Specify an accessed numeric value.
Enter a hexadecimal value directly in the text box or select an input history item from the drop-down list (up to
10 history entries).
The numeric value can be specified as a range of values. In this case, enter data in both the right and left text
boxes to specify a range.
If the right-side text box is blank or labeled [(Input value when range is specified)], the fixed numeric value
specified in the left-side text box is used to perform a search.

(2) [Search range] area

(a) [Number]
Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "last number" are
specified.)
Enter a number in decimal notation directly in the text box or select an input history item from the drop-down
list (up to 10 history entries).
If the left-side text box is blank, the number "0" is assumed.
If the right-side text box is blank, the "last number" is assumed.

[Function buttons]

Button Function

Search Backward Performs a search in the direction toward smaller addresses within a specified range.
The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified, a message is displayed and a search of trace data is not
performed. Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus
was present on another panel, this button is disabled.

Search Forward Performs a search in the direction toward larger addresses within a specified range.
The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified, a message is displayed and a search of trace data is not
performed. Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus
was present on another panel, this button is disabled.

Cancel Nullifies the setting for a search of trace data and closes this dialog box.
Help Displays help for this dialog box.
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[Source Level] tab

The acquired trace data is searched at the source level.
Caution If, while the Trace panel is displayed in the Disassemble display mode, a source-level search is
performed on this tab, the subject data cannot be searched correctly. To perform a source-level

search, make sure the Trace panel is displayed in the Mixed display mode or Source display mode.

Figure A-64. Trace Search Dialog Box: [Source Level] Tab

Trace Search [
Ihstruction Level |S |
. Search object
1 (%) The execution part iz retrieved specifving the zource line
(1)~ () The execution part iz retrieved specifving the function
() The execution part iz retrieved specifving the global variable
— Search condition
Source and Line: | L |
(2) 7 | |
| HEH | | HEH |
B Search range
) Mumber: | w | = | w |
[Function buttons] { [ Cancel ] [ Help ]
This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]
[How to open]
- Click the toolbar button on the Trace panel.
- Choose [Find...] from the context menu on the Trace panel.
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[Description of each area]

(1) [Search object] area
Select the subject to search from the option buttons below.

The execution part is retrieved specifying Searches the specified source for an executed part (default).

the source line Only [Source and Line] is valid as the search condition.

The execution part is retrieved specifying Searches the specified function for an executed part.

the function Only [Function Name] is valid as the search condition.

The execution part is retrieved specifying Searches the specified global variable for an accessed location.

the global variable Only [Variable Name], [Kind] and [Value] are valid as the search condition.

(2) [Search condition] area

(a) [Source and Line]
This item is enabled only when [The execution part is retrieved specifying the source line] is selected.
The character string specified here is searched from within the [Line/Address] area of the Trace panel. Enter a
character string included in the source line to search directly in the text box or select an input history item from
the drop-down list (up to 10 history entries).
Searches are case-insensitive, and partial matches are also allowed.

Examples 1. main.c#40
2. main.c
3. main

(b) [Function Name]
This item is enabled only when [The execution part is retrieved specifying the function] is selected.
Enter a variable name to search directly in the text box or select an input history item from the drop-down list
(up to 10 history entries).
Searches are case-sensitive, and only perfect matches are allowed.

(c) [Variable Name]
This item is enabled only when [The execution part is retrieved specifying the global variable] is selected.
Enter a variable name to search directly in the text box or select an input history item from the drop-down list
(up to 10 history entries).
Searches are case-sensitive, and only perfect matches are allowed.

(d) [Kind]
This item is enabled only when [The execution part is retrieved specifying the global variable] is selected.
Select the type of access ([Reference/Substitution] (default), [Reference], or [Substitution]) from the drop-
down list.

(e) [Value]
This item is enabled only when [The execution part is retrieved specifying the global variable] is selected.
Use a hexadecimal number to specify an accessed variable value.
Enter a variable value directly in the text box or select an input history item from the drop-down list (up to 10
history entries).

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 421 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

The variable value can be specified as a range of values. In this case, enter variable values in both the right
and left text boxes to specify a range.

If the right-side text box is blank, the fixed variable value specified in the left-side text box is used to perform a
search of accessed location.

(3) [Search range] area

(a) [Number]
Specify a range of trace data to search by numbers displayed in the [Number] area of the Trace panel.
Specify start and end numbers in the left and right text boxes, respectively. (By default, "0" to "last number" are
specified.)
Enter a number in decimal notation directly in the text box or select an input history item from the drop-down
list (up to 10 history entries).
If the left-side text box is blank, the number "0" is assumed.
If the right-side text box is blank, the "last number" is assumed.

[Function buttons]

Button Function

Search Backward Performs a search in the direction toward smaller addresses within a specified range.
The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified, a message is displayed and a search of trace data is not
performed. Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus
was present on another panel, this button is disabled.

Search Forward Performs a search in the direction toward larger addresses within a specified range.
The searched spot is put in selected state on the Trace panel.

However, if an invalid value is specified, a message is displayed and a search of trace data is not
performed. Also, if the Trace panel is hidden, or if focus is moved to this dialog box while focus
was present on another panel, this button is disabled.

Cancel Nullifies the setting for a search of trace data and closes this dialog box.
Help Displays help for this dialog box.
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Combination Condition dialog box [E1][E20] [EZ Emulator]

This dialog box is used to change the detailed information on combination condition for the combination break or for the

trace event selected on the Events panel.

Remark See "2.17.7 Points to note regarding event setting" for details on event setting.

Figure A-65. Combination Condition Dialog Box (Combination Break)

Combination Condition @

(1) Break. |
(2) — Combination; | Sequential W |
Ohbject event;
Ma. Event p
After Execution sort.cH13 DxffE5dd
o 2 Read o InBuf Oxl42c - 0x142f == 055
B Rezet event:
) | Ewent Releasze
After Execution sart.ci17 Oxffff35e5
[Function buttons]~|: ok, ] [ Cancel ] [ Help
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Figure A-66. Combination Condition Dialog Box (Trace Event)

Combination Condition

Start Condition | End Condition

3

[Function buttons]~|:

Combination: | 0R L |
Object event:
Ewent p
ReadAsfite g_CharBuf 01000 - 0:1000 == Ox2
After Execution sort.cH17 Dxfifi3bde Do
F Ewent
Reszet event:
Event Releaze
] l [ Cancel ] [ Help

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to the combination break of which you wish to change the detailed

information, then select [Edit Condition ...] from the context menu.

- On the Events panel, move the caret to the trace of which you wish to change the detailed information, then select

[Edit Condition ...] from the context menu.
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[Description of each area]

(1) Tab selection area
You can display the detailed information on combination conditions by the selection of a tab. Types of tabs to be
displayed will differ depending on the event you have selected on the Events panel.

Combination break Only [Break] tab is displayed.

Trace [Start Condition] tab and [End Condition] tab are displayed. By switching, you can
set the combination condition for each tab.

(2) Combination condition selection area

(b) [Combination]
Select the conditions from the following drop-down list.

Conditions Functions
OR The condition is satisfied when one of the set events is encountered.
AND The condition is satisfied when all the set events are encountered irrespective

of the time line.

Sequential The condition is satisfied when the set events are encountered in the specified
sequence.

Cautions 1. When the combination condition is "Sequential”, break event (access-related) can be
specified for the 1st to the 3rd position.
2.  When the combination condition is "Sequential”, break event (access-related) for which
an address area condition has been set can be specified only for the 1st position.
3. For trace events, the combination condition available for a trace end event is only [OR].

(3) Object event condition display area

(a) Display of the list
The object events to be combined are shown in the list.

No. The events in the list are numbered from top to bottom. This item is displayed only
when you have specified [Sequential] for the combination conditions. For the
condition to be satisfied, events must be encountered in the order indicated by
these numbers.

Event Detailed information on event conditions is displayed.

It is identical to the information displayed on the Events panel.
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(b) Buttons

Buttons

Functions

Up

Moves the event serial number upward in the Object event list. This button is
enabled only when you have specified [Sequential] for the combination conditions.

Down

Moves the event serial number downward in the Object event list. This button is
enabled only when you have specified [Sequential] for the combination conditions.

R Event

Moves the event selected in the Object event list to the Reset event list. This
button is enabled only when you have specified [Sequential] for the combination
conditions.

(4) Reset event condition display/cancel area

(a) Display of the list

Detailed conditions are displayed for the event which has been registered as a reset event. When the reset

event displayed in this list is encountered, all the other event conditions which have been holding until then will

be cleared.

Cautions 1.

Only one reset event is specifiable.

If you click the [R Event] button with the reset event registered, the event selected in the

Object event list and the registered reset event will replace each other.

If you change the combination condition from [Sequential] to [OR] or [AND] with the

reset event registered, the event in the Reset event list cannot be included in the Object

event list. In order to include it in the Object event list, you need to first cancel the reset

event registration before making changes to the combination conditions.

The pass count cannot be specified for an event that has been registered as the reset
event.
(b) Button
Button Function
Cancel Moves the event inside the Reset event list to the Object event list. This button is
enabled only when you have specified [Sequential] for the combination conditions.

[Function buttons]

Buttons Functions
OK Applies the detailed settings specified in the dialog box to the combination break or to the trace
and closes this dialog box.
Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Detailed Settings of Timer Measurement dialog box [E1] [E20] [EZ Emulator]

This dialog box is used to display and change the detailed information on the timer event selected on the Events panel.
Note that you cannot edit the address value of the timer event in this dialog box. If you need to edit the address value, first
delete the timer event and then create a new one. For details on timer event setting, see "2.14 Measuring the Execution
Time".

Figure A-67. Detailed Settings of Timer Measurement Dialog Box

[Toolbar]- f[®=
E-. -

4

Ei Meazurement Setting |

Meazurement item Execution cycle
E wecution only ance Mo

Meazurement Setting

(2) -

[Function buttons] — Ok ] [ Cancel ] [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Description of each category]
- [Function buttons]

[How to open]

- On the Events panel, move the caret to the timer event of which you wish to change the detailed information, then
select [Edit Condition ...] from the context menu.
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[Description of each area]

(1) Detailed information display/change area
In this area, detailed information on the timer event selected in the Events panel is displayed by category in the list.
Also, you can directly change its settings.

(2) Property description area
In this area, brief description of the categories and properties selected in the detailed information display/change
area is displayed.

[Toolbar]
Displays categories in the detailed information display/change area.
%Jf Hides categories in the detailed information display/change area and rearranges
only property items in the ascending order.

[Description of each category]

(1) [Measurement Setting]
You can display and modify the detailed settings on timer measurement.

Measurement item Note - RX600 Series
Specify the measurement item.
- RX200 Series

Displays "Execution cycle".

Default Execution cycle

Modifying Select from the drop-down list

Available values One of the following as selected from the drop-down list.
[RX600 Series]

Execution cycle, Execution cycle (Supervisor mode),
Exception and interrupt cycle, Exception cycle, Interrupt
cycle, Execution count, Exception and interrupt count,
Exception count, Interrupt count

[RX200 Series]

Execution cycle

Execution only once Specifies whether to end the measurement after measuring the specified segment only
once.
Default No
Modifying One of the following as selected from the drop-down list
Available values Yes Ends the measurement after measuring the

specified segment only once.

No The measurement value is cumulated every

time you pass through the specified segment.

Note [RX100 Series]
These microcontrollers does not support timers.

R20UT2350EJ0100 Rev.1.00 .’{ENESAS Page 428 of 506
Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

[Function buttons]

Buttons Functions
OK Applies the detailed settings specified in the dialog box to the timer event and closes this dialog
box.
Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Detailed Settings of Execution Events dialog box

This dialog box is used to display and change detailed information on execution-related events selected on the Events
panel.
Note that the execution-related events refer to the following events on the Events panel.
- Hardware break
- After execution (or post-execution) break in the detailed information on combination break [E1] [E20] [EZ
Emulator]
- After execution (or post-execution) events
information on trace
- After execution (or post-execution) events

Note registered as trace start and trace end events in the detailed

Note registered as timer start and timer end events in the detailed

information on timer result (or timer measurement)

Note [Simulator]
Before execution (or pre-execution) events apply instead of after execution events.

Figure A-68. Detailed Settings of Execution Events Dialog Box [E1] [E20] [EZ Emulator]

Detail X
[Toolbar] @| ol

E 1Address

B Pass Count
Pazz count 256
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(2) Specifiez pasz count. [1-256]
[Function buttons] - [ ak. l [ Cancel ] [ Help
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Figure A-69. Detailed Settings of Execution Events Dialog Box [Simulator]
Detail X

[Toolbar] g_| ol

B rAddress

B Pass Count
Pazz count 16383

Pasz count
(2) Specifiez pazs count. [1-16383)

[Function buttons] — [ ()4 ] [ Cancel ] [ Help

This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Description of each category]
- [Function buttons]

[How to open]

- On the Events panel, move the caret to the hardware break of which you wish to change the detailed information,
then select [Edit Condition ...] from the context menu.

- On the Events panel, move the caret to the execution-related event in trace of which you wish to change the
detailed information, then select [Edit Condition ...] from the context menu.

- On the Events panel, move the caret to the execution-related event in timer result of which you wish to change the
detailed information, then select [Edit Condition ...] from the context menu.

[E1] [E20] [EZ Emulator]

- On the Events panel, move the caret to the execution-related event in combination break of which you wish to

change the detailed information, then select [Edit Condition ...] from the context menu.
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[Description of each area]

(1) Detailed information display/change area
This area displays, in list form of the category, the detailed information on an execution-related event that is
selected on the Events panel, allowing for its settings to be changed directly.

(2) Property description area
This area displays a simple description of the category or property selected in the detailed information display/
change area.

[Toolbar]
Displays a category in the detailed information display/change area.
%Jf Hides categories in the detailed information display/change area and rearranges
only property items in the ascending order.

[Description of each category]

(1) [Address]

Address Displays the address at which an execution-related event is set.

No address values can be specified here.

Default Depends on selected event
modifying Not changeable
(2) [Pass Count]
Pass count Specify a pass count in decimal.

The relevant event occurs when the event condition is met as many times as the entered

pass count.
Default 1
Modifying By entering directly from the keyboard
Available values - [E1] [E20] [EZ Emulator]
1 to 256
- [Simulator]
1to 16,383

Cautions 1.  [E1] [E20] [EZ Emulator]
The pass count can be specified by any value other than 1 for only one event among all
events (including access-related events).
If a pass count of other than 1 is specified for two events, an error results.
2. [E1(Serial)/E20(Serial)/EZ Emulator [RX100, RX200 Series]]
No values other than 1 can be specified for the pass count.
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[Function buttons]

Buttons Functions
OK Applies detailed settings made in this dialog box to execution-related events before closing the
dialog box.
Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Detailed Settings of Access Events dialog box

This dialog box is used to display or change detailed information on access-related events selected on the Events
panel.
Note that the access-related events refer to the following events on the Events panel.
- Read, write, and read/write in the detailed information on combination break [E1] [E20] [EZ Emulator]
- Read, write, and read/write in the detailed information on hardware break [Simulator]
- Read, write, and read/write in the detailed information on trace
- Read, write, and read/write in the detailed information on point trace
- Read, write, and read/write in the detailed information on timer result

Figure A-70. Detailed Settings of Access Events Dialog Box [E1] [E20] [EZ Emulator]

[Toolbar] - %: J}l
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End address

(2) 4 Specify the end address. Start address iz the value which iz specified at [Addresz]
property ikern.
[Function buttons] 0k ] [ Cancel ] [ Help ]
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Figure A-71. Detailed Settings of Access Events Dialog Box [Simulator]
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Description of each category]
- [Function buttons]

[How to open]

- On the Events panel, move the caret to the access-related event in trace of which you wish to change the detailed
information, then select [Edit Condition ...] from the context menu.
- On the Events panel, move the caret to the access-related event in point trace of which you wish to change the
detailed information, then select [Edit Condition ...] from the context menu.
- On the Events panel, move the caret to the access-related event in timer result of which you wish to change the
detailed information, then select [Edit Condition ...] from the context menu.
[E1] [E20] [EZ Emulator]
- On the Events panel, move the caret to the access-related event in combination break of which you wish to change
the detailed information, then select [Edit Condition ...] from the context menu.
[Simulator]
- On the Events panel, move the caret to the access-related hardware break of which you wish to change the
detailed information, then select [Edit Condition ...] from the context menu.
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[Description of each area]

(1) Detailed information display/change area

This area displays, in list form of the category, the detailed information on an access-related event that is selected

on the Events panel, allowing for its settings to be changed directly.

(2) Property description area

This area displays a simple description of the category or property selected in the detailed information display/

change area.

[Toolbar]

Displays categories in the detailed information display/change area.

Hides categories in the detailed information display/change area and rearranges
only the property items in the ascending order.

[Description of each category]

The properties that can be displayed and changed differ with the debug tool used.
(1) For [E1] [E20] [EZ Emulator]

(2) For [Simulator]

(1) For [E1] [E20] [EZ Emulator]

(a) [Address]

Address

Displays the address at which an access-related event is set.

No address values can be specified here.

Default Depends on selected event

modifying Not changeable

(b) [Address Condition]

Compare condition

Specify address comparison condition.

Default No specification
Modifying By selecting from the drop-down list
Available values No conditions No address comparison condition is

specified

Address areaNom‘I

Note2

Specify comparison condition based on
an address range.

Compare with
address mask

Specify masked comparison condition.
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Area condition Specify address comparison range condition.

This property is displayed only when [Address area] is selected in the [Compare condition]

property.

Default Inside the range (<=values<=)

Modifying By selecting from the drop-down list

Available values Inside the range Condition holds true for an access
(<=values<=) within the range.
Outside the range Condition holds true for an access
I(<=Values<=) outside the range.

End address Specify the end address

The start address is the value displayed in the [Address] property.

This property is displayed only when [Address area] is selected in the [Compare condition]

property.
Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF
Address mask Specify a mask value in hexadecimaI.Note3

This property is displayed only when [Compare with address mask] is selected in the
[Compare condition] property.

Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF

Compare Specify comparison condition.

This property is displayed only when [Compare with address mask] is selected in the
[Compare condition] property.

Default Specified value (==

Modifying By selecting from the drop-down list

Available values Specified value Condition holds true when the address
==) range that matches the result of the

mask is accessed.

Any other value (=) | Condition holds true when any address
that does not match the result of the
mask is accessed.

Notes 1. [RX100, RX200 Series]
Comparison conditions based on an address area are not supported.
2. [RX600 Series]
You can specify "Address area" as the comparison condition only to one event.
3. The address value to be used as the condition is masked bit-wise with a mask value for which "0" is
specified.
Example) To set an address condition of 0x1000 to Ox1FFF
Address value : 0x1000
Mask value : 0xFO00
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(c) [Data Condition]

Access type

Specify the type of access.

Default

Read/Write

Modifying

By selecting from the drop-down list

Available values

Read The specified type of access is a
read.

Write The specified type of access is a
write.

Read/Write The specified type of access is a
read and a write.

Access size

Specify the access size.

Default

No conditions

Modifying

By selecting from the drop-down list

Available values

No conditions No access size is specified.

True for all access sizes.

Byte The specified access size is a byte.
Word The specified access size is a word.
Long word The specified access size is a long

word.

Compare data

Specify compare data in hexadecimal.

Default

Blank

Modifying

By entering directly from the keyboard

Available values

0x0 to OXFFFFFFFF

Specify the data mask

Specify whether or not to specify a data mask.

Default

No

Modifying

By selecting from the drop-down list

Available values

Yes Data mask is specified.

No No data mask is specified.

Mask value

Specify mask data in hexadecimal.

Note

This property is displayed only when [Yes] is specified in the [Specify the data mask]

property.
Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF
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Compare condition Specify data comparison condition.

This property is displayed only when [Yes] is specified in the [Specify the data mask]

property.

Default Specified value (==

Modifying By selecting from the drop-down list

Available values Specified value (== Condition holds true with the access

of the data value that matches the
result of the mask.

Any other value (!=) Condition holds true with any access
of the data value that does not
match the result of the mask.

Note The data value to be used as the condition is masked bit-wise with a mask value for which "0" is
specified.

(d) [Pass Count]

Pass count Specify a pass count in decimal.
The relevant event occurs when the event condition is met as many times as the entered
pass count.
Default 1
Modifying By entering directly from the keyboard
Available values 1 to 256
Cautions 1.  [E1] [E20] [EZ Emulator]
The pass count can be specified by any value other than 1 for only one event among all
events (including execution-related events).
If a pass count of other than 1 is specified for two events, an error results.
2. [E1(Serial)/E20(Serial)/EZ Emulator [RX100, RX200 Series]]

The pass count can only be specified by 1. Any value other than 1 cannot be specified.

(2) For [Simulator]

(a) [Address]

Address

Displays the address at which an access-related event is set.

No address values can be specified here.

Default Depends on selected event

Modifying Not changeable

(b) [Address Condition]

Compare condition Displays address comparison condition.
Default No conditions
Modifying Not changeable
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(c) [Data Condition]

Access type Specify the type of access.
Default Depends on selected event
Modifying By selecting from the drop-down list
Available values Read The specified type of access is a
read.
Write The specified type of access is a
write.
Read/Write The specified type of access is a
read and a write.
Access size Specify the access size.
Default Depends on selected event
Modifying By selecting from the drop-down list
Available values No conditions No access size is specified.
True for all access sizes.
Byte The specified access size is a byte.
Word The specified access size is a word.
Long word The specified access size is a long
word.
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Compare condition

Specify data comparison condition.

This property is not displayed when [No conditions] is specified in the [Access size]

property.
Default Equal (==
Modifying By selecting from the drop-down list

Available values

Equal (==

True when data matches specified
value.

Not equal (!=)

True when data does not match
specified value.

Inverse sign

True when the sign is inverted
between the previously accessed
data and the data accessed this

time_Note1

Difference

True when the difference between
the previously accessed data and
the data accessed this time exceeds
a specified value.Note1

Greater than (>)

True when data is greater than
specified value.

Less Than (<)

True when data is smaller than
specified value.

to (>=)

Greater than or equal

True when data is equal to or greater
than specified value.

(<=)

Less Than or equal to

True when data is equal to or smaller
than specified value.

(<=Values<=)

Inside the range

True when data is within the range of
specified value.

([Compare data1] <= data <=
[Compare data2])

I(<=Values<=)

Outside the range

True when data is outside the range
of specified value.

(data < [Compare data1] || [Compare
data2] < data)

No conditions

Compare data is not specified.
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Compare data1

Specify compare data in hexadecimal.

This property is displayed when one of the following is specified in [Compare condition]
property.

- Equal (==

- Not equal (=)

- Greater than (>)

- Less Than (<)

- Greater than or equal to (>=)

- Less Than or equal to (<=)

- Inside the range (<=Values<=)

- Outside the range !(<=Values<=)

Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF

Compare data2

Specify compare data in hexadecimal.

This property is displayed when one of the following is specified in [Compare condition]
property.

- Inside the range (<=Values<=)

- Outside the range !(<=Values<=)

Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF

Difference

Specify compare data in hexadecimal.

This property is displayed when [Difference] is specified in [Compare condition] property.

Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF

Specify the data mask

Specify whether or not to specify a data mask.

This property is displayed when one of the following is specified in [Compare condition]
property.

- Equal (==

- Not equal (1=)

- Greater than (>)

- Less Than (<)

- Greater than or equal to (>=)

- Less Than or equal to (<=)

- Inside the range (<=Values<=)

- Outside the range !(<=Values<=)

Default No

Modifying By selecting from the drop-down list

Available values Yes A data mask is specified.
No No data mask is specified.
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Mask value Specify a mask value in hexadecimaI.Notez

This property is displayed when [Yes] is specified in [Specify the data mask] property.

Default Blank
Modifying By entering directly from the keyboard
Available values 0x0 to OXFFFFFFFF

Sign Specify whether or not the data to be compared includes a sign.

This property is displayed when one of the following is specified in [Compare condition]
property.

- Difference

- Greater than (>)

- Less Than (<)

- Greater than or equal to (>=)

- Less Than or equal to (<=)

- Inside the range (<=Values<=)

- Outside the range !(<=Values<=)

Default Signed
Modifying By selecting from the drop-down list
Available values Signed Data is compared with the sign
included.
Unsigned Data is compared with no sign
included.

Notes 1. For [Inverse sign] and [Difference], since comparison is made with the previous data, the condition
never holds true after a reset and in the first determination of whether condition is true.
2. The address value to be used as the condition is masked bit-wise with a mask value for which "0" is
specified.

[Function buttons]

Buttons Functions

OK Applies the detailed settings made in this dialog box to the access-related events before closing
the dialog box.

Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Detailed Settings of Interrupt Events dialog box [Simulator]

This dialog is used to display and change detailed information on an interrupt event selected on the Events panel.

Figure A-72. Detailed Settings of Interrupt Events Dialog Box [Simulator]
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [Description of each category]
- [Function buttons]

[How to open]

- On the Events panel, move the caret to the interrupt event of which you wish to change the detailed information,
then select [Edit Condition...] from the context menu.
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[Description of each area]

(1) Detailed information display/change area
This area displays, in list form of the category, the detailed information on an interrupt event that is selected on the
Events panel, allowing for its settings to be changed directly.

(2) Property description area
This area displays a simple description of the category or property selected in the detailed information display/
change area.

[Toolbar]
Displays a category in the detailed information display/change area.
%Jf Hides categories in the detailed information display/change area and sorts only the
property items in the ascending order.

[Description of each category]

(1) [Address]

Address Displays the address at which an interrupt event is set.

No address values can be specified here.

Default Depends on the selected event
Modifying Not changeable
(2) [Pass Count]
Pass count Specifies a pass count in decimal.
The relevant event occurs when the event condition is met as many times as the entered
pass count.
Default 1
Modifying Direct entry from the keyboard
Specifiable value 1to 16,383
(3) [Interrupt]
Interrupt vector Specifies an interrupt vector.
Default Depends on the selected event
Modifying Direct entry from the keyboard
Specifiable value 0x00 to OxFF
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Priority Specifies an interrupt's priority level.
Default Depends on the selected event
Modifying Direct entry from the keyboard
Specifiable value - [RX610 group]
1t08

If 8 is specified, the interrupt will act as a fast interrupt.
- [Other than RX610 group]
1t0 16

If 16 is specified, the interrupt will act as a fast interrupt.

[Function buttons]

Buttons Functions
OK Applies the detailed settings made in this dialog box to interrupt events, and then closes the dialog
box.
Cancel Nullifies settings and closes this dialog box.
Help Displays help for this dialog box.
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Port Setting dialog box

This dialog box sets a COM port on the host machine to which communication from the microcontroller is redirected.

Figure A-73. Port Setting Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Debug Console panel, select [COM Port...] from the context menu.

[Description of each area]

(1) [COM Port] area
Select a COM port to which communication is redirected. If there are no COM ports available on the host machine,
this drop-down list is blank.

(2) [Baudrate] area
Select a baud rate at which communication is performed with the redirected COM port.
The drop-down list displays the following baud rates. If "System" is selected, the baud rate set by the device
manager applies.
System, 1200, 2400, 4800, 9600, 19200, 38400, 115200

[Function buttons]

Button Function

Connect/Disconnect Connects to (default) or disconnects from a COM port.
When connected to a COM port, the button is labeled "Disconnect."

When disconnected from a COM port, the button is labeled "Connect."

Cancel Nullifies COM port settings and closes this dialog box.
Help Displays help for this dialog box.
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Scroll Range Settings dialog box

Set a range in which the vertical scroll bar of the Memory panel or Disassemble panel is scrolled.
When an appropriate range is set, the slider on the vertical scroll bar of the panel changes in size, so that dragging or
the like operation with the mouse will be improved.

Caution Even when, after a scroll range is set in this dialog box, the addresses represented by specified
address expressions are altered by execution of a line assemble, etc., the scroll range is not

corrected.

Remark Movement in a panel window by the [Page Up], [Page Down], [Up] or [Down] key or a button at the end of
the scroll bar, or by selection of a jump-related menu is possible, even outside the scroll range.

Figure A-74. Scroll Range Settings Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Memory panel, select [View] and then click the button in the toolbar.

- On the Memory panel, select [View] and then [Settings Scroll Range...] on the context menu.

- On the Disassemble panel, select [View] and then click the button in the toolbar.

- On the Disassemble panel, select [View] and then [Settings Scroll Range...] on the context menu.

[Description of each area]

(1) [Start address] area
Specify the start address of a range to be scrolled.
Enter an address expression directly in the text box (specifiable in up to 1,024 characters) or select an input history
item from the drop-down list (up to 10 history entries).
Note that if "All" in the drop-down list is selected, no scroll ranges are set (no limits to scroll range).

Remark By pressing the [Ctrl] + [Space] keys in this text box, it is possible to complement a symbol name at the
current caret position (see "2.20.2 Symbol name completion function").
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(2) [End address] area
Specify the end address of a range to be scrolled.

Enter an address expression directly in the text box (specifiable in up to 1,024 characters) or select an input history
item from the drop-down list (up to 10 history entries).
However, this area disabled if "All" is specified in [Start address]].

Remark

By pressing the [Ctrl] + [Space] keys in this text box, it is possible to complement a symbol name at the
current caret position (see "2.20.2 Symbol name completion function").

[Function buttons]

Button Function
OK Sets a specified scroll range in the panel concerned with it and moves the caret to the subject
panel, with the start address appearing at the beginning of display.
Cancel Nullifies settings and then closes this dialog box.
Help Displays help for this dialog box.
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Go to Line dialog box

This dialog box is used to move the caret to a specified source line.

Figure A-75. Go to Line Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

Go to Line

Line nurnber [1-133)

X

H Cancel ][ Help

- From the [Edit] menu, select [Go To...].

- On the Editor panel, select [Go To...] from the context menu.

[Description of each area]

(1) [Line number (valid line range)] area

"(valid line range)" shows the range of valid lines in the current file.

Directly enter a decimal value as the number of the line you want to move the caret to.

You can also enter a symbol in this area.

By default, the number of the line where the caret is currently located in the Editor panel is displayed.

[Function buttons]

Button Function
OK Places the caret at the start of the specified source line.
Cancel Cancels the jump and closes this dialog box.
Help Displays help for this dialog box.
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Go to the Location dialog box

Move the caret to a specified position.

Figure A-76. Go to the Location Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Choose [Go To...] from the [Edit] menu.
- On the Disassemble panel, select [Go To...] on the context menu.
- On the IOR panel, select [Go To...] on the context menu.

[Description of each area]

(1) [Address/Symbol] or [IOR] area
Specify a location to which you want the caret to be moved.
Enter directly in the text box (specifiable in up to 1,024 characters) or select an input history item from the drop-
down list (up to 10 history entries).
The content of specification differs with the panel concerned, as shown below.

Subject panel Content of specification

Disassemble panel Address expression

IOR panel 1/O register name

Remark If this dialog box is opened from the Disassemble panel by pressing the [Ctrl] + [Space] keys in the text
box here, it is possible to complement a symbol name at the current caret position (see "2.20.2
Symbol name completion function").

[Function buttons]

Button Function
OK Moves the caret to the subject panel, with a specified position appearing at the beginning of
display.
Cancel Nullifies settings and then closes this dialog box.
Help Displays help for this dialog box.
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Data Save dialog box

This dialog box saves the displayed contents of Disassemble panel, Memory panel or Trace panel and the upload data.
(See "2.5.3 Executing an upload")
This dialog box can only be opened when CubeSuite+ is connected with the debug tool.

Figure A-77. Data Save Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- While focus is on the Disassemble panel, choose [Save Disassemble Data As...] from the [File] menu.
- While focus is on the Memory panel, choose [Save Memory Data As...] from the [File] menu.

- While focus is on the Trace panel, choose [Save Trace Data As...] from the [File] menu.

- Choose [Upload...] from the [Debug] menu.

[Description of each area]

(1) [File Name] area
Specify a file name under which you want to save the data.
Enter a name directly in the text box (specifiable in up to 259 characters) or select an input history item from the
drop-down list (up to 10 history entries).
It is also possible to select a file from the Select Data Save File dialog box that is opened by clicking the [...] button.
If you specify only a file name with no path information attached, the project folder is assumed.

(2) [File Type] area
Select the file format in which to save the data from the drop-down list below.

The selectable file format is determined by the type of data you are saving.

(a) When saving the displayed content of a panel

Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables) (*.csv) CSV formatNote
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Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes (™) in order to avoid illegal
formatting.

(b) When saving upload data
For the selectable file format, see "Table 2-3. Uploadable File Formats".

(3) [Save Range xxx] area
Specify the range of data to save.
You can either type ranges directly into the text boxes, or select them from the input history via the drop-down lists
(up to 10 items).
The method of specifying the ranges will differ as follows depending on the type of data to be saved.

Type of Data Description

Disassemble panel Specify the range of addresses to save via the start and end addresses.
Ranges can be entered as base-16 numbers or as address expressions.
When a range is selected in the panel, that range is specified by default.

When there is no selection, then the range currently visible in the panel is specified.

Memory panel Specify the range of memory to save via the start and end addresses.
Ranges can be entered as base-16 numbers or as address expressions.

When a range is not selected in the panel, then the range currently visible in the panel is specified.

Trace panel - Specifying a range to save

Specify the trace range to save via the start and end trace numbers Note,
Ranges can only be entered as base-10 numbers.

- Saving all trace data
From the drop-down list to the left, select [All Trace Data]. The text box to the right is
disabled. All currently acquired trace data will be saved.

The range currently visible in the panel is specified by default.

Upload data Specify the range of memory to save via the start and end addresses.

Ranges can be entered as base-16 numbers or as address expressions.

Note These are the numbers shown in the [Number] area of the Trace panel.

Remark By holding down [Ctrl]+[Space] keys in this text box, you can complete the symbol name at the present
caret position (see "2.20.2 Symbol name completion function").

[Function buttons]

Button Function
Save Saves the data to a file with the specified filename, in the specified format.
Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Progress Status dialog box

When CubeSuite+ is performing a process that takes time, it displays the progress of the process.
This dialog box closes automatically when the process under execution is finished.

Figure A-78. Progress Status Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function button]

[How to open]

- Automatically displayed when a message is generated while a time-consuming process is underway.

[Description of each area]

(1) Message display area
Displays a message generated during a process (not editable).

(2) Progress bar
Shows the progress of the currently executed process by means of the length of a bar.
Note that when the progress rate reaches 100% (when the right edge of the bar is reached), this dialog box closes
automatically.

[Function button]

Button Function

Cancel Aborts the currently executed process and closes this dialog box.

However, if the process under execution cannot be aborted, this button is disabled.
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Option dialog box

This dialog box makes various environment settings of CubeSuite+.
The settings in this dialog box are saved as settings for the current user of CubeSuite+.

Figure A-79. Option Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Select [Options...] from the [Tool] menu.

[Description of each area]

(1) Category selection area
Select an item to set from the categories below.

Category Content of Setting
[General - Startup and Exit] category Make settings related to startup or exit time.
[General - Display] category Make settings related to display.
[General - External Text Editor] category Make settings related to external text editors.
[General - Font and Color] category Make settings related to fonts and colors displayed on each panel.
[General - External Tools] category Make settings with which external tools are started.
[General - Build/Debug] category Make settings related to build or debug.
[General - PythonConsole] category Make settings related to the Python console.
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Category

Content of Setting

[General - Text Editor] category

Make settings related to text editors.

[General - Update] category

Make settings related to updates.

[Others - User Information] category

Make settings related to user information.

Remark For categories other than [General - Fonts and Colors] and [General - Build/Debug], see the separate

edition, "CubeSuite+ Integrated Development Environment User's Manual: Start."

(2) Setting area

This area is where various options for a selected category are set.
For details on how to set up each category, see the section in which the relevant category is described.

[Function buttons]

Button

Function

Initialize All Settings

Restores all of the set items in this dialog box to their default state.

For the [General - External Tools] category, however, newly registered contents are not deleted.

OK Applies changes and closes this dialog box.
Cancel Nullifies changes and closes this dialog box.
Apply Applies changes without closing this dialog box.
Help Displays help for this dialog box.
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[General - Font and Color] category

In this category, you can configure fonts and colors displayed on each panel.

Figure A-80. Option Dialog Box ([General - Font and Color] Category)
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Select [Options...] from the [Tool] menu.

[Description of each area]

(1) Color setting area
This area is where colors are set.

(a) [Setting place] area
Select from the list a spot whose display color is to be specified.
The relationship between the items displayed in the list and the colors set for each by default is as follows.

ltem Example Display Description

DefaultNote AaBhCe Text color Black Standard display colors on all windows and panels

Background | White
color
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ltem Example Display Description
Warning AaBhCe Text color Blue Display colors of warning messages on the Output panel,
as well as display colors for file names with "warnings
Background | Standard ) )
included" on the Project Tree panel
color color
Error AaBhiCe Text color Red Display colors of error messages on the Output panel, as
) well as display colors for file names with "errors included"
Background | WhiteSmoke .
on the Project Tree panel
color
Reserved AaBhCe Text color Maroon Display colors of reserved words on the Editor panel for
word compilers/assemblers used
Background | Standard
color color
Comment AaBhbice | Text color Green Display colors of comment parts (for C source files, "/* to */
") on the Editor panel
Background | Standard
color color
String literal AaBhCe Text color Gray Display colors of string literals on the Editor panel
Background | Standard
color color
Control code | fszBhCr Text color DarkCyan Display colors of control characters on the Output panel
Background | Standard
color color
Highlight Text color White Display colors of highlighted spots in plug-in products, etc.
Background | MediumViol
color etRed
Changed AaBhCe Text color Sienna Display colors on the Memory panel, CPU Register panel,
value ) Local Variables panel, IOR panel and Watch panel of spots
Background | LightYellow )
color whose values have been changed by program execution
Edit value AaBhCe Text color Blue Display colors on the Memory panel, CPU Register panel,
Local Variables panel, IOR panel and Watch panel of spots
Background | Standard )
whose values have been forcibly changed by user
color color
Current PC AaBhiCe Text color Black Display colors on the Editor panel and Disassemble panel
of a line where the current PC position exists
Background | Gold
color
Breakpoint AaBbhiCe Text color Black Display colors on the Editor panel and Disassemble panel of
) lines where breakpoints are set
Background | Light
color Salmon
Update AaBhCe Text color DeepPink Display colors on the Memory panel and Watch panel of areas
periodic whose display is set to be updated in real time
Background | Standard
color color
Read or AaBhiCe Text color Standard Display colors on the Memory panel and Trace panel of spots
fetch color that have been read or fetched
Background | PaleGreen
color
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ltem Example Display Description
Write AaBhiCe Text color Standard Display colors on the Memory panel and Trace panel of spots
color that have been written
Background | Orange
color
Read and AaBhiCe Text color Standard Display colors on the Memory panel and Trace panel of spots
write color that have been read and written
Background | PaleTur-
color quoise
Lost Text color White Display colors on the Memory panel of spots whose values
) obtained from the debug tool are incorrect
Background | LightGray
color
Coverage AaBhiCe Text color Standard Display colors on the Editor panel and Disassemble panel
100% color of lines whose code coverage rates are 100%
Background | LightGreen
color
Coverage 1- | AaBhirc Text color Standard Display colors on the Editor panel and Disassemble panel
99% color of lines whose code coverage rates are 1 to 99%
Background | LightPink
color
Coverage AaBhiCe Text color Standard Display colors on the Editor panel and Disassemble panel
0% color of lines whose code coverage rates are 0% (unexecuted)
Background | LightGray
color
Invalid AaBhCe Text color Gray Display colors on the Memory panel of areas that are not
memory-mapped, and of file names that are not actually
Background | Standard i
present on the Project Tree panel
color color

Note The [Default] text and background colors depend on how Windows is set on the host machine used.
Here, the default settings of Windows, namely "text color: black" and "background color: white," are

shown.

(b) [Use default color]

The items selected in the [Setting place] area are displayed using the standard text color.

|:| Specify any color for the text color of the items selected in the [Setting place] area.

The [Font Color...] button is enabled.

(c) [Use default background color]

The items selected in the [Setting place] area are displayed using the standard background color.

|:| Specify any color for the background color of the items selected in the [Setting place] area.

The [Background Color...] button is enabled.
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(d) Buttons

Font Color... Opens the Edit Colors Dialog Box, making it possible to specify a text color for the
item selected in the [Setting place] area.

However, this button is disabled when the [Use default color] checkbox is checked.

Background Color... Opens the Edit Colors Dialog Box, making it possible to specify a background color
for the item selected in the [Setting place] area.

However, this button is disabled when the [Use default background color] checkbox
is checked.

Reset Selected Item Colors Resets color information for the item selected in the [Setting place] area to restore it
to its default.

Figure A-81. Edit Colors Dialog Box
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(2) [Display example] area
Shows an example of how the colors and fonts specified in the Color setting area and the [Font settings for text edi-
tor] area will be displayed.
Although this example shows a character string "AaBbCc" by default, any character string can be entered directly
in the text box.

(3) [Font settings for text editor] area
Clicking the [Font...] button will open the Font Dialog Box below in which you can select the font to be used by the
text editor.
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Figure A-82. Font Dialog Box
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(4) Buttons area

Import... Opens the Open Option Setting File dialog box to reflect the set contents that
were saved in a file to this category.
Export... Opens the Save Option Setting File dialog box to save the set contents of this cat-

egory to a file.

Initialize Settings

Restores specifications for all of the currently displayed items to their default.

[Function buttons]

Button

Function

Initialize All Settings

Restores all of the set items in this dialog box to their default state.

For the [General - External Tools] category, however, newly registered contents are not deleted.

OK Applies changes and closes this dialog box.
Cancel Nullifies changes and closes this dialog box.
Apply Applies changes without closing this dialog box.
Help Displays help for this dialog box.
R20UT2350EJ0100 Rev.1.00 -ZENESAS Page 461 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

[General - Build/Debug] category

In this category, you can configure settings related to build and debug.

Figure A-83. Option Dialog Box ([General - Build/Debug] Category)
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Select [Options...] from the [Tool] menu.

[Description of each area]

(1) [Enable Rapid Build]

Enable the rapid build function N (default).

] Do not use the rapid build function.

Note This function automatically starts a build each time you save the edited source file.
By enabling this function, it is possible to edit source files and build the project at the same time.
When using this function, we recommend that you save frequently after editing the source file.
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(2) [Observe registered files changing]

Monitor the source files registered in the project for any changes and start a rapid build when the files are edited

and saved by an external editor, etc.

|:| Do not monitor the source files registered in the project for any changes. Do not start a rapid build when the files

are edited and saved by an external editor, etc (default).

Remark This feature is enabled only when the [Enable Rapid Build] checkbox is checked.

Caution In case any nonexistent source file (one grayed out in the project tree) is registered in the
project, checking this box will not start the monitoring even when the said file is registered
again by the Explorer, etc. To activate the monitoring mode, you need to either reload the
project file or check this box again after unchecking it and closing this dialog box.

(3) [Show dependency files in project tree]

Displays the group of files on which the source file depends as a project tree.

|:| Does not display the group of files on which the source file depends as a project tree (default).

(4) [Output quality record file when build is successful]

Outputs a quality record file if the build is successful.

|:| Does not output a quality record file if the build is successful (default).

Remarks 1.  The quality report file is not output when a rapid build is executed, a debug-only project is built, and

compiling or assembling is executed in file units.

2. The following information item is output to the quality report file.
- Time and date on which the file is created
- Log of the build results
- Information on the command file which is used during building
- Information on the detailed version of this product or the current project

3. The quality report file is output with the file name "QuarityReport(project-name.build-mode-
name).text" to the project folder of each project.
If a file having the same name exists, it will be overwritten.
It is also shown on the project tree, under the Build tool generated files node.

(5) [Enable Break Sound]

Beep when program execution is halted by a break event (hardware or software break).

] Do not beep when program execution is halted by a break event (hardware or software break) (default).

(6) [Observe downloaded load module files changing]

Monitor the load module files downloaded to the debug tool for any changes, and display a message, when
changes are detected, to confirm whether to perform the download.

|:| Do not monitor the load module files downloaded to the debug tool for any changes (default).
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(7) [Add source files automatically (for the “Debug Only” project only)]

Automatically add the source files to the project tree when the load-module files are downloaded to the debug
tool in the debug-only project (default).

|:| Do not automatically add the source files to the project tree when the load-module files are downloaded to the

debug tool in the debug-only project.

Caution This function is valid only when the load module files have been added to the download file
node on the project tree. If the load module files have been added via the [Download File
Settings] tab in the Property panel of the debug tool, then the source files will not be added to
the project tree.

(8) Buttons area

Initialize Settings Restores all of the currently displayed items to their default state.

[Function buttons]

Button Function

Initialize All Settings Restores all the settings in this dialog box to their default state.

In the [General - External Tools] category, however, newly registered contents are not deleted.

OK Applies changes and closes this dialog box.
Cancel Nullifies changes and closes this dialog box.
Apply Applies changes without closing this dialog box.
Help Displays help for this dialog box.
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External flash memory dialog box [E1] [E20]

In this dialog box, you can select the external flash definition file (USD file) to be registered.

Figure A-84. External flash memory Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- In the [External Flash] [E1] [E20] category provided in the [Connect Settings] tab on the Property panel, click [...]
button which is displayed by selecting [File] property in the [External flash definition file] property.

[Description of each area]

(1) [Look in] area
Selects the folder in which a file to download is stored from the drop-down list.

(2) File list area
Display the list of files that match the conditions specified in [Look in] and [Files of type] areas.

(3) [File name] area
Specifies the file name to be registered.
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(4) [Files of type] area

Selects the file type to be registered from the following drop-down list.

USD files (*.usd)

User system definition file format (default)

Al files (*.%)

All file formats

[Function buttons]

Button Function
Open Adds the specified file to the [File] property in the [External flash definition file] property.
Cancel Closes this dialog box.
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Open Log File dialog box

This dialog box selects a log file in which to save the displayed content of the Debug Console panel.

Open Log File

Figure A-85.

Open Log File Dialog Box
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This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Debug Console panel, select [Log File...] from the context menu.

[Description of each area]

(1) [Save in] area

Select a folder in which to save a log file.

(2) List of files area

This area displays a list of files that match the conditions selected in the [Save in] area and [Save as type] area.

(3) [File name] area

Specify a file name under which data is saved.

(4) [Save as type] area

This area displays the following types of files (file types).

Log file (*.log)

Text format (default)

Al file (*.*)

All the formats
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[Function buttons]

Button Function
Save Saves a file under a specified file name.
Cancel Closes this dialog box.
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Select Download File dialog box

This dialog box selects a file to download.

Figure A-86. Select Download File Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Click the [...] button in the [File] item in the [Download file property] area of the Download Files dialog box.

[Description of each area]

(1) [Look in] area
From the drop-down list, select the folder which contains the file you wish to download.

(2) File list area
This area displays a list of files that match the conditions selected in the [Look in] and [Files of type] areas.

(3) [File name] area
Specify the name of a file you wish to download.
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(4) [Files of type] area
Select the type of a file to download (file type) from the drop-down list below.

Load module file (*.abs)

Load module format (default)

Hex file (*.hex)

Hex format

S record file (*.mot)

S-Record format

Binary data file (*.bin)

Binary data format

Al files (*.*)

All file formats

[Function buttons]

Button Function
Open Adds a specified file to the Download Files dialog box.
Cancel Closes this dialog box.
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Open Watch Expression Data File dialog box

This dialog box is used to select a file that imports watch-expressions to the Watch panel.

Figure A-87. Open Watch Expression Data File Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the Watch panel, select [Import Watch Expression...] from the context menu.

[Description of each area]

(1) [Look in] area
Select the folder which contains the file you want to import.

(2) List of files area
This area displays a list of files matching the conditions selected in the [Look in] and [Files of type] areas.

(3) [File name] area
Specify the name of a file you want to import.

(4) [Files of type] area
The following type of the file (file type) is shown.

Importable CSV(Comma-Separated Variables) (*.csv) CSV format to enable import
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[Function buttons]

Button Function
Open Imports the specified file to the Watch panel.
Cancel Closes the dialog box.
R20UT2350EJ0100 Rev.1.00 RRENESAS Page 472 of 506

Mar 01, 2013



CubeSuite+ V2.00.00 APPENDIX A WINDOW REFERENCE

Open File dialog box

You can select files you want to open in this dialog box.

Figure A-88. Open File Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- From the [File] menu, select [Open File...] or [Open with Encoding...].

[Description of each area]

(1) [Look in] area
Select the folder which contains the file you want to open.
When you first open this dialog box, "C:\Documents and Settings \user-name\My Documents" will be selected.
After the second time, the last selected folder will be shown by default.

(2) File List area
This area shows the list of files that meet the conditions specified in [Look in] and [Files of type] areas.

(3) [File name] area
Specify the name of the file to be opened.
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(4) [Files of type] area

Select the type of the file to be opened.

Al files (*.*)

All formats

Project File(*.mtpj)

Project file

Project File for CubeSuite(*.cspj)

Project file for CubeSuite

Workspace File for HEW(*.hws)

Workspace file for HEW

Project File for HEW(*.hwp)

Project file for HEW

Workspace File for PM+(*.prw)

Workspace file for PM+

Project File for PM+(*.prj)

Project file for PM+

C source file (*.c)

C language source file

*

C++ source file (*.cpp; *.cc; *.cp)

C++ language source file

Header file (*.h; *.hpp; *.inc)

Header file

Assemble file (*.src)

Assembler source file

Map file (*.map; *.Ibp)

Map file

Hex file (*.hex)

Hex file

Assemble list file (*.Ist)

Assemble list file

S record file (*.mot)

S record file

Text file (*.txt)

Text format

[Function buttons]

Button Function
Open - When you select [Open File...] from the [File] menu:
The selected file will open.
- When you select [Open with Encoding...] from the [File] menu:
Encoding dialog box will open.
Cancel This dialog box will close.
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Save As dialog box

Saves the file being edited under a new name or saves the content of any panel in a file with a specified name.

Figure A-89. Save As Dialog Box
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Here, the following items are explained.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- While focus is present on Editor panel, chose [Save File Name As...] from the [File] menu.

- While focus is present on CPU Register panel, choose [Save CPU Register Data As...] from the [File] menu.

- While focus is present on Watch panel, choose [Save Watch Data As...] from the [File] menu.

- While focus is present on IOR panel, choose [Save IOR Data As...]. from the [File] menu.

- While focus is present on Call Stack panel, choose [Save Call Stack Data As...] from the [File] menu.

- While focus is present on Local Variables panel, choose [Save Local Variable Data As...] from the [File] menu.
- While focus is present on Output panel, choose [Save Tab name As...] from the [File] menu.

[Description of each area]

(1) [Save in] area
Select the folder in which you want to save the file.

(2) File list area
Displays a list of files that match the conditions selected in the [Save In] area and [File Type] area.

(3) [File name] area
Specify a file name under which you want to save.
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(4) [Save as type] area

(a) For the Editor panel
Depending on the type of file being edited, this area displays the following file types.

Text file (*.txt) Text format

C source file (*.c) C language source file
C++ source file (*.cpp;*.cp;*.cc) C++ source file

Header file (*.h;*.hpp;*.inc) Header file

Assemble file (*.src) Assembler source file

Link order specification file (*.mtls) Link order specification file
Map file (*.map;*.lbp) Map file

Hex file (*.hex) Hex file

Assemble list file (*.Ist) Assembler list file

S record file (*.mot) S record file

(b) For the CPU Register panel, Watch panel, IOR panel, Call Stack panel, and Local Variables panel
Following file types are displayed.
The panel content is saved to a file in the file format selected from the drop-down list.

Text file (*.txt) Text format (default)

CSV (Comma-Separated) (*.csv) CSV formatNote

Note Each piece of data are separated with a comma (,) when saved.
To avoid the problem of an invalid file format in cases where any data includes a comma (,), each piece
of data are enclosed in double-quotes (" ") when they are output to a file.

(c) For the Output panel
Following file types are displayed.
Data can be saved in only text format.

Text file (*.txt) Text format (default)

[Function buttons]

Button Function
Save Saves a file with a specified file name.
Cancel Closes this dialog box.
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Select Data Save File dialog box

Select a file in which to save the data.

Figure A-90. Select Data Save File Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- Click the [...] button in the [File Name] area of the Data Save dialog box.

[Description of each area]

(1) [Look in] area
From the drop-down list, select the folder which contains the file you wish to save.

(2) File list area
Displays a list of files that match the conditions selected in the [Look in] area and [Files of type] area.

(3) [File name] area
Specify the name of a file you wish to save.
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(4) [Files of type] area

Select the type of file to save (file type) from the drop-down list below.

The selectable file format is determined by the type of data you are saving.

(a) When saving the displayed content of a panel

Text files (*.txt)

Text format (default)

CSV (Comma-Separated Variables)(*.csv)

CSV formatNote

If the data contains commas, each entry is surrounded by double quotes (

formatting.

(b) When saving upload data

[Function buttons]

Note The data is saved with entries separated by commas (,).

) in order to avoid illegal

For the selectable file format, see "Table 2-3. Uploadable File Formats".

Button

Function

Open

Specifies a specified file in the Data Save dialog box.

Cancel

Closes this dialog box.
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Open Option Setting File dialog box

This dialog box is used to select an option setting file to import to the [General - Font and Color] category of the Option
dialog box.

Figure A-91. Open Option Setting File Dialog Box
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The following items are explained here.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the [General - Font and Color] category of the Option dialog box, click the [Import...] button.

[Description of each area]

(1) [Look in] area
Select the folder which contains the option setting file you want to open.
When you first open this dialog box, the folder is set to "C:\Documents and Settings \user-name\My Documents".
The second and subsequent times, this defaults to the last folder that was selected.

(2) List of files area
This area displays a list of files matching the conditions selected in the [Look in] and [Files of type] areas.

(3) [File name] area
Specify the name of an option setting file you want to open.
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(4) [Files of type] area

The following type of the file (file type) is shown.

Option Setting File (*.mtpu)

Option setting file

[Function buttons]

Button Function
Open Imports the specified file to the [General - Font and Color] category of the Option dialog
box.
Cancel Closes this dialog box.
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Save Option Setting File dialog box

This dialog box is used to save the set contents of the [General - Font and Color] category of the Option dialog box to
an option setting file.

Figure A-92. Save Option Setting File Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]
- [Function buttons]

[How to open]

- On the [General - Font and Color] category of the Option dialog box, click the [Export...] button.

[Description of each area]

(1) [Look in] area
Select the folder in which you want to save the option setting file.
When you first open this dialog box, the folder is set to "C:\Documents and Settings \user-name\My Documents".
The second and subsequent times, this defaults to the last folder that was selected.

(2) List of files area
This area displays a list of files matching the conditions selected in the [Save in] and [Save as type] areas.

(3) [File name] area
Specify the name of an option setting file under which you want to save.
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(4) [Files of type] area

The following type of the file (file type) is shown.

Option Setting File (*.mtpu) Option setting file

[Function buttons]

Button

Function

Save

Saves the option setting file with the specified name.

Cancel

Closes the dialog box.
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APPENDIX B 1/0 FUNCTIONS

This section describes the 1/O settings for the simulator in a low-level interface routine (assembly language part).

The simulator provides functions for handling standard 1/0 and file I/O

The 1/O function for a simulator can be used when [Simulator mode] is specified in the [Select stream I/O mode]
property in the [Stream 1/O] [Simulator] category on the Property panel's [Debug Tool Settings] tab.

B.1 Standard I/O and File I/O

The content of a file that is called from a low-level interfaced routine to perform input and output is replaced with a
program for 1/0.

With the standard I/O functions GETC and PUTC, the functions that perform 1-character input and output, "charput,”
"charget" (_charput, _charget), are replaced with a program for debug console facilities, to perform input and output of
data onto and from the Debug Console panel.

The 1/O functions are listed below.

Table B-1. 1/O Facilities

Classification Facility name Description
Standard 1/0 GETC Accepts 1 byte from standard input.
PUTC Outputs 1 byte to standard output.
File I/0 FOPEN Opens a file.
FCLOSE Closes a file.
FGETC Accepts 1 byte from a file.
FPUTC Outputs 1 byte to a file.
FEOF Checks termination of a file.
FSEEK Moves the file pointer to a specified position.
FTELL Obtains the file pointer's current position.

Remark For details about low-level interface routines, see Chapter 7, "Startup,” in the separate edition, "CubeSuite+
Integrated Development Environment User's Manual: RX Coding."

To implement 1/O function of the simulator, first specify the I/O address in the [Stream |/O address] property within the
[Stream 1/O] [Simulator] category on the Property panel's [Debug Tool Settings] tab. This can be done by entering

address expressions in the range of 0 to "last address of address space" directly from the keyboard.

Figure B-1. [Stream I/O] Category

E Stream /0

Select stream /0 maode Simulator mode
Ilze stream | /0 funchon Mo
( Stream /0 address [Fe=] 0

Upon detecting "Branch to subroutine" instruction (BSR, JSR) to a specified address while executing instructions of the
program, the simulator performs an 1/O process using the contents of the R1 and R2 registers as parameters.
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Therefore, be sure that the following setting is made in the program before an 1/0 process is performed.

- Function code (R1 register)

MSB 1 byte 1 byte 1 byte 1 byte LSB
| 0x01 ‘Function code‘ 0x00 0x00

- Address of the parameter block (R2 register)
For the content of the parameter block, see the description of each I/O function.

MSB LSB

- Reservation of areas for the parameter block and stream 1/O buffer
To access each parameter in the parameter block, make sure that an access is made in size of the relevant
parameter.
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GETC

Accepts 1 byte from standard input.

[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 0x21 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte
+0 Beginning address of
+2 input buffer
[Parameters]
Parameter Description

Beginning address of input buffer (input)

Beginning address of the input buffer to which input data is written

[Detailed Description]

- Accepts 1 byte from standard input.

[Example]
_charget:
MOV.L #1210000h,R1 Set the function code of GETC in RI1.
MOV.L #I0 BUF,R2 Set the address of the input buffer in R2.
MOV.L #PARM, R3 Set the address of the parameter block in R3.
MOV.L R2, [R3] Set the address of the input buffer in the parameter
; block.
MOV.L R3,R2 Set the value of R3 (address of the parameter block)
in R2.
MOV.L #SIM IO, R3 Set the address of the system call in R3.
JSR R3 System call
MOV.L #I0 BUF,R2 Set the address of the input buffer in R2.
MOVU.B [R2],R1 Set the first byte of the input buffer
(acquired 1l-byte character) in RI1.
RTS ; Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 1 Parameter block area
.SECTION B_1,DATA
IO BUF: .BLKL 1 Input/output buffer

R20UT2350EJ0100 Rev.1.00
Mar 01, 2013

RRENESAS Page 485 of 506



CubeSuite+ V2.00.00 APPENDIX B 1/0 FUNCTIONS

PUTC

Outputs 1 byte to standard output.
[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x22 0x00 0x00

[Parameter Block (R2 Register)]

1 byte 1 byte
+0 Beginning address of
+2 output buffer
[Parameters]
Parameter Description
Beginning address of output buffer (input) Beginning address of the output buffer that contains output data

[Detailed Description]

- Outputs 1 byte to standard output.

[Example]
_Charput:
MOV.L #I0_BUF,R2 ; Set the address of the output buffer in R2.
MOV.B R1, [R2] ; Set the value of Rl (output character) in the output
; buffer.
MOV.L #1220000h,R1 ; Set the function code of PUTC in R1.
MOV.L #PARM, R3 ; Set the address of the parameter block in R3.
MOV.L R2, [R3] ; Set the address of the output buffer in the output
; buffer.
MOV.L R3,R2 ; Set the value of R3 (address of the parameter block)
; in R2.
MOV.L #SIM IO, R3 ; Set the address of the system call in R3.
JSR R3 ; System call
RTS ; Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 1 ; Parameter block area
.SECTION B 1,DATA
I0_BUF: .BLKL 1 ; Input/output buffer
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FOPEN
Opens a file.
[Function Code (R1 Register)]
1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x25 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte
+0 | Execution result | File number
+2  |Open mode Unused
+4  |Beginning address of
+6 | file name
[Parameters]
Parameter Description

Execution result (output)

0: Terminated normally

-1: Error

File number (output)

Number that is used for access to files after the open process

Open mode (input)

0x00: "r"
0x01: "w"
0x02: "a"
0x03:
0x04: "w+"
0x05: "a+"
0x10: "rb"
0x11: "wb"
0x12: "ab"
0x13: "r+b"
0x14: "w+b"
0x15:

The content of each mode is as follows:

o

"a+p"

"r": Opens for read.

"w": Opens a blank file for write.

"a": Opens for write from the end of a file.
"r+": Opens for read and write.

"w+": Reads a blank file and opens it for write.
"a+": Opens additionally for read.

"b": Opens in binary mode.

Beginning address of file name (input)

Beginning address of the area that contains the file name
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[Detailed Description]

- When a file is opened by [FOPEN], a file number is returned.

This file number is used in subsequent operations to input or output to the file, as well as to close the file.

- Up to 256 files can be opened at a time.

[Example]
_fileopen:
MOV.L R2,R5 Set the value of R2 (open mode) in R5.
MOV.L #PARM, R2 Set the address of the parameter block in R2.
MOV.L R1,4h:5[R2] Set the value of Rl (first address of the filename)
in R2 + 4 bytes.
MOV.B R5,2h:5[R2] Set the value of R5 in R2 + 2 bytes (open mode) .
MOV.L #01250000h,R1 Set the function code of FOPEN in RI1.
MOV.L #SIM IO, R5 Set the address of the system call in R5.
JSR R5 System call
NOP
MOV.L #PARM, R2 Set the address of the parameter block in R3.
MOV.B 1h:5[R2],R1 Set the value of R2 + 1 byte (file number) in RI1.
MOV.B R1, [R3] Set the value of Rl in the location pointed to by
R3 (file number pointer).
MOV.B [R2],R1 Set the first byte of R2 (result of execution) in RI.
RTS Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 2 Parameter block area
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FCLOSE

Closes a file.

[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 0x06 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte

+0 |Execution result |File number

[Parameters]

Parameter

Description

Execution result (output)

0: Terminated normally

-1: Error

File number (input)

Number that is returned when a file is opened

[Detailed Description]

Closes afile.
[Example]

_fileclose:
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.B R1,1h:5[R2] ; Set the value of R1 (file number) in R2 + 1 bytes.
MOV.L #01060000h,R1 ; Set the function code of FCLOSE in RI1.
MOV.L #SIM IO,R3 ; Set the address of the system call in R3.
JSR R3 ; System call
NOP
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.B [R2],R1 ; Set the first byte of R2 (result of execution) in RI1.
RTS ; Return to the address where the function was called.

.SECTION B,DATA,ALIGN=4
PARM: .BLKL 1 ; Parameter block area
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FGETC

Reads 1 byte of data from a file.

[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x27 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte
+0 |Execution result | File number
+2 [|Unused
+4 |Beginning address of
+6 |input buffer
[Parameters]
Parameter Description

Execution result (output)

0: Terminated normally
-1: EOF detected

File number (input)

Number that is returned when a file is opened

Beginning address of input buffer (input)

Beginning address of the buffer to which input data is written

[Detailed Description]

- Reads 1 byte of data from a file.

[Example]

_fcharget:
MOV.L R2,R5 ; Set the value of R2 (file number) in R5.
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.L R1,4h:5[R2] ; Set the value of R1 (input buffer) in R2 + 4 bytes.
MOV.B R5,1h:5[R2] ; Set the value of R5 in R2 + 1 bytes (file number).
MOV.L #01270000h,R1 ; Set the function code of FGETC in RI1.
MOV.L #SIM IO,R3 ; Set the address of the system call in R3.
JSR R3 ; System call
NOP
MOV.L #PARM, R1 ; Set the address of the parameter block in RI1.
MOV.B [R1],R1 ; Set the first byte of Rl (result of execution) in RI1.
RTS ; Return to the address where the function was called.

.SECTION B,DATA,ALIGN=4
PARM: .BLKL 2 ; Parameter block area
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FPUTC
Writes 1 byte of data to a file.
[Function Code (R1 Register)]
1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x28 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte
+0 |Execution result | File number
+2 [|Unused
+4 |Beginning address of
+6 |output buffer
[Parameters]
Parameter Description

Execution result (output)

0: Terminated normally

-1: Error

File number (input)

Number that is returned when a file is opened

Beginning address of output buffer (input)

Beginning address of the buffer that contains output data

[Detailed Description]

- Writes 1 byte of data to a file.

R20UT2350EJ0100 Rev.1.00
Mar 01, 2013

RRENESAS

Page 491 of 506



CubeSuite+ V2.00.00

APPENDIX B 1/0 FUNCTIONS

[Example]

_fcharput:
MOV.L R2,R5 Set the value of R2 (file number) in R5.
MOV.L #PARM, R2 Set the address of the parameter block in R2.
MOV.L #I0 BUF,R4 Set the address of the output buffer in R4.
MOV.L R4,4h:5[R2] Set the value of R4 (output buffer) in R2 + 4 bytes.
MOV.B R1, [R4] Set the value of Rl (output character) in the

location pointed to by R4 (output buffer).
MOV.B R5,1h:5[R2] Set the value of R5 in R2 + 1 bytes (file number).
MOV.L #01280000h,R1 Set the function code of FPUTC in RI1.
MOV.L #SIM IO,R3 Set the address of the system call in R3.
JSR R3 System call
NOP
MOV.L #PARM, R1 Set the address of the parameter block in RI1.
MOV.B [R1],R1 Set the first byte of Rl (result of execution) in RI.
RTS Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 2 Parameter block area
.SECTION B _1,DATA
IO BUF: .BLKL 1 Input/output buffer
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FEOF

Checks for end of file.

[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 0x0B 0x00 0x00
[Parameter Block (R2 Register)]
1 byte 1 byte

+0 |Execution result |File number

[Parameters]

Parameter

Description

Execution result (output)

0: Not EOF
-1: EOF detected

File number (input)

Number that is returned when a file is opened

[Detailed Description]

- Checks for end of file.

[Example]

_fpeof:
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.B R1,1h:5[R2] ; Set the value of R1 (file number) in R2 + 1 bytes.
MOV.L #010B0000Oh,R1 ; Set the function code of FEOF in RI1.
MOV.L #SIM IO,R3 ; Set the address of the system call in R3.
JSR R3 ; System call
NOP
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.B [R2],R1 ; Set the first byte of R2 (result of execution) in RI1.
RTS ; Return to the address where the function was called.

.SECTION B,DATA,ALIGN=4
PARM: .BLKL 1 ; Parameter block area
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FSEEK

Moves the file pointer to a specified position.
[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x0C 0x00 0x00

[Parameter Block (R2 Register)]

1 byte 1 byte
+0 | Execution result | File number
+2  |Direction Unused
+4
Offset
+6
[Parameters]
Parameter Description
Execution result (output) 0: Terminated normally
-1: Error
File number (input) Number that is returned when a file is opened
Direction (input) 0: Offset in bytes from the beginning of a file
1: Offset in bytes from the current file pointer
2: Offset in bytes from the tail end of a file
Offset (input) Number of bytes from the position specified by direction

[Detailed Description]

- Moves the file pointer to a specified position.
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[Example]
_fpseek:
MOV.L R2,R5 ; Set the value of R2 (offset) in R5.
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.L R5,4h:5[R2] ; Set the value of R5 in R1 + 4 bytes (offset).
MOV.B R1,1h:5[R2] ; Set the value of Rl (file number) in R1 + 1 bytes
; (offset).
MOV.B R3,2h:5[R2] ; Set the value of R3 (direction) in R2 + 2 bytes
; (direction).
MOV.L #010C0000h,R1 ; Set the function code of FSEEK in R1.
MOV.L #SIM IO,R5 ; Set the address of the system call in R5.
JSR R5 ; System call
NOP
MOV.L #PARM, R1 ; Set the address of the parameter block in RI1.
MOV.B [R1],R1 ; Set the first byte of Rl (result of execution) in RI1.
RTS ; Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 2 ; Parameter block area
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FTELL

Obtains the current position of the file pointer.
[Function Code (R1 Register)]

1 byte 1 byte 1 byte 1 byte
| 0x01 ‘ 0x0D 0x00 0x00

[Parameter Block (R2 Register)]

1 byte 1 byte

+0 |Execution result | File number

+2 [|Unused

+4
Offset
+6
[Parameters]
Parameter Description
Execution result (output) 0: Terminated normally
-1: Error

File number (input) Number that is returned when a file is opened
Offset (output) Current position of the file pointer (Number of bytes from the top of the file)

[Detailed Description]

- Obtains the current position of the file pointer.
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[Example]
_fptell:
MOV.L R2,R5 ; Set the value of R2 (offset) in R5.
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.B R1,1h:5[R2] ; Set the value of Rl (file number) in R2 + 1 bytes
; (direction).
MOV.L #010D0000h,R1 ; Set the function code of FTELL in RI1.
MOV.L #SIM IO,R3 ; Set the address of the system call in R3.
JSR R3 ; System call
NOP
MOV.L #PARM, R2 ; Set the address of the parameter block in R2.
MOV.L 4h:5[R2],R1 ; Set the value of R2 + 4 bytes (new offset) in RI1.
MOV.L R1, [R5] ; Set the value of Rl in the location pointed to by R5
; (offset pointer).
MOV.B [R2],R1 ; Set the first byte of R2 (result of execution) in RI1.
RTS ; Return to the address where the function was called.
.SECTION B,DATA,ALIGN=4
PARM: .BLKL 2 ; Parameter block area
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Access width ... 386

Access-related event ... 161, 200

Action event ... 191, 374, 393

Action Events dialog box ... 393
[Interrupt Event Setting] tab ... 398
[Printf event] tab ... 395

Address Offset Settings dialog box ... 406

Address range ... 385

After execution (post-execution) break ... 116

Allowable number of valid events ... 207

AND ... 124,204

Array ... 334, 341

Auto variables ... 334

B

Before execution (pre-execution) break ... 115
Before execution (pre-execution) event ... 430
Big endian ... 135

Binary data format ... 74, 77, 80

Bookmarks dialog box ... 403

Break ... 26, 40, 54

Break event ... 116, 123, 209

Break event (access-related) ... 118, 207, 208
Break event (execution-related) ... 116, 207, 208
Break factor ... 114, 124

Breakpoint ... 26, 54, 114

Built-in event ... 160, 177, 198, 370

Cc

Call stack information ... 354

Call Stack panel ... 354

Channel number ... 180, 371

Clock ... 18,32,47,59

Clock source ... 19, 33, 48

Code coverage measurement ... 188
Code coverage measurement result ... 288

Code outlining ... 287

INDEX

Collecting an execution history ... 154
Clearing the trace memory ... 169
Collecting an execution history in a section ... 160
Collecting an execution history only when conditions
are met ... 165
Collecting an execution history up to a halt ... 160
Displaying an execution history ... 167
Saving the displayed content of an execution history
.. 174
Searching for trace data ... 169
Setting up a trace operation ... 154
Stopping/restarting collection of execution history
. 166
Column Number Settings dialog box ... 405
Combination break ... 123, 203, 207, 208, 369, 370
Combination condition ... 123, 164, 203, 425
Combination Condition dialog box ... 423
Configuration of operating environment ... 15
Connect to/disconnect from the debug tool ... 66
Connectable debug tool ... 12
Connection to the debug tool ... 66
Control register ... 138, 321
Coverage measurement ... 188
Configure the coverage measurement ... 188
Display coverage measurement results ... 188
CPU Register panel ... 321
Current PC mark ... 313
Current PC position ... 286, 313

D

Data coverage measurement ... 188

Data flash memory ... 18, 32, 47

Data Save dialog box ... 452

Debug Console panel ... 382

Debug information ... 275

Debug toolbar ... 235

Debug-dedicated project ... 71

Detailed Settings of Access Events dialog box ... 434
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Detailed Settings of Execution Events dialog box ... 430
Detailed Settings of Interrupt Events dialog box ... 444
Detailed Settings of Timer Measurement dialog box
. 185, 427
Differences between the MCU and the E1/E20/EZ
Emulator ... 225
Disassemble display mode ... 168, 362
Disassemble panel ... 310
Disassembled text ... 94, 310
Display form of watch-expressions ... 346
Display function call information from the stack ... 152
Display call stack information ... 152
Saving the displayed contents of call stack
information ... 153
Displaying and changing memory, registers, and
variables ... 126
Displaying and changing global and static variables
. 142
Displaying and changing local variables ... 142
Displaying and changing memory contents ... 126
Displaying and changing the CPU registers ... 138
Displaying and changing the 1/O registers ... 140
Displaying and changing watch-expressions ... 145
Displaying and changing programs ... 85
Displaying source files ... 85
Displaying the disassembled result ... 94
Executing a build in parallel with other processes
.97
Performing line assembly ... 98
Displaying the disassembled result ... 94
DMM (Dynamic Memory Modification) function ... 129
Download ... 29, 44, 57,71, 274
Download condition ... 76, 388
Download Files dialog box ... 388

Downloadable File Formats ... 74

E

Editor panel ... 280
Emulator firmware ... 66
Encoding ... 401

Encoding dialog box ... 400

Endian ... 22, 24, 36, 38, 50, 52, 59, 135
Epilog of functions ... 334
Event area ... 285, 312
Event management ... 196
Allowable number of valid events ... 207
Changing states of event setting ... 198
Deleting events ... 206
Displaying only a specific type of event ... 199
Editing detailed settings of events ... 199
Jump to an event address ... 199
Types of events that can be set or removed during
execution ... 209
Event mark ... 115, 161, 182, 186, 369
Event type ... 370
Events panel ... 366
Execute programs ... 106
Execute a specified routine ... 110
Execute programs ... 108
Execute programs in steps ... 109
Execution only once ... 186, 428
Execution-related event ... 161, 199
External flash memory ... 22, 81

External flash memory dialog box ... 465

F
Features ... 8
File /O ... 483
File monitor ... 289

Floating-point value ... 128, 305

G

[General - Build/Debug] category ... 462
[General - Font and Color] category ... 457
General-purpose registers ... 138, 321
Global variable ... 142

109, 209

Go to Line dialog box ... 450

Go to Here ...

Go to the Location dialog box ... 451

H
Hardware break ... 114, 207, 208, 209, 369, 370
Hex format ... 74, 77, 80
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Hot plug-in connection ... 68 Measuring the execution time ... 176

Hot-plug Adapter ... 69 Measuring execution time from start to stop ... 177

I/O registers protected against read ... 329

Measuring execution time in a section ... 178

Range of measurable time ... 186

Setting the timer measurement operation ... 176

ID code ... 21,34, 49 Memory access ... 24, 38, 52, 61
Initialization data ... 135, 407 Memory Initialize dialog box ... 407
/O functions ... 483 Memory mapping ... 23,37, 51, 61, 385

FCLOSE ... 489 Memory Mapping dialog box ... 384

FEOF ... 493 Memory panel ... 301

FGETC ... 490 Memory Search dialog box ... 409

FOPEN ... 487 Memory settings ... 60

FPUTC ... 491 Memory type ... 385

FSEEK ... 494 Menu bar ... 233

FTELL ... 49 Methods to register watch-expressions ... 146

GETC ... 485 Mixed display mode ... 86, 168, 280, 362

PUTC ... 486 Motorola S format ... 74,77, 80
Instruction code ... 313 Moving to a specified address ... 95
Instruction level debugging ... 85 Moving to a specified line ... 91
Internal static variables ... 334 Moving to a symbol definition part ... 96
Interrupt event ... 193, 208, 209, 210, 369, 371, 444
IOR panel ... 326 N

Newline code ... 401
J Number of trace frames ... 160
Jump to subroutine instruction ... 110
o
L Offset value ... 302, 313, 361, 406
Label line ... 313 Open File dialog box ... 473
Label name ... 361 Open Log File dialog box ... 467
Line assembly ... 98, 314 Open Option Setting File dialog box ... 479
Little endian ... 135 Open Watch Expression Data File dialog box ... 471
Load module file ... 71, 196 Operation mode ... 83
Load module format ... 74 Option dialog box ... 455
Local variable ... 131, 142, 210 [General - Build/Debug] category ... 462
Local Variables panel ... 333 [General - Font and Color] category ... 457
Lock bit ... 83 OR .. 124, 204
Lost ... 132 Other notes on usage ... 227
Low-level interface routine ... 214 Access to the MPU area ... 229
Boot swap function ... 229

M DMAC and DTC ... 228
Main area ... 286
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Endian select registers (MDEB, MDES) ... 227

FINE interface ... 227

Flash shield window ... 228

High-speed clock oscillator (HOCO) ... 228

Internal flash ROM ... 227

Lock bits ... 228

Operating frequency ... 229

Option function select register 1 (OFS1) setting
. 227

Register values after the flash memory has been
programmed ... 228

Output panel ... 379

Overlay section ... 73, 103

P
Pass count ... 195, 200, 375, 432, 439, 445
Point trace ... 207, 208, 210, 369, 370
Point trace event ... 165, 299

Pointer-type variables ... 334, 341

Pop-up display of variables ... 288

Port Setting dialog box ... 447

Power-down mode ... 210

Print Address Range Settings dialog box ... 411
.. 413

Printf event ... 191, 208, 210, 369, 370, 395

103, 104

Print Preview window

Priority section ...
Progress Status dialog box ... 454
Project Tree panel ... 240
Prolog of functions ... 334
Property panel ... 243
[Connect Settings] tab ... 246
[Debug Tool Settings] tab ... 258
[Download File Settings] tab ... 274
[Hook Transaction Settings] tab ... 277
Pseudo-RRM ... 129

R

Rapid build function ... 97

129, 150
129, 156

Realtime display update function ...
Real-time RAM monitor function ...

Recycle mode ... 88, 282

Register Action Event ... 191, 193
Register variables ... 334
Registering a watch-expression ... 339
Re-registering watch-expressions ... 151
Reset ... 129, 177

Reset event ... 205, 426

Reset microcontroller (CPU) ... 19, 33, 48, 106
Return Out execution ... 110, 236

RRM (real-time RAM monitor) ... 129, 209
Run-Break time ... 177

Run-Break Timer ... 369, 370

Run-Break Timer event ... 177, 368

S
Save As dialog box ... 475
Save Option Setting File dialog box ... 481
Save Settings dialog box ... 401
Saving watch-expressions ... 150
Scope selection ... 142
Scroll Range Settings dialog box ... 448
Select Data Save File dialog box ... 477
Select Download File dialog box ... 469
Selecting blocks ... 289
Sequential ... 124, 204
Set an action into programs ... 191

Insert an interrupt event ... 193

Insert printf ... 191
Set PC to Here ... 109
Set states of events ... 198
Setting up a trace operation ... 154
Setting up the hook process ... 211
Software break ... 114, 207, 208, 209, 369, 370
Source display mode ... 168, 362
Source level debugging ... 85, 280
Specified routine ... 110
Specify the PIC/PID offset ... 101
Standard I/O ... 214, 483
Standard library function ... 214
Start Trace ... 167, 364
Status bar ... 237

Step execution ... 109
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Step In execution ... 110, 236
Step Over execution ... 110, 236
Stop programs ... 114
Stop the program at the arbitrary position (break
event) ... 116
Stop the program at the arbitrary position
(breakpoint) ... 114
Stop the program manually ... 114
Stop the program with the access to variables ... 118
Stop Trace ... 167, 364
Structure ... 334, 341
Subjects that are registrable as watch-expressions
... 146, 341

Supervisor mode ... 112, 185

T

Tag jump ... 92, 288, 380

Target range for the RRM (real-time RAM monitor)
. 131

Text Edit dialog box ... 392

Timer end event ... 179, 370

Timer measurement ... 176, 208, 210, 369, 370, 428

Timer measurement event ... 178

Timer start event ... 179, 370

Timestamp information ... 269, 360

Trace ... 156, 207, 208, 209, 369, 373

Trace end event ... 161, 370

Trace event ... 160

Trace memory ... 154, 157

Trace number ... 360

Trace panel ... 358

Trace Search dialog box ... 415

Trace start event ... 161, 370

Type of breakpoint ... 114, 266

Types of events ... 209

u

Unconditional trace ... 369, 370
Unconditional trace event ... 160, 198
Union ... 334, 341

Upload ... 71, 83

Uploadable file formats ... 84
Usage of PIC/PID Function ... 100
USB boot program ... 22, 35, 255
USD file ... 81

User boot mode ... 22, 35, 254

\")
Vector read access ... 363

Verify ... 264

w

Watch panel ... 339
Watchdog timer ... 129
Watch-expression ... 145, 339
Watch-expression input form ... 342
Window reference ... 230

Work RAM ... 21, 49
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Zoom in or out on a view ... 289
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